## CONTENTS

**DESIGNER NOTES**  
From The Beginning  
That Special Thing  
People Behind the Game  
Final Thoughts  

**PART 1: GAMEPLAY**  

1. **INSTRUCTION**  

2. **GETTING STARTED**  
2.1. Installation  

3. **UNDERSTANDING THE GAME INTERFACE**  
3.1. Main Menu  
3.2. New Game  
3.3. Options  
3.4. Advanced Options  
3.5. The In-Game Interface  
3.6. Further Interface Information  

4. **1939 WORLD AT WAR TUTORIAL**  
4.1. Axis Turn 1  
4.2. Axis Turn 2  
4.3. Axis Turns – Winter 1939  

5. **GAME ESSENTIALS**  
5.1. Key Areas of Gameplay  
5.2. Hotkeys  
5.3. Major and Minor Powers  
5.4. Indicator Sprites  
5.5. Orders
5.6. Unit Modes 86
5.7. Zones of Control 86
5.8. Combat 87
5.9. Raiding 88
5.10. Conquering Countries 89
5.11. National Morale 89
5.12. HQs 90
5.13. Supply Rules 90
5.14. Partisans 92
5.15. Maintaining Units’ Combat Effectiveness 92
5.16. Decision Events 93
5.17. Building Fortifications 93
5.18. Politics and Diplomacy 93
5.19. Weather 94
5.20. The Research Mechanism 95
5.21. Manual Upgrades 96
5.22. Automatic Upgrades 97
5.23. Automatic Industrial Mobilization 99
5.24. Military Production 99
5.25. Further Gameplay Tips 99
5.26. Ending a Turn 100
5.27. Saving a Game 101
5.28. Exiting the Game 101
5.29. Winning the Game 101
5.30. Support 101

6. MOVEMENT AND COMBAT 101
6.1. Basics 101
6.2. Moving Units 103
6.3. Land Movement 107
6.4. Air Movement 111
6.5. Naval Movement 112
6.6. Combat 120
7. Advanced Gameplay Concepts

7.1. General Unit Characteristics
7.2. Combat Target Values
7.3. Headquarters Attachments
7.4. Building Fortifications
7.5. Surrendering Nations
7.6. Capturing Enemy Supply Centers
7.7. Plunder
7.8. Victory Conditions
7.9. The Game Engine’s Turn Sequence
7.10. Collecting Military Production Points
7.11. Supply
7.12. Resource Definitions
7.13. Maximum Resource Strengths
7.15. Besieging Resources
7.16. Port Supply to Land Forces
7.17. Artillery with Zero Supply
7.18. Raiding when at Zero Supply
7.19. Damage to Resources
7.20. Industrial Modifier
7.21. Unit Production
7.22. Reinforcement Costs
7.23. The Cost of Upgrading Units
7.24. Decision Events
7.25. Factors Influencing Combat Effectiveness
7.26. Naval Supply
7.27. Supply and Action Points Table
7.28. Supply & Reinforcements Table
7.29. Morale and Readiness
7.30. Supply Values

8. Unit Types
8.1. Land Units 175
8.2. Air Units 182
8.3. Naval Units 184

9. RESEARCH 188
9.1. Introduction 188
9.2. In Depth: The Research Mechanism 190
9.3. Viewing Progress 193
9.4. Progressing to the Next Level 193
9.5. Research Limits 194
9.6. Research Categories 194
9.7. Applying Manual Upgrades 195
9.9. Automatic Upgrades 202

10. POLITICS AND DIPLOMACY 207
10.1. Alignment Status & Mobilization Values 207
10.2. The Diplomatic Mechanism 208
10.3. Contested Diplomacy 210
10.4. Impending War Entry 210
10.5. Belligerence 210
10.6. The Wider Impact of Declarations of War 211

PART 2: DESIGNING YOUR OWN CAMPAIGNS 213

1. INTRODUCTION 213
1.1. First things First 213
1.2. Using The Editor 214

2. MENU BUTTONS 215
2.1. File 215
2.2. Edit 219
2.3. Map 220
2.4. Campaign 230
DESIGNER NOTES

FROM THE BEGINNING

Starting in 2002, the Strategic Command series has seen numerous releases, including this one, that have covered virtually every aspect of WWI and WWII. In addition, we've also been able to produce a number of expansion packs to fill the void between major releases.

However, one item that has never been included is a chapter discussing the history, inspiration and people behind Strategic Command. When asked to include Designer Notes this time around, it took me some time to step back from the day to day and decompress all the events, time and years spent on these games. For myself, and after many years of working on the Strategic Command series, I had to remember just why I decided to pursue game design, strategy games and more importantly this specific series in the first place.

While the final chapter in the story of the Strategic Command series has yet to be written, the story up to this point is perhaps mostly the story of my life for the last 20+ years. I realize that sounds a bit clichéd, but as with all stories, there is a beginning to this one in that had several specific events not occurred, I most likely would not be sitting down to write these Designer Notes at all.

If I can think of a starting point to the adventure that has been the Strategic Command series it would probably go back to a fateful night in 1993. I had unfortunately totaled my car leaving me with just enough of an insurance claim settlement to purchase, of all things since I was not allowed to purchase another vehicle, my first PC.

While I was now back to taking the bus to high school, I quickly discovered the addictive nature of PC gaming and at one point was devouring games like Civilization, Doom and Wolfenstein 3-D.

What I learned from probably playing way too many hours of these games, was that of all the games I discovered, I really liked strategy games and that I had gained a great interest in how they worked and that it was something I wanted to pursue further by learning how to program.

I then took every programming class I could in high school, and followed that up by pursuing Computer Science at university. By the time I graduated in 1999 I was at a bit of a crossroads as I was now at the point
in my life where I could either go out to find a job, or take some time off to
design my first full game.

I decided that it was worth the risk to pursue game design on my own
with the thinking that if I was successful I could perhaps sell it and make
a living making games. If not, I had hoped that the time off spent on a
gaming project would at least look better on my resume than just having a
Computer Science degree alone. I gave myself 6 months and in the end the
game took nearly 2 years to develop.

Luckily enough the game was a hit and it did happily allow me to pursue
game design as a living.

**THAT SPECIAL THING**

So what makes *Strategic Command* special?

At the time I began development in 1999, there was in my mind a bit
of a void when it came to grand strategy WWII PC war games that were
approachable and somewhere in between what a grognard would like to
see, and what any war game “lite” player would be interested in.

*Clash of Steel* was probably the closest game to the above and really
the type of game I had enjoyed the most, but it had been released 6 years
earlier and was now a bit dated with nothing on the market to really replace
it. Other games that I had loved playing were *Panzer General* and the *Axis
and Allies* board game and later PC version of that game.

For me these games hit the sweet spot between a serious PC war
game and something that would be generally a lot of fun to play for the
casual gamer. Ultimately, they had a very strong influence on the design
philosophy I wanted to pursue with *Strategic Command* which was to
combine all the best elements of these very specific games that I had
enjoyed playing so much.

My immediate goals were for *Strategic Command* to cover the European
Theater, play as a grand strategy game, include items of interest such as
experience medals, show colored control changes on the map, and be
quick and easy to play. Much of which, at least in this type of combination
which is probably surprising to hear today, simply did not exist in a more
serious PC war game back in 1999.
Having it quick and easy to play was probably the most important item on my list as I found all the other more serious war games of the day very cumbersome to play. Right or wrong, they seemed to be porting board game type rules to the PC, whereas I wanted this to be an unhindered pure PC game only. Not having played war board games of any kind other than games like *Axis and Allies* probably helped in this regard as I felt no real attachment to the default implementations at the time.

This meant eliminating specific game play mechanisms such as restrictive phases, and points systems for purchases, operational movements, transports and so on. The idea was to have a simplified production point system (MPPs in *Strategic Command*) that allowed the player to spend on anything they wanted to spend on, and at any time they wanted to spend those MPPs in game.

For example, will it be a good idea to spend all your MPPs operationally moving your entire Army across the front? Perhaps a gamey move to some opponents, but if chosen as a surprise method of engaging and overwhelming your enemy, the result is that you now have nothing left to purchase new units or to invest in Research or Diplomacy for the next few turns.

The general idea was that while both players could more freely pursue multiple options, paths and strategies to victory or defeat, ideally there would always be a downside to any decision. If the new design could find the right balance of enforcing pros and cons to every open decision, and from very few forced rules upon a player, then I felt the game would be a fresh take on a grand strategy war game, and hopefully a winner in the minds of the gamers.

In the end the game was a bit of a success, very well received with a 90% score from PC Gamer, and once we introduced Multiplayer (at one time ranked in the top 5 play by email games of all time by PC Gamer as well) there were some very wild and exciting games. Fans may even fondly remember the competitive atmosphere and the time things got out of control during the infamous forums Christmas riot of 2002!

**People Behind the Game**

As with any product, it is only as good as those that are behind the scenes making it all happen. In the early days, and because we released the
same Editor that we use to design the game, there were quite a few mods created and some really excellent ones that caught my eye. Over the years these excellent designers have contributed hundreds of hours and helped to make the Strategic Command series what it is today.

Notable contributors include Bill Macon, Dave Maurer, Robert Carver, Edwin Fager, David Stoeckl, Alvaro Sousa and Bill Runacre.

In particular, Bill Runacre who has not only written this Manual and all the Strategy Guides, (thank you Bill!) is now the lead designer for the Strategic Command games and has been since 2008 with our Pacific Theater release.

At one point I was thinking of attempting to calculate the man hours both Bill and I have put into this latest game for this chapter, now 3 years in development, and I stopped half way through as I didn't want to depress myself any further on just how much time we've spent on this project.

All jokes aside however, it has been a tremendous effort and one that would not have been possible without all the collaboration with Bill and weight off of my shoulders to simply pursue the coding side of the Strategic Command series.

I'd also like to acknowledge Jean Vincent-Roy, our artist extraordinaire, without whom we'd not have the fantastic look and feel for this new game and of course all our core testers that have been with the series since nearly the beginning. The countless hours of testing, providing feedback and their own individual efforts to help promote and be ambassadors for the game has always been much appreciated.

**Final Thoughts**

This latest release of Strategic Command continues the tradition of the very first game I released in 2002 by attempting to create an easy to play and highly approachable, yet deeply immersive PC war gaming experience. With continued improvements to the campaign and game engine designs, Artificial Intelligence, and overall user experience, we hope that you enjoy this game as much as we enjoyed creating it.

Sincerely, and on behalf of the entire Strategic Command development and testing team,

Hubert Cater
PART 1: GAMEPLAY

“There is only one principle of war and that’s this. Hit the other fellow, as quickly as you can, as hard as you can, where it hurts him most, when he ain’t looking.”

General William Slim, Commander of the Fourteenth Army, Burma.

1. INTRODUCTION

The Second World War was the greatest conflict of the 20th century. The world stood on the edge of a precipice as an alliance of Germany, Italy and Japan thrust much of the planet into turmoil as they strove for world domination.

With Strategic Command you can re-fight the campaigns of those turbulent years, leading your forces forward to conquer as the Axis, or defending and then counterattacking as the Allies. The prospects of victory and the future of the world are in your hands!

To win you will need to plan ahead, manage your resources wisely, use diplomacy where appropriate, make shrewd decisions, invest in technological research, and apply sound military strategies.

Strategic Command provides you with the opportunity to relive this key period in history as you lead your forces to victory!

Our Editor can also be used to design your own campaigns, which can be a very fulfilling thing to do. Our games have a thriving modding community and this Editor means you can dive in too! Either to make slight modifications to the official campaigns to suit your own tastes, or to make totally new ones. Details on how to use it are included in Part 2, Designing Your Own Campaigns.
2. GETTING STARTED

2.1. INSTALLATION

2.1.1. MINIMUM SYSTEM REQUIREMENTS

CPU: 2 GHz Processor
RAM: 2 GB
OS: Windows Vista/7/8/10
Video Card: 128 MB DirectX compatible with 32-Bit Color supporting at least 1024 x 768 pixels in height and width. The program will terminate with an error message if your current system does not support these requirements. Please check the Control Panel → Display Options to see if your video settings can be changed.
Sound Card: 16-Bit DirectSound compatible
HD: 1.5 GB free Hard Disk space

2.1.2. THE INSTALLATION PROCESS

Please ensure that your system meets the minimum requirements listed above.

If you purchased from the Slitherine or Matrix site you will have been provided a download link for the games installer.

Have your Serial Number ready as you will need to enter it as part of the installation process. The Serial Number is included in the order receipt for downloads, or printed on the disk or box for hard copies.

To install the game, either double click on the installation file you downloaded or insert the game’s disk into your drive. Follow all on-screen prompts to complete installation.

Click Finish to close the installer and you are now ready to play!

2.1.3. FILE LOCATIONS

Files will be installed to two separate locations.
The master files and campaigns that come with the game will be installed in the Program Files directory here, unless you change it during installation:

C:\Program Files (x86)\Matrix Games\Strategic Command WWII - World at War
However, all user files, including saves and custom campaigns will be stored in your folder:
\User\Documents\My Games\Strategic Command WWII - World at War
Where User is the name of your log-in.

Warning: Do not move any files from one location to the other, and certainly do not delete any from the main installation location.

Tip to Modders! When launching the Editor, it has 2 ‘Open Campaigns’ buttons, one for default campaigns and one for custom user made campaigns. In game however, all campaigns will be listed in the same ‘Select Campaign’ screen no matter where they might be located.

2.1.4. RESOLVING ISSUES
If you have experienced any issues with installation or when trying to launch or play *Strategic Command* it is recommended to run the installation utility and/or the game as an Administrator. Either logging in with an Administrator account or using the following steps can achieve this:

1. Right clicking the Shortcut
2. Select Properties
3. On the Shortcut tab select Advanced
4. Then Select the Run as Administrator checkbox.

Should you encounter any problems with the installation or game itself, please visit our Help Desk at www.matrixgames.com/helpdesk or post in our Support Forums at www.matrixgames.com. Please provide as much detail on your issue as you can.

2.1.5. UNINSTALLING THE GAME
Please use the Add/Remove Programs option from the Windows Control Panel or the Uninstall shortcut in the game's Windows START menu folder to uninstall the game. Uninstalling through any other method will not properly uninstall the game.

2.1.6. GAME UPDATES
In order to maintain our product excellence, Matrix Games releases updates containing new features, enhancements, and corrections to any known issues. All our updates are available free on our website and can
also be downloaded quickly and easily by clicking on the Check for Update link in your Game menu or by using the Update Game shortcut in your windows START menu folder for the game.

We also periodically make beta (preview) updates and other content available to registered owners. Keeping up with these special updates is made easy and is free by signing up for a Matrix Games Members Club account. When you are signed up, you can then register your Matrix Games products in order to receive access to these game related materials. Doing so is a simple two step process:

Sign Up for a Matrix Games Members Club account – this is a one time procedure; once you have signed up for a Matrix account, you are in the system and will not need to sign up again.

Go to www.matrixgames.com and click the Members’ hyperlink at the top. In the new window, select Register Now and follow the on-screen instructions. When you’re finished, click the Please Create my New Account button, and a confirmation e-mail will be sent to your specified e-mail account.

Register a New Game Purchase – Once you have signed up for a Matrix Games Member account, you can then register any Matrix Games title you own in your new account. To do so, log in to your account on the Matrix Games website. Click Register Game near the top to register your new Matrix Games purchase.

If you purchased your game while already logged in, it will be automatically registered for you. We strongly recommend registering your game as it will give you a backup location for your serial number should you lose it in the future.

Once you’ve registered your game, when you log in to the Members’ section you can view your list of registered titles by clicking my Games. Each game title is a hyperlink that will take you to an information page on the game (including all the latest news on that title).

Also on this list is a Downloads hyperlink that takes you to a page that has all the latest public and registered downloads, including patches, for that particular title. You can also access patches and updates via our Games Section at www.matrixgames.com/games, once there select the game you wish to check updates for, then click the Downloads link at the top of the game page.
Certain value content and additional downloads will be restricted to Members Club members. So it is always worthwhile to sign up there. Remember, once you have signed up for a Matrix Games Members Club account, you do not have to sign up again. At that point you are free to register for any Matrix Games product you purchase. Thank you and enjoy your game!

2.1.7. Game Forums
For game related questions and discussions, please visit our Discussion Forum at Matrix Games. We really appreciate feedback, and want to hear from you!
Our forum is also a good place to meet up with other players, to arrange games, discuss changes and see what mods players are producing.

2.1.8. Help and Feedback
The best way to contact us if you are having a problem with one of our games is through our help Desk.
Our Help Desk has FAQs as well as a dedicated support staff that answer questions within 24 hours, Monday through Friday. Support questions sent in on Saturday and Sunday may wait 48 hours for a reply.
Visit our help Desk by going to http://www.matrixgames.com/helpdesk

2.1.9. Error Handling
Should the game ever crash, an “ERROR” folder is created.
The contents of this folder can be found in the following folder with your user name substituted for <USERNAME>:
C:\Users\<USERNAME>\Documents\My Games\Strategic Command WWII - World at War
If applicable, an ERROR.sav file is created and placed in this folder (i.e., the last known turn and game status before the crash). An errorlog.txt file is also placed in this folder. These files may be helpful for identifying and fixing problems that might arise, and may be sent to support@furysoftware.com for evaluation.
3. UNDERSTANDING THE GAME INTERFACE

3.1. MAIN MENU
When the Main Menu comes up, select the option you wish from the choices available to change settings, start or continue a game against the AI, or to play Multiplayer.

3.1.1. SETTINGS
Sound Volume – move the slider to adjust the volume of sound effects. Sliding it to the far left will turn game sounds off.
Music Volume – move the slider to adjust music volume. Sliding it to the far left will turn music off.
Map Scroll Speed – move the slider to adjust the speed at which the map will scroll.
Video Mode – here you can amend the game resolution, and also switch on/off the Full Screen option.
Mods – click this to view any downloaded mods. Tick the box on the right to select one; clicking again will deselect it. Press OK when done.
Installing Mods
These must be installed in the USER folder for the game, e.g.
Users\<username>\Documents\My Games\Strategic Command WWII - World at War\Mods
Mods must be installed in the following format:
  o Users\<username>\Documents\My Games\Strategic Command WWII - World at War\Mods\<modfoldername>
  o Users\<username>\Documents\My Games\Strategic Command WWII - World at War\Mods\<modfoldername>\Bitmaps
  o Users\<username>\Documents\My Games\Strategic Command WWII - World at War\Mods\<modfoldername>\Interface etc.
However, custom campaign’s Strategy Guides should be placed within the campaign’s own Manuals folder, and called simply Strategy Guide, e.g.
Campaigns\_myCustomCampaign\Manuals\Strategy Guide.pdf
3.1.2. Preferences

**Interface Tips** – This turns tips on/off when hovering with your mouse over a button.

**Alternate Date Format** – Changes the format, e.g. from 22. June 1941 to June 22. 1941.

3.2. New Game

Select New Game from the Main Menu to start playing against the AI.

When New Game is selected, a Select Campaign dialog appears which lists the Campaign Name and Start Date for all available campaigns. This dialog orders major campaigns first, followed by any mini-campaigns and then any user made campaigns, should there be any.

<table>
<thead>
<tr>
<th>CAMPAIGN NAME</th>
<th>START DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1939 Storm over Europe</td>
<td>1. September 1939</td>
</tr>
<tr>
<td>1940 Attack in the West</td>
<td>10. May 1940</td>
</tr>
<tr>
<td>1941 Operation Barbarossa</td>
<td>22. June 1941</td>
</tr>
<tr>
<td>1942 Case Blue</td>
<td>28. June 1942</td>
</tr>
</tbody>
</table>

As each campaign is selected, additional campaign information is provided for that campaign in the panel on the right that includes:

- Turn Length (Seasonal or Daily)
- Which side Starts
- Turn sequence (Alternate or Simultaneous)
- Whether Production is Normalized*
- The name(s) of the campaign’s creator(s)
- The campaign’s name and a short description
*Normalized Production ensures that production per time period is more balanced in campaigns with variable seasonal turn lengths. Its effect will be to increase production in winter turns and decrease it in summer turns.

Click on **Play Campaign** to start a selected campaign, **Victory** to review the campaign’s Victory Conditions, or **Cancel** to exit to the Main Menu.

### 3.2.1. Choose Side

When playing against the AI, you will have the option to play as either the Axis or Allied side, and you can select to have one or more of the Majors on your side played by the AI.

Units belonging to any Majors that are set to be controlled by the AI will appear darkened, as though they have already moved. This is just a visual indicator to show that they are AI controlled.

Even if you have set a Major to be AI controlled, there is nothing stopping you from moving any of its units, conducting research, diplomacy etc., the AI will take over any unmoved units and management of affairs once you press end turn.

You can swap sides during a game too! Simply when its your turn, go to the Options screen, click to play the opposite side and the AI will immediately take over. You can also turn on or off the AI control of friendly Majors at any time. All of these can be changed an unlimited number of times during a game.
Note: A minimum of one Major on your chosen side must be under your control.

3.2.2. Difficulty
Choose a setting to align with the level of challenge you wish to face when playing against the AI.

The Difficulty level defaults to Intermediate, with no bonuses or penalties to the Computer. Use the up/down arrows to choose between Green; Novice; Intermediate; Veteran and Expert.

Higher settings will reward the AI with greater plunder when they conquer countries. Some scripted events will also only occur at the higher difficulty levels, as a way of providing a greater challenge to skilled players.

In addition, the Difficulty levels provide bonuses to the AI's Spotting, Experience and Military Production Points (MPPs). They do not influence combat formulas.

Note: Difficulty Settings can be changed during a game against the AI. So if you find things too easy, or too difficult, modify the settings and continue!

3.2.3. Computer Bonus
The Difficulty settings can be fine tuned by clicking on the Computer Bonuses buttons beneath to change the AI's Spotting, Experience and MPP (i.e. income) bonuses.

After you've finished making your selections click on OK to proceed. You will now be taken to the Options screen.

3.3. Options
When you start a new game, or load a saved turn, you will be presented with an Options dialog to select basic and advanced game options.

The text for activated options will appear in yellow, deactivated ones in gray. Once a game has begun some options cannot be changed, and these will appear in a darker gray.
Once you have finished reviewing and changing any options from their default settings as desired, click OK to start the game.

### 3.3.1. Multiplayer Options

In Multiplayer this screen is slightly different as on the right-hand side instead of the Artificial Intelligence options, there is a button to turn on/off Quick Animation in Multiplayer Replays. If this is turned on then the replays of your opponents’ turns will be faster. Pressing Pause/Break on your keyboard will pause the replay, and it will continue on pressing Pause/Break for a second time.

**Note:** There is no compulsion to amend any settings, as you can just click OK to play with the default settings.

### 3.3.2. View

- **3-D Units** – Display three-dimensional unit sprites or NATO counters.
- **National Colors** – Display the map with National Colors on/off.
- **Last Turn Summary** – Displays a summary of major events that occurred in the last player’s turn. The summary is broken down into three main categories: Combat, Military, and Research. Combat damage reports
include convoy raiding and strategic bombing results. Military activity reports include diplomatic results.

**Messages** – Turn the display of scripted messages on/off.

### 3.3.3. Preferences

**Fog of War** – Play each turn with limited visibility of enemy units on the map. Full visibility is given to enemy units that are adjacent to a friendly unit; Partial visibility is given to any unit that is located within the spotting range of a friendly unit or resource, while all remaining enemy units are hidden from view unless your units spot them by advancing or launching air missions.

Every unit type has a Spotting Range (Land) for spotting enemy land and air units, and another, Spotting Range (Naval) for enemy Naval units. This is the distance at which they can automatically see enemy units, apart from Silent Subs, as these won't be automatically spotted.

On land, most units have a Spotting Range of 2 hexes while at sea it is normally 1 hex, though air units tend to have longer Spotting Ranges.

Fog of war will also hide resource strengths, the research the enemy have achieved, unit honors, unit production, convoy information, the current balance of MPPs, and Industrial Modifiers.

**Note:** If a Multiplayer game finishes when either one side has attained its Victory Conditions, or time has run out and a stalemate has been reached, passwords are set to null so that items not previously visible under Fog of War can be viewed by both sides.

**Weather** – Play the game with realistic weather effects that affect unit movement and combat.

The map is divided into unique Weather Zones consisting of Temperate, Arid, Frozen or Desert climates. The weather can change in each zone once a turn in accordance with that zone’s settings, the season and the previous turn’s weather.

The current weather in a hex is displayed at the bottom left of the screen. If the weather is fine then merely the Weather Zone type will be shown, e.g. Temperate.
The weather in the various zones can be seen while scrolling the map. The map hexes themselves will also change slightly to reflect the current weather, such as brown hues for Mud, whitened frostings for Snow, and rough seas for Storms at sea. These visuals will also help you to identify changes in the weather.

**Undo Moves** – This option allows you to undo a move providing that move hasn't disclosed any previously unseen enemy units. It also cannot be used to undo an attack.

**Retreats** – enable/disable the ability for low strength units to retreat when attacked.

### 3.3.4. Artificial Intelligence

**Show Moves/Combat** – Turn the display of combat during the AI's turn on/off.

**Quick Animation** – Selecting this speeds up the AI's turns though you will observe less detail while it is carrying out its actions.

**Messages (AI Turn)** – if unticked, you will not see the Messages that only appear in the AI's turn.

**Border Style** – Select White, Orange or Black national borders.

**Land Counter Style** – Select your choice of unit bases for land and air units.

**Naval Counter Style** – Select your choice of unit bases for naval units.

Click OK to proceed, Advanced to see further options, or Cancel to return to the Main Menu.

**Note:** Once a unit has expended all its Action Points, it will display a darkened base irrespective of the option chosen above.

### 3.4. Advanced Options

#### 3.4.1. View

**HQ Attachment Highlights** – Clicking on an HQ highlights in green all the units under that particular HQ's command. Additionally, when an attached unit is selected, the parent HQ is highlighted in green. If the HQ is in Auto-Assist or Manual Mode, then clicking on it highlights in red units attached to another HQ, and in blue any units that can potentially be attached to it.
**Intercept Range Highlights** – Clicking on a Fighter highlights in yellow all friendly units and resources within its interception range.

**Escort Range Highlights** – Clicking on a Fighter highlights in blue all enemy units and resources within its interdiction/escort range.

**Unit Experience Medals** – Hide or show unit experience medals in the unit information box in the lower left of screen when a unit. If this is unticked then the unit experience will show in numeric form.

**Unit Strength Values** – Hide or show unit strength values on the map.

**Resource Strength Values** – Hide or show resource strengths on the map. These include all ports, mines, oil fields, cities and capitals.

**Unit / Resource Research Levels** – Hide or show research values for units and resources on the map.

**Borders** – Display the map with national borders on/off.

**National Morale Bars** – Hide or display National Morale Bars in game. These show the current National Morale status for all Majors.

### 3.4.2. Map Text

**Show Text** – If unticked then the Map Text will be hidden.

**Show National Morale Objectives** – With this ticked, locations whose capture will provide National Morale boosts or penalties will be shown with the phrase NM_Objective.

**Show Key Resources** – With this ticked, Key Resources like Capitals, Industrial Centers etc will be labelled as such on the map.

**Hide Text During Map Scroll** – Hiding the text while scrolling speeds up the scrolling.

**Fade In Text After Scroll** – If ticked, this will slow the return of text to the screen.

**Show Text With Faded Outline** – ticking this will add an outline effect to Map Text.

**Scroll(s) Before Text Hides** – Here you can set my many scrolls/nudges with the mouse it will take before the Map Text hides. This can be set to a maximum of 50 steps.
3.4.3. Preferences

Research – Untick this to play the game without Research. By default, if a campaign designer has enabled Research in the Editor then it will be selectable as a game option. If Research has not been enabled by the designer then it cannot be enabled here.

Diplomacy – Untick this to play the game without Diplomacy. By default, if a campaign designer has enabled Diplomacy in the Editor then it will be selectable as a game option. If Diplomacy has not been enabled by the designer then it cannot be enabled here.

Production Delay – Leave this unticked to play the game with realistic military production time delays for all unit purchases rather than “instant” builds. The production delay option means you have to plan ahead and anticipate your future requirements.

Note: This option does not apply to Partisans or the three types of Transport, as these appear instantly even if you are playing with a Production Delay. Also, units in the Production Queue at the start of a campaign will arrive on or after the scheduled date regardless of what you decide here.

Soft Build Limits – Tick this to play the game with flexible build limits for Major countries to accommodate those “what ifs” of history. By default, a campaign imposes “hard” limits that restrict unit builds to pre-established force pool limits. Each specific unit type for each country will have a certain number of allowable builds.

“Soft” build limits allow you to surpass those limits, but with a penalty applied to each additional unit purchase that exceeds the pre-set limit.

The cost penalty is cumulative for each additional unit. So for example, the penalty may be 10% for the first extra unit, 20% for the second extra unit, and so on. Since reinforcement costs are directly related to current unit costs, the cost penalty is also applied to regular and elite reinforcements.

Right-Click Unit Action Menu – If enabled then right-clicking on units will bring up a choice of actions. These are also on the left hand side of the lower information panel. If this is disabled then right-clicking will cancel/deselect the current selection.

Disable Game End Date – Tick this to play past the campaign’s default end date. Any Victory scripts set to run only at that date will not fire, however those that are set to run at any time once in game conditions are satisfied will still fire as expected.
3.4.4. Scripts

When Scripts is selected from the Advanced options dialog, a dialog appears which lists event names by script type.

A flag ("X") at the far right of each event name can be used to toggle the event on or off by clicking in its box. If a script is turned off then it won’t show an “X” and it won’t be highlighted.

Scripts that are turned off won’t occur during the game.

These selections can be changed during a game against the computer. For a Hotseat game, changes can only be made when starting the game, never during one.

Changes to activate or deactivate scripts cannot be made in PBEM games, as both parties need to play using exactly the same campaigns in order to avoid any changes that aren’t open and agreed by both sides.

The script flags are quite useful for customizing each game for variability, or for providing a handicap if one is desired.

Those that have the letters “DE” in front of them are connected to Decision Events, so it will be best to refer to the list of these in the relevant campaign’s Strategy Guide before turning any off.
By toggling the flags on or off, you can easily customize some elements of a campaign without having to modify it in the Editor.
Click OK to return to the Advanced options when done.

3.4.4.1. Options in Multiplayer
Unlike a game against the AI where you have the option to change settings during the game, all Multiplayer games have some of their set-up options, e.g. Fog of War, Undo Moves and Weather, locked in place for the duration of the game.
However, things that will not affect the balance of the game itself, such as the icons displaying, can be modified at any time during the game.

3.4.4.2. Taskbar Icon
When playing, a Strategic Command Taskbar icon is added to the system tray located at the bottom right hand corner on most systems.
If playing against the AI, the icon will flash when the AI has finished its turn.
Note that you can generally use Alt-Tab to switch out of a game, so you can do something else while you are waiting for the AI, but you cannot switch back until the AI has finished. The game is not frozen; it is just completing its tasks before it will pop back up. Waiting for the Taskbar icon to start flashing will avoid any delay.

3.5. The In-Game Interface

3.5.1. Left Hand Buttons
The flags of the active Major countries on your side show at the top left of the screen. Beneath each one’s flag you will see the number of Military Production Points (MPPs) it currently has available, followed by its Mobilization %:
If a Major’s flag is selected then its flag, name and MPP status will appear in the
top row starting from the top left corner, to signify that it is this country that is currently selected.

Clicking on the smaller flags (not the large one in the top left corner) will take you to that country's capital on the map. Right clicking on the flag will bring up the Production table which shows units currently scheduled to be available for deployment during the game.

Major countries whose Mobilization % is less than 100% cannot yet play an active role in the war, though you can move their units, conduct research, and make some preparations for when they will enter the war.

3.5.2. TOP ROW BUTTONS

3.5.2.1. WAR MAPS
In order to attack a neutral country it is necessary to declare war on it.

To do this select the War Maps button at the top of the screen or use the Ctrl-M Hotkey. This will bring up a map which shows flags in the locations of the capitals for all countries that haven't yet surrendered. Countries currently at war with you will display a Tank icon instead of a flag.

Click on the % button to view the Mobilization status of any neutrals. This shows how close they are to joining one side or the other, with pro-Axis countries being highlighted in blue and pro-Allied in red.

Unless declared war upon, or entering the war via a scripted event, when countries reach 100% they will join the relevant side at the end of their opposing side’s turn.

3.5.2.2. HOW TO DECLARE WAR
Select which of your Majors is declaring war by clicking on their flag in the bottom left beneath the map display.

Now click on the target country's flag on the map itself. Icons displaying the targeted country's resources at the bottom of the screen will now appear, showing an indication of the potential worth of conquering this country.

Tip! If you click on the map it will zoom in. This can be very useful when the flags are close together.
To make the declaration of war, now click on the Declare War button at the bottom left. A warning message will come up, where you can either confirm the declaration or cancel it. Click on Close to return to the main game screen.

As declarations of war can trigger political reactions, any applicable ones from your declaration of war will now take place.

Note: Only Majors that are at 100% Mobilization can declare war, and you cannot declare war on any Majors that are on your side.

3.5.2.3. The Strategy Map and Convoy Map

While in the War Maps area, you can also review the Strategy Map and Convoy Map by clicking on their relevant buttons on the right.

The Strategy Map is a zoomed out map of the theater covered by the campaign, showing the locations of all friendly units, and all known locations of enemy units. If you click on the Strategy map you will return to the gaming area, in the location of the map where you clicked.

Click on Close to return to the previous screen, and then Close again to exit the War Maps area.
3.5.2.4. Purchase

Units may be purchased at any time during your turn by selecting Purchase from the button at the top of the screen, or using the Ctrl-P Hotkey.

Select the Major's flag that you wish to purchase units for at the top. Under the Select Country heading, both that Major and any Minors subordinate to it will show.

You can review the various unit types available for each country by clicking on them in the Select Unit column.

If the unit type is available for production and you have sufficient MPPs it will be shown in white text. If you do not have sufficient MPPs then the text will be gray, while if it is not currently available it will be shown in red. This could be due to the Build Limit not yet having been reached, or because the date when this unit type becomes available for purchase hasn't yet been reached.

If the latter is the case, when you click on any units in red the date when it will become available for purchase will be displayed underneath the unit icon.

The number in brackets to the right of each unit type represents the number that can be purchased, while the right hand number under the heading PD represents the Production Delay.

The Production Delay is the number of months it will take from purchase for the unit to be prepared and ready for battle.

So in the example below, Germany can purchase 5 more Garrison units, and after purchasing one we will have to wait 1 month before it will be ready to be deployed:

A graphical representation of the selected unit type appears in the top middle of the screen, along with the MPP cost of the unit. Available MPPs are shown in the top right, so you can consider whether this purchase is within your budget.

Named units are shown to the right of this column. With HQ units, the commander’s rating is shown in brackets after its name, with higher numbers representing better commanders.

Tip! Land and air units that are destroyed at supply 5 or higher are cheaper to buy back and will be ready in half the indicated time. The names of these units will have an asterisk after their name, and it is strongly recommended to purchase these units first.
The Combat Values of all unit types are shown on the right hand side of the screen, so you can review these when considering which to purchase.

In the bottom right of the screen any available upgrades for the selected unit will be shown. Clicking on the up arrow(s) to apply these will increase both the cost and Combat Values of the unit, and this will be reflected both underneath the unit icon and also in the Combat Values area above.

When you have made your selection, click on the Purchase button in the bottom center to purchase the unit.

When you have completed reviewing this screen and/or making purchases, click Close at the bottom right to leave this area.

3.5.2.5. Production

To view units that are currently scheduled to arrive during the game, click on the Production button in the bottom right. This will show all units due to arrive for the selected Major and its Minors, their arrival dates and location (if applicable). To select a different Major, click on its flag at the top.

Note: Units due to deploy by script, e.g. ones mentioned in Decision Events, will not appear in the Production table.
When you’ve finished reviewing this area, click OK at the bottom to return to the previous screen.

3.5.2.6. New Units

When new units are available for deployment this button will be highlighted, whereas when none are available it is grayed out.

When the button is highlighted, click on it to bring up the details of any units that are now available for deployment.

If there is more than one unit available, select the one you wish to deploy and click OK.

Units can generally only deploy in their home country, so will need to scroll the map to the relevant country where the locations you can deploy this unit will be highlighted as per the example below:

Left click on one of the highlighted hexes to deploy the unit.

It isn’t necessary to deploy any or all new units this turn, and if you don’t wish to deploy them just click Cancel. However, there is rarely anything to be gained from delaying deploying any units, so it is generally recommended to deploy units in the turn they become available.

3.5.2.7. Diplomacy

Select Diplomacy or use Ctrl-D to bring up the Diplomacy dialog. This is where you can attempt to influence neutral powers to swing your way.

Every Major that has entered the war has a number of chits, and these can be invested for a cost in MPPs. Each invested chit then has a small % chance per turn of swinging the targeted country towards your side. The more chits you invest, the greater the % chance.
In the countries list on the left hand side, neutral Majors will be listed first, followed by all neutral Minors, in alphabetical order.

To the right of their name will be an icon denoting their leaning and which Major with the same leaning they would be subordinate to if they were to enter the war. For instance, Saudi Arabia shows a star as it would be a US Minor were it to join the Allies.

The % column shows their current Mobilization value towards the side that the icon denotes.

Select the flag of the Major that you wish to carry out some diplomacy. Its flag will now have a green border around it. Your available MPPs and Diplomacy chits (Influence Remaining) are shown in the top right.

Now click on a country that you may wish to attempt to influence. The cost of investing against a given country will be displayed, and this will vary as neutral Majors are more expensive to invest diplomacy in than Minors.

The % chance of a diplomatic success per chit per turn is shown in the middle of the screen. If multiple chits have been invested, whether by one or more of your Majors, then a cumulative % chance of success will be shown. This is the % chance of success every turn.

To invest a diplomacy chit, click on the “up” button in the middle of the screen, and click Yes on the confirmation message that comes up to proceed.

Only a limited number of chits can be invested in some countries, e.g. Spain or Switzerland, representing their reluctance to enter the war. Once a chit has been invested in them, the resulting limit will be shown, e.g. if a chit has been invested in Spain, then the country name will display as Spain (1 of 3), signifying that 1 chit is invested out of a maximum of 3.

You can also declare war from the Diplomacy screen. To do this, select the Major that is to declare war, click on the country you wish to attack, and then press the Declare War button at the bottom. Confirm your declaration by clicking yes.

Click on OK to return to the main game screen.

3.5.2.8. Influencing Major Powers
Neutral Major powers can be influenced diplomatically, but they will not switch sides. Thus German diplomacy against the USA could at best help to slow the USA’s entrance into the war: the USA will never become pro-Axis.
3.5.2.9. Research

Research may be conducted at any time during game play by clicking on the Research tab or pressing Ctrl-R.

Only Major countries can conduct research, and there are two types of research categories: Manual and Automatic. Manual categories occupy all of the left hand column, Automatic the right hand column.

Manual categories mean that you apply the research successes individually to your units and resources by upgrading them. This allows you to decide where these upgrades are most needed and to target your income accordingly where it matters.

Automatic categories mean that you benefit immediately from successes in those categories without having to manually upgrade any units or resources.

Selecting one of the Major country flags at the top of the Research dialog will set the screen to display that country's research fields.

Available MPPs for investment are shown at the top right, along with the current number of MPPs invested. At the bottom right you can see the maximum number of MPPs that can be invested in research at any period of the game.

To the right of each category you can see in order:

- The cost per chit
- The number of chits currently invested
- Up/Down buttons for investing or reclaiming chits.
- Your current level of research*
- The maximum level that can be attained*

*If these appear in red then the maximum level has already been attained.

To invest in a category, click on the yellow “up” button. If this isn’t showing in yellow then no research is possible in this category. You can invest as many chits into a category as are allowed, providing you have sufficient MPPs. If a category isn’t available for research, then its name will appear as N/A.
3.5.2.10. Research Tooltips
Providing Interface Tips is turned on, hover your mouse over the name of each research category and a description of that category will appear in the panel at the bottom left.

Those categories that are already invested in will appear with a black outline surrounding the category name box. If progress has been made towards researching the next level, then a green bar will be present within that box, giving a visual representation of progress.

By hovering your mouse over the names of the categories that you are currently researching, you will see your current research progress as a %.

3.5.2.11. Reclaiming Chits
To reclaim an invested chit, click on a yellow “down” button. You will regain 50% of the chit’s cost in MPPs. It is best to only do this in extreme situations where MPPs are desperately needed for other tasks.

3.5.2.12. The Research Table
Select Table at the bottom of the screen to bring up the Research Table dialog. This table summarizes the current research levels attained by all friendly Majors. If Fog of War is turned off then enemy research levels will also be displayed.

Tip! See The Research Mechanism in Chapter 8 for more details on how research works.

Click on OK at any time to return to the Game Menu.

3.5.2.13. Reports
Click on the Reports button to see charts, tables and graphs displaying income, losses and overall investment in categories such as Research and Diplomacy since the start of the game.

3.5.3. Right Hand Buttons
End Turn – click this red button to end your turn.
Options – this brings up the Options screen.
Info – This brings up the following buttons:
Hotkeys – this brings up a list of the game’s Hotkeys.
User Manual – this brings up the Game Manual.

Strategy Guide – this brings up the campaign's Strategy Guide.*

Victory – this brings up the campaign's Victory Conditions.**

*The Strategy Guide button will only appear if the designer has placed a file called Strategy.pdf into the campaign's own relevant sub-directory:

<installation path>\Campaigns\<campaign subfolder>\Docs\Strategy.pdf

**The Victory button will only appear if a Victory image has been added to the campaign's own relevant sub-directory:

<installation path>\Campaigns\<campaign subfolder>\ Victory.png

Save – save the turn. This allows you to continue at a later time.

Quit – to exit the game.

3.5.4. Unit Display

All friendly units and any enemy units adjacent to yours will display information on and around their graphical representation.

From the left there is the Activation icon, then their strength, and to the right of their strength value their research upgrade levels, if applicable, will be displayed.

These research numbers are in order from left to right, so its first upgrade category will show on the left, with a second or third if applicable showing to its right.

As a unit gains experience, white dots representing each full experience point will appear above its strength value:
3.5.5. INFORMATION PANEL
This panel at the bottom of the screen will display unit, terrain and resource information as you hover your mouse over features on the map.

Click on the mini-map in the middle of this panel to jump to different parts of the map. This is a very quick and useful way of moving around the playing area.

Providing you don’t have anything selected on the map, the panels to either side of the mini-map will display information on the hex your mouse is currently hovering over.

If you select a unit by left-clicking on it, or if you merely hover your mouse over it (providing you don’t already have one selected) then information on that unit will be displayed in the left hand panel.

With one of your units selected, if you hover your mouse over an enemy unit then providing it is within your strike range, information on the enemy unit will display in the right hand panel.

If you hover your mouse over an enemy held resource whose strength is hidden by Fog of War, the display will show the MPP value per strength point of this resource. This gives you an idea as to the value of the resource, without giving away its actual strength.

3.5.5.1. COMBAT PREDICTIONS
With a friendly unit selected and the mouse hovered over an enemy unit in strike range, the mini-map will disappear and be replaced by a Combat Predictions panel. This shows the likely casualties should you attack this unit with your currently selected unit. In the example below the prediction is for the attacker to suffer 1 point of damage and the defender 3.

Given the unpredictable nature of combat, actual results may vary by 1 damage point in either direction.

The Combat Predictions panel also displays factors impacting on the combat result, such as launching a Prepared Attack and attacking across a river. These are both included in the example above, where they are represented by a tank icon for the Prepared Attack, and a wavy symbol for attacking across a river.

The abbreviations shown in the panel represent the following:

<table>
<thead>
<tr>
<th>SA</th>
<th>Soft Attack</th>
</tr>
</thead>
<tbody>
<tr>
<td>HA</td>
<td>Hard Attack</td>
</tr>
<tr>
<td>ARTA</td>
<td>Artillery Attack</td>
</tr>
<tr>
<td>SARTA</td>
<td>Strategic Artillery Attack</td>
</tr>
<tr>
<td>RA</td>
<td>Rocket Attack</td>
</tr>
<tr>
<td>TA</td>
<td>Tank Attack</td>
</tr>
<tr>
<td>FA</td>
<td>Fighter Attack</td>
</tr>
<tr>
<td>BA</td>
<td>Bomber Attack</td>
</tr>
<tr>
<td>STRA</td>
<td>Strategic Bomber Attack</td>
</tr>
<tr>
<td>KA</td>
<td>Kamikaze Attack</td>
</tr>
<tr>
<td>NA</td>
<td>Naval Attack</td>
</tr>
<tr>
<td>CA</td>
<td>Carrier Attack</td>
</tr>
<tr>
<td>SUA</td>
<td>Sub Attack</td>
</tr>
<tr>
<td>TRA</td>
<td>Transport Attack</td>
</tr>
<tr>
<td>AAA</td>
<td>Anti-Aircraft Attack</td>
</tr>
<tr>
<td>RESA</td>
<td>Resource Attack</td>
</tr>
<tr>
<td>SD</td>
<td>Soft Defense</td>
</tr>
<tr>
<td>HD</td>
<td>Hard Defense</td>
</tr>
<tr>
<td>ARTD</td>
<td>Artillery Defense</td>
</tr>
<tr>
<td>SARTD</td>
<td>Strategic Artillery Defense</td>
</tr>
<tr>
<td>RD</td>
<td>Rocket Defense</td>
</tr>
<tr>
<td>TD</td>
<td>Tank Defense</td>
</tr>
<tr>
<td>FD</td>
<td>Fighter Defense</td>
</tr>
<tr>
<td>BD</td>
<td>Bomber Defense</td>
</tr>
<tr>
<td>STRD</td>
<td>Strategic Bomber Defense</td>
</tr>
<tr>
<td>KD</td>
<td>Kamikaze Defense</td>
</tr>
<tr>
<td>ND</td>
<td>Naval Defense</td>
</tr>
<tr>
<td>CD</td>
<td>Carrier Defense</td>
</tr>
<tr>
<td>SUD</td>
<td>Sub Defense</td>
</tr>
<tr>
<td>TRD</td>
<td>Transport Defense</td>
</tr>
<tr>
<td>AAD</td>
<td>Anti-Aircraft Defense</td>
</tr>
<tr>
<td>RESD</td>
<td>Resource Defense</td>
</tr>
</tbody>
</table>

### 3.5.5.2. Information Panel Buttons

*Above the panels are some handy buttons for making your gaming easier!* In the middle are Previous and Next unit buttons. Use these to scroll through your forces. These buttons scroll by unit type, so for example, if you have an Air unit selected, the next/previous unit will be another Air unit.
Note: These buttons will not work for AI controlled units on your turn.

The buttons alongside the Previous and Next unit buttons will also display Tool-tips if you hover your mouse over them. Many of these are alternatives to either using the game’s Hotkeys, or to save you having to right-click on units or resources to carry out actions.

The Upgrade and Reinforce buttons on the right hand side are among the most useful. If you select one and then hover your mouse over your units, the tool icon will change to orange and a cost (in MPPs) will display for upgrading or reinforcing them, depending on the one selected. This is the quickest way of upgrading or reinforcing large numbers of units.

3.6. **FURTHER INTERFACE INFORMATION**

3.6.1. **NATIONAL COLORS**

Each Major and their associated Minors has a unique color on the map that represents the territory they control.

When units are selected, their names will also appear in their respective National Color, and this has the advantage of showing at a glance which Major a Minor is subordinate to, i.e. Dutch unit names are in blue, matching their status as a Minor to France.

<table>
<thead>
<tr>
<th>UK</th>
<th>China</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>India</td>
</tr>
<tr>
<td>USA</td>
<td>Germany</td>
</tr>
<tr>
<td>USSR</td>
<td>Italy</td>
</tr>
<tr>
<td>Poland</td>
<td>Japan</td>
</tr>
</tbody>
</table>
3.6.2. Glossary of Abbreviations

IM – Industrial Modifier
NM – National Morale
NM_Objective – National Morale Objective
MPPs – Military Production Points

3.6.3. Symbols On The Map

Each type of terrain or resource can have several different properties depending upon its type. These can be movement penalties, defense bonuses or penalties, and additionally for resources, supply and income values.

3.6.4. Terrain Symbols

<table>
<thead>
<tr>
<th>Terrain</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>River</td>
<td><img src="image" alt="River" /></td>
</tr>
<tr>
<td>Major River</td>
<td><img src="image" alt="Major River" /></td>
</tr>
<tr>
<td>Lake</td>
<td><img src="image" alt="Lake" /></td>
</tr>
<tr>
<td>Major Lake</td>
<td><img src="image" alt="Major Lake" /></td>
</tr>
<tr>
<td>Marsh</td>
<td><img src="image" alt="Marsh" /></td>
</tr>
<tr>
<td>Forest</td>
<td><img src="image" alt="Forest" /></td>
</tr>
<tr>
<td>Bush</td>
<td><img src="image" alt="Bush" /></td>
</tr>
<tr>
<td>Field</td>
<td><img src="image" alt="Field" /></td>
</tr>
<tr>
<td>Bocage</td>
<td><img src="image" alt="Bocage" /></td>
</tr>
<tr>
<td>Oasis</td>
<td><img src="image" alt="Oasis" /></td>
</tr>
<tr>
<td>Desert</td>
<td><img src="image" alt="Desert" /></td>
</tr>
<tr>
<td>Depression</td>
<td><img src="image" alt="Depression" /></td>
</tr>
</tbody>
</table>
### Note:
Empty islands do not contain a source of supply and cannot serve as a base, so if any exist on the map units should not land in these islands as they will become stranded there.

#### 3.6.5. Resource Symbols

<table>
<thead>
<tr>
<th>Resource</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oil</td>
<td><img src="../../images/oil_icon.png" alt="Image" /></td>
</tr>
<tr>
<td>Capital</td>
<td><img src="../../images/capital_icon.png" alt="Image" /></td>
</tr>
<tr>
<td>Mine</td>
<td><img src="../../images/mine_icon.png" alt="Image" /></td>
</tr>
<tr>
<td>Major Capital</td>
<td><img src="../../images/major_capital_icon.png" alt="Image" /></td>
</tr>
<tr>
<td>Settlement</td>
<td><img src="../../images/settlement_icon.png" alt="Image" /></td>
</tr>
<tr>
<td>Fortress</td>
<td><img src="../../images/fortress_icon.png" alt="Image" /></td>
</tr>
<tr>
<td>Town</td>
<td><img src="../../images/town_icon.png" alt="Image" /></td>
</tr>
<tr>
<td>Major Fortress</td>
<td><img src="../../images/major_fortress_icon.png" alt="Image" /></td>
</tr>
</tbody>
</table>
3.6.6. Miscellaneous Symbols

Convoy Routes – active Axis convoys are shown in blue, Allied ones in red, and all inactive convoys in white. Here is an Allied convoy from Iraq to the UK:
**Raiding Locations** – place naval units on these locations to damage your opponent’s economy.

**Loops** – units placed on these locations will transfer to a new location after a short delay, as per the description on the map.

### 3.6.7. Combat Interface Definitions

**Across River Combat Penalty** – 20% Reduction in Readiness when units attack across a River.

**Across Major River Combat Penalty** – 35% Reduction in Readiness when units attack across a Major River.

**Hidden Attacker Readiness Bonus** – 25% boost in Readiness for hidden units that the enemy stumbles upon without having seen them first.

**Prepared Attack Readiness Bonus** – 25% boost in Readiness for units attacking before moving.
3.6.8. **Hiding the Interface**
Press F4 on your keyboard to hide the Interface. Press it again or deselect a unit or resource and the Interface will reappear.

3.6.9. **Target Types**
Every unit has Attack and Defense values relating to the following Target Types:

- Soft
- Hard
- Artillery
- Strat. Artillery
- Rocket
- Light Armor
- Tank
- Fighter
- Bomber
- Strat. Bomber
- Kamikaze
- Naval
- Carrier
- Sub
- Transport
- Anti-Aircraft
- Resource

Each unit also has the following values:

- Spotting (Land)
- Spotting (Naval)
- Action Points
- Operational Range
- Intercept Range
- Escort Range
- Strike Range
- Min Shells
- Max Shells
- De-Entrenchment
- De-Moralization
- Interceptions
- Escorts
- Strikes
- % Attacking
- % Defending
- Raid Multiplier (MPPs)
- Enemy NM Losses (Per Raid)
- Attack
- Defense
- Defense Bonus
- Max Entrench

### 3.6.10. Evasion

Some unit types can evade damage when they are engaged in combat. For example, ships will not receive any damage when bombarding most land units, while some units will have a small chance of evading damaged when they are attacked.

Here are the unit types affected, including their % chance to avoid suffering casualties for every combat they are engaged in. Note that some research categories may increase these percentages.

<table>
<thead>
<tr>
<th>WHEN ATTACKING</th>
<th>% EVASION CHANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partisans, Reconnaissance, Airships</td>
<td>10%</td>
</tr>
<tr>
<td>Strategic and Maritime Bombers</td>
<td>20%</td>
</tr>
<tr>
<td>Anti-Air, all types of Artillery, Rockets, Coastal Guns, Armored Trains</td>
<td>100%</td>
</tr>
<tr>
<td>All surface vessels except for Carriers &amp; Escort Carriers against Land Units</td>
<td>100%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WHEN BOTH ATTACKING &amp; DEFENDING</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor Torpedo Boats</td>
<td>10%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WHEN DEFENDING</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Transports &amp; both types of Amphibious Transports</td>
<td>10%</td>
</tr>
</tbody>
</table>
### 3.6.11. Unit Symbols

Not all the units listed here are available in every campaign.

<table>
<thead>
<tr>
<th>Unit Type</th>
<th>3-D Symbol</th>
<th>NATO Icon</th>
<th>Unit Type</th>
<th>3-D Symbol</th>
<th>NATO Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>HQ</td>
<td><img src="image" alt="HQ Icon" /></td>
<td><img src="image" alt="HQ NATO Icon" /></td>
<td>Cavalry Brigade</td>
<td><img src="image" alt="Cavalry Brigade Icon" /></td>
<td><img src="image" alt="Cavalry Brigade NATO Icon" /></td>
</tr>
<tr>
<td>Garrison</td>
<td><img src="image" alt="Garrison Icon" /></td>
<td><img src="image" alt="Garrison NATO Icon" /></td>
<td>Cavalry Division</td>
<td><img src="image" alt="Cavalry Division Icon" /></td>
<td><img src="image" alt="Cavalry Division NATO Icon" /></td>
</tr>
<tr>
<td>Brigade</td>
<td><img src="image" alt="Brigade Icon" /></td>
<td><img src="image" alt="Brigade NATO Icon" /></td>
<td>Cavalry Corps</td>
<td><img src="image" alt="Cavalry Corps Icon" /></td>
<td><img src="image" alt="Cavalry Corps NATO Icon" /></td>
</tr>
<tr>
<td>Division</td>
<td><img src="image" alt="Division Icon" /></td>
<td><img src="image" alt="Division NATO Icon" /></td>
<td>Partisans</td>
<td><img src="image" alt="Partisans Icon" /></td>
<td><img src="image" alt="Partisans NATO Icon" /></td>
</tr>
<tr>
<td>Corps</td>
<td><img src="image" alt="Corps Icon" /></td>
<td><img src="image" alt="Corps NATO Icon" /></td>
<td>Shock Army / Pillbox</td>
<td><img src="image" alt="Shock Army/Pillbox Icon" /></td>
<td><img src="image" alt="Shock Army/Pillbox NATO Icon" /></td>
</tr>
<tr>
<td>Army</td>
<td><img src="image" alt="Army Icon" /></td>
<td><img src="image" alt="Army NATO Icon" /></td>
<td>Anti-Air</td>
<td><img src="image" alt="Anti-Air Icon" /></td>
<td><img src="image" alt="Anti-Air NATO Icon" /></td>
</tr>
<tr>
<td>Mechanized</td>
<td><img src="image" alt="Mechanized Icon" /></td>
<td><img src="image" alt="Mechanized NATO Icon" /></td>
<td>Rocket Artillery</td>
<td><img src="image" alt="Rocket Artillery Icon" /></td>
<td><img src="image" alt="Rocket Artillery NATO Icon" /></td>
</tr>
<tr>
<td>Special Forces</td>
<td><img src="image" alt="Special Forces Icon" /></td>
<td><img src="image" alt="Special Forces NATO Icon" /></td>
<td>Field Artillery</td>
<td><img src="image" alt="Field Artillery Icon" /></td>
<td><img src="image" alt="Field Artillery NATO Icon" /></td>
</tr>
<tr>
<td>Engineers</td>
<td><img src="image" alt="Engineers Icon" /></td>
<td><img src="image" alt="Engineers NATO Icon" /></td>
<td>Heavy Artillery</td>
<td><img src="image" alt="Heavy Artillery Icon" /></td>
<td><img src="image" alt="Heavy Artillery NATO Icon" /></td>
</tr>
<tr>
<td>Paratroops</td>
<td><img src="image" alt="Paratroops Icon" /></td>
<td><img src="image" alt="Paratroops NATO Icon" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rail Gun</td>
<td>Coastal Gun</td>
<td>Rockets</td>
<td>Reconnaissance</td>
<td>Armored Train</td>
<td>Anti-Tank</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
<td>----------------</td>
<td>---------------</td>
<td>-----------</td>
</tr>
<tr>
<td><img src="image1" alt="Image" /></td>
<td><img src="image2" alt="Image" /></td>
<td><img src="image3" alt="Image" /></td>
<td><img src="image4" alt="Image" /></td>
<td><img src="image5" alt="Image" /></td>
<td><img src="image6" alt="Image" /></td>
</tr>
<tr>
<td>Tactical Bombers</td>
<td>Medium Bombers</td>
<td>Strategic Bombers</td>
<td>Maritime Bombers</td>
<td>Kamikazes</td>
<td>Dreadnought</td>
</tr>
<tr>
<td><img src="image12" alt="Image" /></td>
<td><img src="image13" alt="Image" /></td>
<td><img src="image14" alt="Image" /></td>
<td><img src="image15" alt="Image" /></td>
<td><img src="image16" alt="Image" /></td>
<td><img src="image17" alt="Image" /></td>
</tr>
</tbody>
</table>
### 3.6.12. Zoom

Use your mouse scroll wheel to zoom in or out. There are three zoom settings, and the default setting is the first level.

Zoom out to the next level for a grander view of the scene, and again to the third level to see the whole map. All unit Activation symbols are shown at all levels.

When fully zoomed out, you can either continue with the scroll wheel to return to the first level of zoom, or you can just click on the screen to return to the middle level.

Try these now, and while the default level is best for most things, they can all be useful at different times. For instance, being fully zoomed out makes it easier to spot units in other parts of the map that you may wish to move.

### 3.6.13. Right Clicking on a Unit

Do this to carry out one of the following tasks. Note that not all will be applicable for all unit types:

- Reinforce
- Elite Reinforcements
- Upgrade
- Unload (from a Transport or Amphibious Transport
- Operate
- Transport*
- Amphibious Transport*
- Long Range Amphibious Transport*
- Disband
- Sack/Replace with (for HQs, to change commanders)
- Rename
- Properties (to see Combat Values and Honors gained from service)
- Set Mode
  Auto; Auto-Assist; Manual (for HQs)
  Prepare (for Paratroops)
  Hunt or Silent (for Submarines)
  Auto; Intercept; Escort or Ground (for Fighters)
  Fighter (Combat Air Patrol); Bombers; Mix (for Carriers and Escort Carriers)
- Set CAP Mode
  Auto; Intercept; Escort or Ground (for Carriers and Escort Carriers)
- Set Convoy Mode Raider (if this is unticked then no raiding will occur)
- Sleep
- Cancel – this deselects the unit

*When an applicable unit is adjacent to a Port then a number will appear in brackets. This shows the number of available Transports.

### 3.6.14. Reinforcing Units

- Units cannot be reinforced in the same turn as they move or attack.
- All Naval units can only be repaired in port, and (with the sole exception of Motor Torpedo Boats) they can only receive a maximum of 5 strength points per turn.
- For Carriers and Escort Carriers, when right clicking on them while in port there are two reinforcement options: one for the Carrier itself and the other for its air component. Each has to be reinforced separately, as new planes cannot be embarked until the vessel itself has been repaired. Note that the restriction on reinforcing a maximum of 5 strength points per turn does not apply to the aircraft component.
3.6.15. HQ Attachments
- HQ command ranges default to 5 but they can be increased via research.
- HQ have three modes: Auto, Auto-Assist and Manual. The default setting is Auto.
- Select a HQ and any units attached to it will be highlighted in green. If the HQ is set to either Auto-Assist or Manual then any units that can potentially be attached are in blue.

3.6.16. Indicator Sprites
- Any unit that has not yet used up any of its potential movement is considered active and will display a flashing sprite on its lower section.
- Units that have moved but that still have Strikes and are in range of attacking an enemy unit will also display a flashing sprite on its lower section.
- Units that have moved with action points remaining but with no strikes remaining, will have a faded unit activation symbol flash.
- Units that have no Action Points or strikes remaining, are darkened to indicate that no further movement is possible.
- Units that have Strikes remaining but have exhausted all their Action Points and have no valid targets within range will have their Strikes set to zero, and they will be darkened to indicate that no further movement/strikes are possible.

3.6.17. Major Powers’ Flags
- Left clicking on a Major Power’s flag on the panel at the top left of the screen will center the map on that nation’s capital.
- Right clicking on the flag will access that country’s Production Table dialog.

3.6.18. Forced March/Naval Cruise
Click on any applicable unit a second time and it will highlight the relevant option according to its unit type, e.g. Armies can Force March, ships can Cruise, Fighters can Intercept or Escort.
3.6.19. **Fighter Intercept/Escort Ranges**
Clicking on a Fighter unit will show its movement range. Click again to see its Intercept Range (shown with yellow cross hatching), and a third time for its Escort Range (shown with blue cross hatching).

3.6.20. **HQ Highlights**
With this switched on, when one of your units is selected, the HQ it is attached to will have a thicker ring around it. In the example below, the two units immediately to the north of the HQ in Lublin are commanded by that HQ, as are three units along the Soviet frontier:

3.6.21. **Zone of Control Highlights**
The ‘hatched’ green highlights indicate enemy Zone of Control (ZoC) reducing your Action Points if you move into, through or out of that hex. The ‘hatched’ orange highlight indicates how far you could move if the enemy ZoC was eliminated. This can be helpful in letting you know how far you could advance if the ZoC were removed.
3.6.22. Sleep Mode
You can set a unit in Sleep Mode if you do not intend to move it, and if you don’t wish to see its indicator sprite flashing on the War Maps, nor for it to be included when you cycle through units using the Page Up/Page Down keys on your keyboard.

To do this, right-click on the unit and select the Sleep option. Please note that this unit will remain in Sleep mode in subsequent turns unless you again right click and deselect Sleep.

You can also put a unit to sleep for just the current turn via the Sleep Tool (with the unit selected, this can be accessed in the left hand panel at the bottom of the screen), pressing the space bar instead of a left mouse button click.

Units set for an indefinite sleep show a white dot, while those set to just sleep this turn will show a black dot.

3.6.23. Undo Moves
To undo moves by Land and Air units press Ctrl-Z.
Note that Naval units cannot undo their moves. This stops them from being able to repeatedly search the map for the enemy until they find them.
3.6.24. **Fog of War Shroud**
The limits of your current visibility can be easily seen as hexes beyond the spotting range of your units and resources are darkened:

![Map of Fog of War Shroud](image)

This shroud effect will automatically adjust as the situation changes, so moving units or using air units to spot will remove the shroud from all affected hexes. This means that you can be certain, at least on land, whether or not any enemy units are within any unshrouded hexes. At sea, even with air reconnaissance there is always the possibility that enemy Subs may be present if they are in Silent Mode.

For all types of selected units, you will notice that their potential unit movement path is highlighted as you move the cursor around the map, including the applicable movement penalty costs as shown in the image below where for the German Tanks it would cost 5 Action Points to move behind the Polish Cavalry Brigade:

3.6.25. **Front Line**
The Front Line effect places a border around your territory, updating automatically as you advance or get pushed back. Together with the Fog
of War Shroud it provides you with an immediate understanding of the situation at a glance.

3.6.26. AIR COMBAT LOSSES
Air combat losses will be displayed briefly above enemy aircraft that engage in air combat, even if the enemy units are outside your normal viewing range.

3.6.27. PARTISAN LOCATIONS
To view where Partisan activity can be expected, pressing the ‘P’ key on your keyboard will show all likely partisan trigger points, though only for countries that are currently at war.

To prevent Partisans from appearing it will suffice to have a unit in either that hex or an adjacent one.

Note, regular Partisan logos indicate partisans that will be added to the map while those shown with a red circle and a line through them represent locations where Partisans will only reduce the strength of resources.
4. 1939 WORLD AT WAR TUTORIAL

Here will we will give you some advice and explanations that will be useful for your first few turns when playing the 1939 World at War campaign.

The focus of this chapter isn’t to explain all the game’s features, they are explained in more depth elsewhere, it is simply to help you get started and having some fun.

Our advice is to use this section first to get a feel for the game, move onto the Game Essentials chapter for a greater understanding of the game’s concepts, and then delve in deeper should you feel the need!

4.1. AXIS TURN 1

4.1.1. SELECT THE CAMPAIGN

With the game opened up, from the Main Menu go to Single Player, select the 1939 World at War campaign and then click on Play Campaign.

From the Choose Side dialog, leave the Difficulty level at Intermediate (0%) and the Computer Bonuses at +0. For greater challenge, try the higher settings later once you’ve got a good understanding of how to play.
For the purposes of this Tutorial we are going to play as Axis, and as the Axis side is by default already selected, click on OK to proceed.

The Options screen will now come up. Click on OK to start the game as Axis. The AI will control the Allied opponent.

4.1.2. Pop Up Messages
The first thing you will see is a Pop Up message headlined Strategic Advice. This sets the scene and gives you some advice on strategy. It is best to read this and all subsequent ones that appear from time to time during the game as they will contain important information.

Left click on the screen to remove this message once you've finished reading it. This and any subsequent ones are not set to disappear by themselves - this is to ensure that you are in control and never miss an important message!

4.1.3. Surveying the Scene
The game map will be centered on north eastern China. Scroll around a little using your mouse. To do this, simply move your mouse in the direction you wish to scroll the map.

Try the G and H Hotkeys to toggle the map grid on/off and Hide/Show units respectively.

Take some time to review the map. At the bottom of the screen are Information Panels showing information relevant to the hex your mouse is hovering over, such as its owner, terrain type, any movement penalties and its Max Entrenchment value if applicable.

The mobilization value of any country will also be shown in the left hand panel when you hover over a land hex, as will its owner, political leaning and any special rules particular to its terrain type. Any country at 100% Mobilization, e.g. China, is considered to be fully active in the war.
If you hover over a unit, or left click on it to select it, then information specific to that unit will appear in the left hand panel:

Scroll around the map with the mouse cursor and notice that as you hover over hexes belonging to different countries you’ll see that they will have varying Mobilization Values.

Text colors in the Information Panel will show as white for units on your side and yellow for enemy units. The text for units on either side that have low Supply, Readiness or Morale will display those fields in gray.

### 4.1.4. War Maps

Select the War Maps button at the top of the screen or use the Ctrl-M Hotkey. This will bring up a zoomed out map, and you can zoom in by left-clicking anywhere on it.

Press the % button in the bottom left to show Mobilization Levels for all countries. You’ll see that Germany is at 100% Mobilization. Because Germany is already at war with Poland, Poland’s icon is represented by a Tank Icon. This denotes that Poland is at war.

Most countries are neutral, including the USA and the USSR. It’s a good idea to revisit this map from time to time to keep an eye on how Mobilization Levels change during the game. Doing so will give you an idea of when to expect others to prepare for war.

When you are ready, click the Close button in the bottom right. We will return to the War Maps screen in the spring of 1940 when it will be time to make some declarations of war!

For this tutorial, Axis strategy will focus on the first year of war and preparing for the full scale campaigns that will come when the USA and USSR enter the conflict later on.

Japanese strategy will focus on making advances in China while also preparing for war with the UK and USA.
4.1.5. The Situation in China

When the game begins, the first things you will have seen were two Pop Up messages advising the Japanese player to capture the city and port of Nanning in China, and secondly to take care not to unnecessarily aggravate the UK, USA and USSR.

This second piece of advice is extremely important, because when Japan declares war on countries in South East Asia and the South Pacific, this action will bring her into direct conflict with both the UK and USA.

Here there is a major difference to the situation facing Germany, as the Germans are able to invade more neutrals in Europe before provoking the USA and USSR into war. Thus the Japanese must plan wisely, so that when the time for war with the UK and USA comes, as it undoubtedly will, Japan can strike hard and fast in order to win a decisive victory.

Studying the map, note that Japan starts with a large force engaged in China, a smaller force garrisoning Manchuria to the north, a few units in Japan itself, and with their navy on duty off the east coast of China with one Destroyer at Truk, some units off the Chinese coast, and others in territorial Japanese waters.

As you move around the map you will see that your units all have flashing sprites on their icons to indicate that they are active and are available for use this turn.

Before doing anything else, click on the Chinese Corps that is 2 hexes due south of Wuhan. Wuhan is in hex 191,60 (hex numbers are shown in the bottom left of the screen, just to the left of the central Information Panel). To help you find Wuhan you can always press H to hide the units. Once you’ve found Wuhan you can either left or right click with the mouse to display the units again, or press H as that will also bring them back.

Notice that the Chinese Corps’s Readiness is 70% and its Entrenchment value is 3. Remember these numbers and we’ll return to them later.

Now we are going to attack this Corps with three Japanese Armies, the two adjacent to it and also by moving the one in Nanchang to attack it. Because the Chinese Corps is strongly entrenched (remember the Entrenchment value of 3) our first attacks will on average not be as effective as later ones.
Once a unit’s Entrenchment value has been reduced to 0 then any further attacks on it that turn will be more effective.

Now left click on the Japanese 34th Army to its north-east and with it still selected, hover with your mouse over the Chinese Corps. When you hover over an enemy unit with one of yours selected that can attack it, the Information Panel at the bottom of the screen will display an estimate of the losses if you do decide to attack:

You will also see the estimated losses appear over the Chinese unit, in this instance 0:0, with the number on the left being the attacker’s expected losses, that on the right the defender’s. Actual results may vary by 1 in either direction, so it is possible that your own unit will suffer a loss.

Now we are going to attack the Corps, so with your unit remaining selected, left-click on the enemy unit. This will launch your attack.

Now attack the same Chinese unit with Japanese 13th Army that is due north of the Chinese Corps by left clicking on the Japanese Army and then left clicking on the Chinese Corps.

Finally, we are going to swap two units so that you can launch another attack on the Chinese. To do this, left click on the Japanese 34th Army that you launched your first attack with. Then press and hold Shift on your keyboard and hover your mouse over the Japanese Army to its south-east in Nanchang.
You will notice that your mouse cursor changes to a double headed black arrow. When this is showing, you are ready to swap the position of two units, all you need to do now is to left click on one of them and they will swap.

Doing this should have moved the 34th Army into Nanchang, leaving the Army that was in there positioned to the north-east of the Chinese Corps that you have already attacked twice. This Army is now in a position to attack it too!

After 3 attacks, the Chinese unit will now have significantly reduced Readiness and Morale, and its Entrenchment Value will have been reduced to zero. These all combine to render it more vulnerable to further attacks.

If a unit’s Readiness, and therefore its potential combat effectiveness, is below 50% then this can be easily seen without having to click on any units because the number representing its unit strength will look fainter. Keep an eye out for enemy units with fainter strength numbers as all other things being equal, they will be more vulnerable to attack.

In addition, if you hover your mouse over the enemy unit to view its details in the Information Panel, its Readiness value will show in gray rather than in yellow:

All units’ Entrenchment values increase by 1 every turn until they reach the maximum value for the terrain they are on.
However, a unit loses all its Entrenchment whenever it moves, while units that attack before moving receive a 25% Readiness bonus as they are considered to be launching a Prepared Attack.

One thing to beware of is that Chinese partisans may appear and liberate areas if we leave them empty of troops. To ensure that you don’t accidentally trigger any partisans by moving a unit away from an area where they might appear, press P on the keyboard and you will be able to see the areas you need to keep garrisoned, as in the example below:

![Map of southern China with partisans and areas to keep garrisoned.]

To prevent partisans from appearing it will suffice to have a unit in an adjacent hex to the areas where they can trigger.

4.1.6. ADVANCE TOWARDS NANNING

In southern China, move the I Corps just 1 hex north into Pakhoi. If you now release the unit by right clicking with your mouse or clicking on another unit, it will commit that move. At this point Fog of War will be updated to reveal the Chinese Corps in Nanning.

This is why we suggested only moving 1 hex, as if you had advanced further at once then your unit may have taken losses from a surprise contact with the Chinese in Nanning. Although your losses may not have been heavy as the Chinese Corps is nowhere near being the strongest unit you will encounter during the war, reconnaissance saves lives.
This doesn't mean that you always need to move just 1 hex at a time. Far from it, as the extent to which you can see is shown by the Fog of War shroud. The limits of your current visibility can be easily seen as hexes beyond the spotting range of your units and resources are darkened by the shroud, and this shroud automatically adjusts in line with the situation.

You can now move the I Corps an extra hex to position it adjacent to Nanning, and then move the Okamura HQ from Haikou north towards Nanning too, as its presence will be needed to supply your units around Nanning. The I Corps is better off not attacking Nanning this turn, as the predicted combat losses are 1:0, meaning that your forces are predicted to lose 1 strength point, the Chinese none.

4.1.7. Launching an Air Attack

Medium Bombers are good at reducing their target's combat effectiveness, without necessarily inflicting significant casualties on them. In short, they will leave the unit they bomb in a weakened and more fragile state.

Tactical Bombers have shorter range but can inflict more precise attacks on their targets, so they are more likely to inflict casualties on the target.

Click on the Japanese Medium Bombers in hex 192,60 to the north-east of Wuhan. Keeping the Bombers selected, now hover your mouse over various Chinese units in turn. You'll see that the expected casualties vary, and aren't always favorable.

This is because factors like the unit's Supply, Morale, Readiness, Entrenchment as well as its own weaponry are taken into account. Those Chinese units under the command of a HQ will be significantly tougher than those without a HQ commanding them, though due to Fog of War this information won't always be apparent.

Note that you will not see any numbered predictions if the enemy unit is partially hidden by Fog of War. Nor if you are targeting enemy resources or other hexes that are also hidden by Fog of War. These will instead be represented solely by question marks.

One unit that we could inflict 2 points of damage on is the Chinese Army to our north in hex 191,57. This unit is occupying a Marsh therefore it isn't entrenched, which renders it more vulnerable to attack.
We are also likely to lose some losses if we attack it, whereas the Chinese Corps to our south are less likely to inflict any losses on us, as they are a weaker unit type.

Nevertheless, for the purposes of this Tutorial we are going to bomb the Chinese Army. With our Medium Bomber still selected, left click on the Chinese Army and the air attack will be launched.

Chinese Fighters will intercept your Medium Bombers, and friendly Japanese Fighters will take to the skies to act as escorts to your bombers. Aerial combat will ensue with casualties to be expected on both sides. The Medium Bombers will now strike the Chinese unit, with further losses. You will undoubtedly witness a lot of air combats like this as you play.

All other air attacks are launched in the same way, though it is generally best not to use Fighters to attack enemy units. Their main purpose is in engaging enemy aircraft, though they can also be used for reconnaissance. They will automatically intercept enemy planes, or act as escort to yours, providing they have a strength of at least 5, are not at zero supply, haven't already used up all their missions for that turn, and haven't been set to only escort or intercept.

All air units can launch reconnaissance missions, and to do this select the air unit you wish to use, select a target hex that is under or adjacent to the Fog of War shroud, and left click on that hex. The Fog of War shroud will recede and any enemy units between your air unit and the targeted hex, as well as 1 hex around the target, will be disclosed.

### 4.1.8. Basics of Movement

Having attacked with your Medium Bomber, it can launch no more attacks this turn but it is still available to be moved should you wish to do so.

Air units that move cannot then attack, and after attacking they are only allowed to move ¼ of their normal movement, in this instance 2 hexes, as it would have been able to move 11 hexes if it hadn't attacked. Unlike land units, air units cannot move into enemy held territory.

The functionality of moving units works the same as attacking enemy units. Left click on the unit you wish to move and all potential destinations are highlighted on the map.
With the Medium Bomber selected, hover your mouse over some of the highlighted hexes. You will see a number appears in the hex as you hover over it. This is the movement cost in Action Points. Click on a destination that is 1 hex away.

The Medium Bombers will now move to that hex, and you have 1 Action Point remaining so you can still move another hex. Do so now.

Notice that now you have moved your full distance, the counter underneath the unit image has darkened, and it no longer shows an Activation sprite at the bottom left of the counter. These changes signify that this unit has used up all its Action Points for this turn and can do nothing more until next turn.

One thing to note is that air units cannot move into territory that is under enemy control.

4.1.9. Land Movement
Now we’ll look at land movement and how you can seize territory from the enemy.

Attacks by land units work almost exactly the same as for attacks by aircraft, except:

Units that attack before moving receive a Prepared Attack Bonus

This increases their Readiness by 25% for this attack, making their attack more effective.

All land units apart from artillery have to be in a hex adjacent to the target to attack.

Whenever an active unit has been selected with a left mouse click, its allowable movement range is highlighted on the map as shown below:

Then, just as we saw previously with the Medium
Bombers, depending upon the current mouse position the highlighted movement path will display the total movement cost. This includes all associated terrain penalties as well as any additional penalties if attempting to move near enemy units that are exerting a Zone of Control.

4.1.10. Transports
You will notice that you have a Transport containing the 17th Korean Army in the port at Taipei on Formosa.

To move land units between mainland China and Japan or other islands you will need to use Transports.

There are three types: Regular, Amphibious, and Amphibious (Long Range).

The first is for moving troops between friendly ports, whereas the others are for landings on hostile shores, using the Long Range ones for the most distant targets.

The Transport containing the 17th Korean Army is a regular one, as it has no prefix denoting otherwise. You can use this to reinforce your forces in China, and given that foreign aid is reaching China via Nanning, sending it to Haikou to unload there so that it can take part in the attack on Nanning is recommended.

You will need to move the Carrier out of the port to enable the Transport to enter the port.

Once there it can unload, either by right clicking on the Transport and selecting unload, or by left-clicking on a highlighted destination hex. The embarked unit will then disembark, and it is now ready for action, albeit with limited Action Points in the turn it disembarks.

Embarking units in any type of Transport costs Military Production Points (MPPs), with the Amphibious Transports being more expensive than regular ones. Additionally, each country has a limit on how many it can use at any one time of any particular type of transport.

When it comes to launching invasions, Amphibious Transports have the ability to attack prior to unloading the embarked unit, which means that in many situations any targeted units can be attacked twice. This feature will lend more potency to your attacks, which can be supported by land based air or Carrier strikes. Bear this in mind as while not so relevant now,
it will become more useful later in the game when you are expanding your empire throughout the Pacific.

This is about all for Japan this turn, as we have finished moving Japan's units for now.

4.1.11. THE TOP LEFT SIDEBAR
At the top left of the screen is a sidebar showing the flags of your Majors, Germany, Italy and Japan.

Under each flag are shown the available Military Production Points (MPPs) followed by the Major's current Mobilization Level. Germany and Japan being at 100%, while Italy is only at 65%.

Right click on the Japanese flag and you will see the units that Japan has due to deploy during the campaign. Their exact arrival dates are shown beneath each unit. If you now click on the German or Italian flag at the top of the table it will show you the units that they are due to receive.

Once you've finished looking, click OK.

We are now going to head to Europe so left click on the German flag on the sidebar at the top left of the screen to center the map on Germany's capital, Berlin. This is a quick and handy way of moving around the map, as you can select any of your Majors' flags to be taken to their capital.

4.1.12. ZONE OF CONTROL
One thing to notice is that as enemy units become weakened and their strength falls below 5, they no longer exert a Zone of Control.

This means that their ability to impede your advance will decrease, so it isn't always necessary to destroy a unit with your attacks this turn. Sometimes it will be best to damage it, bypass it, and destroy it next turn if it will then be on lower supply.

4.1.13. INVADING POLAND
Now we are going to look at the situation in Europe, where Axis forces are poised to invade Poland.

Conquering Poland is one of the easiest campaigns that Germany will fight, but even so its conduct will contain some useful lessons. If these are learned properly then they will ensure that your units are used as
effectively as possible in future campaigns, while keeping your losses to the minimum.

Warsaw is the ultimate objective, but capturing it first requires the destruction of a number of Polish units.

By scrolling the map you will see German forces massed on the Polish border in four locations: to the north and south of Poznan, in East Prussia and also in Slovakia.

4.1.14. Focus on the Objective
The key to winning the campaign as quickly as possible is to focus on what matters, and to avoid putting any effort into attacks that won't directly lead to the capture of Warsaw.

Use your air units to bombard Polish units that stand in the way of your advance on their capital, such as the Pomorze and Modlin Armies. These are in hexes 107,35 and 110,36 respectively.

Air attacks should be followed up with attacks by your ground forces, the most potent of which are your Panzers, as they can launch 2 Strikes in a turn. Once they have launched their attacks, we should send our Panzers as far as they can go in the direction of Warsaw.

Move your HQs forward close behind your advancing troops so that they can provide better supply to our forces in Poland. This does run a risk of Polish units attacking one or more of our HQs in the coming Allied turn, but the attacking units will be in low supply so their attacks shouldn't cause significant casualties.

Get close to Warsaw so that in your second turn you will have units that will be in range of launching a ground assault on the capital and any defenders around it.

Your forces in Slovakia can attack, but their role is a secondary one and does not need to be pressed with the same aggressiveness and speed as the others.

Do not worry too much about destroying all weakened enemy units. If you can cut them off from Warsaw, or better still from any Polish resources, then their supply level will fall and their combat effectiveness as of next turn will plummet too.
This will make them much easier to destroy, and it won’t take your prized Panzers to do so, your Corps will probably be able to achieve this on their own.

Not that destroying the whole of the Polish army is your immediate goal. That isn’t necessary as once Warsaw has fallen, Poland will almost certainly surrender straight away, and if not very shortly after. Why risk suffering casualties destroying enemy units when their destruction will not assist your victory?

Additionally, if you can predict that enemy units will have lower supply and/or readiness in the following turn then it is often better to delay
attacking them until your next turn when you will find that the expected combat losses will be much more favorable.

It is important to seize some enemy resources as you advance to provide sources of supply closer to Warsaw, but it isn’t necessary to take them all, so seek to capture Lodz, but don’t worry about Poznan.

Use these principles with your attacks into Poland from Breslau to the south west of Lodz, and coming out of East Prussia to attack Warsaw from the north.

Below is one possible outcome for the situation in Poland at the end of your first turn, having zoomed out and pressed H on the keyboard to hide the units:

Finish moving and attacking with all the units that you wish to use in the invasion of Poland before continuing.

4.1.15. THE SITUATION IN WESTERN GERMANY

Let’s look at western Germany now. Here we have much fewer forces, but they should be sufficient to hold the line until we can send reinforcements from Poland.

Upgraded units are better able to either attack, defend or move than their equivalents without upgrades. As the Luftwaffe will soon be fighting the RAF and French air force over the skies of France and the UK it will be a good idea to upgrade Luftflotte III at Frankfurt. Right click on this unit and select Upgrade > Fighters.

Now click on the up arrow that is to the left of the words Advanced Fighters. This will cost us 25MPPs but this Fighter unit will now benefit from better Air Attack and Air Defense factors. If you are playing with 3-D counters you will also notice that the Fighter unit is now represented by a slightly different graphic. Click on OK to proceed.

4.1.16. THE WAR AT SEA

Now we’re going to move to the north to review Germany’s fleet. You may wish to zoom out one level to better see where all its vessels are located.

Germany has two U-Boats in and adjacent to Kiel, as well as one to the northwest of the northern tip of Denmark in hex 92,28.
It is up to you to decide whether to send these out into the Atlantic now to raid the UK’s convoy routes, or to wait until your Research provides you with Advanced Subs level 1 and you can upgrade them before sending them out to sea.

For the purpose of this Tutorial we are going to send our U-Boats out into the Atlantic. It may be the best thing to do anyway, as their raiding will impact on the UK’s ability to defend France, the Middle East and even its own shores.

The argument for not doing so would be to wait until France has fallen, as without the French fleet assisting them, the British will find it harder to defend their convoys. For this reason we are going to keep Germany’s surface vessels in home waters for the moment.

Left click on U-32, the Submarine that is to the west of Denmark. Now left click on it again. You’ll notice that the hexes around it have turned orange. This is because it is now in Cruise mode rather than normal mode.

Cruise mode means it can move double its normal distance for a cost of 1 supply point,

Now left click on a destination hex, heading north west to somewhere near Iceland. This is the start of a long range patrol in the Atlantic. It is always best to keep clear of enemy held coastlines, and although in some games you may find it possible to sneak through the English Channel, it is rarely possible to do so while France remains Allied.

You can select a movement path by holding down Ctrl on your keyboard and then left clicking on a hex you wish to pass through. The unit won’t actually move until you either release the Ctrl button and then left click on your final destination, or you left click with Ctrl held down on the most distant point you can reach.

4.1.17. Starting the Battle of the Atlantic

Moving much further west to the Atlantic itself, and this might be where you want to zoom out to the next level using the scroll wheel on your mouse, you will see two Axis icons flashing just over half way between Ireland and Canada.

Zoom back in to where they are. You have U-30 and the Deutschland Heavy Cruiser awaiting your orders. They are currently positioned along
a white, i.e. currently inactive, convoy route. This is the convoy route from Canada to the UK. Placing your units here means that as soon as Canada joins the Allies, both U-30 and the Deutschland will be able to raid this convoy route.

When the convoy does become active, U-30 is automatically set to raid it as it is not in Silent mode. Switching from Hunt to Silent mode can only be done before moving or attacking, and is done by right clicking on the Sub, clicking on Set Mode and then choosing the relevant mode.

If you wish for the Deutschland to also raid, right click on it and select Set Convoy Mode – Raider. Once you have clicked on Raider a small blue icon will appear at the bottom left of the ship icon. This means that it too will automatically raid the convoy route once Canada joins the Allies. This can be turned off at any time by going through the same process.

4.1.18. The Convoy Map

The Convoy Map is accessed by clicking on the War Maps button at the top of the screen, and then clicking on Convoy Map.

This map shows the convoy routes between countries with similar leanings, as both the convoy sender and recipient have to have the same political leaning of either Axis or Allied. Country flags are displayed for each source nation with a convoy event.

Axis countries have a blue border around their flag and Allied countries have a red border. Active convoys are shown with either a red line if the convoy is Allied, or a blue line if the convoy is Axis, while inactive convoys belonging to either side are represented by white convoy lines.

The map also displays the location of friendly units, including air units, that are capable of raiding convoys. This can be useful in showing you where they need to move to from their current positions in order to raid.

Left clicking on a source country's flag provides information about its convoy event. For countries with active convoys the convoy event name is shown. If it is a friendly convoy, or if Fog of War is off, then the number of MPPs being transferred and the Seasonal Reduction Value are also displayed.

The Seasonal Reduction Value represents the fact that some convoy routes are affected by the weather and will then work at less than 100%
efficiency. They may even be shut down during the winter due to ice. When this is so they will display a white line to represent that they are inactive.

For countries with inactive convoys, the convoy event name, current Mobilization Values and trigger requirements for the convoy are displayed. If the Fog of War option is selected, for enemy convoys only the convoy event name is displayed. Note that convoys may be activated or inactivated as country’s Mobilization Values change, and every country’s status can be monitored via the War Maps button as mentioned previously.

**Tip!** For convoys between Major powers, you can adjust how much will be transferred each turn. The transfer amount will remain the same until you change it via the Convoy Map, where an Up/Down arrow for the selected convoy can be used to adjust the transfer value.

### 4.1.19. Suspended Convoys

If a Convoy route passes through a friendly port while en route to its destination, and the port is either captured or damaged to below strength 5, then the Convoy will be temporarily suspended. This means that the Convoy recipient will not receive any income from that Convoy until the port’s strength has returned to at least 5, or the relevant port has been recaptured.

### 4.1.20. Italy

Let’s not forget our ally in the south. For the moment Italy is neutral but with a strong pro-Axis leaning, and she will most likely enter the war in the late spring or summer of 1940.

The Italian army is not very strong and should prepare to defend its territories in Abyssinia and Libya from attack. Early in the war we will be presented with two Decision Events providing us with the ability to bolster our forces in Abyssinia or closer to home (see DE 700 and DE 703), though there is nothing to stop us sending additional forces to either or both destinations should we wish to.

Between now and when Italy enters the war, it will be best to take steps to increase your forces around Tobruk. Sending an HQ and a unit of Tanks there will help, as will reinforcing all units in that area to full strength.

However, do not leave the French border unprotected as when Italy joins the Axis it would be embarrassing to have a French army invading...
northern Italy. Also ensure that there is always a unit in Rome to defend it from an amphibious landing.

When Italy does join the Axis, the Italian navy should if possible avoid engaging the Allied navies until after France has fallen. It can do this by remaining in port, mainly in the Adriatic, and with the Italian air force positioned to protect it.

Some research can be considered before Italy enters the war. There are many areas that would be of benefit to Italy, but Infantry Weapons and Naval Weaponry would certainly be good investments.

Upgrading your forces in Libya with Infantry Weapons will make them more formidable against the British, and Naval Weaponry will improve the navy's prospects when it battles the Royal Navy. This will be especially important when you need to engage the enemy in order to escort reinforcements across the Mediterranean.

**4.1.21. RESEARCH**

Select Research from the bars along the top, or use Ctrl-R to bring up the Research dialog.

The dialog that opens is focused on Germany. Categories in green are currently being researched, and by hovering over a category you will see an explanation of it in the bottom left corner.

Germany has already attained some advanced technology levels. For instance, the dialog shows Infantry Weapons at Level 1 (of 2), Advanced Fighters at Level 1 (of 5) etc.

In the top right you can see your available MPPs, as well as the amount that have already been invested in research. At the bottom right you can see the maximum amount that can be invested at any one time.

By clicking on the Japanese flag you can view Japan's research investments and progress. It will be wise to review all your Majors' progress and investments on a fairly frequent basis, so that you can plan your research investments in line with your strategies.

Select Table at the bottom to bring up the Research Table dialog. This shows the current level for all technologies for all your Majors.

Click OK to return to the Research dialog. Japan begins the game with 150 MPPs, so let's invest 100 MPPs in Amphibious Warfare research right away.
Click on the up arrow next to Amphibious Warfare and then click Yes on the confirmation box that appears, so as to make the investment. The Research screen now shows 1 chit in Amphibious Warfare.

Click on Close when done.

4.1.22. ENDING THE TURN
This completes all actions for this turn, so select End Turn or Ctrl-E to finish the turn.

On ending the turn, countries like Australia, Canada, New Zealand and South Africa may join the Allies, and once they do, convoy routes from these countries will start running to the UK, thus boosting the UK’s income.

The Allied computer opponent will now carry out its turn. There probably won’t be much combat except for in China as the Allies reinforce and re-position their units.

4.2. AXIS TURN 2

4.2.1. THE BATTLE FOR WARSAW
Our priority this turn is to capture Warsaw. The Poles will probably have positioned more forces around the city, so we may need to defeat them before we can attack the city’s defenders.

Most of the Polish units facing you around Warsaw will be fairly weak so ground assaults will generally suffice to destroy them, saving your bombers (providing they are in range) for the attack on the Polish capital.

Use your units that aren’t as close to Warsaw first, so that they can advance, attack, and clear a path for your spearhead units to then launch their own attacks on Warsaw.

It isn’t necessary to capture Modlin. In real life Modlin’s garrison held out until after Warsaw fell, and all that matters is creating a path to Warsaw to enable you to attack the city with sufficient force to destroy its defenders and occupy the city.

With the route to Warsaw cleared, advance to attack Warsaw. If you haven’t already attacked with all your bombers, use them to bomb the capital. Your Medium Bombers will be good at softening up the Polish unit
in Warsaw, reducing its Morale, Readiness and Entrenchment, possibly its strength too, so that it will be easier to destroy with a ground attack. Follow them up with your Tactical Bombers, as these are more likely to inflict strength losses on the defender.

Now attack with your ground forces, not forgetting that your units of Tanks with their 2 attacks should be able to inflict sufficient damage to destroy the unit defending the capital.

If you are able to destroy Warsaw's defenders, move a German unit into Warsaw and use your other units to attack any remaining Polish units, but only where the expected combat losses are significantly in your favor.

The reason for doing this is that the more units Poland retains at the end of this turn, the lower the chance of her surrendering this turn, and a significantly delayed Polish surrender could lead to a rise in Soviet mobilization.

Continue moving units to the west after they've attacked, as you only need to keep 2 German units within 6 hexes of Warsaw after Poland has fallen. Königsberg already has a Garrison, so that counts for one, therefore all you need to do in addition is to leave a Corps in Warsaw and you can move everything else to the west.

4.2.2. CHINA
Here, seek out opportunities to launch attacks that will weaken the Chinese without significantly depleting your own forces.

Additionally, if followed, the advice to capture Nanning will require a concerted assault on the city and extra forces may be needed to ensure its capture.

Carriers can be used to attack targets within range, but they aren't generally a cost effective way of damaging land units, so use them sparingly in this role. This is really a role for land based air units that are commanded by HQs and in good supply.

Aim to badly damage or destroy a small number of enemy units, rather than spreading your attacks over a wide front. Battered units will take time to recover, and will be more vulnerable in subsequent turns than others because even if they recover their losses via reinforcements, their Morale and Readiness will be lower than other units, all other things being equal.
4.2.3. HQ Settings
One thing you can do during the game is to change which units are commanded by your HQs.

Left click on a Japanese HQ in China and notice how the units attached to its command are highlighted in green. These are the units that receive a leadership bonus based on the HQ’s command rating.

By right clicking on an HQ and selecting Set Mode from the drop down menu, attachments for that HQ may be set to Auto, Auto-Assist or Manual.

When in Auto-Assist or Manual mode, you can change a unit’s attachment or detachment status, e.g. to change which units are commanded by a HQ.

Click on the HQ so that the units attached to it are highlighted in green. To detach a unit, right click on a unit highlighted in green and select Detach. To attach one right click on one highlighted in blue and select Attach (the colors denote whether or not they are already attached).

This isn’t something you should need to do very frequently, but at times it will come in useful, especially when you don’t have enough HQs for all your units and a decisive battle must be won!

4.2.4. The War at Sea
Once you’ve finished attacking and moving in Poland, it is time to turn once again to the Kriegsmarine. Go to U-32 that we left last turn near Iceland.

Right click on it and select Set Mode > Silent. You will see that its potential movement path has now decreased.

Submarines will not raid when in Silent mode, and being in Silent mode reduces their movement rate, but it does also reduce the chance of the enemy locating your Sub.

If you feel that going into Silent mode isn’t necessary at this stage, as the Royal Navy probably won’t be operating in this area, just right click again on the unit to switch it back to Hunt mode.

We ended our first turn with U-30 in the Atlantic sitting astride the convoy route from Canada to the UK.

Raiding the convoy from Canada to the UK is fine for a while, but after raiding that for a few turns it may be worthwhile to go and raid at another point. This keeps the Allies having to move around, uncertain of your next move and having to spread their forces.
It is also because when convoy routes are being raided, in your opponent’s turn, recent raiding locations will be marked with a “?” and this will help them to track you down.

It is therefore likely that Allied ships will arrive in due course to attack your raiders, and if your U-Boats do survive but in a battered condition (i.e. their strength has been reduced below 5) then it will be best to sail them away from the convoy routes.

Or you could go and raid the Canadian coast. Click on the mini-map at the bottom and scroll until you are off the coast of eastern Canada. You will notice that here there are red hatched icons in the vicinity of some ports. These signify good raiding areas, where your navy can attack and sink enemy merchant ships and therefore reduce the strength and supply level of the nearby port, and possibly other resources nearby. The engine will handle this, so all you need to do is to place a unit on one of the red hatched icons for the enemy to suffer some economic losses.

When your strength or supply values get low, it isn’t necessary or always best to head directly back to Germany. Once France falls their ports will become available, and the Allies will have to watch the whole of the European coast from Bordeaux in France to Narvik in Norway.

As an extra bonus, once Paris is in Axis hands and Spain has a pro-Axis leaning of at least 25%, Franco will allow Axis vessels access to the port of Vigo in northwest Spain and Santa Cruz in the Canary Islands. These provide alternative destinations for refueling and some limited repairs.

Tip! Use Cruise mode to move to your next destination if your supply is at least 5, using way-points to confuse any watching Allied ships as to your actual destination, or Silent mode if your supply is less than 5 and you fear being attacked.

4.2.5. THE FALL OF POLAND

It is now the end of the second Axis turn. If you captured Warsaw this turn then Poland will probably surrender. If the USSR elected to invade Poland (they may not have done, in which case you will gain all of Poland) you will be presented with a Decision Event asking you whether or not to honor the Molotov-Ribbentrop Pact and cede eastern Poland to the USSR.
It is best to honor the Pact to avoid annoying Stalin. However, if you are not afraid of the Soviet reaction, and want to take advantage of the better starting position that having eastern Poland will give for your eventual invasion of the USSR, then choose No.

4.3. AXIS TURNS – WINTER 1939
Over the next few turns continue moving German forces to the west, taking up positions along the French, Belgian and Dutch borders. You may wish to Operate the slowest moving units, or to use Forced March to speed them on their way, though don’t forget to keep two units within 6 hexes of Warsaw so that Stalin doesn't perceive any weakness in our position there.

4.3.1. OPERATING UNITS
Operating represents the rapid relocation of a unit over a long distance, for a cost in MPPs, and it will be the only action the unit can carry out this turn.

To Operate a land or air unit, right click on it and select Operate. You will then be presented with a dialog box informing you of the cost if you proceed. Saying yes does not yet commit you to Operating, but by doing so potential destination hexes will then be highlighted. Left click on the one you wish to travel to, or right anywhere on the map click to cancel.

To be able to Operate, land units must have a supply value of at least 5 and be on or adjacent to a railroad that is linked to at least one resource with a strength of at least 5. This will provide the opportunity to move the unit to any connected resource on the railroad that also has a strength of at least 5.

For air units, no rail connection is necessary though the unit will need a minimum supply value of 3, as will the resource it operates to. The cost of operating air units is double that of land units, as moving air units over long distances requires a greater logistical effort.

4.3.2. DEPLOYING A NEW UNIT
In January 1940 you will have a German Paratroop unit to deploy. This will appear in the New Units dialog at the start of your turn, and it will need to be placed on the map by left clicking on one of the highlighted areas. You can defer deploying it, but there is little to be gained by doing so.
To assist in the invasion of the Low Countries, deploying it in or around Düsseldorf could be useful. This is probably the best choice, but if you want to send forces to North Africa as soon as Italy joins the Axis, then Graz which is to the northeast of Trieste would be the ideal place.

If you really don’t wish to deploy a unit in the turn it becomes available, you can always press cancel. You can still deploy it later in the same turn or leave it until a later turn. When you’re ready to deploy it, click on the New Units tab at the top of the screen, decide on a destination and left click on it.

4.3.3. PREPARING FOR AN AIRBORNE DROP
In your next turn you will be able to prepare the Paratroops so that they will be able to carry out an Airborne Drop in a subsequent turn. This is done by right clicking on the Paratroops and then left clicking on Set Mode and Prepare. Once you have done so a letter “P” will appear next to the unit.

Weather permitting, after the turn in which they prepare they will be able to carry out a drop. If you ever want to move or attack with a prepared Paratroop unit, rather than drop them, just right-click, select Set Mode and left click on Prepare. This will deselect Prepare and they will be able to move and attack like any other unit.

If the hex where a Paratroop unit lands isn’t empty then it will suffer casualties, and if there is no adjacent empty hex then it will be destroyed.

4.3.4. REINFORCEMENTS
Reinforcing all units that received damage in the invasion of Poland will be best before engaging them in the battle for France.

Damaged units can be reinforced by right-clicking on them and selecting Reinforce, expending some MPPs to do so, but losing some unit experience in the process.

Or you can use the Reinforce tool. This is located second from the right, on the right side of the panel at the bottom of the screen:
With this selected, any unit you click on that can be reinforced, will be reinforced to the maximum possible provided that you have MPPs available to do so. It’s a very quick way of reinforcing large numbers of units.

Note that a unit cannot carry out any other actions that turn if reinforcing. An exception is if the unit has swapped position with another, as it can reinforce after swapping.

Reinforcing a unit uses all of its Action Points and completes its turn. When you reinforce naval units, you will see that, with the exception of Motor Torpedo Boats, they can only receive a maximum of 5 strength points per turn.

4.3.5. Elite Reinforcements
As units engage in combat they will increase in experience, and successful actions will lead to greater experience gains. If a unit has any full experience bars then this will be represented by white dots above the unit’s strength. Experience icons will also display in the Unit Info Panel, e.g. a full Iron Cross for German units, as in the example below:

In this example the German unit has 1 experience point. Elite Reinforcements can be purchased at a rate of one per turn, up to the
maximum number of experience bars that a unit has, and you can do this by right clicking on the unit and selecting Elite Reinforcements.

If your unit already has strength points equal to the number of full experience bars, then further reinforcement won't be possible, i.e. if a unit has one experience point and is already at strength 11, then it cannot receive any Elite Reinforcements.

In addition to the normal restrictions on reinforcing units as explained above, there are some additional requirements for receiving Elite Reinforcements:

- It must not be adjacent to an enemy unit
- Its supply level must be 6 or greater
- Its strength must be at least 10

4.3.6. Declaring War

Once you have got significant forces massed in the west along the French, Dutch and Belgian borders, and providing the weather is clear, it will be time to declare war on Belgium, Luxembourg and the Netherlands.

The spring of 1940 will probably be best for doing this, though it can be done in the autumn of 1939 if you are feeling adventurous.

Declaring war is done via the War Maps or Diplomacy screens. Refer to the section in the previous chapter entitled How to Declare War.

Belgium, Luxembourg and the Netherlands stand in the path of your advance on Paris, so declare war on them all when you are ready to do so.

4.3.7. Next Steps

Now that we've given you a start, refer to the 1939 World at War Strategy Guide for further information and advice on playing and winning this campaign.

For more information on game features, the next chapter on Game Essentials should be your next step.

If you have any further questions you can search this Manual for the answer, but if you get stuck or would like to share your opinion on anything please visit our forum at Matrix Games.
5. GAME ESSENTIALS

5.1. Key Areas of Gameplay
There are five key areas of gameplay to consider during your turn, and considering each of them in the following sequence will ensure that nothing important is missed out:

- **Read any Reports** – To help you assess the situation
- **Orders** – Move, Attack, Reinforce Units
- **Politics and Diplomacy** – Declare War, Monitor Developments, Invest in Diplomacy
- **Research** – Invest Research Chits
- **Military Production** – Purchase Units, Deploy New Arrivals

5.2. Hotkeys

- **G** – Turn the map hex grid on or off.
- **H** – Temporarily hide all units on the map.
- **L** – Display the last turn’s summaries for reference.
- **P** – Show the location of potential enemy Partisan activity.
- **R** – Show reinforceable units, as these will show a green unit strength number.
- **S** – Show the level of supply your forces currently receive, along with a prediction of how much they will receive if venturing into enemy territory if you press S again.
- **U** – Show upgradeable units and resources, displayed by a green research level number.
- **Page Up/Down** – Select the previous or next active unit that has not yet moved.
- **To Set a Path** – hold down Ctrl then select a route.
- **Space** – this deselects a currently selected unit
- **Shift** – Select this to see how far a Carrier that hasn’t yet moved can attack.
- **← → ↑ ↓** – Scroll map left, right, up or down.
- **+/-** – Map zoom controls
- **Ctrl-D** – Diplomacy
- **Ctrl-E** – End Turn
- **Ctrl-I** – Reports
- **Ctrl-M** – Maps
5.3. MAJOR AND MINOR POWERS

- Major Powers like the UK, USA, USSR, Germany or Japan collect income in Military Production Points (MPPs), can carry out diplomacy, research, produce units, and declare war.
- All other countries are Minor Powers which when they enter the war are subordinate to one of the Major Powers, for whom they provide income. Minor countries can often be reinforced by purchasing new units, though their owning Major will have to pay for them.
- Each Major Power and their associated Minor allies has a unique color on the map, a ‘National Color’ that represents the territory controlled by that particular Major.

5.4. INDICATOR SPRITES

- Any unit that has not yet used up any of its potential movement is considered active and will display a flashing sprite on its lower section.
- Units that have moved but that still have Strikes and are in range of attacking an enemy unit are set to indicate the normal unit activation symbol flashing.
- Units that have moved with action points remaining but with no strikes remaining, will have a faded unit activation symbol flash.
- Units that have no Action Points or strikes remaining, are darkened to indicate that no further movement is possible.
- Units that have Strikes remaining but have exhausted all their Action Points and have no valid targets within range will have their Strikes set
to zero, and they will be darkened to indicate that no further movement/strikes are possible.

5.5. Orders

Actions use Action Points (APs) which determine their movement range. Once a unit has moved and/or attacked all its APs for that turn are expended, and each Attack uses up one AP.

Dynamic Movement – Units that haven’t used up all their Action Points can continue to move until they have done so, even if deselected and reselected again later. Exceptions to this are Air units, Artillery, Rockets, regular Amphibious Transports, and any “Surprised” units.

Rebasing Air Units – Air units can either move their full move distance, Operate to move further, or attack and move 1/4 of their normal move distance. Note that they cannot move then attack. Right click on an air unit with a supply factor of at least 3 and spend MPPs to Operate it to another friendly location that has a supply strength of at least 3. If a unit Operates it will not be able to carry out any other actions in the same turn.

Surprised Units – are those that bump into previously unseen enemy units during their movement. They can defend themselves but any remaining APs will be automatically lost.

Mouse Hovering – Hovering the mouse over a unit will display its unit info at the bottom left hand corner of the screen, in the game information area.

Move/Attack – Left click on the unit to see its potential movement range. Enemy units can be attacked by moving adjacent to them (if not already so) and left clicking on them with your attacking unit selected. Units like aircraft and artillery have longer ranges so they don’t need to move adjacent to the target before attacking.

Passing through – Naval units that pass through an opponent’s naval units have a 50% chance of losing 1 strength point for every enemy unit they pass through.

Specify a Movement Path – Press Ctrl on your keyboard and left click to select individual way-points.

Moving Artillery into Empty Enemy Resources – Press Ctrl and rather than bombard the enemy held resource, the Artillery unit will be able to move in and capture the resource.
**Forced March** – Left click on a land unit twice and providing it is a unit capable of Forced March, it has a supply value of 5 or more and it is not adjacent to an enemy unit, it will be able to move 50% further than usual but for a cost in Morale (which reduces its combat effectiveness). It will not be able to attack or capture enemy resources when doing this.

**Cruise** – Left click on a naval unit twice and providing it has a supply value of 5 or more it will be able to move double their normal movement distance but for the loss of 1 supply point. It will not be able to attack when doing this. Regular Amphibious Transports are the only naval units that cannot Cruise, though subs are restricted to only using Cruise when they are in Hunt mode.

**Operate** – Right click on a land unit with a supply factor of at least 5 that is in or adjacent to a railroad that is linked to at least one resource with a strength of at least 5. This will provide the opportunity to move the unit for a cost in MPPs to any connected resource on the railroad that also has a strength of at least 5. For air units, no rail connection is necessary though the unit will need a minimum supply value of 3, as will the resource it operates to. If a unit Operates it will not be able to carry out any other actions in the same turn.

**Swap** – Select one unit, press Shift and select an adjacent unit you wish to swap it with. There is a Morale penalty for doing so, and both units will have a maximum of 1 Action Point after swapping. Unless the swapped units have already done so, they will still be free to attack or reinforce. Providing they aren’t adjacent to any enemy units they can be upgraded.

**Reconnaissance** – Air units and Carriers can target hexes not known to contain enemy forces. Left click on the unit and then left click on the targeted hex. Enemy Fighters or AA may react, and if an enemy unit is found to be within the targeted hex then it will be attacked. Regardless, all enemy units within one hex of the targeted hex and the flight path will be spotted.

**Sleep** – Right click a unit you do not intend to use for a while and select this option. This will prevent its icons from flashing and also remove it from the sequence when cycling through unactioned units using the Page Up/Down Hotkeys.

**Airborne Drops** – Paratroops have to prepare for an airborne drop. Paratroops may move into a new position and prepare during the same
turn, but they cannot prepare when adjacent to enemy units. To prepare, providing they have a supply value of 5 or more, right click on the unit and select Set Mode → Prepare. A small black circle will appear in the top left. On a subsequent turn providing the weather doesn't prevent it, the Paratroops’ movement radius will reflect their airborne range. Left click on the unit, and again on their drop location. They will then fly to their drop zone and deploy there, ready to fight and move in the same turn. If dropped into a non-clear hex, even if friendly territory, there is a 30-45\% chance that they will suffer landing casualties, depending on the weather.

**Transports** – Use these to move troops by sea between friendly ports.

**Amphibious Transports** – Use these to move troops by sea to land on hostile shores. All units apart from Special Forces have to be loaded in friendly ports. Enemy naval units and Coastal Guns will fire on Amphibious Transports that halt in an adjacent hex, even if only temporarily prior to landing. Note that neutral Majors cannot embark units into Amphibious Transports.

**Landing Casualties** – Both paratroops and units unloading from Amphibious Transports may suffer landing casualties, potentially losing a proportion of their strength, especially when landing in bad weather. With Amphibious Transports, the lower their supply value, the higher their landing casualties are likely to be.

**Reinforcing Units** – Increase unit strength up to their maximum (5; 8 or 10 depending on unit type) though some experience will be lost in the process, and supply can limit the ability to do this. Note that naval units (with the sole exception of Motor Torpedo Boats) can only receive a maximum of 5 strength points per turn, though the restriction on reinforcing a maximum of 5 strength points per turn does not apply to the aircraft component of Carriers.

**Elite Reinforcements** – Increase experienced units’ strength by 1 point per turn, up to 3 strength points above their maximum, depending on the number of full experience bars they have.

**Upgrading Units** – Increase their combat factors.

**Renaming Units** – Customize unit names, though names within each type must be unique.

**Disbanding Units** – Do this to recoup some MPPs, though Naval units cannot do this, nor can Land or Air units adjacent to enemy units.
5.6. Unit Modes
Right clicking on some units can bring up options to change their mode, thus providing some extra options for their use. The options for Escort Carriers, Carriers and Subs must be chosen before they move or attack.
HQ – Auto, Auto-Assist or Manual. The last two are options for manually controlling which units are under a HQ’s command. Refer to the full Game Manual for details.
Field Artillery, Heavy Artillery, Rocket Artillery, Coastal Guns, Rail Guns – Auto or Silent. Silent means that they will not provide counter-battery fire, which can help to keep their location secret.
Paratroops – See the section on Airborne Drop above.
Engineers – See the section on Building Fortifications below.
Fighters – Choose between Auto, Intercept, Escort, or Ground. Auto means they will automatically intercept enemy air attacks, or escort your own, as applicable. Intercept or Escort means that they will only carry out that action and not the other. Ground is best used if your Fighters are weak or you wish to keep their presence in an area secret. Interceptors will attack an attacking bomber after combating the Escorts, if their remaining strength after the Escort engagement is at least 5.
Escort Carriers and Carriers – There are two separate sets of options for these. The first is to choose between Fighter (Combat Air Patrol); Bombers and Mix. These determine whether the vessel is to launch fighters, bombers, or a mixture of the two. If Fighters are chosen then the second set of options: ‘Select CAP Mode’ become relevant, and these work exactly the same as for Fighters.
Subs – Hunt to raid convoy lines; Silent to increase your chances of not being seen. Changing from Hunt to Silent mode or vice versa can only be done before the Sub moves or attacks.
All other Surface Vessels – See the section on Raiding below.

5.7. Zones of Control
Most land units exert a zone of control hindering enemy movement in adjacent hexes. To determine the extent of the zone of control exerted, all units are assigned a category:
Front Line Units are Army; Mechanized; Special Forces; Shock Army; Coastal Gun; Anti-Tank; Light Tanks; Tanks; Heavy Tanks, Subs, and all surface combat vessels apart from Destroyers, Motor Torpedo Boats, Carriers and Escort Carriers.

Support Units are all remaining land units apart from HQs and Rockets.

No Zone of Control Units are HQs, Rockets and all air units.

Damaged Units: units below strength 5 do not exert any Zone of Control.

One Front line unit will exert a Zone of Control, and this means that all enemy units moving into, or within, one hex of it will have to pay an extra Action Point to do so, while it will require two Support units to have the same effect.

5.8. Combat

There are three main categories of units: Land, Sea and Air, and these are further divided into sub-categories, called Target Types, each of which has different statistics.

Target types are Soft (i.e. weak), Hard, Light Armor, Tank, Anti-Air, Strategic Artillery, Rockets, Fighter, Bomber, Strategic Bomber, Kamikaze, Naval, Carrier, Sub, Transport, and Resource.

Each unit has unique Attack and Defence values when combating each of these target types, so a quick comparison of capabilities can be seen by looking at a unit’s properties and comparing its attack value against a Soft target with that unit's defence against the attacking unit's target type.

Combat results are affected by unit Readiness and their relevant combat factors. Readiness is based on their units’ Strength, Morale, HQ support (based on the HQ's rating and experience). Supply is a major factor in unit Morale.

Entrenchment provides some protection from losses, with greater entrenchment providing more protection. Entrenchment is reduced by enemy attacks and automatically lost when leaving a position, being regained at the start of your next turn, at a rate of 1 Entrenchment level per turn. Units in Fortifications and Fortresses gain Entrenchment levels faster.
Location is also a factor, as terrain and resources generally provide bonuses while attacks across river and/or after having moved are less effective.

Weakened units may automatically retreat when attacked, but the attacker's losses will be halved when this happens.

Air units and support units have a higher chance of retreating than front line combat units.

Land units will be less likely to retreat from resources and fortifications or fortresses.

Units gain experience from combat and experienced units will be able to avoid some losses in future combats, while in general inflicting higher casualties on the enemy. It isn't necessary to have full experience points in order for this to help, as some experience is better than none. Experienced units are to be prized and are frequently best used as spearheads or to launch effective counter-attacks.

Units can gain up to a maximum of 3 experience points.

HQs gain experience from the units under their command, with successful operations providing more experience and raising their effectiveness as commanders.

HQs and Transports cannot attack.

Naval Units lose 1 Supply point every time they are engaged in combat, unless they are a unit with 2 strikes as they will only lose 0.5 supply per attack.

5.9. RAIDING

Raiding enemy convoy lines is a good way of reducing their income and National Morale. Naval units can do this by moving either on, or adjacent to, enemy convoy lines. Right click on the unit, select Select Convoy Mode and then click on Raider. This raiding option can be switched in the same way by right clicking on the unit and de-selecting Raider.

Subs that aren't in silent mode will automatically raid enemy convoy lines when they end their turn on or adjacent to one.

Naval units, including Subs, cannot raid if an enemy surface vessel is adjacent to them (note that Subs and Transports cannot prevent raiding). Either sink this unit or move away to a better raiding position.
- All types of Bombers can raid convoy lines, though Maritime Bombers are the most effective. Position the air unit within strike range of the convoy, right click on the unit and select Raider. The Bomber will attempt to raid the convoy, being prevented from doing so if the weather prevents it, or if the enemy station a Fighter unit within interception range of the part of the convoy line you are attempting to raid.
- At the end of your turn all raiding takes place, and its effects are worked out by the game engine, no micro-management is required.

Note: Air units (including) Carriers cannot raid a convoy that starts from a Neutral country.

5.10. Conquering Countries

A country will only surrender if their capital has been captured and if enough of their current land forces have been destroyed. The nationality of the unit occupying the surrendering country's capital determines who the country surrenders to, and they will receive Plunder in MPPs providing the country surrenders by direct conquest rather than by an in-game event.

When a country surrenders, the conquering side's forces will receive a Unit Morale Boost, while the opposing side's units will suffer a Unit Morale Penalty. This is a temporary effect which will have a moderate effect on combat effectiveness in the short term.

5.11. National Morale

- National Morale represents a Major Powers’ willingness to fight, and will be reduced when their resources are captured, casualties are suffered and key locations are taken.
- If National Morale falls to zero then the Major Power will surrender, so maintaining National Morale is important, especially for France whose National Morale is fragile.
- Capturing resources belonging to enemy Majors, destroying enemy land and air units while their supply is less than 5, and sinking enemy ships at sea irrespective of their supply value, will also provide boosts to your National Morale.
Taking key locations marked as National Morale objectives will either boost the occupier’s National Morale or penalize their opponent’s, sometimes both. Plan your strategies accordingly as taking these locations will assist your efforts to win the war.

5.12. HQs

- HQ units are probably the most important in the game as not only do they provide supply, but they also provide combat bonuses to units under their command.
- By default HQs command 5 units within 5 hexes, though this can be increased by researching Command and Control.
- Weakened HQs are less effective at both providing supply and boosting units under their command with combat bonuses.
- HQs have a minimum supply distribution value of 3, even if they are at low strength.
- They can only be reinforced in stages, so if damaged it is wise to start reinforcing them as soon as possible. Or move them to safety if they are in extreme danger.

5.13. Supply Rules

Units receive supply from friendly resources and HQs, and unit supply is a major factor in determining combat effectiveness.

5.13.1. General Notes on Supply

- Resources which provide the most supply are Major Capitals and Major Ports, as they can provide supply values of up to 12.
- These are followed by Major’s Capitals, Industrial Centers, Primary Supply Centers and Ports, which can potentially provide supply up to 10.
- Secondary Supply Centers and Minor’s Capitals provide supply up to a maximum of 5.
- Connection by rail to any other friendly resource from all of the above except for Ports will raise the connected resources to their maximum strength and supply levels. So advancing into enemy territory to cut off their troops and resources from these Key Locations can reduce enemy income, and lead to the destruction of these enemy forces at lower
supply. This will help because units at lower supply are less effective and much easier to destroy!
- Captured enemy resources will generally provide less supply than friendly ones.
- The supply benefit of resources decreases with distance by 1 per hex in clear terrain.
- The rate of decrease will be greater in non-clear terrain, as such terrain is an impediment to good supply. For example, placing units in large forests, mountains or marshes, unless they are close to a nearby supply source, will generally be a bad move.
- Roads negate the effect of terrain on supply, so keeping units on or near roads is recommended.
- Oil, Mine and Settlement resource types do not provide supply to any units.
- Units in low supply cannot be reinforced as well as those in higher supply, while those lacking any supply cannot be reinforced at all.
- Naval units can only be reinforced in port and, with the exception of Motor Torpedo Boats, they can only receive a maximum of 5 strength points per turn.
- Naval units can only be fully supplied in port, though they will gain some supply from being in the proximity of friendly ports, the benefit decreasing with distance.

5.13.2. Viewing Supply
- Press S on your keyboard to view current supply levels. Press it again to view a prediction of supply in the next turn, including in currently enemy territory, should you seize that territory this turn. If a unit currently has a supply value less than the overlay value, this will show in brackets in red alongside the overlay value.

5.13.3. Damage to Resources
- Resources can be damaged by bombing, shore bombardment, partisan activity, scripted events and also by scorched earth when resources change hands.
- Resources damaged by any of the above will automatically repair by
1 strength point at the start of their owning side’s turn. No micro-management of this is necessary.

- On land, any resource except for a Major’s Capital or Fortress that has 2 or more enemy units adjacent to it will have their resource strength reduced by 1 point per turn until it reaches 0. If there aren’t 2 enemy units present then the resource regains strength by 1 point per friendly turn, i.e. deterioration happens in enemy turns, and regaining strength only occurs in friendly turns.
- The presence of an enemy unit adjacent to a port will prevent that port from providing supply to any friendly land units. Destroying the enemy naval unit or driving it away will enable that port to provide supply again.

5.14. PARTISANS

Partisan activity can be prevented by keeping units in or adjacent to their spawning hexes. Partisans may simply damage resources, or launch full scale uprisings which will place a Partisan unit on the map. These units deploy at strength 8, always have a minimum supply level of 3, and in difficult terrain front line combat units may be needed to deal with them.

5.15. MAINTAINING UNITS’ COMBAT EFFECTIVENESS

- Keep them in good supply.
- Have an HQ commanding them, with the best available in the most important sectors.
- Reinforce units after they have suffered casualties to the maximum as soon as possible.
- Strengthen with Elite Reinforcements if they are available and you can afford the cost.
- After reinforcing, especially from serious casualties, you should rest the unit away from the front line for a few turns before sending it to combat again.
- Research the Automatic Upgrade categories as some of these will improve unit morale.
- The liberation of friendly countries that had been conquered, and the loss of friendly countries that surrender, will provide temporary bonuses or penalties to unit morale and readiness. So try to liberate anywhere that falls, and not to lose too many allies!
5.16. Decision Events
During the game you will be asked to make strategic decisions, called Decision Events, where you will be given information and prompted to choose either Yes or No. Further details on these events can be found in the Strategy Guide in the Manuals folder, or you can access the guide while playing the relevant campaign.

5.17. Building Fortifications
Engineers can build fortifications which improve the defensive values of units within them. Right click on the Engineer unit to see the options and the time each will take. Canceling construction before complete will lose all work done in that hex. The Engineer unit will display a small black circle in the top left, indicating that it is fortifying the hex.

Note: Engineers cannot fortify hexes containing Resources.

5.18. Politics and Diplomacy
- Major Powers can declare war by going to the War Maps, selecting the country you wish to declare war with, and then selecting the flag of the country you wish to declare war on. All active Minors subordinate to either Major will automatically become at war with that country too.
- It also possible to see via the War Maps the Mobilization level of every neutral country, by clicking on the % button.
- Neutral Majors only produce a proportion (relative to their Mobilization level) of their production capability, while neutral Minors only provide income via Convoys.
- Every Major has a certain number of chits which can generally be invested wherever desired, though some investment can be limited, e.g. towards Spain.
- Every diplomacy chit invested has a 5% chance of moving the target country towards your side by 4-8% if it is a Major power, with a 33% chance of that swing being 12-24% if the targeted country is a Minor.
- If both sides are investing in a country, only the one with the most chits invested can swing the target country, and only their chits in
excess of their opponent’s will count towards achieving a diplomatic breakthrough.

- Unlike with Research, players who reclaim an invested diplomacy chit will not regain any of the MPPs invested in it.
- Once a country has reached 90% Mobilization it will automatically enter the war within a few turns.

### 5.19. Weather

Weather effects on an individual unit are generally based on the weather in the unit’s starting location and not its destination location. Exceptions relate to Airborne Drops and Amphibious landings.

#### 5.19.1. Rain

- Air units including Carrier based aircraft cannot attack or spot enemy units, though limited rebasing is possible. Operational Movement is still allowed.

#### 5.19.2. Mud

- AP values are halved, with all units having a minimum of 1 AP.
- Paratroops’ operational ranges are halved.
- Air unit attack values and spotting/strike ranges are halved.

#### 5.19.3. Sandstorms

- Air units including Carrier based aircraft cannot attack or spot enemy units, though limited rebasing is possible. Operational Movement is still allowed.

#### 5.19.4. Snow

- Operational movement is allowed, but re-basing of air units is restricted.
- Attack values are halved for all unit types.
- Air unit spotting/strike ranges are halved.
- There is no AP penalty for crossing snowed over enemy-held river hexes.
- No amphibious loading is allowed from a snowed port hex.
- No amphibious unloading is allowed onto a snowed coastal hex.
5.19.5. FROZEN
- Operational movement is allowed, but re-basing of air units is restricted.
- Attack values are halved for all unit types.
- There is no AP penalty for crossing frozen enemy-held river hexes.
- No amphibious loading or unloading is allowed from or onto a frozen coastal or port hex.
- No transport loading or unloading is allowed from or into a frozen port hex.

5.19.6. STORMS
- Attack values are halved for all naval unit types.
- Carrier-borne aircraft are grounded and cannot attack or spot enemy units.
- Naval units not within one hex of a friendly port or on a coastal sea hex (i.e. those fully at sea) may suffer some weather damage. This may be just a reduction in unit morale, or it could involve the ship losing strength.

5.19.7. ICE
- Naval units trapped in ice can only move 1 hex until they are clear of the ice.

5.20. THE RESEARCH MECHANISM
- For every chit invested, progress will be made at the end of each side’s turn towards reaching their next levels of research.
- Per turn increments to achieve levels 1-3 in a technology field average 5% per turn, in reality between 2-7% per chit.
- Per turn increments to achieve levels 4-5 in a technology field average 4% per turn, in reality between 2-6% per chit.
- Research automatically succeeds in gaining the next level on reaching 100% progress, though there is a small chance of a breakthrough speeding up your progress by an extra 15-25% every turn. Researching Intelligence can speed up this process.
- Chits can be recouped at 50% of their original cost.
Costs rise with unit upgrades, generally by 10% per level of upgrade, though some like Anti-Submarine Warfare only cost 5% and others like Mobility cost 20% (30% for Germany).

The notes which follow explain the benefits of each level of upgrade, firstly for Manual Upgrades, then for Automatic Upgrades.

To benefit from **Manual Upgrades**, right click on a unit once the research has been achieved and select **Upgrade**. You can upgrade some or all of the potential upgrades available.

### 5.21. Manual Upgrades

- **Infantry Weapons** – increases the Soft, Hard, Artillery, Strategic Artillery, Rocket, Light Armor and Tank Attack and Defense values for all Infantry and Cavalry units including Partisans, as well as for Pillboxes, Reconnaissance units and Armored Trains.
- **Anti-Tank Weapons** – this increases the attack and defense values of dedicated Anti-Tank units against other ground units.
- **Advanced Tanks** – increases the Soft, Hard and Tank Attack and Defense values for Light Tanks, Tanks and Heavy Tanks.
- **Heavy Bombers** – increases the Resource Attack values for Strategic Bomber units, as well as their Fighter and Anti-Aircraft Defense values by 1 and 0.5 respectively. In addition it increases the chance of inflicting damage on a unit occupying a resource by 10% per level.
- **Naval Weaponry** – increases the Naval and Carrier Attack values, as well as their Naval Defense values, for Airships, Bombers (except Strategic Bombers), Kamikazes, all types of combat surface vessels except for Escort Carriers. It also increases the attack values of Carriers against all land targets by 0.5 per level, and by 10% the chance of a shore bombardment inflicting damage on a unit occupying a re-source.
- **Long Range Aircraft** – increases the Spotting, Action Points, and Strike Range values by +1 for all types of Aircraft and both types of Carriers.
Exceptions are that Maritime Bombers’ Strike Ranges, and Airships and Maritime Bombers’ Naval Spotting ranges increase by 2, Strategic Bombers’ Strike Ranges by 3 and Fighters’ Escort Ranges by 4 per level. Each new level also increases the operational range of Paratroops by 1 hex.

**Advanced Subs** – increases the Naval Attack and Carrier Attack values for Subs, while also increasing their chance of diving if attacked by 10%.

**Artillery Weapons** – increases the Soft Attack, Tank Attack, Air Attack, Bomber Attack, Naval Attack, Carrier Attack and Sub Attack values for all types of Artillery, Rail Guns and Coastal Guns.

**Rocket Weapons** – only Germany can research this category and deploy Rocket units. It improves the Resource attack value and strike range values for all Rockets, while also increasing the chance by 10% that a rocket attack against a resource occupied by a defender will inflict a hit on that defending unit. Note that Rocket’s effectiveness decreases with range.

**Ground Attack Weapons** – this improves attacks by Tactical and Medium Bombers against ground units and aircraft they hit while on the ground.

**Mobility** – increases the Action Points for HQs, all infantry (except Garrisons), Special Forces, Engineers, Anti-Aircraft, all types of Artillery, and all Armored units.

**Anti-Submarine Warfare** – ASW research improves the Sub Attack and Sub Defense values of Maritime Bombers, and all types of surface naval combat units apart from Battleships, who only benefit from improvements in their defense values against Sub attack. Each new level of ASW reduces an attacked Sub’s current dive percentage by 10%. This is a must for the UK.

**Anti-Aircraft Defense** – protect your resources, ground units and ships from air attack. Applies to all except Partisans, Transports, Carriers and Escort Carriers.

### 5.22. Automatic Upgrades

**Command and Control** – increases the number of units your HQs can command, their command range and their command rating by 1 per level.

**Infantry Warfare** – improves the Unit Morale of all Infantry and Cavalry units (excluding Partisans) by 10% per level.
Armored Warfare – improves the Unit Morale of all Mechanized, Reconnaissance, Anti-Tank, Light Tank, Tank and Heavy Tank units by 10% per level, and provides Tanks, Heavy Tanks and Mechanized units with 2 strikes rather than one.

Aerial Warfare – improves the Unit Morale of all air units except for Airships and Kamikazes by 10%, Carriers and Escort Carriers by 5%. It also enables Fighters to launch 2 intercepts or escort missions and for Strategic Bombers to be able to launch 2 strikes.

Naval Warfare – improves the unit morale of all naval units by 10%, and Carriers and Escort Carriers by 5%, as well as the unit’s chance of avoiding any losses when attacking by 5%.

Amphibious Warfare – increases the Build Limit and Action Points for Amphibious Transports, their morale by 5% and their de-moralization and attack values when attacking directly from the Amphibious Transport, i.e. prior to unloading the unit on the beach. Only once level 1 has been reached can Amphibious Transports move 1 hex in the turn they embark. This research category also improves Amphibious Transport’s defensive capabilities if attacked by aircraft or by Soft and Hard unit types. The bonuses for Amphibious Transport (LR) are the same except that their Action Points do not increase with research.

HQ units, after amphibiously unloading, start at supply equal to 5 + their current level of Amphibious Warfare technology, with their supply dropping 2 supply points per turn after that. This allows the HQ to act as a Mulberry for an initial landing until further supply sources are achieved, and provides another good reason to invest in this category.

Trench Warfare – this will only become activated when we release a WWI game.

Shell Production – this will only become activated when we release a WWI game.

Synthetic Oil – to be confirmed.

Spying and Intelligence – this provides a 1% chance per turn, per level, of spotting enemy units (up to a maximum of 5), while also speeding up research by providing intelligence on the enemy’s own developments.

Logistics – this reduces operational movement and regular Transport costs by 10%, while also increasing HQ Build Limits for Majors, and all types
of Transports’ Build Limits for Majors and their respective Minors. HQ’s minimum supply values also increase by 1 per level.

**Production Technology** – this decreases unit production costs by 5%.

**Industrial Technology** – this increases a Major’s home production by 10% (20% for the USA).

### 5.23. Automatic Industrial Mobilization

Some US and Soviet resources only start producing MPPs when activated by events.

### 5.24. Military Production

- Providing they have sufficient MPPs, each Major Power can purchase units belonging to their own country, and also for their subordinate and active Minors.
- There is a Production Delay of 1-18 months before these units will be ready for deployment. This depends on unit type and the longer build times represent naval units.
- Land and air units that were destroyed in combat while they had a supply value of 5 or more can be repurchased at reduced cost and with a shorter Production Delay.
- Only Germany and the USSR can deploy Rocket Artillery units.
- Only Germany can research and deploy Rocket units.
- Units can only be deployed in their home countries at or adjacent to friendly resources that are connected by rail to the Capital or an Industrial Center. A road connection alone is not enough.

### 5.25. Further Gameplay Tips

Here are some general thoughts on things to consider every turn:

- Reinforce or move to safety any battered units, replacing them if they were defending key positions.
- Look for any other key positions that aren’t currently defended, but are threatened by the enemy, and see if you can place or move units to defend them.
- Now make your moves and attacks. Some useful things to know are that:
  - Units that attack before moving will generally have more effect.
Units attacking across rivers suffer a penalty, so try to cross elsewhere if possible.

Use your aircraft to reconnoiter before advancing deep into enemy territory.

Armored and Mechanized units are vulnerable to infantry assault in urban areas.

Damaged units need reinforcements and good supply to recover.

Keep your HQs, air and any other support units close to, but not in, the front line.

Consider whether you need to buy any units to either replace losses, or for use in the near future. Plan ahead, as there will be a delay between buying a unit and its arrival.

Upgrade any units that can be upgraded, but keep an eye on your available expenditure as some upgrades are more important than others. For instance, upgrading your navy probably isn’t very relevant if the enemy are attacking your capital.

Consider whether you have any remaining income to undertake any research or diplomacy.

Consider providing Elite Reinforcements to any experienced units.

Partisans can spring up if their trigger points aren’t covered. Keep an eye out for them!

Forests block line of sight, so bear this in mind when planning your moves.

Check out the main Manual and Strategy Guide in the Manuals folder or access them in game using the buttons at the top right of the screen.

Have fun! That’s what it’s all about, so don’t get too hung up on doing everything right first time. It will come, and sometimes a decisive defeat is the best teacher.

If you do get stuck on anything, don’t be afraid to ask on our forums. We monitor them regularly and are very happy to help.

5.26. ENDING A TURN

Select End Turn from the Game Menu or use Ctrl-E. Military Production Points (MPPs) will be collected, based on the number of resources currently owned or occupied by your side, and income will also be received from convoys and scripted events.
5.27. SAVING A GAME
- A game can be saved at any time by selecting Save from the Game Menu or using Ctrl-S. Select a file name.
- Games played against the computer are saved in the Save folder, while Hotseat games are saved in the Hotseat folder.
- All games are also automatically saved at the start of each turn in a file called autosave.sav in their relevant default folder.

5.28. EXITING THE GAME
In order to end the game select Quit from the Game Menu or use Ctrl-Q.

5.29. WINNING THE GAME
The Victory Conditions for each campaign can be seen during the game by clicking on Options and then the Victory button.
   Once the game is over, multiplayer passwords are set to null so that items not previously visible under Fog of War will now become visible to both sides.

5.30. SUPPORT
You can report issues on the forums or email support@furysoftware.com.

6. MOVEMENT AND COMBAT

6.1. BASICS

6.1.1. DEPLOYMENT PHASE
Campaigns which start with a Deployment Phase for one or both sides have units set to be deployed at their commander's discretion before the actual fighting starts.
   Once all these units have been deployed, the campaign itself will start.
6.1.2. Turn Activities
There are five key areas to think of during each turn, and considering each of them in the following sequence will ensure that nothing important is missed out:

- **Read any Reports** – to help you assess the situation
- **Orders** – Move, Attack, Reinforce and Upgrade Units
- **Politics and Diplomacy** – Declare War, Invest Diplomacy Chits
- **Research** – Invest Research Chits and check on progress
- **Military Production** – Purchase Units and Deploy New Arrivals

6.1.3. Turn Lengths
The default setting in our *WWII: World at War* is to have turns that cover 14 days of play, while turns in our *WWII: War in Europe* release have variable lengths according to the season, with longer winter turns and shorter summer turns.

Turns are alternate rather than simultaneous, so in our *WWII: World at War* release, the Axis turn will cover 1st to 14th September 1939, and the first Allied turn will run from 15th to 28th September 1939.

**Seasons run as follows:**

<table>
<thead>
<tr>
<th>SEASON</th>
<th>DATES COVERED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring</td>
<td>21st March to 20th June</td>
</tr>
<tr>
<td>Summer</td>
<td>21st June to 20th September</td>
</tr>
<tr>
<td>Fall</td>
<td>21st September to 20th December</td>
</tr>
<tr>
<td>Winter</td>
<td>21st December to 20th March</td>
</tr>
</tbody>
</table>

In addition to the four normal seasons, four separate sub-seasons are provided for Late Spring (May 1 to June 20), Early Fall (September 21 to October 14), Late Fall (December 1 to December 20), and Late Winter (March 1 to March 20). These don’t need to be filled in by campaign designers, but if they are then their Trigger % will apply for the periods in question. If they aren’t filled in then the Trigger % for the main seasons will apply during these periods.

**Note:** The length of turns, as well as whether or not they are simultaneous or alternate, is fully customizable in our Editor.
6.1.4. Visibility
The following applies if you are playing with the Fog of War option on.

All units can spot enemy land or naval units according to their set spotting ranges, though neutral Majors’ spotting ranges are limited to 1 hex.

Land units can generally spot enemy land and air units that are within 2 hexes of them, while air units can spot further when they launch attacks or reconnaissance missions.

6.1.5. Air Reconnaissance Missions
Air reconnaissance missions can be used to locate hidden enemy forces, and launching these missions before your ground forces advance will prevent the latter from suffering heavy casualties should they inadvertently contact previously unseen enemy units. Ambushes can be painful!

Air reconnaissance missions can also be used to see if raider units shown with a '?' are still at the indicated location. These missions when targeted at such hexes will make the '?' disappear, and if an enemy naval unit is present then it will now be spotted.

Land units can only spot into territory belonging to neutral or non-belligerent Majors if they are placed immediately adjacent to the border, and they can never see further than 1 hex beyond the border. Air units cannot spot or fly over neutral or non-belligerent territory.

Air reconnaissance missions are possible within friendly territory as this is helpful to scout your own borders, to see if any enemy forces are building up on the front line if you don’t have any ground units within spotting range.

6.2. Moving Units

6.2.1. Indicator Sprites
- Any unit that has not yet used up any of its potential movement is considered active and will display a flashing sprite on its lower section.
- Units that have moved but that still have Strikes and are in range of attacking an enemy unit will also display a flashing sprite on their lower section.
Units that have moved with Action Points remaining but with no Strikes remaining, will display a faded flashing sprite.

Units that have no Action Points or Strikes remaining, are darkened to indicate that no further movement is possible.

Units that have Strikes remaining but have exhausted all their Action Points and have no valid targets within range will have their Strikes set to zero, and they will be darkened to indicate that no further movement/Strikes are possible.

6.2.1.1. Sleep Mode
If you do not intend to move a unit, and don’t wish to see its indicator sprite flashing on the War Maps, nor for it to be included when you skip through units using the Previous/Next unit buttons, you can select the Sleep option by right-clicking on the unit.

However, please note that this unit will remain in Sleep mode in subsequent turns unless you again right click and deselect Sleep.

6.2.2. Dynamic Movement
Dynamic Movement allows most land and naval units to move or attack, be deselected, then reselected again until they have used up all their Action Points (APs) or Strikes.

The exceptions to using Dynamic Movement are some unit types including all Artillery and Air units. After Artillery attack they can move 1 hex, while Air units can move 1/4 of their normal Rebasimg movement distance.

6.2.3. Specifying Controlled Movement Paths
A specific movement path can be chosen by pressing Ctrl on your keyboard. Individual Waypoints can then be selected by left clicking on the hexes you wish to move through.

You can either select each individual hex to be moved through, or you can select several Waypoints and let the game engine determine the paths in between. Left click on the final destination to carry out the move.

Tip! If playing using Fog of War, you can use controlled movement paths to avoid surprise contacts with hidden enemy units whose location is only suspected.
6.2.4. Unit Spotting Ranges During Movement

If a unit has moved its full distance in one move, i.e. without being deselected at any point, then its full spotting range will remain after its movement. However, by moving its full movement all at once the risk of Surprise Encounters with hidden enemy units is high.

The only way to avoid these Surprise Encounters is either to reconnoiter with aircraft first, or to deselect an advancing unit, have it spot, and then move it again. But when a unit moves or attacks, after its second committed move (i.e. when it has been deselected a second time) its spotting range is reduced to 1 hex. Thus it retains its full spotting range after its first move, but loses it once it moves a second time.

The unit’s movement range will update as it is moved, and you can click on new attainable destination hexes without deselecting it.

6.2.5. Surprise Contact

Fog of war provides a special combat feature that occurs when a unit moves adjacent to a hidden enemy unit. A message denoting *Enemy Contact!* will appear when this happens. These encounters will only result in combat if it favors the hidden unit; otherwise, the moving unit may still attack normally.

If the contact results in combat, then the hidden unit (which counts as the attacker) has its readiness increased by 25% for the combat calculation. Additionally, the hidden unit’s combat losses will be 25% less and the moving unit’s combat losses 25% more than they would otherwise have been.

When a surprise contact occurs at sea, the enemy contact adjustment for the attacker only applies when calculating attacker losses and does not apply when calculating defender losses. For example, if a Battleship is moving and there is enemy contact with a Cruiser, the Cruiser becomes the attacker. The Cruiser will still take 15% less damage when calculating its losses but it will not inflict 15% more damage on the Battleship. An encounter at sea still favors the hidden unit, but the impact is reduced.

Special surprise encounter effects apply to Paratroops. For Paratroops landing on a previously hidden enemy unit, only the Paratroops will take losses from the surprise encounter and then they will attempt to land in an empty adjacent hex. If successful, the Paratroops can land and fight
normally; otherwise, but if there is no empty adjacent hex then they are shattered and destroyed. If Paratroops land adjacent to a hidden enemy unit, there is no surprise encounter and the unit can fight normally. In other words, the advantage in this case goes to the Paratroops.

Land units that are surprised by a hidden enemy unit do not lose any Action Points, but surprised naval units will generally have their remaining Action Points divided by 5, except for in the following exceptions:

- Subs in Silent mode will have their remaining Action Points divided by 2.
- Naval units that have engaged in combat as a result of the surprise will have their remaining Action Points divided by 2.
- Naval units in cruise mode will lose all remaining Action Points.

**Note:** any naval unit using Cruise will not be stopped by a Sub in Silent mode.

### 6.2.6. Zones of Control

In addition to the Terrain penalties listed above, most land units exert a zone of control hindering enemy movement in adjacent hexes. To determine the extent of the zone of control exerted, all units are assigned a category:

- **Front Line Units** are Army; Mechanized; Special Forces; Shock Army; Coastal Gun; Anti-Tank; Light Tanks; Tanks; Heavy Tanks, Subs, and all surface combat vessels apart from Destroyers, Motor Torpedo Boats, Carriers and Escort Carriers.
- **Support Units** are all remaining land units apart from HQs and Rockets.
- **No Zone of Control Units** are HQs, Rockets and all air units.
- **Damaged Units:** units below strength 5 do not exert any Zone of Control.

One Front line unit will exert a zone of control, and this means that all enemy units moving into, or within, one hex of it will have to pay an extra Action Point to do so, while it will require two Support units to have the same effect.

**Note:** Naval units can pass through enemy naval units but they may suffer a 50% chance of a 1 strength point loss for doing so.

**Exceptions**

- **Weak Units:** Any unit with a strength of less than 5 does not exert any Zone of Control.
- Newly Landed Units: Units landing from Transports and Amphibious Transports are not impeded by Zone of Control rules, though they are limited to moving 1 hex.
- Dived Subs: If a Sub dives then it won't exert any Zone of Control for as long as it remains hidden. This can lead to naval units having the appearance of gaining some Action Points when an enemy Sub dives near them.

6.2.7. Surprise Encounters
If any units bump into a previously hidden enemy unit while moving then a Surprise Encounter will occur. Any surprised units automatically lose any unused APs, though not any unused attacks.

The engine will immediately check to see whether the surprised unit or the hidden unit has the advantage. The hidden unit will automatically attack the surprised unit if it has the advantage. If the hidden unit does attack the surprised unit, then it does so at 25% greater effectiveness than in a regular combat.

**Exception**: Subs that have dived when attacked will not attack a surprised unit that runs into them in the same turn.

**Tip!** Surprise Encounters can lead to your units suffering severe casualties which a more cautious advance or prior reconnaissance might have avoided.

6.3. Land Movement
Land unit movement is divided into 5 main areas:
- Regular Movement
- Operational Movement
- Forced March
- Swapping Units
- Airborne Drop

6.3.1. Regular Movement
Whenever an active land unit has been selected with a left mouse click, the hexes it can move to will have a green outline.
If you now move your cursor over the hexes you can move to, the movement cost in Action Points will be shown. This cost includes any factors such as terrain penalties or moving into or within the enemy's Zone of Control.

Left click on your chosen destination hex and your unit will move there.

6.3.2. Operational Movement

An Operational Movement for a land unit represents its rapid transfer by rail between valid urban resources or Fortresses that are all connected by a railway.

To perform an Operational Movement, the unit must be on or next to a friendly urban resource or Fortress, and from there it must be possible to follow a railway line that travels through an unbroken path of friendly land hexes connecting it to the final destination. Other requirements are:

- The controlling Major must have sufficient MPPs to pay for the Operational Movement. This is 10% of the unit's current production cost, though the cost is reduced with every advance in Logistics research.
- The destination rail-head hexes must be on or next to a Town or City.
- The unit's supply value must be at least 5.
- The origin, destination and all through points must have a strength of at least 5.

In order to Operate a land unit, right click on the unit and select Operate from the drop down menu. Left clicking on any one of the highlighted destination hexes will complete the movement. **Note** that Operational Movement triggers a 15-25% loss of unit morale, and it costs air units double that of land units to operate.

6.3.3. Forced March

This enables you to move your units at a much faster pace, but in doing so they will suffer a 50-65% loss of morale. This will severely reduce their combat effectiveness.

Left click on a Land unit twice and providing it is a unit capable of Forced March, it has a supply value of 5 or more and it is not adjacent to an enemy unit, it will be able to move 50% further than usual.
In carrying out a Forced March the unit will not be able to attack any enemy units or capture any enemy resources. The outline of the hexes it can move to solely by using Forced March will have an orange outline.

The dramatic loss of Unit Morale represents the tiredness, disruption, and logistical problems caused by the unit moving at such a rapid rate.

### 6.3.4. Swapping Units

Select a unit that has not yet used up all its Action Points, press Shift and select an adjacent unit you wish to swap it with. There is a Morale penalty of 15-20% for swapping, and both units will have a maximum of 1 Action Point after doing so. Unless the swapped units have already attacked they will still be free to attack, and providing they aren't adjacent to any enemy units, to be reinforced or upgraded.

### 6.3.5. Airborne Drop

Paratroops have the unique ability of being able to be dropped behind enemy lines, i.e. to be transported by air over enemy units and terrain obstacles to reach their objective.

For Paratroops to be able to carry out an Airborne Drop, they must first Prepare. This has to be done in a turn prior to when they want to drop, and to Prepare they must have a supply value of at least 5 and not be adjacent to any enemy units. Providing these criteria are met, they can move and Prepare in the same turn.

To Prepare, right click on the unit, select Set Mode and then Prepare from the drop down menu. The unit will now display a small black circle in the top left, indicating that it is preparing for an Airborne Drop.

On the next and subsequent turns, the Paratroops’ movement radius will reflect its greater Operational Range. Select and move the unit normally to its drop location. Here they may land, fight and possibly even move 1 hex depending on the situation where they have landed.

Ensure that your Paratroop drop can be escorted by friendly Fighters, as otherwise enemy Interceptors could savage your Paratroops, reducing their strength dramatically.

Paratroops can also suffer casualties when landing on non-clear terrain. Non-clear terrain is defined as any hex containing terrain or a resource,
even if friendly controlled. Paratroops landing in non-clear terrain have a 30% chance of suffering landing casualties, rising to 45% if landing in bad weather. Morale and readiness will be recalculated after any landing losses are factored in.

Anti-Aircraft units can also inflict losses on Paratroops, so reconnoitering the landing zone first to avoid landing within range of these units is recommended.

If your Paratroops are Prepared but you would rather move or attack with them than have them perform an Airborne Drop, simply right click on the unit and untick the **Prepare** button.

If you do so, the Paratroops will only have 1 Action Point available this turn, and they can be reset to **Prepare** if you change your mind, but they would not be able to perform an Airborne Drop until your following turn.

### 6.3.6. The Effect of Terrain on Land Movement

Launching attacks reduces Action Points by 1 per attack, and moving into a clear hex or along a Paved Road uses up 1 Action Point per hex.

However, some hexes cost 2 or more Action Points to move into, as there is an additional penalty point associated with moving into or through them as follows:

#### 1 Penalty Point
- Major River
- Land/Sea Hexes e.g. those linking Egypt with the Sinai Peninsula
- Forest
- Marsh
- Hill
- Bush
- Bocage
- Oasis
- Desert
- Enemy held Major River
- Mud
- Rain/Fog
- Snow
- Sandstorms
- Storms at Sea
2 Penalty Points
Jungle
Mountain
Lake
3 Penalty Points
High Mountains

The above are cumulative so some hexes may require a unit to have a significant number of Action Points available to be able to move into them. **Tip!** Given that supply is a very important factor on the number of Action Points a unit has, keep your units in good supply, and consider upgrading them with Mobility to increase their Action Points.

### 6.3.7. Hex Ownership
Advancing units will not change the ownership of empty hexes that are contested by an enemy unit or resource. Instead, ownership of these contested hexes will only change if the hex is no longer contested, i.e. if the enemy unit contesting ownership from an adjacent hex is destroyed or retreats, or if the resource is captured.

This means that you can see changes to hex ownership instantly, increasing clarity and helping with your planning.

### 6.4. Air Movement
Air unit movement is divided into two main areas: Rebasing and Operational Movement.

**Tip!** Air units cannot attack after moving, but they can move 1/4 after attacking.

#### 6.4.1. Rebasing
Since air units must be able to relocate as front lines change, they can be Rebased up to the full range specified by their Action Point value. Unlike land units, air unit movement is not penalized by terrain movement costs or enemy unit positions. Thus, air units can be Rebased to any friendly hex, including those behind enemy lines or across bodies of water. In order to
Rebase an air unit, select any active air unit and then left click on one of the highlighted destination hexes to complete the movement.

If playing with the Weather option on, then air units will find their movement rates reduced in bad weather.

**Note:** It is possible for designers working on their own campaigns to switch off the Rebasing option, in which case all air unit relocations would have to be made by Operational Movement only, as described below.

### 6.4.2. Operational Movement

Operational movement for an air unit consists of the rapid transfer of air units from one battlefront to another. Since air units are not penalized by terrain movement costs or enemy unit positions when moving, the starting point and destination do not have to be connected by friendly hexes.

The controlling Major must have sufficient MPPs to pay for the movement. This will be 10% of the unit’s current production cost (20% for air unit’s) reduced by every level of *Logistics* research that has been attained, and the air unit must have a supply value of 3 or more. The destination must be on or next to an urban resource or Fortress with a minimum strength of 3.

In order to Operate an air unit, right click on the unit and select **Operate** from the drop down menu. Left clicking on any highlighted hexes will complete the Operational Movement to that hex, and this will result in a 15-25% unit morale loss.

There is a setting in place so that the USSR can only operate air units on its own territory, including to or from any Allied Minors that are subordinate to it. This means that it cannot operate its air units to countries like the UK or the USA, and nor can these countries operate their air units to the USSR.

### 6.5. Naval Movement

Naval unit movement is divided into four main areas:

- Regular Movement
- Naval Cruise
- Transport Movement
- Submarine Movement
6.5.1. Regular Movement
All naval units can be moved by first selecting the unit and then left clicking on any one of the highlighted destination hexes.

A specific movement path can be chosen by pressing and holding Ctrl on your keyboard. Individual Waypoints can then be selected by left clicking on the hexes you wish to move through. Left click on the final destination to carry out the move.

6.5.1.1. Naval units and Neutral Majors
Naval units belonging to neutral Majors cannot be used to blockade the path of belligerent nations’ naval units. The belligerent's units can sail through them, though they cannot literally occupy the same hexes as the neutral’s vessels.

6.5.2. Naval Cruise
The option to Cruise is available for almost all naval units that have a supply value of 5 or more, and this enables them to move double their normal movement distance, but for the loss of 1 supply point.

Left click on a naval unit twice, and the outline of the hexes it can move to will change from blue to orange. Click on your destination and the unit will move there, providing it doesn't encounter any previously unseen enemy units en route.

A cruising naval unit will not be able to attack, not even if it does encounter previously hidden enemy units in a Surprise Encounter, nor will it be able to slip past any previously unseen enemy units.

Regular Amphibious Transports are the only naval units that cannot Cruise, though Subs are restricted to only using Cruise if they are in Hunt mode.

Troop Transports and Long Range Amphibious Transports can Cruise because they are generally using larger ships, often fast cruise liners, whereas regular Amphibious Transports are designed more for short range operations and are less seaworthy.

6.5.3. Surface Raiders
Surface vessels are generally less useful in Convoy raiding than Subs, as they will tend to inflict less damage on the Convoy and they are also more vulnerable to attack as they cannot dive.
To raid a Convoy route, Surface vessels must be in Raider mode, and this mode can be turned on or off at any time during your turn.

6.5.4. Transport Movement
Regular Transports are used solely to move land units across the sea, and they have no attack capabilities. Transports can only load or unload units at a friendly-controlled Port, and can then be moved just like other naval units.

Note: Air units cannot be moved by sea, but must instead Operate to their destination.

The cost for embarking units in Transports is set at 10% of unit cost, but Logistics research will decrease this cost by 10% per level.

Even if the controlling Major has sufficient MPPs, each country can only put a limited number of units in Transports at any one time. This limit will increase through researching Logistics, as Build Limits will increase by 1 per level for Majors and their respective Minors.

To transport a land unit using regular troop Transports, the unit must be active and located adjacent to a friendly Port that has a strength of at least 5.

By right clicking on the unit and selecting Transport from the drop down menu, the land unit will be replaced by a Transport icon either directly on top of the Port hex or, if there is already a unit in the Port, adjacent to it. The Transport will have a supply value of 10. If more units are present to be placed in Transports, they can be embarked as long as there are available sea hexes adjacent to the Port for them to go to.

In terms of combat, Transports are quite weak since they cannot attack and their defense is poor. They do have a 10% chance of evading damage if attacked, but even so, providing them with naval escorts is strongly recommended.

A regular Transport can be moved immediately after loading. The embarked unit can only be unloaded in a friendly Port, and possibly in the same turn if it has sufficient Action Points to reach the new Port destination.

To unload in a friendly Port, move the unit into the desired Port hex and then finish its movement. The unit will remain active and may be unloaded either by left clicking on the Transport again, or by right clicking on it and...
selecting Unload from the drop down menu. Left clicking on any one of the highlighted hexes adjacent to the Port will complete the unloading.

Nevertheless, regular Transports can only enter and unload in a Port in the same turn if the Port has a strength of at least 5. If the Port’s strength is below 5 then the Transport can enter in one turn and unload in the next. This represents the disruption to unloading facilities that would exist in a damaged Port.

**Note:** Transport loading or unloading cannot take place at a frozen Port hex.

Once unloaded, the Transport icon will disappear and the original transported unit will then land with a maximum supply value of 5 regardless of the current Transport supply value. In most cases this will be a reduction in unit supply and it represents the reorganization required following troop transport. Morale is recalculated when the unit is unloaded, which may also result in a reduction in unit readiness, but the unit may now move and fight normally.

### 6.5.4.1. Limits on Transports

Each country can only put a limited number of units in Transports at any one time. This limit will increase through researching *Logistics*, as Build Limits will increase by 1 per level for Majors and their respective Minors. *Logistics* also decreases the cost of putting units in Transports by 10%.

### 6.5.5. Amphibious Transports

Amphibious Transports are used to conduct invasions against enemy shores, so their use will be vital for the Allies and sometimes useful for the Axis. Note that neutral Majors cannot embark units into Amphibious Transports.

The cost for Amphibious Transport is set at 20% of unit cost, and this higher cost is due to the specialized organization and equipment required for an amphibious landing.

Researching *Amphibious Warfare* will increase the Attack Values, Action Points and Build Limits of Amphibious Transports. *Amphibious Warfare* research also increases by 10% their chance of evading damage when attacked by enemy naval units.
Like regular Transports, land units have to be embarked on Amphibious Transports at a Port that is at strength 5 or more. However, they can unload not only in friendly Ports, but also directly onto friendly or enemy held Coastal hexes.

Special Forces are a unique unit type in that they don’t need to be adjacent to a Port in order to embark in an Amphibious Transport.

Right click on the unit and select Amphibious Transport from the drop down menu, and the unit will be replaced by an Amphibious Transport icon either directly on top of the Port hex or adjacent to it.

Unlike regular Transports, the Amphibious Transport cannot move on the turn the unit embarks unless level 1 in Amphibious Warfare has been reached, in which case it will be able to move 1 hex after loading. This can be useful as it increases the ability to load multiple units at a single port.

On your next turn you will be able to move the Amphibious Transport in accordance with its number of Action Points.

Like regular Transports, the embarked unit will be given full supply of 10 and there will be an immediate recalculation of morale to reflect this supply value. If more units are present to be placed in Amphibious Transports, they can be embarked as long as there are available sea hexes adjacent to the Port for them to go to.

The Amphibious Transport’s supply value will drop by 1 each turn it is at sea, and its Action Points and the embarked unit’s readiness will also fall the longer it remains at sea.

Regular Amphibious Transports are the only naval units that cannot Cruise or use Dynamic Movement, so their moves need to be planned well, especially with a view to avoiding them being at sea for very long.

The Weather will impact on some amphibious operations, as:

- No Amphibious loading is allowed from a snowed Port hex.
- No Amphibious unloading is allowed onto a snowed Coastal hex.
- No Amphibious loading or unloading is allowed from or onto a frozen Coastal or Port hex.

To help soften up the target before a landing is made, Amphibious Transports can themselves attack an enemy unit occupying a Coastal hex, before the unit they are carrying is landed. This feature enables amphibious
units to attack small defended islands, such as Malta. However, it can only unload into an empty hex, so the defender will have to be eliminated before landing. Once the unit has been unloaded from the Amphibious Transport it can attack again.

To unload onto either friendly or enemy territory, move the Amphibious Transport adjacent to the desired Coastal hex and then finish its movement. The unit will remain active and may be unloaded, either by left clicking on the Amphibious Transport again or by right clicking on it and selecting Unload from the drop down menu.

Left clicking on any one of the adjacent highlighted Coastal hexes will complete the unloading. The Amphibious Transport icon will disappear and the original transported unit will then land with its current supply onto the selected Coastal hex. Once unloaded, the unit may move and fight normally.

When unloading an Amphibious Transport onto enemy territory, the unit only has 1 Action Point so it cannot move too far inland. Also, when unloading onto enemy territory there is a chance that landing casualties will be suffered. This random chance is related to the amphibious unit’s current supply as shown in the following formula:

\[ \text{Landing Casualty Chance} = 100 - (\text{Amphibious Unit Supply} - 1) \times 10 \]

As supply decreases over time, the longer a unit is at sea the greater its chance of suffering landing casualties. If this trigger is met, the landing casualty penalty will be a loss of up to 25\% of unit strength in good weather, and up to 40\% in bad weather.

Also, if landing on non-clear terrain then there is a 50\% chance of suffering additional landing casualties on top of the previous landing casualty rule. Morale and readiness will then be recalculated after any landing losses are factored in.

Enemy naval units and Coastal Guns will fire on Amphibious Transports that halt in an adjacent hex, even if only temporarily prior to landing, so if your own naval units and bombers can deal with these prior to the landing then that will help to keep your casualties down.

6.5.6. AMPHIBIOUS TRANSPORTS (LONG RANGE)

These act just like Amphibious Transports except that they don’t lose supply every turn, have a much greater normal movement range, and they can Cruise.
Their ability to Cruise is really useful for launching invasions far from their starting point. However, as they are 25% more expensive than regular Amphibious Transports, their use should be carefully considered before embarking the troops.

Their benefits from Amphibious Warfare research are the same as for regular Amphibious Transports, except that they do not gain any increases in their Action Points.

6.5.6.1. Launching Successful Invasions

The key to successful amphibious landings is to have the units embarked for the shortest possible time, with naval escorts and air cover, and for them to seize a port as soon as possible after landing.

To maintain supply after the landing, it is important to land a HQ as part of the invasion force, keeping it safe from counterattack so that it can provide command and logistical support in subsequent turns as reinforcements are fed into the battle and the enemy driven back.

HQ units, after amphibiously unloading, start at 10 supply and maintain supply for up to 5 turns with a drop of 2 supply points per turn. This is similar to Special Forces, and allows the HQ to act as a Mulberry for an initial landing until further supply sources are achieved.

6.5.7. Submarine Movement

Subs have a mode option that can be set by right clicking the unit and selecting the appropriate mode from the drop down menu:

- Hunt – Set to automatically raid Convoys. This is a Sub's default status and it will display a small blue button when in this mode.
- Silent – Set to run silent and pass through enemy naval units undetected, though with only 2/3 their normal number of Action Points.
- Subs in Silent mode will display a small red button when in this mode.
- Changing from Hunt to Silent mode or vice versa can only be done before the Sub moves or attacks.

Hunt mode is faster and a Sub can Cruise while in Hunt mode, so it is useful for rapidly getting to a good raiding position, though at greater risk of being spotted or encountering enemy naval units.
In Silent mode a Sub cannot attack a Convoy route, but it can attack enemy naval units. To attack enemy Convoy routes it will need to switch to Hunt mode, but in this mode it will not be able to pass through enemy naval units unseen.

Silent mode allows Subs to pass through enemy naval formations and Convoy routes with a good chance of not being detected, but it reduces their normal speed to 2/3 and they cannot Cruise in this mode.

Subs that are attacked while running in Silent mode, will have their potential losses reduced by 50%. They will also have the effectiveness of their defensive return fire reduced by 50%, with no hits possible against attacking aircraft.

Note: Subs in Port that are in Silent Mode will not benefit from being in Silent Mode if attacked. Nor will they be hidden from enemy spotting like they would if at sea. However, if a Sub is attacked while in Port, the damage it receives is automatically halved.

The Sub’s Silent mode represents movement beneath the surface where Subs can pass through any enemy units unless they end their move next to one, or they pass through a hex occupied by an enemy Destroyer.

If they do encounter an enemy Destroyer while in Silent mode then they have a 50% chance of being discovered by that Destroyer. If they are discovered then their turn will immediately end with a Surprise Encounter.

When attacked, Subs have a % chance of diving. If they dive, they have a 25% chance of losing 1 strength point.

They have a 40% starting chance, increasing by 10% with every upgraded level of Advanced Subs.

However, each new level of Anti-Submarine Warfare upgrade reduces an attacked Sub’s dive percentage by 10%.

If they do dive then they will generally move 1-2 hexes away, and if they were in Hunt mode then they will automatically switch to Silent mode. This means that the attacker will probably have to relocate the Sub before it can be attacked again.

Note that the best use of Subs in combat is to lurk and ambush enemy vessels. If however a Sub moves before attacking then the vessel it attacks will have its losses reduced by 50%, and the attacking Sub will have its losses doubled.
6.6. Combat
There are three basic types of combat: land, air and naval. Unlike some games where multiple units may combine their attacks into a single combat, units in Strategic Command move and attack individually, and may do so in any order. Therefore, you are advised to learn to sequence and orchestrate your combat maneuvers depending on the situation. While most units can participate in both attack and defense sequences, some restrictions may apply and will be further explained in the sections below.

To launch an attack, left click to select one of your units that has an enemy unit within its Strike Range, and move your mouse cursor over the enemy unit.

6.6.1. Combat Predictions
Before attacking, the estimated combat results from an attack can be seen above the target cursor as well as in the center of the Information Panel at the bottom of the screen.

6.6.2. Combat Results
Once combat is resolved, the casualties suffered will appear temporarily above each unit/resource that suffers a loss.

6.6.3. National Morale Bonus
Whenever an enemy unit is destroyed when its supply status is less than 5, the Major whose unit destroyed it will receive a National Morale bonus equal to the MPP cost of the unit it has just destroyed.

If a unit belonging to a Minor power destroys an enemy unit, then its controlling Major will receive the National Morale bonus.

6.6.4. Land Combat
Most land units can participate in two different modes of combat:
- Prepared Attack
- Blitz Attack
Artillery units work differently in that they may fire Offensively and/or Defensively.
6.6.4.1. Launching Attacks
Left click to select one of your units that has an enemy unit within its Strike Range, and move your mouse cursor over the enemy unit you would like to target.

For most land units their Strike Range is 1 hex, though for Artillery units it will tend to be 2 or 3 hexes.

Once a valid target has been found, both the attacker and defender information is shown at the bottom of the screen. Also, the expected combat losses are shown at the top center of the information bar, as well as above the unit’s involved, as shown below.

In this example, the defender will also receive Artillery support, as represented by the white Artillery symbol on the right of the main panel. Artillery support is only factored into the prediction when the attacker is aware of it, so results can be worse than predicted.
Note: HQ units cannot attack at all since they are administrative in nature.

6.6.4.2. Prepared Attack
A Prepared Attack occurs when a land unit attacks without moving first. The attacking unit receives a 25% readiness bonus in the combat calculations.

If a unit can launch 2 or more Strikes, it will only benefit from the Prepared Attack bonus with its first attack.
6.6.4.3. Blitz Attack
A Blitz Attack occurs when a land unit moves before attacking an enemy unit. Land units that perform a Blitz Attack do not receive the Readiness bonus that they would when launching a Prepared Attack. The same limits on Strike Range apply, but are calculated from the final attacking position of the land unit and not from its original position.

It is possible for a unit with 2 Strikes to launch a Prepared Attack, move, and then launch a Blitz Attack in one turn. Or to move, attack, move and attack again.

6.6.4.4. Attacks and Action Points
Each attack costs one Action Point, so a unit that attacks before moving its full potential distance will have its potential movement distance reduced.

6.6.4.5. River Crossings
When attacking across enemy held watercourses the attacker suffers a Readiness Penalty in the combat calculation as follows:

<table>
<thead>
<tr>
<th>ATTACKING ACROSS</th>
<th>READINESS PENALTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>River</td>
<td>20</td>
</tr>
<tr>
<td>Major River or Land/Sea Hex</td>
<td>35</td>
</tr>
<tr>
<td>Stream/Wadi</td>
<td>10</td>
</tr>
</tbody>
</table>

6.6.4.6. Offensive and Defensive Artillery
Artillery units of all types receive a supply of shells each turn, and these can be fired one by one during your turn, or left so that should your opponent attack anyone within range of your artillery, they will fire defensively to protect the targeted unit.

Field Artillery units start each turn with 2 shells, and that is the maximum number they can have at any time. All other artillery units, including Heavy Artillery units, receive 1 shell per turn, and can accumulate up to 3. This way, they can launch heavy bombardments of 2-3 shells every 2-3 turns.

Artillery can fire blindly, potentially damaging hidden units, though the firer will not discover from this whether or not any enemy units are present.
Rail Guns can only fire offensively, they do not provide Defensive Fire. Field Artillery, Heavy Artillery and Rail Guns can either fire or move in their turn. If they fire, then they can move 1 hex after firing.

Coastal Batteries cannot move, but they can fire either offensively or defensively. Their Defensive Fire will target any enemy Amphibious Transports that come within range, so they can be very useful against an enemy invasion.

6.6.4.7. Retreats
Weakened units may retreat when attacked. This may happen if their estimated remaining strength after the combat is 5 or less, and the unit will be fully de-entrenched. However, if they retreat then the attacker will only receive 50% of their potential losses, and in retreating they may leave a resource unguarded, and a follow up attack will have a very good chance of destroying the retreating unit.

The chance of a unit retreating depends not only on its strength, but also on its unit type and on the hex it is occupying when it is attacked. The potential retreat range is also dependent on the unit type.

For example, here are some examples of the % chances of some unit types to retreat, depending on the hex they are in when attacked, along with their maximum retreat range:

<table>
<thead>
<tr>
<th>HEX TYPE</th>
<th>HQ</th>
<th>CAVALRY BRIGADE</th>
<th>ARMY</th>
<th>FIGHTER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Resource</td>
<td>50%</td>
<td>30%</td>
<td>30%</td>
<td>50%</td>
</tr>
<tr>
<td>Town, Settlement, Mine, Oil</td>
<td>35%</td>
<td>25%</td>
<td>10%</td>
<td>50%</td>
</tr>
<tr>
<td>City, Major City, Fortification, Fortified Town</td>
<td>20%</td>
<td>15%</td>
<td>0%</td>
<td>50%</td>
</tr>
<tr>
<td>Fortress, Major Fortress</td>
<td>15%</td>
<td>5%</td>
<td>0%</td>
<td>50%</td>
</tr>
<tr>
<td>Maximum Retreat Range</td>
<td>1 hex</td>
<td>2 hexes</td>
<td>1 hex</td>
<td>3 hexes</td>
</tr>
</tbody>
</table>

6.6.4.8. Shattered Units
If a unit is at strength 1 or 2 when it is attacked, and it is unable to retreat, then it will be destroyed instead.
6.6.5. AIR COMBAT

Air combat is divided into four main areas:

- Interdiction
- Strategic Bombing
- Interception
- Escort duty

6.6.5.1. Restrictions on Air Units

All land based air units can either move their full distance in a turn, or they can attack and then move 1/4 their full movement distance. Some Bombers can launch two attacks, one directly after the other, but most types can only attack once.

Carriers can move and attack and, providing they are set to Fighter mode, with a CAP mode of either Auto or Escort, then they can also escort friendly air attacks providing they haven’t already used up all their Strikes.

6.6.5.2. Highlights

To help visualize air combat ranges, selected Fighters will have Interception Range highlights in yellow and Escort Range highlights in blue. With these you can quickly see the current defensive air cover of a Fighter, or whether it can provide Escorts to an attack by your Bombers.

6.6.5.3. Interdiction

All types of aircraft including Carrier borne aircraft can attack land units, but the best to use in a ground attack role by a significant margin are Tactical and Medium Bombers.

6.6.5.4. Attacking Naval Targets

Tactical Bombers, Maritime Bombers, and Carriers (set to Bombers Mode) are the best air units to use against enemy naval targets, especially if equipped with Naval Warfare upgrades.

6.6.5.5. Bombers as Convoy Raiders

Bombers can be used to target Convoy routes. If an enemy Convoy route is within range of your Bombers at the end of your turn, then the Convoy
route may be hit. This will reduce its income value and also inflict a small reduction of up to 10 National Morale points against the Convoy recipient, due to the effect that intercepting Convoys could have on the supply of food and other goods for the home population.

However, Bombers cannot raid if the enemy has a Fighter unit within range to protect the Convoy, and if this is the case then at the end of the turn there will be a pop up saying “Defensive Air Cover Protects...” to advise you of this. No damage will be inflicted on either the Bombers or Fighters, but the Bombers will have failed to damage the Convoy.

Maritime Bombers are the most effective in this role, but Tactical, Medium and Strategic Bombers can also raid to varying degrees, with Strategic Bombers being the least effective.

6.6.5.6. Strategic Bombing

Well planned attacks by Strategic Bombers can greatly reduce an opponent’s ability to wage war and can thus be extremely valuable as part of your overall war plan. The damage they can inflict to resources can reduce enemy income, supply, and prevent units from Operating to or from them.

Unlike attacks by all other air units, Strategic Bomber attacks will first strike the resource. There is then a 10% chance (+10% for each level of Heavy Bomber research) that a defending unit located on the resource will also suffer a strength point loss.

When a Strategic Bomber attacks a resource with a defending unit located there, the combat indicator in the Information Panel will show the estimated resource losses first, and then the estimated unit losses (in brackets).

For example, a Strategic Bombing attack may display “Atkr=1 : Dfdr=2(0)” for estimated losses, where the resource is expected to lose 2 strength points and the occupying unit none. If, like in the example below, there is a white Anti-Aircraft symbol on the right of the information panel then this denotes that the Bombers should expect to receive fire from a nearby Anti-Aircraft unit:
The effect of Strategic bombing on Resources will be to:
- Reduce their Operational Efficiency
- Reduce their Economic Value
- Reduce their value as a Supply Source

All other air units’ attacks will strike enemy units occupying the resource, only being able to attack the resource itself if there is no enemy unit present.

6.6.5.7. Reduced Operational Efficiency
Damaged Urban resources cannot carry out the following functions:
- If at less than strength 5, they cannot be used by land units for Operational Movement.
- If at less than strength 3, they cannot be used by air units for Operational Movement.
  
A Port that has been reduced below strength 5:
- Cannot be used to load units into Transports.
- Cannot be used to unload units from Transports in the same turn that they enter the Port.
6.6.5.8. Reduced Economic Value
Strategic bombing will immediately reduce an opponent's MPPs, as each point of damage inflicted on the resource will deduct MPPs proportionate to the economic worth of that resource.

End of turn MPP income will also be reduced, as a damaged resource will not provide its full potential output until they have been fully repaired.

As resources only repair themselves by 1 strength point per turn, if severe damage is inflicted then it can take a long time for normal production to resume, and repeated attacks every 3-4 turns can prevent this recovery.

Reduced value as a Supply Source
Damaged Urban resources will provide less supply to units in their vicinity, so this means that unless they have alternative supply sources, enemy units in this area will have their combat efficiency reduced and be easier to destroy.

As a result it can be very useful to launch multiple attacks by Strategic Bombers in the turn before launching a ground offensive or amphibious invasion. The defender's reduced supply values, coupled with impeded ability to bring in reinforcements via Operational Movement could greatly increase your offensive's chance of success and lead to a decisive victory.

6.6.5.9. Interception
Fighters can automatically intercept enemy air activity during your opponent's turn.

To act as interceptors the Fighters must:
- Be within both Strike and Spotting Range of the hex targeted by the enemy.
- Be set to either Auto or Intercept mode.
- Have a strength value of at least 5.

Carriers can also act as interceptors providing:
- They are within both Strike and Spotting Range of the hex targeted by the enemy.
- Their air component has a strength value of at least 5.
- They are set to Fighter (Combat Air Patrol) mode.
- Their CAP mode is set to Auto or Intercept.
The Spotting Range used is determined by the type, i.e. a Fighter will use its Land Spotting Range to intercept while a Carrier will use its Naval Spotting Range.

Note: Fighters and Carriers at zero supply cannot intercept.

6.6.5.10. Escort Duty
Fighters can be automatically activated as escorts when a friendly Bomber attack, reconnaissance mission or Paratroop drop encounters enemy interceptors. To act as escorts the Fighters must:
- Be within Strike Range of the targeted hex.
- Be set to either Auto or Escort mode.
- Have not yet moved or attacked.
- Have a strength value of at least 5.

Escorting Fighters cannot guarantee that enemy interceptors won’t damage the escorted aircraft, for after the interceptor/escort combat is resolved, if the interceptor’s remaining strength is 5 or more then they will attack the escorted aircraft or Paratroops at half effect. Even so, escorts are very important as they will greatly reduce the damage your escorted aircraft will receive.

Note: Fighters and Carriers at zero supply cannot escort.

6.6.5.11. Automatic Mobilization Options
Generally, the automatic mobilization of Fighters and Carriers for interception and escort duty makes them extremely useful when they are positioned skilfully on the map.

All Fighters and any Carriers set to Fighter (Combat Air Patrol) mode have the following options that can be set by right clicking the unit and selecting the appropriate mode from the drop down menu:
- Auto - Set to automatically intercept and escort
- Intercept - Set to intercept only
- Escort - Set to escort only
- Ground – Set for no automatic mobilizations

Fighters and Carriers set to Fighter (Combat Air Patrol) mode will display a Green icon in the top left for Intercept, Orange for Escort, and Red for Ground.
Fighters can move or attack normally during their turn, irrespective of their mode, but they cannot do so and then act as escorts.

Fighter modes can be toggled on and off during the turn, even for units which have already completed their action for the turn. This means that you can set specific units for missions early in the turn, and then reset them later, e.g. to Ground if they took significant losses. Another example when this could be particularly useful would be when you want a specific Fighter unit to provide escort for a specific bombing mission.

Important! Carriers and Escort Carriers can change mode after moving, but not after they launch any air missions, including acting as escort to friendly air attacks.

6.6.6. Naval Combat

Naval combat is divided into four main areas:
- Regular Combat
- Carriers and Escort Carriers
- Shore Bombardment
- Convoy Raiding

6.6.6.1. Naval Combat and Supply

Each combat that a naval unit is involved in will use up 1 supply point, whether the unit is attack-ing or defending. However, Aircraft Carriers that can launch 2 Strikes will only use up 0.5 supply per attack. The only time that a unit doesn't lose a supply point when attacked is when a Subma-rine avoids an attack by diving. Naval units that engage in combat will have any remaining Action Points halved.

6.6.6.2. Sinking Enemy Vessels

Whenever a vessel is sunk, the Major whose unit sinks it will receive a National Morale bonus equal to the MPP cost of the vessel sunk, and its owner will suffer a similar penalty. If it were a Carrier, Battleship or Cruiser then the penalty is double the cost.

If a unit belonging to a Minor power destroys the enemy vessel, then its controlling Major will receive the National Morale bonus.
6.6.6.3. Regular Combat
Regular naval combat occurs whenever a naval unit attacks another naval unit within its Strike Range, either before, during or after moving. Apart from Carriers and Escort Carriers that can launch their planes to strike at distant targets, the Strike Range for all naval units is 1 hex.

Generally the higher the class of surface vessel, the more dangerous to the enemy their attacks will be, so Battleships will tend to defeat all types of Cruisers, who will in turn tend to defeat Destroyers and Motor Torpedo Boats.

Note that the best use of Subs in combat is to lurk and ambush enemy vessels. If however, a Sub moves before attacking then the vessel it attacks will have its losses reduced by 50%, and the attacking Sub will have its losses doubled.

6.6.6.4. Carriers and Escort Carriers
Carriers and Escort Carriers are the only unit types that are subdivided into two entities: the Carrier itself and its air component. It is possible to receive damage to one but not the other, and both need to be reinforced and upgraded separately, to reflect the length of time it took to undertake repairs and upgrades.

Carriers can be set to three main modes:
- Fighter (Combat Air Patrol)
- Bombers
- Mix

If you are in Bombers Mode (demonstrated with a Purple button on the left of the unit), then the CAP mode is disabled and the Auto/Intercept/Escort/Ground setting is removed from the Carrier.

If you are in Fighter (no button will be showing) or Mix Mode (an Orange button) then you can set the CAP mode to one of the following sub modes:
- Auto (this is the default setting)
- Intercept
- Escort
- Ground

Carriers can be upgraded with the following research technologies:
- Advanced Fighters
- Long Range Air
- Naval Warfare
Important! Carriers and Escort Carriers can change mode after moving, but not after they launch any air missions, including acting as escort to friendly air attacks.

6.6.6.5. CARRIERS’ MULTIPLE STRIKES
Unlike Escort Carriers that have only 1 Strike, Carriers have 2 Strikes and can use these to either:
- Launch 2 Strikes
- Escort 2 friendly air attacks
- Strike once, and escort another attack with their 1 remaining Strike
- Or just Strike once and reserve their strength and supply.

Carriers can also intercept twice during your opponent’s turn, providing the strength of their air component is at least 5 before launching the interception, and they are in the required mode.

6.6.6.6. RECOMMENDED MODES
If enemy aircraft are likely to intercept your Carrier’s attacks, set your Carrier to Fighter (Combat Air Patrol) before moving/attacking. This will maximize your air combat potential, though any attacks you launch on enemy land or naval targets will inflict minimal damage.

If you are unsure whether or not any air opposition is likely, set your carrier to Mix mode. In this mode your Carrier can launch not only a Strike against a ground or naval target, but if this Strike is intercepted the Carrier can send up an escort too. However, the act of escorting your first Strike will use up your second Strike.

Mix Mode Carriers intercepting an attack by an enemy Carrier can damage the Carrier as well as its aircraft if it is within Strike Range of the intercepted Carrier. This is because their air units will contain a mixture of Fighters and Bombers, so they will be able to inflict damage on the Carrier, whereas a Carrier set to Fighter (CAP) mode wouldn’t be able to inflict this damage.

If effective enemy air opposition isn’t expected, or if your air attacks will have escorts, setting your Carrier to Bombers will maximize the damage your Carrier will inflict with both its Strikes against a ground or naval target.
If setting your Carriers to Bombers mode, make sure that you have some aircraft capable of intercepting any air attacks launched against your Carriers. Otherwise enemy air attacks could easily sink your Carriers. Air protection is vital.

6.6.6.7. Attacking Naval Units In Port
All attacks on a Port will target any naval units in the Port, apart from attacks by surface vessels, Rail Guns and Strategic Bombers, as these will target the Port first. They will then have a small % chance (shown in the Combat Predictions Table before attacking) of damaging any naval units that may be in the Port.

All naval units in Port are very vulnerable to attack by land units. So if enemy ground forces are near any of your Ports, and the situation looks precarious, it might be best to move any naval units out of the Port.
Tip! Upgrading a Port with Anti-Aircraft Defense will help to protect its occupants against air attack.

6.6.6.8. Shore Bombardment
This occurs whenever naval units attack resources and enemy units located on a Coastal hex. These attacks can help soften up any defenses prior to an amphibious landing.

Shore bombardment of resources works the same as the Strategic Bombing of resources, in that damage can be inflicted on resources even if there is a unit located there. Shore bombardments will first strike the resource and then there is a 10% chance (+10% for each level of Naval Weaponry research) that a defending unit located on the resource will also suffer a strength point loss. Note that Subs cannot perform shore bombardment.

6.6.6.9. Convoy Raiders
In addition to their regular naval combat capabilities, surface vessels and Subs can be selected to hunt enemy Convoys in order to disrupt enemy shipping, thus reducing your opponent's income.

Active Convoy routes are shown as red lines in game, or as white lines if they are inactive. These can both also be seen on the Convoy Map.
To raid a Convoy route:
- The raiding unit must be within 1 hex of a Convoy route
- The raiding unit cannot be adjacent to any enemy naval units
- Surface Vessels must be in Raider Mode
- Subs must be in Hunt Mode

Convoy raiding will reduce the income received by the Convoy’s recipient, and Axis players are advised that a concerted campaign against the UK can have a very significant impact on their income.

Convoy raiding will also inflict a small National Morale penalty on the Convoy recipient. Subs and Battleships inflict a reduction of 25 National Morale points against the Convoy recipient, while smaller vessels will have a smaller effect.

Subs gain 0.2, other naval units 0.1 experience, per successful raid.

Tip! At zero supply units cannot raid convoy lines, and Submarines cannot dive, so returning to port periodically to refuel is strongly advised. The time in port can also be used to reinforce and upgrade.

6.6.6.10. Convoy Raiding Mechanism

When Subs raid Convoy routes, to determine their effect, the raider’s Advanced Subs (AS) level is compared to both the convoy sender and recipient’s Anti-Submarine Warfare (ASW) research levels. Whichever of the sender or recipient’s ASW levels is higher is the one that is used.

If the Sub’s AS level is greater than the enemy’s ASW level, a multiplier is first calculated as shown below:

\[ \text{Multiplier} = 1 + \text{AS level} - \text{ASW level} \]

The minimum Multiplier is 1, so it will never fall below 1 even if the defender’s ASW level is greater than the raider’s AS level.

Resulting enemy MPP losses, up to the maximum value of the Convoy, are then determined by one of the following two formulas:

**Subs**

\[ \text{Convoy MPP Loss} = \frac{\text{Random Value}}{10} \times \text{Sub Raid Multiplier} \times \text{Seasonal Decrease \%} \]

Where: \( \text{Random Value} = \left[ \text{Sub Strength} + \left( \text{Sub Strength} \times \frac{(\text{Multiplier} - 1)}{2} \right) \right] \)

\[ \text{Sub Strength} + \left( \text{Sub Strength} \times \frac{\text{Multiplier}}{2} \right) \]
All other Raiders
Convoy MPP Loss = Random Value / 10 * Raider Raid Multiplier * Seasonal Decrease %
Where: Random Value [Raider Strength, Raider Strength + (Raider Strength / 2)]
Example
A Sub with AS level 2 versus ASW Level 1 will have a Multiplier of 2, as:
Multiplier = 1 + 2 (AS level) – 1 (ASW level) = 2
If the Sub is at strength 10, with a Raid Multiplier of 10 (MPPs), then it could inflict 15-20 MPPs in Convoy losses using the above formula.

6.6.7. Purchasing Units
Units may be purchased at any time during your turn by selecting Purchase from the button at the top of the screen, or using the Ctrl-P Hotkey.

Once the Purchase Unit dialog appears, available units by country and by type will be selectable on the left, while a breakdown of their combat values will be displayed in a single column on the right.

By clicking on the Major country flag at the top, the name of that country and all its active Minors will appear in the Select Country box. All purchases are made by the Major powers, and they are responsible for paying for any new units belonging to their Minors. If buying a unit for a Minor, click first on the Major’s flag and then on the relevant country’s name. The Minor must be both allied to you and an active participant in the war, i.e. it hasn’t surrendered.

The names of the unit types available for purchase are shown in white, while those that you could have bought had you sufficient MPPs are shown in gray.

The number of units of each type available for purchase are shown in parentheses. If you are playing with the Production Delay option then these will be followed by the number of months or turns before the purchased unit will be ready to deploy.

In the Set Name box, you can select the named unit you wish to purchase, or you can change the name providing the new name you choose does not already exist for that unit type.

The dialog screen will show an icon for the selected unit type, the base unit cost including any costs for any upgrades you apply, and its adjusted
unit cost in parentheses. These adjusted costs will take into account any reductions due to Production Technology research, and Soft Build Limit penalties if you are playing with that option switched on.

Unit types whose Build Limit has already been reached will be shown in red, as will those that will only be available for purchase at a later date. You can tell the latter from the former by clicking on the unit type’s name, as if they can’t yet be bought then they will show the date when they will become available.

6.6.7.1. Upgrading Units when Purchasing

In the Upgrade box at the bottom of the dialog you can add upgrades when you purchase the units in accordance with your current research levels. The corresponding unit cost and combat values are dynamically adjusted as you add or remove selected upgrades. If the adjusted unit cost is more than a country’s currently available MPPs, the cost will be highlighted in light gray, and the Purchase button will be unselectable.

Tip! If MPPs are tight and you need to produce units quickly, then upgrade them later when you have more MPPs available.

Tip! If you are researching Production Technology and are not in a rush for new units, wait until you have achieved success in this category as that will reduce their cost by 5% per level attained.

Once a unit is selected and you have added any upgrades, click on the Purchase button to complete the purchase.

Purchased units will arrive as new units for placement as described below under New Unit Arrivals. Once all purchases are complete, click on the Close button to return to the Game Menu.

Note: There is no confirmation requested when you make a purchase, nor is there any way to cancel a purchase, so be sure that you really want to buy the unit before pressing the Purchase button.

6.6.7.2. Reforming Destroyed Units

When a land or air unit is destroyed with a supply level of at least 5, it can be repurchased at 60% base cost with 1/2 the usual Production Delay. In the Purchase List, these unit’s names will be annotated with an ‘*’.
Tip! Prioritize these for repurchase rather than other units of the same type.

This represents the ability to repair equipment, call on cadres, partially trained recruits and the wounded returning to the ranks. This isn't available to naval units as even though they represent more than one vessel, land and air units are much better able to recover from losses and be reconstituted into fighting formations, albeit ones that will have lost any experience they may have had before they were destroyed.

6.6.7.3. The Production Table

Units scheduled to arrive for each Major and their respective Minors can be accessed by either right clicking on the Major's flag at the top left of the screen, or by clicking on the Production button within the Purchase screen.

The Production Table shows all units that are due to arrive in future game turns, i.e. that are in the Production Queue. These can be units included within the campaign as well as units that you have purchased. Though if you are playing with the Production Delay option switched off, then only the former would show, as any units you buy can be deployed immediately after purchase.

Arrivals are arranged in two-month periods; e.g., Jan/Feb, Mar/Apr, etc. with their specific arrival dates and locations, if applicable, listed beneath the unit graphics. Click on OK at any time to exit back to the previous screen.

Note: Units destined to arrive by script or as a result of Decision Events are not shown in the Production Queue.

6.6.8. New Unit Arrivals

New units becoming available for deployment this turn, or that weren't deployed in previous turns, are displayed when you start the turn in a New Units dialog box as shown below:

Select a new unit and click OK to place it on the map. Valid locations
where the unit can be deployed are highlighted on the map. Left click on one to place the unit there.

You can continue placing units until there are no more available this turn, or you can click Cancel to delay any remaining unit placements until either later this turn, or in a future turn.

If you do delay any or all unit placements, you can select New Units from the Game Menu or use Ctrl-N at any point during the turn to bring up the New Units dialog again. The only reminder that new units remain available for placement is that the New Units button on the Game Menu remains highlighted. If there are no new units available, the menu button is grayed out.

New units may not move or engage in combat during the turn that they are placed on the map.

Tip! Regardless of how long the deployment of new units is delayed, they will deploy with 50% morale. So there is very rarely anything to be gained by delaying unit deployments beyond the current turn, unless you are very uncertain of where you wish to place them.

6.6.8.1. New Units’ Supply
Most new units have a supply value of 10 when they deploy, however, there are two occasions when units will deploy with zero supply.

The first is when you declare war on a neutral Minor, and the second is when a Major enters the war and some of its units deploy by script. A good example of the latter is the Red Army’s deployment when the USSR enters the war. These units will have zero supply for that turn.

This means that an aggressor has the potential to wreak havoc in the turn that they attack a neutral country, but they may face stiffer opposition in subsequent turns as any surviving enemy units will have better supply.

6.6.9. Reinforcing Units
To reinforce a unit, right click on it and select either Reinforce or Elite Reinforcements from the drop down menu. If the unit cannot receive any of these then these options will be grayed out.

Note: Reinforcing a unit completes its action for the turn.

A unit can be reinforced providing:
- It has not yet carried out any actions this turn.
- Its current Supply Value allows for an increase in strength.
- Its controlling Major has sufficient MPPs available.

A unit's maximum reinforcement value is relative to its Supply Value, see the *Supply and Reinforcements Table* for full details. Regular reinforcement will allow a unit to be reinforced up to a maximum strength value of 10, with a small reduction in experience for every strength point reinforced. This represents the intake of new recruits lacking in combat experience.

Note that naval units (with the sole exception of Motor Torpedo Boats) can only receive a maximum of 5 strength points per turn, and this rule does not apply to the air component of Carriers.

### 6.6.9.1. Surrounded Units
These can only be reinforced to a maximum strength of 5, irrespective of their supply level and available MPPs. The following formulas reflect the relative reinforcement costs of a unit due to combat losses:
- Regular Reinforcement Cost = # of Strength Points * (Cost of Unit / 10) / 2
- Elite Reinforcement Cost = Regular Reinforcement Cost * 2

### 6.6.9.2. Elite Reinforcements
Elite Reinforcements can only be applied if a unit is already at full strength. The reason for this is that adding Elite Reinforcements increases a unit's strength beyond the normal maximum without any loss in experience. These are more expensive than regular reinforcements and can only be added if there are no adjacent enemy units.

Units can only receive 1 extra strength point of Elite Reinforcements per turn, and they can only receive these up to the number of full experience bars that they are carrying. For example, a unit with 2 experience bars can only be reinforced to 2 strength points beyond its normal maximum. **Note:** HQs cannot receive Elite Reinforcements.
6.6.10. Upgrading Units
To upgrade a unit, right click on it and select Upgrade from the drop down menu.

Once the Upgrade dialog appears, a list of available research levels will be displayed on the left hand side and a breakdown of the unit’s adjusted combat values as you apply upgrades will display in brackets [...] on the right.

You may customize units by setting the exact upgrades by type and level, and the cost is dynamically adjusted as you do so, so you can consider different options before deciding.

Note that units belonging to most Minors will cost more to upgrade.

It will at times be the case that a unit can only be upgraded in one of its research categories, either because others haven’t yet been researched or because sufficient MPPs aren’t available.

A unit can be upgraded providing:
- It has not yet carried out any actions this turn.
- Its current Supply Value is at least 5.
- Its controlling Major has sufficient MPPs available.
- There are no adjacent enemy units.

If the unit cannot be upgraded, the drop down menu option will be grayed out.

Note: Upgrading a unit completes its action for the turn.

Tip! It isn’t necessary to upgrade units to their maximum potential. It is fully up to you how many upgrades you implement.

6.6.10.1. Upgrading Resources
Resources may also be upgraded to higher levels of Anti-Aircraft Defense, providing that category has been successfully researched. To upgrade a resource and increase its defense values against enemy air attacks, right click on it and select Upgrade.

If a unit is also located on the resource, the drop down menu will expand to allow either the unit or the resource to be selected.

Once the Upgrade dialog appears, a list of available research levels will be displayed on the left hand side and a breakdown of the resource’s adjusted defense values will be displayed in brackets [...] on the right.
This is shown in the figure below.

6.6.11. Renaming Units
In order to rename a unit, right click on it and select Rename from the drop down menu.
Note: A check is made when renaming a unit to determine if the new name already exists for the country and unit type. A warning message will prompt you to select another name if it does.

6.6.12. Disbanding Units
Land and air units belonging to Major powers can be disbanded, and any unit that is disbanded results in an immediate recovery of MPPs as shown in the formula below:

\[
\text{Recovered MPP} = \frac{\text{Unit Cost}}{10} \times \text{lowest value of unit's supply or strength} \times 20\%
\]

In order to disband a unit, right click on it and select Disband from the drop down menu.
To avoid abuse of this feature, a unit can only be disbanded if:

- It has not yet carried out any actions this turn.
- It has a current supply value > 0.
- No enemy units are adjacent.

Naval units and Minor’s units cannot be disbanded, again to avoid abuse. Also excepted from being able to disband are units that have unloaded from Transports this turn, and Paratroops preparing for an airborne drop.

7. ADVANCED GAMEPLAY CONCEPTS

7.1. GENERAL UNIT CHARACTERISTICS

The following table outlines the basic characteristics for all units:

<table>
<thead>
<tr>
<th>CHARACTERISTIC</th>
<th>MAX VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experience</td>
<td>Up to 5*</td>
</tr>
<tr>
<td>Supply</td>
<td>10</td>
</tr>
<tr>
<td>Action Points</td>
<td>Unit’s AP Value</td>
</tr>
<tr>
<td>Strength</td>
<td>Varying from 1-15</td>
</tr>
<tr>
<td>Strikes</td>
<td>0-2</td>
</tr>
<tr>
<td>Morale</td>
<td>Determined by Formula</td>
</tr>
<tr>
<td>Readiness</td>
<td>Determined by Formula</td>
</tr>
<tr>
<td>Entrenchment</td>
<td>Dependent on Terrain Type</td>
</tr>
</tbody>
</table>

*This is a potential maximum, but in the official campaigns this is set to 3.
7.2. **Combat Target Values**

Each unit type also has Combat Target Values for:

<table>
<thead>
<tr>
<th>ATTACK VALUES</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft</td>
<td>Soft</td>
</tr>
<tr>
<td>Hard</td>
<td>Hard</td>
</tr>
<tr>
<td>Artillery</td>
<td>Artillery</td>
</tr>
<tr>
<td>Strat. Artillery</td>
<td>Strat. Artillery</td>
</tr>
<tr>
<td>Rocket</td>
<td>Rocket</td>
</tr>
<tr>
<td>Light Armor</td>
<td>Light Armor</td>
</tr>
<tr>
<td>Tank</td>
<td>Tank</td>
</tr>
<tr>
<td>Fighter</td>
<td>Fighter</td>
</tr>
<tr>
<td>Bomber</td>
<td>Bomber</td>
</tr>
<tr>
<td>Strat. Bomber</td>
<td>Strat. Bomber</td>
</tr>
<tr>
<td>Kamikaze</td>
<td>Kamikaze</td>
</tr>
<tr>
<td>Naval</td>
<td>Naval</td>
</tr>
<tr>
<td>Carrier</td>
<td>Carrier</td>
</tr>
<tr>
<td>Sub</td>
<td>Sub</td>
</tr>
<tr>
<td>Transport</td>
<td>Transport</td>
</tr>
<tr>
<td>Anti-Aircraft</td>
<td>Anti-Aircraft</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GENERAL</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Spotting (Land)</td>
<td>Min Shells</td>
</tr>
<tr>
<td>Spotting (Naval)</td>
<td>Max Shells</td>
</tr>
<tr>
<td>Action Points</td>
<td>De-Entrenchment</td>
</tr>
<tr>
<td>Operational Range</td>
<td>De-Moralization</td>
</tr>
<tr>
<td>Intercept Range</td>
<td>Interceptions</td>
</tr>
<tr>
<td>Escort Range</td>
<td>Escorts</td>
</tr>
<tr>
<td>Strike Range</td>
<td>Strikes</td>
</tr>
</tbody>
</table>

Not all of these characteristics will be applicable to every unit type, so where they aren’t applicable a default value of zero will apply. For instance, only Artillery units have Shells so all other unit types will have Min and Max Shell values of zero.

Many of these values can be improved through researching and upgrading your units, please refer to chapter 9 on Research for further details.
7.3. HEADQUARTERS ATTACHMENTS

Headquarters attachments are vital in improving the Morale and Readiness and therefore combat efficiency of your units.

Default unit attachment to an HQ is limited to the 5 closest units of the commander’s nationality that are within 5 hexes of the HQ at the start of each turn. Click on a HQ a second time will show its attachment range.

If the HQ is a Major that can command units belonging to its Minors too, then these will be included in the process. Thus German HQs can command Slovakian units, and British HQs can command Canadian ones.

The game engine will automatically attempt to attach units firstly to the highest rated HQ within its Attachment Range. It will also attempt to prioritize attaching units that are adjacent to enemy units.

Basically, the HQ automatically reaches out until it collects the maximum number of attachable units within its Attachment Range. If there is more than one HQ in the area or units are manually attached to other HQs, then the engine will attempt to allocate attachment as best satisfies the above requirement.

Clicking once on an HQ will highlight in green all of the units it commands. A second click shows its attachment range. Also, when an attached unit is selected, its parent HQ is highlighted in green.

7.3.1. HQ MODES

You can manually select and deselect HQ attachments if you wish to fine tune them to get the best combat results. However, any changes in a unit’s attachment or detachment status will only alter that unit’s Readiness value this turn, its Morale value won’t change until the next turn.

To do this, right click on an HQ, select Set Mode, and then choose between Auto, Auto-Assist and Manual.

Auto is the default and is automatically handled by the game engine, as described above.

Auto-Assist allows attachments to be set manually, but the game engine will provide assistance in subsequent turns by automatically selecting replacement attachments if any of the units that had been manually attached no longer fulfill the attachment requirements. So for instance, if the unit is now too far away from the HQ, or has been destroyed, then the engine will attempt to find another that can benefit from the HQ’s command.
Manual allows attachments to be set manually under the same rules as for automatic attachments, except that you will have to make all changes yourself. In subsequent turns you will need to keep an eye on the attached units, because if one exceeds the attachment range or is destroyed then you will have to create a new attachment yourself in a subsequent turn.

Once either Auto-Assist or Manual modes are selected, with the HQ selected you will notice highlights in blue for units within its attachment range that could be attached to it. To change a unit’s attachment or detachment status, simply right click on a green unit and select Detach from the drop down menu or right click on a blue unit and select Attach.

Note that only units that haven’t yet carried out any actions may be attached or detached, so it is best to change unit attachments at the start of your turn.

As an example, the screenshots below show the basic process for von Rundstedt detaching the highlighted 8th Army. First, right-click on von Rundstedt and set the mode to either Auto-Assist or Manual by left-
clicking on one of these options. Now right-click on the unit of Tanks and you will be given the option to Detach it:

Attaching units works in exactly the same way, except that if an HQ is already commanding its maximum complement of units then you will have to detach a unit before you can attach another.

7.4. BUILDING FORTIFICATIONS

Engineers have the ability to build Fortifications that units can then occupy in order to benefit from defense bonuses when attacked.

Engineer units must have a supply value of at least 5 to being constructing Fortifications, and they may move into position and begin fortifying in the same turn. Engineers cannot begin constructing a Fortification when they are adjacent to any enemy units, though they can continue with the work should the enemy advance to an adjacent hex.

To begin constructing a Fortification, right click on the unit, select Set Mode and Fortify from the drop down menu.

A dialog box will now appear which you can use to design your Fortification as you can set the number of sides (# of Sides) and its orientation (Rotate).

The construction time is noted at the bottom of the dialog box. Note that the construction time depends upon the number of sides selected, as additional sides will extend the construction time.

Once you have set the Fortification’s design, the Engineer unit will receive a small black circle on its base indicating that it is fortifying the hex. The Engineer unit must remain in place during the entire construction period, and when the work is complete a Fortification will appear in the hex. The Engineer unit can then either occupy the Fortification and defend it, or better still, it can move away to construct another while a front line unit moves in to occupy the Fortification in its place.

If a Fortification provides a lower defense bonus than the underlying terrain, e.g. the Fortification is in a Mountain hex, then the unit will benefit from the terrain’s Defense Bonus +1.

If the Engineer unit is destroyed or moves away before construction is complete, all work is lost and must be started all over again.

Note: Engineers cannot fortify hexes containing Resources.
7.5. SURRENDERING NATIONS

7.5.1. SURRENDERING DUE TO LOSING THE CAPITAL

The primary way that a country will surrender is if its Capital has been captured and it has few land units left within the country to defend it. Some countries may continue fighting even if they have lost their Capital, and on rare occasions it might even be possible to counterattack and liberate the Capital.

Every turn after a country loses its Capital (or last Capital if it had more than one) there will be a check to see if it carries on fighting. The chance that it will carry on fighting depends on the number of units it has left within its own borders, as follows:

- Major Country Surrender = 3% * number of remaining units within the home country
- Minor Country Surrender = 6% * number of remaining units within the home country

The chance for Minors is slightly higher because Minors generally have significantly fewer units.

Tip! Liberating the Capital will end this process, so if you lose your Capital do your best to take it back!

7.5.2. ALTERNATIVE CAPITALS

Some countries do not immediately surrender when their Capital is captured, either because they have one or more Alternative Capitals where their government will move to, or because their government may transfer to another country altogether. For example, if Moscow falls then its Capital will move to Kuybyshev, and then Perm if Kuybyshev falls too.

When a Capital is captured, unit morale for that country’s land and air units will fall by 20-30%, and 5-15% for naval units. The side that captures the Capital will also receive a boost in unit morale of from 10-20% for land and air units, and from 5-15% for naval units.

A country whose Capital transfers will lose its current Production Queue items unless the new Capital is connected to either the location of the previous Capital, or to any of the Industrial Center locations for that
country. So the UK will lose its units in the Production Queue if its Capital transfers abroad (e.g. to Canada), while the USSR will be very unlikely to lose any should its Capital transfer to Kuybyshev or Perm, as they are connected by land to Moscow.

7.5.3. Fighting on from Exile
Some countries’ units have a chance that they will not give up the fight when their country surrenders.

French and British land and naval units, and elements from the Polish, Greek and Norwegian navies have a chance of fighting on from exile and becoming “free” units.

Beware that the chance of units fighting on from exile varies according to their nationality, and is far from guaranteed. So do not evacuate the French army to the UK because it will be much better used in defending France rather than hoping, possibly in vain, that some of its units may elect to join the Free French when their country falls.

7.5.4. Liberating Capitals
Capitals move back to their original location as they are liberated. So if Perm is the new Soviet Capital and the Red Army is able to liberate Kuybyshev then it would move there. If they then liberate Moscow then it moves back there as well.

The liberations don’t have to be carried out in order, so if the Soviets liberate Moscow but not Kuybyshev then it would move back to Moscow.

7.5.5. Surrendering Due to Low National Morale
The alternative way in which a Major will surrender is if its National Morale value falls to zero, irrespective of whether or not it still holds its Capital.

7.6. Capturing Enemy Supply Centers
An occupier gains the pre-existing Primary and Secondary Supply Centers when an enemy country surrenders.
7.7. Plunder
When a country surrenders, the conqueror will plunder the country and receive a one-off MPP bonus. The actual Plunder value is based on the following:

- The total number and value of its Resources
- The number of units the country had before surrendering

The plunder formulas do not include any units that will become free units, such as the Free Polish Navy. The formulas used are:

Unit Plunder = Current Unit Cost / 10 * strength * 5% (for all units)

Resource Plunder = Full value of all originally owned Resources * 75%

These values are added together and then multiplied by a random factor of between 150-200% for Major countries and between 250-300% for Minor countries.

A final factor is the Difficulty Setting if playing against the AI.

Tip! Disbanding units when you realize a Major is about to surrender will not reduce the amount of Plunder your opponent will receive. Fight on, do not give up as only the enemy benefits from defeatism!

7.8. Victory Conditions
Victory Conditions are determined by specific scripts set for each campaign. A message indicating the Game Over Victory Status will be displayed when the game ends in either a victory for one side or in a stalemate.

With the game over, items not previously visible under Fog of War will now become visible. These include all of your opponent’s units and strengths, research successes, current diplomatic investments and items in their Production Queue.

Decisive Victory is normally achieved whenever you have successfully defeated most currently activated Major countries in the game.

Major and Minor Victory Conditions normally apply if the campaign’s end date has been reached with one side having an advantage, but without being in a strong enough position to claim a Decisive Victory.

Stalemate Victory Conditions occur if neither side achieves any of their Victory Conditions by the campaign’s end date.
The scripts controlling the Victory Conditions are read in sequence, so even if more than one set of conditions apply, the one that is higher in the listed order will be the one that applies.
Tip! Be sure to read a campaign's Victory Conditions as you play, as these should inform your strategy.

7.9. The Game Engine’s Turn Sequence
These are the processes the engine goes through at the start and end of each turn.

**Calculation Phase I (at the start of the turn)**
- Determine resource Operational Efficiency
- Calculate Unit Supply
- Calculate Unit Morale
- Determine Unit Entrenchment
- Calculate unit Action Points
- Determine Fog of War

**Calculation Phase II (after you have hit end turn)**
- Test for weather changes
- Test for liberated countries
- Test for country surrender
- Test for scripted events
- Test for Fortification completions
- Test for naval damage at sea
- Test for Partisan activity
- Test for Diplomacy (current side only)
- Test for Research (current side only)
- Calculate Military Production Points (MPPs)

7.10. Collecting Military Production Points
Military Production Points (MPPs) are collected by Major countries at the end of each turn and are based on the number, strength and type of Resources currently owned or occupied by either side, coupled with the level of Industrial Technology research that each Major has achieved.
For neutral, inactive Majors, their income is linked to their Mobilization Values, as full production will not be reached until the country reaches 100% Mobilization.

Although Minor countries do not receive MPPs, they do contribute MPPs to their controlling Majors, who are in turn responsible for paying for everything relating to their Minors, e.g. buying new units and reinforcing and upgrading existing ones.

7.11. Supply
Units receive supply from friendly Resources and HQs, and unit supply is a major factor in determining combat effectiveness.

7.11.5.1. General Notes on Supply
- Resources which provide the most supply are Major Capitals and Major Ports, as they can provide supply values of up to 12.
- These are followed by Major’s Capitals, Industrial Centers, Primary Supply Centers and Ports, which can potentially provide supply up to 10.
- All of the above, except for Ports and Major Ports, are considered Key Resources.
- Connection by rail from Key Resources to other friendly resources will enable those resources to reach their maximum strength and supply levels.
- It is therefore wise to consider cutting the rail connections linking enemy resources to their Key Resources, and this should be a factor in determining your axis of advance into enemy territory. This way you can not only reduce enemy income without capturing any Resources, but it can also facilitate the destruction of enemy units at lower supply. This will help because units at lower supply are less effective, are much easier to destroy, and if destroyed with a supply value of less than 5 then they cannot be cheaply reformed.
- Secondary Supply Centers and Minor’s Capitals provide supply up to a maximum of 5, potentially increasing up to their maximum value according to their Resource type if they are connected by rail to any of the above.
Captured enemy Resources will generally provide less supply than friendly ones.

The supply benefit of Resources decreases with distance by 1 per hex in clear terrain.

The rate of decrease will be greater in non-clear terrain, as such terrain is an impediment to good supply. For example, placing units in forests, mountains or marshes, unless they are very close to a good supply source, will generally be a bad move.

Both types of Roads negate the effect of terrain on supply, so keeping units on or near roads is recommended. However, when the weather is Mud only Paved Roads will do so.

Oil, Mine and Settlement Resource types do not provide supply to any units.

Units in low supply cannot be reinforced as well as those in higher supply, while those lacking any source of supply cannot be reinforced at all.

Naval units can only be fully supplied in Port, though they will gain some supply from being in the proximity of friendly Ports, the benefit decreasing with distance.

HQs may only improve the supply level of air units that that are under their direct command, i.e. that are attached to them. Otherwise the air unit will only receive supply from nearby resources.

An air unit that could have higher supply if it were attached to an HQ will show with a red hatched highlight underneath it. If supplied by a HQ but it could receive higher supply if commanded by another nearby HQ projecting higher supply, will show with a purple hatch highlight underneath it.

Note: HQs belonging to different friendly countries cannot supply each others’ air units as they cannot command them.

### 7.12. RESOURCE DEFINITIONS

#### 7.12.1. MAJOR POWERS’ CAPITALS

- These act as a primary supply source providing supply up to their maximum strength value according to their Resource type (usually 10).
- New units can be deployed in a Capital and any friendly urban resource belonging to the same country with a strength of at least 5 that is connected via friendly controlled hexes to it.
- If the Capital falls the country generally surrenders, unless it transfers to an Alternative Capital.

### 7.12.2. **Industrial Centers**
- These act as a primary supply source providing supply up to their maximum strength value according to their Resource type (usually 10) even if they are cutoff from the Capital.
- New units can be built at an Industrial Center and any urban resource with a strength of at least 5 that is connected via friendly controlled land hexes to the Industrial Center.

### 7.12.3. **Primary Supply Centers**
- These act as a primary supply source providing supply up to 10 even if cutoff from the Capital.
- You can only build new air units at a Primary Supply Center unless it is connected to a Major’s Capital or Industrial Center via friendly controlled land hexes.

### 7.12.4. **Secondary Supply Centers**
- These act as a secondary supply source that provides supply up to 5 if cutoff from any of the above.
- You cannot build new units from a Secondary Supply Center unless it is connected to a Capital or Industrial Center via friendly controlled land hexes.

### 7.12.5. **Minor’s Capitals**
- These act as a secondary supply source that provide supply up to 5 if cutoff from a friendly Major’s Capital, Industrial Center or Primary Supply Center.
- New units belonging to that Minor can be built at a Minor Capital and in any urban resource within that country with a strength of at least 5 that is connected via friendly controlled land hexes to the Minor Capital.
- If the Minor Capital falls the country generally surrenders.
7.12.6. **Key Resources**
- The above are all defined as Key Resources.
- Resources not connected to a Key Resource will have a maximum supply value of 3, or 5 if they are a Port.
- Port supply = Port strength from the hexes adjacent to the port, minus the distance in hexes from the Port, both out to sea and also on land, with terrain and roads also needing to be factored in with the latter.

7.13. **Maximum Resource Strengths**

The following outlines the conditions that determine the maximum Operational Strength Value of a resource.

7.13.1. **Connected Resources**

If the resource is in direct connection via rail to a friendly Major’s Capital, Industrial Center or Primary Supply Center, then unless they are damaged, these resources will have strength and supply values of:
- 12 for Major Cities, Major Capitals and Major Fortresses
- 10 for Cities, Ports, Capitals and Fortresses
- 10 for Occupied enemy Major Cities and Major Capitals
- 8 for Towns, and any Occupied enemy Resources
- 8 for Settlements

7.13.2. **Unconnected Resources**

If the resource is connected to a Secondary Supply Center but not to a friendly Major’s Capital, Industrial Center or Primary Supply Center, then it will have a maximum strength of 5.

7.13.3. **Captured but Unconnected Enemy Resources**

The Occupational Efficiency penalty (the fact that enemy resources don’t generally work as efficiently under your control) doesn’t apply in the following circumstances:
- Occupied Capitals, Primary or Secondary Supply Centers that aren’t connected by rail to a friendly Major’s Capital, Industrial Center or Primary Supply Center will have a maximum strength of 5.
- Occupied Industrial Centers that aren’t connected to a friendly Major’s Capital, Industrial Center or Primary Supply Center will have a maximum strength of 3.

### 7.14. Supply Connection Rules
- All resources connected via rail to either a Primary or Secondary supply source will have their maximum strength & supply values according to their type, e.g. Towns will be at strength 8, Cities at 10.
- All resources that are only connected by road via friendly territory to a Primary or Secondary supply source will max out at strength 5.
- All resources that do not fall into any of the connection categories outlined above are considered cutoff and will have a maximum strength value of 3. Ports are an exception to this rule, as their maximum will default to 5.

### 7.15. Besieging Resources
Any resource except for a Major’s Capital or Fortress that has 2 or more enemy land units adjacent to it will have its strength reduced by 1 point at the beginning of every enemy turn until it reaches 0.

If the number of enemy land units adjacent to the resource falls below two, the resource regains strength at the beginning of every friendly turn by 1 point per turn.

This rule also applies to Ports with two or more enemy naval units present.

### 7.16. Port Supply to Land Forces
Any Port that has an enemy unit adjacent to it will not provide supply to friendly land units within its supply range. Port strength itself will be unaffected, and the only effect of the presence of the enemy unit will be to impede supply to land units. Destroying the enemy unit or driving it away will enable that Port to provide supply again.
7.17. **Artillery with Zero Supply**
Artillery and Rail Guns do not accumulate shells beyond their minimum if their supply level is zero.

7.18. **Raiding when at Zero Supply**
Units cannot raid convoy lines when they are at zero supply, though they can still disrupt shipping at locations marked on the map.

Submarines cannot dive when they are at zero supply, rendering them more vulnerable, so it is strongly advised to return to port for refueling before their supply level drops too low.

7.19. **Damage to Resources**
Strategic bombing, air attack, naval blockade and bombardment, partisan activity and rocket attacks can all reduce the strength of resources. This will in turn reduce both their supply value and also the number of MPPs collected at the end of each turn.

On subsequent turns, the Operational Strength Value for damaged resources is automatically increased by one point per friendly turn, up to their maximum strength value. This simulates rebuilding and repair of damaged infrastructure, without requiring any micromangement.

7.20. **Industrial Modifier**
A factor in determining the actual income received by each Major from its own Resources is its Industrial Modifier. This represents the production capability of its Resources relative to their strength.

Each friendly Major’s Industrial Modifier value appears when you hover your mouse over the Major’s flags in the top left of the screen:

A value of 100% represents a 1-to-1 relationship between collected MPPs and production capability. A value of 75% represents three-quarters production, 125% represents one and one-quarter production, and so on.
This Industrial Modifier value will increase with each level of Industrial Technology research that is achieved. Please refer to chapter 9 on Research for additional details.

Since Minor countries cannot conduct their own research, and do not benefit from their Major’s Industrial Technology research successes, they will always have a default Industrial Modifier of 100%.

In general, all MPPs collected at the end of each turn are available for use during the next turn. The production values for each type of controlled resource are added together and then multiplied by their country’s Industrial Modifier.

For neutral Major countries, as their Mobilization value is less than 100%, their income is adjusted to account for this. The following formula shows how MPP collection is calculated:

\[
\text{MPP Collection} = \text{Total Resource Value} \times \text{Industrial Modifier} \times \text{Mobilization Value}
\]

Note: If a campaign has longer winter turns and shorter summer turns, then this has the effect of meaning that less income is received in winter. If this isn’t desired then campaigns can be amended to use the Normalized Production option which ensures that production per time period is more balanced in campaigns with variable seasonal turn lengths. Its effect will be to increase production in winter turns and decrease it in summer turns.

**7.21. Unit Production**

In general, a country’s production of units can only occur in or adjacent to those urban resources that are connected by rail to their Capital or an Industrial Center. In addition, most campaigns are set so that new units can only be deployed in their Home Countries.
The following table outlines the standard production costs in MPPs for each unit type with no research upgrades added:

<table>
<thead>
<tr>
<th>HQ</th>
<th>300 + (HQ RATING * 5%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Garrison</td>
<td>50</td>
</tr>
<tr>
<td>Brigade</td>
<td>30</td>
</tr>
<tr>
<td>Division</td>
<td>75</td>
</tr>
<tr>
<td>Corps</td>
<td>150</td>
</tr>
<tr>
<td>Army</td>
<td>250</td>
</tr>
<tr>
<td>Mechanized</td>
<td>250</td>
</tr>
<tr>
<td>Special Forces</td>
<td>185</td>
</tr>
<tr>
<td>Engineers</td>
<td>200</td>
</tr>
<tr>
<td>Paratroops</td>
<td>200</td>
</tr>
<tr>
<td>Cavalry Brigade</td>
<td>40</td>
</tr>
<tr>
<td>Cavalry Division</td>
<td>80</td>
</tr>
<tr>
<td>Cavalry Corps</td>
<td>160</td>
</tr>
<tr>
<td>Partisans</td>
<td>75</td>
</tr>
<tr>
<td>Pillbox</td>
<td>250</td>
</tr>
<tr>
<td>Anti-Air</td>
<td>100</td>
</tr>
<tr>
<td>Rocket Artillery</td>
<td>200</td>
</tr>
<tr>
<td>Artillery</td>
<td>100</td>
</tr>
<tr>
<td>Heavy Artillery</td>
<td>200</td>
</tr>
<tr>
<td>Rail Gun</td>
<td>200</td>
</tr>
<tr>
<td>Coastal Gun</td>
<td>100</td>
</tr>
<tr>
<td>Rockets</td>
<td>200</td>
</tr>
<tr>
<td>Reconnaissance</td>
<td>100</td>
</tr>
<tr>
<td>Armored Train</td>
<td>200</td>
</tr>
<tr>
<td>Anti-Tank</td>
<td>200</td>
</tr>
<tr>
<td>Light Tanks</td>
<td>200</td>
</tr>
<tr>
<td>Tanks</td>
<td>250</td>
</tr>
<tr>
<td>Heavy Tanks</td>
<td>300</td>
</tr>
<tr>
<td>Airships</td>
<td>75</td>
</tr>
<tr>
<td>Fighters</td>
<td>250</td>
</tr>
<tr>
<td>Tactical Bombers</td>
<td>300</td>
</tr>
<tr>
<td>Medium Bombers</td>
<td>300</td>
</tr>
</tbody>
</table>
## 7.22. Reinforcement Costs

Reinforcement costs for damaged units are based on the current cost of the unit. The following formulas reflect the relative reinforcement costs of a unit due to combat losses:

- Regular Reinforcement Cost = \# of strength points * (Cost of Unit / 10) / 2
- Elite Reinforcement Cost = Regular Reinforcement Cost * 2

## 7.23. The Cost of Upgrading Units

Research is vital to improving the combat effectiveness of your units. There are two categories of Research, Manual and Automatic. Automatic research successes don’t increase unit production and reinforcement costs, but Manual upgrades applied to units will do so.

The following formula reflects the cost of units according to their applied research upgrades:
Cost of Unit = Standard Production Cost + (% increase * # of applicable research levels)

By % increase we are referring to the increase in cost due to each upgrade applied to the unit. So for example, if an Army is upgraded with *Infantry Weapons* level 1 then its price will increase by 10% as that is the cost per upgrade for that research type.

Cost increases for units upgraded with multiple technologies will have cumulative effects. For example, upgrading a unit with level 3 research in both *Advanced Fighters* and *Long-Range Aircraft* would increase overall costs by 45%, as the former increases costs by 5% per level, and the second by 10%. These upgrades make reinforcing Fighter units and the Air component of Carriers that much more expensive. See chapter 9 on Research for more details.

### 7.24. Decision Events

During the game you will at times be asked to make strategic decisions. This feature is called a Decision Event and you will be prompted to choose either Yes or No.

The text accompanying the Decision Event will describe and explain the choice facing you, but choose wisely because once you have chosen you will not be able to change your mind.

Examples of Decision Events include:
- For the USSR: choosing whether or not to attack Finland in the Winter War.
- For the UK: choosing whether or not to swap Destroyers for Bases with the USA.
- For Germany: choosing whether or not to form Vichy France.
- For Japan: choosing whether or not to form the Indian National Army.

Clicking on the ‘Notes’ tab on the bottom right of the Decision screen will bring up notes relating to the decision that may help you make your choice.

While a Decision is awaiting your choice, you can click on ‘View Map’ so that you can consider the situation with reference to the actual game map, checking various things like your Production Queue and Diplomacy.
When you’re ready, you can return to the Decision screen by clicking on the button in the bottom left corner. Note that you won’t be able to continue playing until you have responded to the Decision Event by choosing either Yes or No.

**7.25. Factors Influencing Combat Effectiveness**

Let’s now look at the different factors that determine a unit’s combat effectiveness.

**7.25.1. Experience**

A unit’s experience is based upon its success in combat, with a small extra bonus for attacking and destroying enemy units.

Unit experience has a maximum value of 3 in our official campaigns, though the maximum can be edited up to 5.

When replacing losses, some experience will be lost, and the formula used for this is as follows:

\[
\text{Experience Point Losses} = \frac{\text{Reinforcement amount} \times \text{Experience}}{10}
\]

For HQs, combat experience is dependent upon how well subordinate units under their command perform in the field according to the following two equations:

- If Defender’s Losses > Attacker Losses
  +0.1 (Attacker’s HQ)
  -0.05 (Defender’s HQ)

- If Defender’s Losses >= Attacker Losses
  +0.05 (Defender’s HQ)
  -0.05 (Attacker’s HQ)

**7.25.2. Factors Influencing Action Points**

In general, normal supply is traced from friendly sources over friendly controlled hexes, with the supply value decreasing as the distance from the supply source increases.

Terrain movement costs apply to supply paths, reducing by 2 for entering Mountain and Lake hexes, 3 for High Mountains, and by 1 for all other terrain. Supply to land units cannot be traced over bodies of water,
across depressions, or through neutral territory. The supply value of a hex is the maximum supply it is receiving from any source, and this may not be the closest, e.g. a Town 3 hexes away will, all other things being equal, provide less supply than a Major City 4 hexes away.

7.25.3. ROADS AND SUPPLY
Paved Roads negate the effect of terrain and weather on supply, and as troops also move faster on roads it is usually best to keep most of your units on roads, and only leave them when you will gain a tactical advantage by doing so.

Dirt Roads work like Paved Roads except that they do not prevent a reduction in Action Points (APs) when the weather effect is that of Mud.

One special rule is that if a unit has only 1 AP then any additional weather penalties do not apply.

7.25.4. HQ SUPPLY
HQs have a calculated supply value just like all other units, but in addition they have a Supply Distribution Value that can be applied to supply other friendly units around them.

This Supply Distribution Value is calculated based on the current supply value of the HQ. The following table outlines HQ supply distribution calculations, based on full strength HQs:

<table>
<thead>
<tr>
<th>HQ SUPPLY (INCOMING)</th>
<th>HQ SUPPLY DISTRIBUTION (OUTGOING TO OTHER UNITS)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>&lt;3</td>
<td>5</td>
</tr>
<tr>
<td>&lt;5</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>&gt;5</td>
<td>10</td>
</tr>
</tbody>
</table>

7.25.5. THE SUPPLY VALUE OF LOW STRENGTH HQS
Low strength HQs aren’t very effective sources of supply to units around them because they are working at reduced efficiency. Consequently their Supply Distribution Value is reduced using a formula that multiplies the HQ Supply Distribution Value by HQ strength, divided by 10.
The final Supply Distribution Value of an HQ cannot fall below their current Logistics level. For example, if a Major has Logistics Level-5, then the minimum final calculated Supply Distribution Value of its HQs cannot be less than 5.

7.25.6. Reinforcing HQs

Low Strength HQs can only be reinforced in stages, so if damaged it is wise to start reinforcing them as soon as possible. Or move them to safety if they are in extreme danger.

7.25.7. Raising HQs’ Minimum Supply Value

Researching Logistics raises the Minimum Supply Value for HQs. At level 1, the Minimum Supply Value is 1, and this will rise by 1 for every subsequent level attained.

So if level 5 Logistics has been attained, then a HQ with a strength value of 1-4 will have a minimum supply value of 5 even if it has no access to a supply source.

It is true that this means that you will only really see any benefit if a high level of Logistics is researched, but this may be of use in a critical situation.

7.25.8. Boosting HQ Supply

Friendly HQs with a supply value of at least 3, will automatically boost the supply of another friendly HQ that is within supply distribution range.

Any friendly HQ with a supply level less than 5 can receive this boost. The friendly HQ providing the supply boost, will only boost the supply of one other low supply HQ, and the boosted HQ can-not in turn boost another.

The hex of the friendly HQ providing the supply boost will be outlined in yellow when clicking on the boosted HQ. The engine will seek to make lower rated HQs provide supply for higher rated ones, rather than vice versa.

As HQ units are moved around the map, the engine will also automatically recalculate HQ supply boosting connections after each turn.

By positioning HQ units appropriately in low supply areas, the HQ supply boosting mechanism can be helpful in extending higher distribution supply to your units than would otherwise be possible.
Supply boosting between two HQs works as follows:
   a) If the first HQ has a supply value of 1 or 2 and the second HQ has an incoming supply of less than 3, then the second HQ will have its supply boosted to 5(6). Its own supply being 5 which enables it to reinforce, operate or be upgraded, and its supply distribution being 6.
   b) If the first HQ has an incoming supply of at least 3, and the second HQ has an incoming supply of less than 5, then the second HQ will have its supply boosted to 5(8).

7.25.9. HQ Supply During Amphibious Invasions
HQ units, after amphibiously unloading, start at 5 supply + their current Amphibious Warfare level, maintaining supply for up to 5 turns with a drop of 2 supply points per turn.
   This allows the HQ to act as a good supply source for an initial landing until further supply sources are achieved.
   Note: HQs that have amphibiously unloaded cannot boost another HQ, nor receive a boost from another HQ, until they have secured a supply providing resource greater than their current supply level.

7.26. Naval Supply
Naval supply is handled differently than normal supply for land and air units. In general, naval units within range of a Port receive maximum supply, minus their distance from Port, regardless of Port strength.
   Once naval units are out of Port range they will not have their supply values reduced unless they:
   - Cruise
   - Raid a Convoy route
   - Engage in combat, whether in attack or defense
   The exception to this rule are regular Amphibious Transports, as they will have their supply value reduced by one for each turn at sea, regardless of their vicinity to a Port. This does not apply to Amphibious Transport (Long Range) as they act like any other naval unit in this respect.
7.27. SUPPLY AND ACTION POINTS TABLE
This table shows the Action Point penalties that all unit types receive, whether land, air, or naval, if their supply values are low:

<table>
<thead>
<tr>
<th>UNIT'S SUPPLY VALUE</th>
<th>ACTION POINT VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 - 10</td>
<td>Unit's Maximum</td>
</tr>
<tr>
<td>1 - 5</td>
<td>Unit's Maximum minus 1</td>
</tr>
<tr>
<td>0</td>
<td>Unit's Maximum minus 2</td>
</tr>
</tbody>
</table>

7.28. SUPPLY & REINFORCEMENTS TABLE
Unit strength can only be reduced by combat losses, events such as the effect of winter on Axis units in the USSR, and naval units may occasionally suffer from storms at sea.

Land and air unit's strength can be replenished through reinforcement, providing the unit has sufficient supply, and its controlling Major has MPPs available to cover the cost.

Naval units must be in a friendly Port to be reinforced, and their attainable strength is based on the Port's strength value rather than the naval unit's supply value. However, it works in the same way as for land and air units, so for example, a naval unit in a Port that is at strength 5 can only be reinforced up to strength 8.

Note: naval units (with the sole exception of Motor Torpedo Boats) can only receive a maximum of 5 strength points per turn, though this rule does not apply to the air component of Carriers.

If a unit's strength is already greater than its attainable strength then it cannot be reinforced.

The following table shows reinforcement potential in accordance with the above:
Please refer to the Reinforcing Units section in Chapter 6 for information regarding the cost of reinforcing a unit, and how to reinforce units during a game.

7.28.1. Reinforcing Damaged HQs
HQs can only be reinforced to their maximum strength of 10, as they cannot receive Elite Reinforcements to take them beyond that. The rate at which they can be reinforced is also dependent on their strength, as shown in the table below:

<table>
<thead>
<tr>
<th>HQ STRENGTH</th>
<th>CAN BE REINFORCED TO</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>6-9</td>
<td>10</td>
</tr>
</tbody>
</table>

It can therefore take several turns to bring a low strength HQ back up to full strength.

7.28.2. Low Supply & Attrition Losses
Land and air units receiving zero supply, HQs excluded, automatically lose 1 strength point per turn if they are at least one hex beyond traceable supply. Land and air units also have a 50% chance, and units at 1 supply a 20% chance, of 1 strength point loss per adjacent enemy unit, providing
they are adjacent to at least 2 enemy front line units with strength and supply levels of at least 5. If their last strength point is lost then the unit surrenders.

**Additionally:** Units at zero supply suffer a unit Morale penalty of 50%, those at 1 supply 25%.

The effectiveness of an attack against a unit at zero supply is increased by 50%.

### 7.29. Morale and Readiness

At the start of a new game, all units will start with morale equal to their calculated supply value. For example, a unit that has a supply of 9 will start with 90% morale.

At the start of each subsequent turn, unit morale is determined by two things: its supply value, and its current strength compared to its potential maximum strength.

Newly deployed units start with 50% morale, and this will update at the end of their first turn in accordance with their situation.

Morale is formulated to drop over time when a unit is cut off or low on supply, and this will ultimately affect the unit's readiness. For example, if a German Army marches into the USSR and is subsequently completely cut off from any source of supply, then its morale and readiness will drop. Conversely, as a unit's supply situation improves, its morale will rise.

These changes are gradual over time as determined by the following formula:

New Morale = Old Morale x 75% + (Strength x 10 – Old Morale x 75%) x (Supply/10 x Old Morale/100)

**Note:** The actual Morale formula includes minor corrections for Strengths greater than 10 and if the Old Morale value was greater than 100, then it is capped at 100.
Morale Boosts from Automatic Upgrades are added in addition to the formula, but in a way that won’t allow them to accumulate from turn to turn. Their role is simply to provide a small boost to the actual Morale of the unit based on its condition and situation.

The formulas will also take into account if the unit has a Maximum Strength below 10, so that they aren’t penalized for this.

Units will start their turn with at least 10% Morale, regardless of prior turn reductions below 10%, and all newly deployed units start with a Morale value of 50%.

### 7.29.1. Morale Losses Due To Movement

The following actions will trigger Morale Losses within the range specified:

<table>
<thead>
<tr>
<th>Action</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forced March</td>
<td>50-65%</td>
</tr>
<tr>
<td>Operational Movement</td>
<td>15-25%</td>
</tr>
<tr>
<td>Unit Swap</td>
<td>15-20%</td>
</tr>
</tbody>
</table>

### 7.29.2. Unit Attacks Inflicting Morale Losses

Even if they don’t inflict any casualties, many unit types will reduce the targeted unit’s morale when they attack.

These defender Morale losses are relative to the strength of the attacking unit. For example, a Special Forces unit at strength 9 would inflict 90% of a 30% morale loss = a 27% morale loss.

All units that inflict Morale Losses when attacking are listed below:
<table>
<thead>
<tr>
<th>ATTACKING UNIT TYPE</th>
<th>MORALE LOSS INFLECTED ON THE DEFENDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Army</td>
<td>10%</td>
</tr>
<tr>
<td>Mechanized/Shock Army</td>
<td>20%</td>
</tr>
<tr>
<td>Special Forces</td>
<td>20%</td>
</tr>
<tr>
<td>Paratroops</td>
<td>20%</td>
</tr>
<tr>
<td>Partisans</td>
<td>15%</td>
</tr>
<tr>
<td>Rocket Artillery</td>
<td>25%</td>
</tr>
<tr>
<td>Field Artillery</td>
<td>10%</td>
</tr>
<tr>
<td>Heavy Artillery</td>
<td>20%</td>
</tr>
<tr>
<td>Rail Gun</td>
<td>5%</td>
</tr>
<tr>
<td>Coastal Gun</td>
<td>20%</td>
</tr>
<tr>
<td>Rockets</td>
<td>5%</td>
</tr>
<tr>
<td>Armored Train</td>
<td>10%</td>
</tr>
<tr>
<td>Tanks</td>
<td>35%</td>
</tr>
<tr>
<td>Heavy Tanks</td>
<td>50%</td>
</tr>
<tr>
<td>Airships</td>
<td>5%</td>
</tr>
<tr>
<td>Fighters</td>
<td>5%</td>
</tr>
<tr>
<td>Tactical Bombers</td>
<td>30%</td>
</tr>
<tr>
<td>Medium Bombers</td>
<td>50%</td>
</tr>
<tr>
<td>Strategic Bombers</td>
<td>15%</td>
</tr>
<tr>
<td>Kamikazes</td>
<td>25%</td>
</tr>
<tr>
<td>Dreadnought</td>
<td>20%</td>
</tr>
<tr>
<td>Battleship</td>
<td>20%</td>
</tr>
<tr>
<td>Battle Cruiser</td>
<td>10%</td>
</tr>
<tr>
<td>Heavy Cruiser</td>
<td>10%</td>
</tr>
<tr>
<td>Escort Carrier</td>
<td>5%</td>
</tr>
<tr>
<td>Carrier</td>
<td>5%</td>
</tr>
<tr>
<td>Sub</td>
<td>30%</td>
</tr>
<tr>
<td>Amphibious Transport</td>
<td>10%</td>
</tr>
<tr>
<td>Amphibious Transport (Long Range)</td>
<td>10%</td>
</tr>
</tbody>
</table>

**7.29.3. Morale Bonuses and Penalties**

There are two additional morale effects in the game. When a country surrenders there is a unit morale bonus for all units of the conquering country as well as for all similarly aligned fully active Majors, and a corresponding
morale decrease for all fully active opponent Majors. These morale gains or losses are 20-30% for land and air units and 5-15% for naval units.

Similarly, when a country is liberated there is a morale bonus for all units of the liberating country and other aligned and fully active Majors of 10-20% for land and air units, and 5-15% for naval units.

Morale bonuses are restricted to units whose morale is below 125%, and Morale Penalties are restricted to units whose morale is above 50%.

These effects are intended to replicate those hard to quantify morale boosts and penalties that victories and defeats during a war can have on either side. Their effect is solely on unit’s combat effectiveness, and generally unit morale will only be affected for a few turns.

7.29.4. Unit Readiness and Its Effect on Combat

Unit strength, supply and morale values all combine to determine a unit’s overall readiness for combat, and this Readiness value is key to its combat effectiveness.

Readiness for **land and air units** is calculated using one of the following two formulas:

If the unit comes under a HQ

Readiness = \(((\text{Unit Strength} + \text{HQ Rating}) / 2 + \text{Unit Morale} / 10 + \text{HQ Experience}) / 2) * 10

If the unit isn’t commanded by a HQ

Readiness = ((\text{Unit Strength} / 2 + \text{Unit Morale} / 10) / 2) * 10

As **naval units** never come under the command of HQs they always use a special formula of their own:

Readiness = (\text{Unit Strength} + (\text{Unit Morale} / 10)) / 2 * 10

**The Importance of HQs**

Because the HQ rating has such an important impact on readiness for land and air units, purchasing the more expensive but highest rated HQs is highly recommended, providing you have the funds available to do so.

Also, an HQ’s experience from combat leadership is passed down to all units under its command as a combat morale bonus. This makes experienced and highly rated HQs very useful in improving the effectiveness of units under their command.
The Importance of National Morale
Majors with reduced National Morale will suffer a small penalty to their Unit Morale, while those with National Morale of higher than 110% will benefit from a small boost.

- If National Morale < 40% then Unit Morale is multiplied by 0.85.
- If National Morale < 75% then Unit Morale is multiplied by 0.90.
- If National Morale < 95% then Unit Morale is multiplied by 0.95.
- If National Morale > 110% then Unit Morale is multiplied by 1.10.

7.29.5. The Effect of Entrenchment on Combat
Entrenchment provides attacked units with a chance to suppress combat losses. It is therefore best to avoid attacking units with high Entrenchment Values if other targets are nearby whose destruction will equally assist your plan.

For example, when advancing into the USSR there may be times when bypassing entrenched units is best, cutting them off from sources of supply and forcing them to either retire or be attacked when in lower supply.

Each level of Entrenchment is multiplied by a factor of 10 to determine the percentage chance that a unit will suppress strength losses from combat. For example, a unit with an entrenchment level of 4 will have a 40% chance of suppressing a strength loss.

If a strength loss is suppressed, then the targeted unit will suffer a morale loss of 10% per suppressed loss instead. So a unit that should have lost 2 strength points, would lose 20% of its morale instead.

While Entrenchment is very useful in reducing losses, an accumulation of morale losses may penalize the unit that receives them for some turns to come. This is because morale is a stored value that is updated each turn with its previous turn's value (including the morale losses suffered) being a major factor in the next turn's value. So a unit may survive some early hits but a rapid decrease in morale without relief may cause the unit to break down that much quicker in later rounds of combat.

7.29.6. Gaining Entrenchment
Entrenchment Values automatically increase by 1 point every friendly turn that a land or air unit stays in the same hex, up to the maximum value depending on terrain type.
If a unit moves into, or starts a turn within a friendly Fortress or Fortification, it will immediately entrench up to 1/2 of the maximum entrenchment value for those prepared positions.

Land and air units of all Majors, and of fully mobilized Minors can entrench, though air units have a maximum entrenchment of 1 regardless of underlying terrain or resource. Naval units cannot entrench under any circumstances.

Units belonging to neutral Minors cannot build up their Entrenchment Values, though campaign designers can provide their units with entrenchment so that they enter the war with those values.

All Entrenchment Values are lost when a unit moves out of its current hex, so if playing defensively it is best to position your units a few turns prior to an expected enemy attack so that they can build up their Entrenchment Values.

A defending unit can only have its Entrenchment Value decreased by direct attack, and the following table outlines these reductions according to attack type:

<table>
<thead>
<tr>
<th>ATTACKING UNIT</th>
<th>DEFENDER’S ENTRENCHMENT LOSS PER STRIKE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Garrison; Brigade; Rockets; Rail Guns; all Cavalry</td>
<td>0</td>
</tr>
<tr>
<td>All other Infantry units including Partisans</td>
<td>1</td>
</tr>
<tr>
<td>All Artillery apart from Rail Guns</td>
<td>1</td>
</tr>
<tr>
<td>Reconnaissance; Armored Train; Anti-Tank</td>
<td>0</td>
</tr>
<tr>
<td>Light Tanks</td>
<td>0</td>
</tr>
<tr>
<td>Mechanized; Tanks; Heavy Tanks</td>
<td>1</td>
</tr>
<tr>
<td>Airships; Fighters; Strategic Bombers</td>
<td>0</td>
</tr>
<tr>
<td>Tactical Bombers; Medium Bombers</td>
<td>1</td>
</tr>
<tr>
<td>All Naval Units including Carriers &amp; Escort Carriers</td>
<td>0</td>
</tr>
<tr>
<td>Amphibious Transports (including Long Range)</td>
<td>1</td>
</tr>
</tbody>
</table>

**7.29.7. Combat Losses**

The primary effect of combat is to reduce unit strength, and the following formulas illustrate the processes involved in determining the casualties that will be suffered.
First a Combat Multiplier based on a unit’s Readiness establishes the % of a unit’s attack or defense capabilities. The Combat Multiplier is calculated as shown below:

\[ \text{Combat Multiplier} = \frac{\text{Readiness}}{100} \]

The combat formulas that determine a unit’s strength losses are as follows:

\[ \text{Attacker Losses} = \text{Defender’s Combat Multiplier } \times (\text{Defense Type Value } + \frac{\text{Defender Experience}}{3}) - \text{Attacker Multiplier } \times \frac{\text{Attacker Experience}}{3} \]

\[ \text{Defender Losses} = \text{Attacker Multiplier } \times (\text{Attack Type Value } + \frac{\text{Attacker Experience}}{3}) - (\text{Defender Multiplier } \times (\frac{\text{Defender Experience}}{3} + \text{Defender Entrenchment + Defense Bonuses})) \]

**Note:** The Attack and Defense values used depend on the unit types involved in combat. When units of different target types fight each other, then their values respective to the enemy unit are used.

For example, if a Hard unit attacks a Soft unit, then the attacker’s Soft Attack values apply in determining the defender losses, and the defending Soft unit’s Hard Defense values apply in the calculation of the attacker’s losses.

Defense Bonuses are provided by the terrain and resources a defending unit is occupying, with forests, mountains, cities and fortresses providing the most.

Combat includes an awareness of relative unit upgrades so that it is only the difference between combat factors that count. For example, two Level-2 Tanks attacking each other will inflict damage on each other similar to two Level-0 Tanks.

Actual combat losses are a complex calculation based on the following:

- Unit Type
- Experience
- Supply
- Strength
- Unit Morale
- HQ Command Rating
- HQ Experience
- Entrenchment Value
- Terrain Defense Bonus
When calculating some combat losses there are additional considerations and the above formulas have been adjusted internally to take the following factors into account:

- HQs and Transports cannot attack.
- Land and air units cannot defend against naval bombardments.
- Air units attacking Subs will not suffer any losses.
- Land units have their attack values halved when they are attacking from terrain with a negative defense bonus value.
- Land units, air units and Resources cannot defend against Rocket attacks.
- Only Cities, Ports, Fortresses and Fortifications can defend against naval bombardments, other resources will not inflict damage on their naval attackers.
- Entrenched units may suppress combat losses and have their morale reduced instead.
- Attack values against Transports are increased by 50%.
- Weather effects may reduce attack values, except that they will not reduce the 50% bonus for attacking Transports.
- Elite unit strength is not included when calculating readiness for Transports.

7.29.8. Variability in the Combat Results

In addition to each of the factors described above, there is a possible +/-1 point variation in each combat that provides some randomness to the combat calculations.

This variation is small enough to produce reasonable and expected variety from game to game, but not significant enough to produce extreme results.

Exceptions: There are three occasions when this variable won't apply:

- If any units engaged in combat are at zero supply.
- If a unit has an attack or defence value of zero that is relevant to this combat.
- If the calculated defender losses would have been greater than their remaining strength.
You aren’t expected to memorize all of the formulas surrounding combat, but it helps to have a broad understanding of how all of the various factors are used in the calculations. This intuitive “feel for the game” will enable you to make sound decisions as you play.

The casualty predictions that are displayed above the units as well as in the Information Panel prior to resolving combats are a fairly accurate estimate when the Fog of War game option is turned off, apart from the +/-1 point variation.

However, if Fog of War is being used then some hidden enemy factors such as HQ command rating and combat morale bonus are ignored in the calculated estimates, and so the experienced player should expect slightly different results.

7.30. Supply Values

7.30.1. Land/Air Units

<table>
<thead>
<tr>
<th>CONNECTED TO A FRIENDLY MAJOR’S CAPITAL OR INDUSTRIAL/PRIMARY SUPPLY CENTER</th>
<th>Unit’s Supply Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Location</td>
<td></td>
</tr>
<tr>
<td>≤ 10 Action Points to HQ</td>
<td>HQ Supply minus Shortest Distance</td>
</tr>
<tr>
<td>≤ 10 Action Points to Friendly/Occupied Resource (12 if Major City or Port)</td>
<td>Resource Strength minus Shortest Distance</td>
</tr>
<tr>
<td>&gt; 10 Action Points to HQ</td>
<td>0</td>
</tr>
<tr>
<td>&gt; 10 Action Points to Friendly/Occupied Resource (12 if Major City or Port)</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CUT OFF FROM A FRIENDLY MAJOR</th>
<th>Unit’s Supply Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Location</td>
<td></td>
</tr>
<tr>
<td>Cut off from HQ but connected to a Friendly/Occupied Resource</td>
<td>Resource Strength minus Shortest Distance</td>
</tr>
<tr>
<td>Cut off from any valid City/Port but not from a friendly HQ</td>
<td>HQ Supply minus Shortest Distance</td>
</tr>
<tr>
<td>Cut off from any HQ and any valid Resource</td>
<td>0 (3 if Partisans)</td>
</tr>
</tbody>
</table>
Note: If either an HQ or a friendly/occupied resource can supply a unit then the greatest of the above values will be taken for a unit’s supply.

7.30.2. NAVAL UNITS

<table>
<thead>
<tr>
<th>IN RANGE OF A FRIENDLY/OCCUPIED PORT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Location</td>
</tr>
<tr>
<td>≤ [Port Strength] Action Points to valid Port</td>
</tr>
<tr>
<td>&gt; [Port Strength] Action Points to valid Port</td>
</tr>
</tbody>
</table>

8. UNIT TYPES

8.1. LAND UNITS
Making the most effective use of your land forces can make all the difference between victory and defeat, as they are vital for holding and capturing territory and resources.

Knowing their attributes is important, so this chapter is a guide to the various land units in the game.

8.1.1. TARGET TYPES
All Land Units are divided into six Target Types:
- **Soft** – HQ, Garrison, Brigade, Engineers, Partisans
- **Hard** – Division, Corps, Army, Special Forces, Paratroops, Shock Army
- **Light Armor** – Mechanized, Light Tanks
- **Tank** – Tanks and Heavy Tanks
- **Anti-Air** – Anti-Aircraft Units
- **Artillery** – All Artillery unit types

8.1.2. DEFAULT MAXIMUM STRENGTH
In the section that follows, Default Maximum Strength refers to maximum potential strength unless the unit has sufficient experience to receive Elite Reinforcements. All units described below have a default maximum of 10 unless stated otherwise.
8.1.3. Headquarters

An HQ is a strategic unit that provides leadership and logistical support to subordinate units. In real life it could employ thousands in largely administrative roles providing essential support to the soldiers in the front line.

Although HQs are administrative in nature and cannot attack, they provide supply to units in their vicinity, even to those not directly under their command.

Normally, up to 5 land and air units within a range of 5 hexes may be attached to an HQ.

Historical commanders are available to most nations, and they all have a preset base Command Rating. The higher this Command Rating, all other things being equal, the better the units under their command will fight. In game terms, this is because higher ratings equate to higher readiness values for the units under their command.

Example Base HQ Command Ratings:

- Von Manstein 8
- Zhukov 8
- Slim 8
- Montgomery 7
- Kimura 7
- Gamelin 4

HQs not only increase the readiness of units under their command, they also provide a combat morale bonus.

This bonus can increase over time if their subordinate units perform well in action, as any unit that performs well when attached to an HQ will increase that HQ's command experience. This will in turn increase the combat morale bonus that the HQ provides to all units under its command. So success breeds success!

However, it works in reverse too, so if units attached to an HQ are defeated then that HQ's command experience is reduced, and this will in turn reduce the combat morale bonuses for all units under its command.
8.1.4. Garrison
A Garrison unit is a very small force that can prevent an enemy unit from simply occupying a position without contest, but it is unlikely to withstand a strong attack. Garrisons have a default maximum strength of 5.

8.1.5. Brigade
Generally comprising 3-4 Battalions and with an official strength of maybe 5,000 at most, Brigades aren't represented in most of our official campaigns, but the unit slot is available for use in other campaigns if desired. Brigades have a default maximum strength of 8.

8.1.6. Division
A Division is the lowest organized infantry unit that is self-sustaining for field operations. The division consists of two to three infantry Brigades with 10,000 to 20,000 soldiers and heavy weapons support. It is weaker than a Corps or an Army.

8.1.7. Corps
In general, the standard Corps in the Second World War had a strength of between 40,000 to 60,000 men. Corps are the smallest unit that can really be useful in combat in our official campaigns. They are cheaper than Army units, but more vulnerable too.

8.1.8. Army
Armies represent a large formation containing numerous divisions and support elements. Able to deploy significantly more firepower than a Corps, they are more useful in both attack and defense but they are also far more expensive.

8.1.9. Mechanized
Mechanized units are mobile formations, generally of up to Corps strength, capable of exploiting successes or reacting rapidly to fill a gap in the line. They are vulnerable to infantry assault in urban areas, so they are not the best unit to use for the defense of Towns and Cities.
8.1.10. SPECIAL FORCES
Special Forces are elite offensive infantry units representing such important historical units as the British Royal Marines and US Rangers.

Special Forces have the unique ability of being able to embark on Amphibious Transports from any Coastal hex. This makes them very useful for raiding purposes, as they may be able to evacuate via sea if the landing fails to capture a Port.

The supply value of Special Forces units that have amphibiously unloaded will only drop by 2 points per turn in the absence of a separate source of supply, meaning that they will have some supply for a maximum of 5 turns.

8.1.11. ENGINEERS
These units are effectively Construction Engineers as Combat Engineers are presumed to be an integral part of the other combat units in the game.

Engineers can be used to build Fortifications to help strengthen defenses against enemy land attacks and amphibious operations. While Fortifications are not as strong as Fortresses such as the Maginot Line, they can be very useful in providing strong-points which the enemy may struggle to capture if properly defended.

Building Fortifications is covered in more detail in the Advanced Gameplay chapter.

8.1.12. PARATROOPS
Paratroops can drop behind enemy lines using parachutes and gliders, and their main use is as part of grand offensives when their operations can cause disruption, block supply lines, or seize crucial resources in the line of advance.

See the Airborne Drop section in Chapter 6 for full details on using Paratroops.

8.1.13. CAVALRY BRIGADE
Forming the backbone of Poland’s mobile forces in 1939, Cavalry Brigades lack the manpower and punch to deliver strong attacks, but they can serve to slow the invader’s advance and are more mobile than their infantry counterparts.

Cavalry Brigades have a default maximum strength of 8.
8.1.14. **Cavalry Division**  
Larger formations with better combat capability, but still out of place on a modern battlefield.

8.1.15. **Cavalry Corps**  
Large formations of cavalry were largely a thing of the past by 1939, but this did not stop the Soviets from fielding Cavalry Corps on the Eastern Front. While far from being a modern way of fighting war, their mobility gives them some potential in exploiting a breakthrough or closing a gap while stronger forces are brought up.

8.1.16. **Partisans**  
Partisan resistance throughout Europe, especially in the Balkans, Poland and USSR, diverted many Axis units from the main fighting fronts.

  Smaller partisan actions are simply represented by damage to resources, with no actual units being deployed on the map.

  Partisan uprisings of significant strength will deploy units on the map, and these can capture resources and interdict supply lines causing immense trouble to their occupiers.

  Partisans have a default maximum strength of 8, a minimum supply value of 3, and they are restricted to operating within their home country.

  Most partisan activity can be prevented by keeping units in or adjacent to their spawning hexes, and these can be seen by pressing ‘P’ on your keyboard.

8.1.17. **Pillbox**  
Pillboxes are static defensive positions, weaker than Fortresses, with a default maximum strength of 5. Although not represented in our official campaigns, this unit slot is available for use in your own campaigns.

8.1.18. **Anti-Aircraft**  
As Strategic Bombers played a major role in WWII, wreaking havoc across continents, these units represent massed anti-aircraft batteries deployed to protect vital resources from attack.
8.1.19. **ROCKET ARTILLERY**
Only Germany and the USSR have the potential to deploy Rocket Artillery units as these represent massed rocket batteries of Nebelwerfers or Katyushas. Acting like other artillery units, they can be most useful in softening up enemy units immediately prior to launching an offensive.

8.1.20. **ARTILLERY AND HEAVY ARTILLERY**
Artillery units represent concentrations of artillery, deployed at key points to either bolster the defense or support an attack. Artillery units can be useful in lowering enemy entrenchment values and demoralizing the target.

Artillery units also have an automatic ability whereby, providing they have shells remaining, they will provide Defensive Fire to shell any enemy units attacking friendly units within range.

Artillery can also fire blindly, targeting enemy held hexes and potentially damaging hidden units in them. These attacks will not disclose the presence of hidden units.

No Artillery and only a small number of Heavy Artillery units can be purchased in most of our official campaigns.

8.1.21. **RAIL GUN**
Rail Guns are primarily useful in shelling enemy resources. They can only fire before moving and naturally their movement is restricted to friendly railway lines. They accumulate shells in the same way that Artillery does, though they do not provide Defensive Fire to friendly units under attack.

8.1.22. **Coastal Gun**
Coastal Guns are static defensive units that can shell enemy forces, accumulating shells in the same way that Artillery does. Coastal Guns will fire on Amphibious Transports that halt in an adjacent hex, even if only temporarily prior to landing, and this feature means that they will have to be a prime target for destruction before an amphibious invasion can expect to succeed.

Coastal Guns cannot Operate or Swap as they have a default setting of zero Action Points.
8.1.23. Rockets
Only Germany can research and deploy Rocket units, as they were the main developers of these weapons, progressing from the V1 to V2 and with further designs in progress as the war drew to a close.

Rockets can be used to attack strategic resources, and their key advantage in this role is that their attacks cannot be opposed or intercepted, so they will only lose strength points from direct attack by other units. They can be used against ground targets too, but their main impact will be against enemy resources.

8.1.24. Reconnaissance
This unit type represents a fast moving unit with a longer spotting range than most, but that will generally be fairly weak in combat.

8.1.25. Armored Train
Fast moving Armored Trains equipped with artillery pieces and heavy machine guns mounted in armored turrets, supported by rail borne light armored units, can be useful for anti-partisan duty or to oppose an enemy breakthrough. Like Rail Guns their movement is restricted to friendly railway lines.

8.1.26. Anti-Tank
Only Germany and the USSR can deploy significant numbers of dedicated Anti-Tank units. As they specialize in fighting armored units, they are weak in the face of attack by enemy infantry units.

8.1.27. Light Tanks
Only Spain, China, Japan and the USSR can field any Light Tank units, the latter's only deploying when the USSR enters the war. They represent poorly armored obsolete tanks, likely to be rapidly destroyed, and while they can be upgraded, they will struggle to compete against Tanks and Heavy Tank units.
8.1.28. **Tanks and Heavy Tanks**

Tank units represent large mechanized and armored units, with good mobility and firepower. Heavy Tank units are less mobile, but they contain greater punch so their base combat capabilities are higher.

Special Bonus! Researching level 1 in *Armored Warfare* will provide Tank and Heavy Tank units with 2 Strikes, making them by far the most devastating land units in the game.

**8.2. Air Units**

Air units are vital for protecting your forces and resources, launching reconnaissance missions to locate the enemy, and bombing missions to destroy them.

**8.2.1. Airships**

In WWII the only country to use Airships was the USA, which used them for anti-submarine warfare. They can be useful for spotting enemy warships and U-Boats.

**8.2.2. Fighters**

Fighters specialize in winning air superiority and in your turn you can use them to launch raids to duel with enemy Fighters, carry out reconnaissance missions, or escort your Bombers. During your opponent's turn they can intercept enemy air attacks, so keeping them near vital resources and to protect important units is recommended.

While they can be used to attack ground targets, their attack values are low so that it is better to use them mainly for air combat and reconnaissance.

**8.2.3. Tactical Bombers**

Tactical Bombers specialize in ground and naval attack. With Fighter escort, their contribution to ground offensives or in attacking enemy naval units will often be the key to success.

Tactical Bombers can be considered as a form of air artillery, and as such they are very useful in lowering entrenchment and demoralizing an enemy unit prior to it being attacked by ground units.
Tactical Bombers have the advantage over artillery in that they may move further and they have a significantly greater Strike Range, but they may also be grounded by bad weather, rendering them temporarily ineffective.

Tip! Use these periods of bad weather to move to better positions, upgrade or reinforce.

Tactical Bombers can raid Convoy routes, but Maritime Bombers will be more effective at doing so.

8.2.4. Medium Bombers
Medium Bombers are good at softening up enemy units, inflicting significant de-moralization on targeted enemy units, but they are less proficient at inflicting casualties due to Tactical Bombers’ better targeting abilities.

Medium Bombers have a longer Strike Range than Tactical Bombers, and can raid Convoy routes just as effectively.

8.2.5. Strategic Bombers
Strategic Bombers can be used to attack any enemy unit within range, but their main function and strength is in bombing enemy resources. Using them to bomb enemy resources, especially their Mines and Oil Fields, will reduce your opponent’s income and supply, weakening their war effort and paving the way for the victories to come.

When they bomb enemy resources, Strategic Bombers will spot the targeted resource’s strength value. Gaining this important information will be useful in determining the success of your bombing raids, and therefore whether to continue targeting the same location or to switch targets.

Strategic Bombers can also raid Convoy routes, but they are less effective at doing so than other aircraft types.

Special Bonus! Attaining level 1 in Aerial Warfare research will provide Strategic Bombers with the ability to launch 2 Strikes per turn.

8.2.6. Maritime Bombers
These are useful for spotting naval targets and attacking Submarines, especially when upgraded with Long Range Aircraft and Anti-Submarine Warfare research.
Tip! All Bomber types are vulnerable to Fighter interception so providing them with escorts is vital. It is true that the escorts may not be able to prevent the Bombers from receiving some damage in the ensuing air combat, but without escorts the damage would be so much greater.

8.2.7. Kamikazes
Japan can build and deploy Kamikaze units from the 1st January 1944. These are one shot units that can damage or destroy a targeted unit.

If being used against naval targets, they have an additional 25% chance of damaging an adjacent naval unit to the one targeted, if there is one.

Kamikaze attacks are not intercepted by enemy Fighters or Anti-Aircraft fire because Kamikaze units are destroyed whenever they strike an enemy unit, but they are cheap and have a short Production Delay, so it shouldn’t be long before they can be rebuilt and be back in action!

8.3. Naval Units
Naval units represent several combat and support vessels clustered around a named capital ship. They can be used to help control or threaten vital sea-lanes and Convoy routes, and they can also carry out shore bombardments, though they are vulnerable to enemy air attack when doing so.

8.3.1. Resisting Amphibious Invasions
Dreadnoughts, Battleships, and all classes of Cruisers and Destroyers can also be used to direct automatic Defensive Fire against Amphibious Transports that end their move adjacent to one of these ships. By placing these naval units in key areas they can help to frustrate your opponent’s amphibious landings.

8.3.2. Raiding Ports
Naval units can reduce the effectiveness of enemy Ports by raiding in selected locations on the map. They will not gain experience from doing so, but nor will they lose supply in doing so. These areas are shown on the next page.
Another use of naval units is to raid enemy Convoy routes in the same way as Submarines do, though no surface vessel will be quite as effective as a Submarine in this role.

8.3.3. Dreadnoughts
This unit type is not used in our official campaigns, though this slot can be used if you are designing your own campaigns and would like to deploy a heavier ship class.

8.3.4. Battleships
Battleships are the hardest hitting naval units in surface actions, the rulers of the seas with the ability to launch devastating attacks on much lighter vessels like Destroyers and Transports. They are however vulnerable to air attack and very expensive to repair, so it will be best to avoid situations where they risk being bombed or attacked by superior forces.

Battleships can also be useful for shore bombardments as they can significantly demoralize targeted units and damage resources along the coast.

8.3.5. Cruisers
There are three types of Cruisers: Light; Heavy and Battle Cruisers. Their combat factors increase in that order, though so do their production and reinforcement costs. All types are capable of engaging in surface fleet actions and carrying out shore bombardments, though all things being equal none are as devastating as Battleships.

8.3.6. Destroyers
Destroyers are small and fast naval units that are especially useful in hunting Submarines. Their small size and lack of firepower means that they will normally be easily outclassed in a naval engagement with enemy Battleships or Cruisers. It is therefore best to only use them in areas where enemy Submarine activity is expected, keeping them as far as possible away from enemy Capital ships.
8.3.7. Carriers and Escort Carriers

With their extended Strike Range due to their ability to move and attack in the same turn, Carrier units can be extremely useful for either attacking enemy units or reconnoitering enemy held coastlines.

Their torpedo bombers when in Bombers Mode are particularly effective against naval targets, although their effectiveness against targets on land is much more limited.

Carriers have two strength values – a ship/hull strength, and an air strength rating.

Carriers have a number of different modes:
- Fighter (Combat Air Patrol)
- Bombers
- Mix

If you are in Bombers Mode (demonstrated by a Purple button on the left of the unit), then the CAP mode is disabled and the Auto/Intercept/Escort/Ground setting is removed from the Carrier.

If you are in Fighter (no button will be showing) or Mix Mode (an Orange button) then you can set the CAP mode to one of the following:
- Auto (this is the default setting)
- Intercept (I)
- Escort (E)
- Ground (G)

Much cheaper and quicker to build than Carriers, Escort Carriers are ideally suited for hunting enemy Submarines and can be useful against other naval targets, but they are somewhat fragile and cannot keep pace with most other naval units.

Escort Carriers can launch 1 Strike a turn, while Carriers can launch 2.

Important! Carriers and Escort Carriers can change mode after moving, but not after they launch any air missions, including acting as escort to friendly air attacks.

8.3.8. Subs

Submarines can be effective in regular naval combat but their great inherent strength lies in their stealthy ability to disrupt enemy Convoys. This ability is of major importance in the Battle of the Atlantic as the United
Kingdom’s economy relies on Convoys from places like Canada, the British Empire and the Near East.

Note that the best use of Subs in combat is to lurk and ambush enemy vessels. If however a Sub moves before attacking then the vessel it attacks will have its losses reduced by 50%, and the attacking Sub will have its losses doubled.

Convoy raiding by Subs is covered in more detail in the Advanced Gameplay Chapter.

8.3.9. Motor Torpedo Boats
These are light craft useful for escorting transports, or for attacking weak naval targets. They should generally try to avoid encounters with heavier classes of warships.

8.3.10. Transports
Transports are used to move land units across the sea. Transports can only load or unload units at a friendly-controlled Port, and can then be moved just like other naval units.

In terms of combat, Transports are quite weak since they cannot attack and their defense is poor. They do have a 10% chance of evading damage if attacked, but even so, providing them with a naval escort is recommended.

Build Limits: Each country can only put a limited number of units in Transports at any one time. This limit will increase through researching Logistics, as Build Limits will increase by 1 per level for Majors and their respective Minors. Logistics also decreases the cost of putting units in Transports by 10%.

8.3.11. Amphibious Transports
Amphibious Transports are used to conduct invasions against enemy controlled shores.

Unlike regular Transports, Amphibious Transports can be used to unload units directly onto Coastal hexes, either friendly or enemy controlled. Amphibious Transports may also unload units at a friendly controlled Port.

To help soften up the target before a landing is made, Amphibious Transports can themselves attack an enemy unit, before the unit they are
carrying lands. Be aware that the Amphibious Transport and consequently the unit it is carrying can suffer casualties when doing so. Even so, this can be useful if attacking defended islands or coastlines, and the unit itself can also attack once it has been unloaded from the Amphibious Transport.

**8.3.12. Amphibious Transports (Long Range)**
These act exactly the same as Amphibious Transports, except that they don't lose supply every turn. Their benefits from Amphibious Warfare research are the same as for Amphibious Transports, except that they do not gain any increases in their Action Points.

They can Cruise and are really useful for launching invasions far from their starting point, but as they are 25% more expensive than regular Amphibious Transports their use should be carefully considered before embarking the troops.

**8.3.13. Using Transports and Amphibious Transports**
Right clicking on a unit which is immediately adjacent to a friendly Port will provide the option to place it in a Transport or Amphibious Transport, providing it hasn’t yet moved or attacked, and you have sufficient MPPs available.

Special Forces are a unique unit type in that they don’t need to be adjacent to a Port in order to embark in an Amphibious Transport.

**9. RESEARCH**

**9.1. Introduction**
Getting the best out of your armed forces and economy requires investing a significant proportion of your income into Research.

All Majors can conduct research to improve their income and the fighting qualities of their armed forces. Minors can benefit from the research undertaken by their controlling Majors, but they cannot themselves invest in research.
Each technology area has a maximum potential achievement level of 5, though the actual limits per category do vary.

In other campaigns the limits may be different, in accordance with the settings chosen by their designer.

The limits can be seen in the Research screen, as the maximum level that can be researched is shown in brackets at the end of each category's entry:

![Spying and Intelligence](image)

The actual maximum level for upgrades can also vary according to unit type. For instance, Partisans can only be upgraded to level 1 with *Infantry Weapons*. The aim of this lower maximum level in this instance is to ensure that a Partisan unit can never reach quite the same level of effectiveness as regular units in the field.

In our official campaigns, you may invest up to 2 research chits at a time in most categories. Other campaigns might have different limits as the investment limits can be adjusted to vary from 1-5 chits per category.

Each Major has its own investment limit, in MPPs. This prevents anyone from investing far more in research than was historically possible, and it also means that those countries capable of rapid progress are more likely to do so. For example, Germany can invest more in research than Italy, but less than the USA.

9.1.1. IN BRIEF: THE RESEARCH MECHANISM

- For every chit invested, progress will be made at the end of that side's turn towards reaching the next level of research.
- Per turn increments to achieve levels 1-3 in a technology field average 5% per turn, in reality between 3-8% per chit.
- Per turn increments to achieve levels 4-5 in a technology field average 4% per turn, in reality between 2-7% per chit.
- Research automatically succeeds in gaining the next level on reaching 100% progress, though there is a small chance of a breakthrough speeding up your progress by an extra 10-20% once the 45% threshold has been crossed.
- The chance of a breakthrough once the 45% threshold has been crossed is 5% per turn per chit invested.
- The Research Sharing feature and researching Spying & Intelligence can both speed up your research progress.
- Research chits can be recouped at 50% of their original cost.
- Costs rise with unit upgrades, generally by 10% per level of upgrade, though some like Anti-Submarine Warfare only cost 5% and others like Mobility cost 20% (30% for Germany).

9.2. IN DEPTH: THE RESEARCH MECHANISM
Now let’s look at this mechanism in more detail.

9.2.1. PROGRESSION EVERY TURN
At the end of each turn, each invested chit will advance your progress by a % towards the next level of research.

To achieve level 1 in a research category, the base % progress per chit per turn is 5% per turn.

The actual per turn increment will vary from 50% less to 50% more than the % above, with fractions being rounded down.

So, as an example, if you have 1 chit at 5% then you will have a 3 – 8% increment towards 100% per turn.

The more chits invested in a particular technology area, the faster you will progress towards the next level. So, if you have 2 chits if researching level 1 then you will have a 5 - 15% increment towards 100% per turn.

Each chit makes progress every turn from 0-100%, and once you reach 100% you will automatically achieve the next level in that category.

9.2.2. RESEARCH BREAKTHROUGHS
There is a chance every turn of achieving a Research Breakthrough that will speed your progress by an extra 15-25% that turn.

The chance of a breakthrough is based on the number of chits invested multiplied by the % chance of progressing per turn.

For example: once you have reached 45% towards level 1, 1 chit @ 5% gives you a 5% chance every turn that you might achieve a Research Breakthrough. For researching subsequent levels, 1 chit will give you a 5% chance of a Breakthrough per chit once the 45% threshold has been passed.
While there is some uncertainty about when your research will be successful, what is certain is that it will not be until the 45% threshold has been reached, and it will definitely occur once research has progressed to 100%. The mechanism is designed to give a blend of uncertainty and certainty, with no immediate success on investing the chit, but with ultimate success guaranteed after a period of time.

When a Breakthrough occurs, you will see a message at the end of your turn like these:

Scientists Report Advances In <research_name> Development
Espionage Advances <research_name> Development

9.2.3. CATCH UP BONUS

The research formula also has an adjustment that takes into account real life situations that occur in every war, such as studying captured enemy equipment and the results of spying and espionage.

Therefore, if a fully mobilized enemy Major has achieved a higher level than you in something you are researching, then a bonus will be applied to your progress every turn of 1% per difference in level. This bonus might be further modified by Research Sharing and Spying & Intelligence as described below.

9.2.4. RESEARCH SHARING

Friendly Major powers that are politically closely aligned can help each other through sharing their research. For instance, the UK’s research can benefit the USA, and vice versa, but not the USSR. The full list of relationships is as follows:

- UK shares with France, Poland, India and the USA.
- France shares with the UK, USA and Poland.
- The USA shares with the UK, France, China and India.
- The USSR shares with no one.
- China shares with no one.
- India shares with the UK.
- Poland shares with the UK and France.
- Germany and Italy both share with each other.
- Germany shares with Japan.
Japan shares with no one. To share progress, both Majors must be fully mobilized, and whichever is ahead assists the other(s) with a 1% boost per difference in level.

The effect of any boost from Research Sharing is cumulative to boosts from the Catch Up Bonus. Consequently, if both friendly and enemy forces are significantly ahead in a particular field, then both the Catch Up Bonus and Research Sharing should see your country’s research progress faster than in other circumstances.

9.2.5. SPYING & INTELLIGENCE

Each new level of Spying & Intelligence increases your own research by 1% per turn. However, this can be impacted if your opponent is also researching and achieving Spying & Intelligence levels of its own.

The impact can either be to decrease or to negate your research bonus entirely. Though note that only the intelligence levels of fully mobilized enemy Majors are taken into account.

For example, if the enemy’s intelligence level is higher than yours, then it will negate your own Spying & Intelligence. But if your intelligence level is higher than your enemy’s, your Spying & Intelligence bonus will be the difference between the two levels.

For example, if Germany has intelligence Level-1 and the UK has intelligence Level-2, then the UK’s research bonus will only be the difference of 1. Germany will receive no bonus in her own research as the UK has a higher level.

If both you and your enemy’s highest Spying & Intelligence levels are the same, then they simply cancel each other out until one or the other achieve a new higher level. Essentially Spying & Intelligence helps you if you are ahead of your opponent but not if you have the same or a lower level in it.

9.2.6. EXAMPLES

Our first example represents the research formula using just the Catch up Bonus.

- We have just one chit in Advanced Aircraft at Level 1 (where the normalized research formula means you have an average 5% progression per turn) and the enemy currently has Level 3, so the result will be:
Base Chance + (highest enemy level - current level) x research chits invested
5 + (3 - 1) x 1 chit = an average 7% progression per turn

- Let's now add the Research Sharing Bonus to the equation, where we assume that a friendly sharing Major has already achieved Level 4:

Base Chance + (highest enemy level – current level) + (highest friendly level - current level) x research chits invested
5 + (3 - 1) + (4 – 1) x 1 chit = 10% average progression per turn

- Let's continue with the examples from above and now include the *Spying & Intelligence* bonus. In this example we will assume that our *Spying & Intelligence* is 2 levels higher than our enemy's.

Base Chance + (highest enemy level - current level) + (highest friendly level - current level) + *Spying & Intelligence* modifier) x research chits invested
5 + (3 - 1) + (4 – 1) + 2 x 1 chit = 12% average progression per turn

If 2 chits were invested then progression would average out at an impressive 24% a turn!

### 9.3. Viewing Progress

To view your current research progress, hover your mouse over the relevant research field and the exact advancement % towards the next level will be shown.

The green bars show your progress at a glance:

### 9.4. Progressing to the Next Level

Research will advance a level once your progression reaches 100%.

While progression varies per turn, the chance of a breakthrough does not, as it is set to be the % for the relevant level, per turn per chit invested.
If you are ahead in *Spying & Intelligence* research then the chance of a breakthrough will be 1% higher per level that you are ahead.

So if you have 1 chit invested to research a level 1 technology at 5% a turn, then while progression will be 3 – 8% per turn if no other Major has yet researched that level. If we leave aside Spying & Intelligence research for the moment, then the chance of a breakthrough to speed up your research will be 5% a turn.

Once you attain the next research level, 1 invested chit is consumed by default and cannot be reinvested or redeemed.

**9.5. RESEARCH LIMITS**

While chits may vary in cost, the total maximum invested in Research cannot exceed the allowable MPP limit per Major.

If you change your mind about your investments, an invested chit may be redeemed at 50% of its original MPP cost. But in doing so you will lose any progress made.

If your research progresses to the highest possible level in a particular field, and you had more than 1 chit invested, you will need to manually redeem any remaining chits in that field.

Some modded campaigns might not follow the rule that consumes chits when research advances are made. If that were the case then the chits would remain invested in the given technology after you have successfully progressed to the next level.

**9.6. RESEARCH CATEGORIES**

The following section explains the benefits of each level of upgrade, firstly for Manual Upgrades, then for Automatic Upgrades. Manual Upgrades are effectively improvements in equipment and training, while Automatic Upgrades encompass a broader spectrum including improvements in communication, doctrine, military intelligence and social and economic mobilization for war.
9.7. Applying Manual Upgrades

To benefit from your research success in the Manual Upgrades category, you will need to apply the upgrades to individual units. To do this, right click on a unit and select Upgrade.

You can upgrade some or all of the potential upgrades available, providing the unit:
- Hasn’t carried out any actions this turn
- Is at a supply level of at least 5
- Isn’t adjacent to the enemy
- You have sufficient MPPs to cover the cost

Research levels greater than zero will be indicated on upgraded units with a small number on the bottom right of their counter as shown below:

---


9.8.1. Infantry Weapons

This research field covers a broad spectrum of improvements in small arms, support weapons such as mortars, anti-tank weaponry, artillery, and assault guns and armored cars attached to infantry units. It also takes into account the important advances that were made in communications within and between units and the huge impact these developments had on combat.

Each new level increases the Soft, Hard, Artillery, Strat. Artillery, Rocket, Light Armor and Tank Attack and Defense values for all Infantry and Cavalry units including Partisans, as well as for Pillboxes, Reconnaissance units and Armored Trains.
Tip! All Majors are advised to research this category as infantry are the main force in every army and improving their quality will be essential for success.

Production and Reinforcement cost increase per level: 10%.

9.8.2. Anti-Tank Weapons

Anti-Tank Weapons research encompasses towed and self-propelled anti-tank guns being equipped with heavier chassis, greater armor and better armored piercing weapons.

Each new level increases Anti-Tank unit’s Attack values against all ground units by 1. Their Defense values against ground units will also increase by 1 against Soft, Light Armor and Tank units, and 0.5 against Hard, Artillery and Strategic Artillery attacks.

Note: Only Germany, Italy, China, Japan, France, the UK, USA and USSR can produce dedicated Anti-Tank units.

Production and Reinforcement cost increase per level: 10%.

9.8.3. Advanced Tanks

Both the Axis and Allies put extensive research into developing new and improved tanks, bringing out models like the Sherman Firefly, the Cromwell, Panther, Tiger and T34-85 among many others.

Each new level of Advanced Tanks research increases the Soft, Hard and Tank Attack and Defense values for Light Tanks, Tanks and Heavy Tanks.

Research advances in this area are important for Germany’s early Blitzkrieg campaigns, so that they can result in quick and resounding successes. This area of research will continue to be important throughout the war, especially in Eastern Europe where German and Soviet armored units will undoubtedly wage frequent and bloody armored battles. In the Pacific it is of lower importance, but still useful all the same, particularly in India, Burma and the invasion of Japan.

Production and Reinforcement cost increase per level: 10%.

9.8.4. Advanced Fighters

Each new level of Advanced Fighters research improves the Air Attack and Air Defense values for Fighters and Carriers.
Gaining air superiority is a vital factor in winning the war, so researching this technology area is very important. Not only will high-level fighters will be a decisive factor in the air war, but an improved Fighter (CAP) component of Carriers will also be vital in the Pacific.

**Production and Reinforcement cost increase per level:** 10% for Fighters, 5% for Carriers and Escort Carriers.

### 9.8.5. Heavy Bombers

As the Second World War progressed, heavy bombers emerged as important instruments in the disruption of supply and the destruction of vital resources.

Bombers can inflict both immediate and long-term MPP losses on damaged or destroyed enemy resources, and a single Strategic Bomber unit supported by escorts can often keep several resources at low strength for an extended period.

Each new level of Heavy Bomber research improves the Resource Attack values for Strategic Bomber units. It also increases by 10% the chance of inflicting damage on a unit occupying a resource.

**Production and Reinforcement cost increase per level:** 10%.

### 9.8.6. Naval Weaponry

All navies experimented with various types of radar to improve the accuracy of their main armament for naval combat and shore bombardment. Armament was also improved and upgraded, especially on older ships that had been laid down earlier in the Century.

Each new level of Naval Weaponry research improves the Naval and Carrier Attack values, as well as their Naval Defense values, for all surface combat vessels and air units except Fighters and Escort Carriers.

It also increases the attack values of Carriers against all land targets by 0.5 per level, and by 10% the chance of a shore bombardment inflicting damage on a unit occupying a resource.

**Tip!** Researching this technology will help significantly in establishing naval superiority, especially in the Mediterranean and Pacific. Even in the Atlantic this technology will prove useful should the surface fleets of both sides meet in battle.
Production and Reinforcement cost increase per level: 5%.

9.8.7. **LONG RANGE AIRCRAFT**
An essential development throughout the war years, long-range aircraft provided an effective means of attack and defense on almost every front. Notably, long-range aircraft assisted the Allies in their bombing campaigns against Germany, while in the Pacific the US was able to bomb Japan in the later stages of the war.

Long-Range Aircraft research increases the Spotting, Action Points, and Strike Range values by +1 per level for most types of Aircraft and both types of Carriers. For Airships and Maritime Bombers the upgrades provide the same benefits except that their Naval Spotting ranges increase by +2 per level.

Additionally, each new level increases the Operational Range of Paratroops by 1 hex.

The Strike Range of Strategic Bombers will rise by 3 per level, and the Escort Range for Fighters will increase by 4 per level.

**Tip!** If you upgrade your Bombers be sure to upgrade your Fighters too, as otherwise they won’t be able to escort your Bombers, who will then suffer unnecessarily heavy casualties.

Researching this category will prove essential for everyone in the Pacific, for the UK and the USA in launching bombing raids against Germany, for Germany in conducting its own air offensives, and for the Allies in covering the Atlantic Gap so that they can defeat the U-Boat menace.

Paratroops and all air units, including Carriers and Escort Carriers, can be upgraded with *Long Range Aircraft*.

Production and Reinforcement cost increase per level: 5%.

9.8.8. **ADVANCED SUBS**
Each new level of *Advanced Subs* research improves the Naval Attack and Carrier Attack values for Subs, making them much more deadly in encounters with enemy naval units. It also increases their chance of surviving attack, as normally Subs have a 40% chance of successfully diving from either naval or air attack, but with each new research level this base percentage improves by 10%.
The UK’s economy relies on Convoys from all over the world, giving Germany plenty of opportunities to interdict these Convoy routes with their Subs. A dedicated U-Boat campaign, used in conjunction with other means of weakening the UK, such as bombing British industry and launching an offensive into Egypt and the Middle East, could effectively neutralize the UK’s potential to play an aggressive role in the war.

Japan also relies significantly on convoy routes, and so an Allied strategy to wage submarine warfare against them could help pave the way to ultimate victory.

**Production and Reinforcement cost increase per level:** 10%.

### 9.8.9. Artillery Weapons

This category represents improvements in accuracy, targeting methods and increases in the caliber of the guns.

Each level of Artillery research improves the Attack values for all types of Artillery units, Rail Guns and Coastal Guns against all non-naval target types.

Deploying specialized Heavy Artillery units and researching this category will be useful on the Eastern Front for bolstering defensive lines and also in preparing the way for attacking units to break through enemy lines when the time comes to launch a decisive offensive.

**Note:** Only Germany and the USSR can deploy Rocket Artillery units.

**Production and Reinforcement cost increase per level:** 10%.

### 9.8.10. Rocket Weapons

Only Germany can research this category and deploy Rocket units.

Each level of Rockets research improves the Resource Attack value and Strike Range values for all Rockets. It also increases the chance by 10% that a Rocket attack against a resource occupied by an enemy unit will inflict a hit on that defending unit.

However, Rocket units are unique in that their attack values decrease by one with increasing range.

For example, Level 1 Rockets have a Resource attack value of 2 at a range of 1 hex but only a Resource attack value of 1 at a range of 2 hexes. This decrease in effectiveness represents the inherent inaccuracy of Rockets at extended range.
Although it is expensive, a Rocket strategy could be useful for launching attacks on London or Allied controlled Ports on mainland Europe following an Allied landing there.

**Production and Reinforcement cost increase per level:** 10%.

### 9.8.11. Ground Attack Weapons

WWII saw significant advances in ground attack methods, both in the weapons used and also the communications equipment to call up and organize ground attacks.

Researching *Ground Attack Weapons* will simulate this as Tactical and Medium Bombers can be upgraded with *Ground Attack Weapons*. This increases their attack values against all targets apart from all types of naval units. The increments are by 1 per upgrade level.

*Ground Attack Weapons* will also increase upgraded air units' Anti-Aircraft Defense values by 0.5 per upgrade level, so reaching level 2 will be required to have any effect as fractional increments are rounded down.

De-Entrenchment values will also rise by 0.5 per level, so units with level 2 will be better at softening up an enemy target prior to a ground assault.

**Production and Reinforcement cost increase per level:** 10%.

### 9.8.12. Mobility

The development of wheeled and tracked support vehicles greatly improved the mobility of combat units during the Second World War. The primary impetus was to allow the infantry to keep pace with the fast-moving tanks, to provide them with support and also enhance their strategic reach.

*Mobility* represents increasing the mobility of units through reducing their reliance on horse drawn transport and marching on foot, and increasing the proportion of motor vehicles allotted to units in their place. It also signifies improving the mobility of the logistical support supplying the upgraded unit, in order to increase its strategic versatility.

Additionally, *Mobility* represents the doctrinal and command mechanisms required for flexibility in the field, as shown by the great successes the German army had in the early war period in outmaneuvering their slower moving and reacting opponents.
Each new level of Mobility research increases the Action Points of HQs, all infantry units (except Garrisons), Special Forces, Engineers, Anti-Aircraft, all types of Artillery, and all Armored unit types. 

**Production and Reinforcement cost increase per level:** 20% (Germany: 30%).

### 9.8.13. **Anti-Submarine Warfare**

Anti-Submarine Warfare (ASW) developments were essential in defending ships from Submarine attack, as well as for Submarine detection and destruction.

ASW research improves the Sub Attack and Sub Defense values of Maritime Bombers, and for all types of surface naval combat units apart from Battleships, who only benefit from improvements in their Sub Defense values.

Each new level of ASW reduces an attacked Sub’s current dive percentage by 10%, while an extra benefit is that it also reduces the MPP loss that convoys suffer from raiders.

Just as Germany will benefit from investing in Advanced Submarines, so the UK and USA will benefit greatly from researching Anti-Submarine Warfare. Otherwise a U-Boat campaign in the Atlantic could cripple the UK’s economy.

Japan is also recommended to invest in this in the event that the Allies start raiding her convoys.

**Production and Reinforcement cost increase per level:** 5%.

**Note:** Upgrade limits on units can vary according to unit type.


This research area provides increased defense from air attacks, through the development of more accurate and effective anti-aircraft guns and their supporting elements.

All ground units apart from Partisans can be upgraded with Anti-Aircraft Defense, as can all naval combat units apart from Carriers and Escort Carriers.

Every new level improves all upgraded units and resources’ defense values against air attack. It also improves the Air Attack Values of Anti-Aircraft Units.
If resources are upgraded with *Anti-Aircraft Defense* then it will help protect them from Strategic Bombers, but it will not help protect any units occupying the attacked resources should they be struck too.

This technology is often a relatively inexpensive way to counter enemy air superiority. The Allies have the greatest potential to carry out a strategic bombing campaign, as US and British bombers stationed in the UK can pave the way for a successful D-Day by striking German targets in France, the Low Countries, and Germany’s industrial heartland in the Ruhr.

Japan will find this useful when building up her island defenses to resist the Allied counter-attack.

Resources must be individually upgraded at a cost of 10 MPPs per level per resource. Increasing the levels of *Anti-Aircraft Defense* on resources does not otherwise increase any production or reinforcement costs.

**Note:** Due to the nature of the hex owner/controller relationship when Minor countries may claim territory for Majors, *Anti-Aircraft Defense* research is presumed to be a shared technology between a parent Major and its controlled Minors. For instance, the UK could upgrade Cairo in Egypt. Also, captured resources may be upgraded, so Germany can upgrade French Towns and Cities after the fall of France.

While all other units only improve their defensive capabilities against air attack if upgraded, Anti-Aircraft units will also improve their attack values against all air units including carriers. This means that if defending themselves or adjacent targets, anti-aircraft units will tend to inflict higher losses on attacking air units.

**Note:** Although resources can be upgraded with *Anti-Aircraft Defense* up to level 5, upgrade limits on units are significantly lower. **Production and Reinforcement cost increase per level:** 10%.

### 9.9. Automatic Upgrades

Unlike with Manual Upgrades and as the name implies, Majors automatically benefit from success in the Automatic Upgrades research fields. No manual intervention is necessary to apply upgrades, and these categories do not increase any production or reinforcement costs.
9.9.1. Command and Control
This represents improvements in overall military doctrine, command structures, communications and generalship. As such, this is an important research area because an opponent at a significantly higher level will tend to win engagements at much less cost.
If researched this increases the following by 1 per level:
- The number of units their HQs can command
- Their HQ’s command range
- Their HQ’s command rating
- Their APs by 0.5 per level.

9.9.2. Infantry Warfare
Representing investment in training, tactical innovations and doctrine, this category improves the Unit Morale of all Infantry and Cavalry units except Partisans by 10% per level.
This will improve their overall effectiveness in combat, and will be most effective if combined with improved weaponry and your supporting HQs benefiting from Command and Control.

9.9.3. Armored Warfare
The Second World War saw the unprecedented use of large scale armored formations at the strategic level, playing a leading role in Germany’s early victories as they attempted to carve a new empire throughout Europe.
This research category represents armored doctrine, vehicle communications, tactical innovations and training.
This research category improves the Unit Morale of all Mechanized, Reconnaissance, Light Tanks, Tanks and Heavy Tanks by 10% per level.
Important! This research field enables Tanks, Heavy Tanks and Mechanized units to launch 2 Strikes rather than 1.

9.9.4. Aerial Warfare
Representing training, aerial tactics and communications, this category improves the Unit Morale of all air units, except for Airships, by 10% per level.
It improves the unit morale of Carriers and Escort Carriers by only 5% per level, because they also benefit from 5% per level of Naval Warfare research.

**Important!** This research field enables Fighters to launch 2 intercepts or escort missions and for Strategic Bombers to be able to launch 2 Strikes when level 1 is attained.

### 9.9.5. Naval Warfare

Representing good training and strong naval traditions like the British Royal Navy’s, this research improves the unit morale of all naval units by 10% per level.

It improves the unit morale of Carriers and Escort Carriers by 5% per level, as they also benefit from 5% per level of Aerial Warfare research.

Apart from Carriers and Escort Carriers, Naval Warfare also increases all naval unit’s chance of Loss Evasion when attacking by 5% per level.

It will therefore assist in winning naval actions, and where both sides are otherwise fairly evenly matched, this research field could help swing things your way, or be the difference between a ship surviving an action and being sunk.

### 9.9.6. Amphibious Warfare

This is a very important area of research for any country planning amphibious assaults, and in particular for the UK and USA, as both will have to launch at least one amphibious invasion. It would also be wise for Germany to invest in this very early in the war if they plan to invade the UK.

Researching Amphibious Warfare technology will increase the Attack Values, Action Points and Build Limits of both types of Amphibious Transports. Most Build Limits increase by 1 per level, but Japan’s increases by 3.

Amphibious Transports cannot move on the turn the unit embarks unless level 1 in Amphibious Warfare has been reached.

Researching this will also provide your Amphibious units with some limited improvements in defense if attacked by aircraft, or if attacked while in port by Soft and Hard unit types. It will also increase by 10% per level their chance of evading damage when attacked by enemy naval units.
One final benefit from this research is that each level will improve both types of Amphibious Transport’s morale by 5%. Coupled with the other benefits, this will mean that a high level of research will significantly improve the chances of a successful attack by an Amphibious Transport prior to the unit it is carrying hitting the beach.

9.9.7. Spying & Intelligence

Intelligence operations during the Second World War consisted of a broad spectrum of information-gathering activities that included espionage, sabotage and counter-intelligence.

From the brave wireless operators operating in occupied Europe to the skilled mathematicians at Bletchley Park, this technology encompasses vital war work that helped commanders to plan operations and ensure victory.

Gaining information on enemy deployments will assist in planning your own offensives or counter attacks, so all Majors will benefit from this area of research.

Spying & Intelligence can reveal enemy units on the map with a 1% chance per unit per level, with a limit of 5 units per turn being revealed. So when a Major has level 2 it will have a 2% chance per turn of spotting each hidden enemy unit. This can be especially useful in naval warfare where knowing the location of the enemy’s fleet could make all the difference between victory and defeat.

Each new level of Spying & Intelligence research increases your own research bonus by 1% and decreases your opponent’s bonus by 1%.

Spying & Intelligence levels only compete with each other, so if the enemy have higher intelligence than you, the only net effect will be to negate the benefit you’ll get from your own intelligence level. It won’t prevent or slow the base research % chance per turn.

Only the highest Spying & Intelligence level belonging to a fully mobilized enemy Major is taken into account, and compared with your own Major’s level. Friendly Majors’ levels do not assist in this respect.

Spying & Intelligence will also increase the chance of a research breakthrough, so there is a lot to be gained from researching this category.
9.9.8. Logistics
This technology represents improvements in infrastructure for the rapid deployment and redeployment of forces, as well as for their supply and reinforcement.

Each new level of **Logistics** research reduces Operational Movement and regular Transport costs by 10%.

**Logistics** also increases by 1 per level HQ’s minimum supply values, the HQ Build Limit for all Majors, and the Build Limits for regular Transports for Majors and their Minors.

9.9.9. Production Technology
Advances in any of the Manual Upgrades research areas result in cumulative increases in production and reinforcement costs for upgraded units. High technology areas such as aircraft and Heavy Tanks – units that consume vast quantities of oil and minerals – will necessarily incur higher costs. Thus, to offset these additional costs, developing **Production Technology** will not only improve a country’s industrial capacity but also the efficient use of raw materials.

Each new level of **Production Technology** research decreases unit costs and the cost of Manual Upgrades by 5%.

If you are playing with Soft Build Limits enabled, Soft Build Limit penalties are still applied where applicable, but only after the calculation of the final unit cost minus any reduction due to **Production Technology**.

9.9.10. Industrial Technology
Mobilization for war and the transformation of economies to a war footing took time, and this research category represents Majors mobilizing their resources to support the war effort.

The initial Industrial Modifiers at the start of the war do vary, representing different factors such as their economic power, their self sufficiency, and their relative preparation for war.

The **Industrial Technology** increments for the UK, China, India, Japan, France, Poland and Italy are 10% per research level, Germany’s and the USSR’s are 15% and the USA’s, due to its greater capacity to expand, is 20% per level.
For neutral, inactive Majors, the Industrial Modifier is linked to its Mobilization Value, which means the full value of the Industrial Modifier is not effective until the country is activated and at war.

**Example:** The USSR with a base Industrial Modifier of 50% and a Mobilization Value of 50% would have an effective Industrial Modifier of 25%.

### 9.9.11. Automatic Industrial Mobilization

This is not a research category, but a game feature that you will see in play in some campaigns where countries can have Resources that aren’t producing for their respective war efforts at the start of the war, but that will enter into production as their respective countries increase their military production. These will show a strength value of zero.

For example, in the USA, all non-producing resources start switching to military production as soon as they enter the war.

For the USSR, should the Axis invade the Ukraine then the USSR will have the opportunity to move much of its industry from there to safer locations in the Urals.

### 10. Politics and Diplomacy

#### 10.1. Alignment Status & Mobilization Values

All countries have an Alignment Status of either Axis, Axis Minor, Allied, Allied Minor or Neutral.

All countries that are neither fully mobilized nor totally neutral at the start of a campaign will have a Mobilization Value showing as a %, as well as an indication of whether they favor the Axis or Allies.

For neutral Majors, the higher their Mobilization Value the higher their income. So countries like Italy, the USA and USSR will see their income rise as their Mobilization Values increase as they move towards entering the war. This enables them to step up their preparations for war, so they can invest in key research areas or important units.
Note that Majors cannot switch sides, so for instance, the Axis could only hope to reduce the USA's pro-Allied Mobilization value. They will never be able to sway the USA into siding with the Axis.

10.1.1. Non-Cooperative Majors
Both China and the USSR will provide supply to units belonging to other Allies that might enter their territory. However, other Allied units cannot operate into or out of their territories, nor can Chinese or Soviet forces operate into or out of western Allied territories.

Japan is a non-cooperative Axis power, which means not only that its Axis allies won't be able to operate into its territories, but they will receive a maximum supply of 3 from Japanese resources.

10.1.2. Minor Combatants
Scripted events will trigger changes in the Mobilization Values for Minors. For example, Spain is a neutral but pro-Axis Minor, and it will respond favorably to German successes in France and the Mediterranean. These successes alone won't be sufficient to make them enter the war, and for that diplomacy will be required.

10.2. The Diplomatic Mechanism
The diplomatic mechanism gives each side the opportunity to influence neutral countries into joining their side.

Each fully mobilized Major can invest a limited number of chits in Diplomacy. Diplomacy chits represent political efforts as well as the promise of trade, military equipment, and economic packages that were often used to influence neutrals. The number of chits is limited to reflect the historical difficulties in bringing neutrals into the war.

The cost of Diplomacy chits depends on the neutral being targeted, with diplomacy targeted at Majors being more expensive due to the greater value of bringing them into the war on your side. The maximum diplomatic investment (i.e. the number of chits) cannot exceed the allowable limit that each Major can purchase.
Each country has a Mobilization Value that reflects their current political leaning towards a particular side. It is generally best to focus your diplomatic efforts on countries that are already leaning towards your side, instead of investing in countries that had little or no sympathy with your side. For instance, the Axis have more chance of enticing Sweden than Greece to enter the war.

Diplomacy can be used to try to delay or prevent an enemy Minor from entering the war, and there will be times when this is a good thing to do.

If your diplomatic strategy is focused on a particular country, with all your Majors investing to the maximum, then success will be more likely and the MPP investment will more likely be worth the economic cost.

Once a diplomacy chit has been purchased and assigned to a country, in each successive turn there will be a random chance of an increase in its Mobilization Value towards your side. If you have more chits assigned, there is a greater chance of success.

The chance per turn for diplomatic influence will be 5% (7% for the USA’s diplomatic efforts) multiplied by the number of diplomacy chits assigned to the target country.

If diplomacy succeeds, there will be a favorable increase of 4-8% in the targeted country’s political leaning towards your side, with a 33% chance of that swing being 12-24% if the targeted country is a Minor.

If a Minor country’s Mobilization Level drops below 0%, then its Political Alignment will switch to the other side. It will now have a Mobilization Level towards that side. Note that the Mobilization Level of a Major country may not drop below 0% and its Political Alignment cannot change.

Once you achieve a diplomatic success, your invested chits are consumed and the targeted country will move towards your side. At this point the successful Major will now be able to repurchase and invest that chit, either in the same country if it is still neutral, or in another one.

Unlike Research, you cannot reclaim an invested diplomacy chit to regain the MPPs spent. Once a diplomatic investment is made, the MPPs have been invested in that country and while the chit can be reclaimed and therefore freed up for use elsewhere, the MPPs cannot be.
Note: Due to the flexibility available in the game engine, it is possible that some modded campaigns may allow chits to remain invested in a target country after a success is achieved.

10.3. Contested Diplomacy
At the same time as you are investing in diplomacy, your opponent could also be purchasing diplomacy chits to influence the same country. In this event, the difference between the cumulative friendly diplomatic pressure and the cumulative enemy diplomatic pressure will determine the % chance for a diplomatic result.

This allows for counter-diplomacy as well as for more interesting and occasionally surprising diplomatic results under Fog of War whereby the target of the enemies’ diplomacy remains unknown. Therefore diplomacy and counter-diplomacy will have a realistic feel, sometimes frustrating and sometimes exhilarating.

Standard political events (i.e. random political triggers and war readiness factors) may also change Mobilization Values. These will represent historical situations, the result of Decision Events, or be the result of successful offensives that can inspire neutrals to reconsider their position. For instance, the fall of France will move Spain towards the Axis, as would the taking of London.

10.4. Impending War Entry
Once a country’s Mobilization Value reaches 90% there is a random automatic boost of 1-5% per turn, and this will continue until the Mobilization Value reaches 100%.

10.5. Belligerence
Each Major has a Belligerence setting that is separate to its mobilization setting, which means that it can be fully mobilized, i.e. at 100% mobilization, but not necessarily at war with any other country. A Major country that is
fully mobilized can move its units, declare war, invest in diplomacy etc, even if it is not actually at war with anyone.

So in a global campaign encompassing the whole of WWII, this would enable Japan to be at peace with the USSR, while being at war with the UK, USA and China.

The Belligerence settings enable you to decide which of the Majors under your control will declare war, so that Germany can declare war on the USSR, while Italy may choose not to do so.

Fully mobilized Minor countries will follow the belligerence settings of their Majors. For example, if the UK is at 100% mobilization, natural allies like Canada will automatically enter the war when their own mobilization reaches 100%.

Similarly aligned and fully mobilized Majors can only enter each other’s territory if they share a common belligerent. Consequently British units cannot enter the USSR unless the UK and USSR are both at war with at least one of the Axis powers. Nor would Soviet units be able to enter the territory of British Minors in this instance, because fully mobilized Minors follow the same belligerence settings as their Majors.

One point to note is that units cannot attack an enemy from a non-belligerent hex, i.e. Germany cannot attack British units in Egypt from an Italian controlled Libya if Italy is not yet at war with the UK.

10.6. The Wider Impact of Declarations of War

The Mobilization Value of neutral Majors and the timing of their eventual war entry can be greatly affected not only by diplomacy but also by either side’s declarations of war against other neutrals.

For instance, Axis declarations of war will automatically increase the USA’s Mobilization Value. Some declarations will be necessary, but an overly aggressive strategy of invading many more countries than the Axis attacked historically could result in the USA and USSR entering the war significantly earlier than expected.

The same works in reverse, so if the Allies were to invade countries like Belgium or Ireland then they could seriously delay the USA’s entrance into the war.
Attacking a neutral Minor will not necessarily bring you into conflict with its assigned Major, unless that Major is already close to full Mobilization. Though nearby Minors may react to aggression against their neighbors by swinging towards the other side.

US declarations of war against Central and South American countries, Allied declarations of war on Ireland, Axis declarations of war against Spain, or anyone’s declarations of war against Switzerland will trigger National Morale penalties to the aggressor.
PART 2: DESIGNING YOUR OWN CAMPAIGNS

“There are three essential factors in all human activity: spirit, materials, and action.”

Chiang Kai-shek, Chairman of the Nationalist Government of China.

1. INTRODUCTION
While we hope that the campaigns that come with Strategic Command provide you with hours of entertainment, this game also comes with an Editor that you can use to massively increase your enjoyment of this game.

It is very easy to amend the default campaigns if you wish to change some of their details or to test out different scenarios, and it’s also very easy to design new campaigns from scratch.

This Editor is no different from the one used to design the default campaigns, so you have all the tools at your fingertips for designing good quality campaigns, of course within the confines of the overall game engine.

This guide will talk you through all the Editor’s features, and if you get stuck at all then please don’t hesitate to post your question on our discussion forum at Matrix Games.

1.1. First things First
The contents of this Manual includes details on how to use literally everything in the Editor, from designing a map through deploying units to
sitting back and watching the AI play out both sides in a play-test of your campaign.

But before you get started with this Manual, the best thing to do is to open up the Editor, open a default campaign, and just try out all the functions you can see in the top rows.

Playing with these to see what they do is the quickest way to get a feel for the Editor, for what it can do and just how easy it is to do many things. Use this Manual as a guide to specific things, but you’ll probably find that within a very short period of time you’ll have learned far more than if you’d just sat back and read the Manual.

Above all, have fun while you try things out, and don’t worry about what things might do. The good thing is that if you are trying things out with a default campaign then you cannot save any of your changes over it. If you do want to save them, you will have to go to File and Save As, and rename the campaign as something else, e.g. Test Campaign.

Once you’ve familiarized yourself a bit through practicing with the Editor, use the following Manual and let it guide you through everything in more detail so that you too can start creating wonderful campaigns for either your own amusement, or for other players to enjoy too!

1.2. USING THE EDITOR
Welcome to our guide on how to use the Editor. Using this you can use it to amend the existing campaigns or create new ones from scratch!

This guide is written on the assumption that you have at least a basic understanding of how the game works, though if you come across anything you don’t understand please either consult the main Game Manual, or post on our forums at Matrix Games.

1.2.1. EDITOR HELP FILE
Pressing F1 opens this document, so you can easily access it from within the Editor.
1.2.2. THE INFORMATION PANEL
At the bottom of the screen is the Editor’s Information Panel which will display different information as you work on a campaign.

Keep an eye on this panel as it is a useful tool because the information it shows will vary in accordance with the selection type you are working on.

For example, if you are adding units to the map then information relevant to the units will show here, whereas if you are editing terrain then it will show the terrain types instead.

The middle of the Information Panel will always show the X-Y coordinates of the hex your mouse is currently hovering over, as well as whether it is a Land, Sea or Land-Sea hex.

2. MENU BUTTONS
Before we proceed further, here is a guide to the Menu Buttons that are available in the Editor once you have a campaign file open, or are creating a new one.

2.1. FILE

2.1.1. FILE → CREATING A NEW CAMPAIGN
Once the Campaign Editor has fully loaded, a new campaign may be created by selecting File → New from the Main Menu bar at the top left of the screen. This will create a blank campaign template. Use the scroll to set the map size. This can be from a minimum of 10 x 10 to a maximum of 512 x 256 hexes.

By default the new campaign will be created with all hexes filled with sea, and in 9. Menu Buttons - Second Row we will look at using the Map commands to change these hexes so that you can design your own campaign.

2.1.2. FILE → OPEN DEFAULT CAMPAIGN
To open a default campaign, select File → Open Default Campaign from the Main Menu bar.
You may open the original campaigns that come with Strategic Command this way, to either view them or to create your own mods from these. If you do make any changes to any of these default campaigns you will need to save your version with a new name, as the original campaigns are protected.

2.1.3. File → Open User Campaign
To open any campaigns that you have created or amended, or any user made campaigns that you have downloaded, select File → Open User Campaign from the Main Menu bar.

These campaigns are stored in a different place to the default campaigns, and any new campaigns you create will be saved here.

Tip: From the Open dialog, it is also possible to right click on a *.cgn file in the Campaigns directory to delete or rename it.

2.1.4. File → Saving A Campaign
There are two options to saving a campaign, either File → Save or File → Save As.

Using Save will save the campaign with the current file name, while Save As allows you to rename the current campaign prior to saving it as a *.cgn file in the Campaigns directory. Using Save As will also save copies of any custom files relating to the campaign into the newly named campaign's folder within the game's Campaigns folder.

If when using Save As you select a pre-existing campaign's file name to save the files to, then a warning message will prompt you to confirm that you wish to overwrite the Event scripts for that campaign.

You cannot save over a default campaign, instead you will have to use Save As and give it a new name.

2.1.5. File → Import Data
Once a new campaign is created, or with an existing campaign open, the File → Import Data command allows you to import data extracted from a different campaign (see the next item for how to export data).

After clicking on Import Data there will be a Warning Message to check that you wish to proceed.
If you select Yes to continue, you will now need to choose the folder where the data to be imported is kept, then press OK.

You can now select to import any or all items from a previous campaign for use in the campaign that you have open at the moment. The browser will default to the game’s Data directory and you will have to choose the sub-directory containing the desired Data files.

To import any data from the Map Layers, the imported map size must match the current map size. If they don’t match then a warning message will advise you of the discrepancy, and you will have to adjust the current map size before importing.

![Error: Imported map size [40,40] does not match current map size [50,50]. Please adjust current map size before importing.]

**Caution:** The import feature will overwrite the current campaign’s data with that contained in the imported *.dat files, so only import if you are 100% sure or have a backup just in case.

### 2.1.6. File → Export Data

Using the **File → Export Data** command allows you to save the current Map Layers, Country Data, and General Data as *.dat files onto your computer.

The Editor will prompt you to select a folder to export the data to, and if you haven’t already done so, it will be best to create a new folder specifically for this data in an easily accessible location.

Select the folder and press OK.

You will now be presented with a Dialog box listing all the different types of data to be exported. You can select as much or as little as you wish, and there is a **Select All** button in the bottom right for use if you wish to export all the campaign’s data. Click OK once you’ve chosen, and
*.dat files will now appear in that folder containing the information that you have exported.

This Export Data function can be very useful as exporting Data files will enable you to import some or all of them into another campaign. For instance, you might be interested in re-using the map of an official campaign for your own totally different campaign. Using this feature you can import as much or as little as you like!

Note: Individual data files are NOT saved when the Save or Save As commands are used; only the *.cgn campaign file and any amended scripts will be saved using these.

Note: The default Data directory for all export information will be a new sub-directory with the name of the current campaign (e.g., \Data\1939 World at War). From the Browse for Folder dialog that opens when you select Export Data, you will be able to choose another export folder or make a new folder if you would rather.

2.1.7. File → Export Map Positions (F6)

This is useful for script work where you want to use the co-ordinates of multiple locations when writing Event scripts.

To execute this feature, click on Map and tick both Edit Hex Layer and Select Item(s). Now select your chosen map positions and then either press F6 or click on File and select Export Map Positions. This will generate a text file called map_positions.txt in the main Strategic Command directory pertaining to the game in question.

You can then cut and paste the generated #MAP_POSITION text into the appropriate script event, though you might have to rename the control ‘#’ entry to the appropriate name for some scripts.

By default you can only select the hexes of one country at a time. However, if you want to select hexes belonging to more than one country at the same time, simply hold down both your left mouse button and the Shift button, as this will enable you to select hexes irrespective of their ownership.

Note: Once you have used this feature, the .txt file that it creates will be added to every time you use this function, so you may want to either delete the contents of the file or the file itself once you’ve used the exported data.
2.1.8. **FILE → EXPORT DATES (F7)**
This allows you to export the campaign’s dates into a text file, where you will be able to see on which date it will be an Allied or Axis turn. This can be of use when scripting to ensure that events happen when you would like them to.

2.1.9. **FILE → EXIT**
When you have finished your work for the time being, the **File → Exit** command will close the Editor.

**Note:** Before closing the file, a warning message will prompt you to save the current campaign if you have made any changes since it was opened or last saved.

2.2. **EDIT**

2.2.1. **EDIT → UNDO**
Undo the previous action(s). Up to 10 of the previous actions can be undone.

**Ctrl-Z** will Undo the action via the keyboard.

2.2.2. **EDIT → REDO**
Redo the previous action.

**Ctrl-Y** will Redo the action via the keyboard.

2.2.3. **EDIT → LOCK AND UNLOCK SCROLL**
This Locks the map view in the current position, though if unlocked you can scroll the map using either the mouse cursor or arrow keys.

**Tip!** Locking the map view is very useful when drawing or editing a new map and you are constantly selecting sprites from the sprite library on the right. This prevents the map from shifting whenever you move the mouse cursor too far in any direction.

2.2.4. **EDIT → CHANGE VIDEO MODE (F3)**
Select one of the choices of screen resolution.
The Editor will remember the last opened position on your screen, so if for example you had it open in the top left of your screen, then the next time you open it it will open up in the same place.

2.2.5. **EDIT → REFRESH FONTs (F4)**

If you load customized fonts into this game's Fonts folder while a campaign is open, then pressing F4 to refresh Fonts will show the new fonts when accessing the Text Layer.

2.2.6. **EDIT → REFRESH BITMAPS (F5)**

This refreshes the Bitmaps for this campaign, so if they have been edited since you opened the campaign and have saved changes to them, the Editor will now show them with the latest changes.

**Tip!** This is a very useful tool if you are customizing any of the image files in the game. Once an image has been modified, using Refresh Bitmaps or pressing F5 on your keyboard will automatically reload all the images in the Editor so that you can immediately see your amended image files without having to close and reopen the Editor.

2.3. **MAP**

2.3.1. **GENERAL MAP DRAWING TIPS**

2.3.1.1. **OFFSETS**

Offsets enable you to fine tune the exact position of items on the map, allowing you to move them by up to 25 pixels along both the X and Y axis.

To use Offsets, select the Layer relevant to the Hex you wish to adjust, e.g. Terrain Layer, click on Select Item(s), and right click on the Hex in question. Select the **Offsets** option and click on the X and Y scroll buttons to move the item in question until you are happy with its new position. Click OK when done.
2.3.1.2. Selecting Hexes in the Hex Layer
If you left click and drag with the mouse, you will only select hexes belonging to the same country as that of the first selected hex. For this selection type, Land/Sea hexes and all Coastal hexes are treated as Land hexes.

If you left click and drag the mouse while holding down Ctrl, you will select Land hexes en masse, but they will only be hexes belonging to the same country as that of the first selected hex. For this selection type, Land/Sea hexes and all Coastal hexes are treated as Land hexes.

If you left click and drag the mouse while holding down Shift, you will select any hex, Land and/or Sea, irrespective of their nationality.

If you left click and drag the mouse while holding down Alt, you will only select Sea hexes. For this selection type, Land/Sea hexes, and all Coastal hexes, are treated as Sea hexes.

If you left click and drag the mouse while holding down both Shift and Ctrl keys, you will select hexes en masse of any type, whether Land or Sea, irrespective of their nationality.

If you left click and drag the mouse while holding down both Alt and Ctrl, you will select Sea hexes en masse. For this selection type, Land/Sea hexes and all Coastal hexes are treated as Sea hexes.

2.3.1.3. Drawing/Selecting in all other Layers
Left clicking and dragging with the mouse will select valid game objects belonging to the currently selected layer.

Left clicking and dragging with the mouse while holding Ctrl will select en masse valid game objects belonging to the currently selected layer.

2.3.1.4. Right Clicking to Select Items
While you are in Draw mode, right clicking on a hex will select that hex’s sprite as the current drawing sprite. It will also bring that sprite to the top of the sprite list on the right hand side of the Editor.

2.3.1.5. The + and – Keys
While you are in Draw mode, if you hover the mouse over a hex and press + or – on your keyboard then you can scroll respectively up or down the selected sprite type. For example if you have the Hex Layer selected it will
scroll through that layer. As you scroll, providing your mouse is hovering over the hex, the sprites will immediately show on the map and you can then select the one that you prefer.

2.3.2. **MAP → EDIT HEX LAYER**

Here you can add and edit Sea, Land and Coastal hexes on the map. Coastal hexes count as either Land or Sea, depending on the proportion of each in the hex, and there are also some hexes with both attributes called Land/Sea hexes. These act as land bridges between land masses, e.g. the Suez Canal or the Bosphorus Strait.

New Land hexes will automatically be aligned to the country that is marked as Major Country Number 1. See the section on *Edit Major Country IDs Data* on how to change this.

Land hexes drawn over the top of pre-existing Land hexes will automatically have the same country and ownership as the Land hexes that were already there.

**Tip!** One technique for drawing a new map is to take a picture of the map you want, decide on an appropriate scale and overlay a hex grid. From this you can gain a rough idea of the content needed for each hex, i.e. where to put coasts, resources etc.

2.3.3. **MAP → EDIT TERRAIN LAYER**

Add and edit forests, mountains, marshes and depressions on the map.

2.3.3.1. **DRAWING DESERT HEXES**

When drawing Desert hexes in the Terrain Layer, image numbers 531, 532, 539 and 540 are set as full Desert hex sprites. If you select to draw with one of them, hold down Ctrl and as you drag and draw with the mouse, the Editor will automatically select randomly between the four to draw on the map.

This makes things easier when drawing a large desert area as the engine will automatically introduce randomness into the terrain layer. By releasing the Ctrl key you can then fine tune the actual desert hexes to suit your design.
2.3.4. Map → Edit River Layer
Add and edit Rivers and Major Rivers on the map, including river mouths and tributaries.

Rivers can be very quickly added to the map once you have selected Edit River Layer by selecting a river sprite from the Selection Column on the right hand side by left clicking on it.

Now draw a river by left clicking on the map and moving the mouse with the left mouse button held down. This will draw the river's path. It isn't likely to produce a 100% perfect river at the first attempt, especially not if the river doubles back on itself, but drawing whole sections of river directly onto the map, rather than on a hex by hex basis, can be done very quickly with edits being made afterwards.

If you want to change a River on the map to a Major River, or vice versa, this can easily be done by doing the following:

Right click on a normal River sprite on the map, then right click again and the Selection Column will select the matching Major River sprite.

You can now draw this Major River by left clicking on the map, either overtop of the normal River sprite or elsewhere.

You can then repeat the above steps for any other River sprites that you'd like to change to Major Rivers.

This process can also be used in reverse to change Major Rivers into Rivers.

With stage 1, each right click is alternating between both types, so right clicking for a second time on the same spot will go back to the regular River sprite.

2.3.5. Map → Edit Road Layer
Add and edit Roads and Dirt Roads on the map, including their junctions.
Roads can be very quickly added to the map by selecting a road sprite from the Selection Column on the right hand side by left clicking on it. Now draw the road by left clicking on the map and moving the mouse with the left mouse button held down. You can edit the road, adding or amending junctions afterwards.
2.3.6. **MAP → Edit Rail Layer**
Add and edit Rails on the map, including junctions.
Railways can be very quickly added to the map by selecting a rail sprite from the Selection Column on the right hand side by left clicking on it. Now draw the railway by left clicking on the map and moving the mouse with the left mouse button held down to draw its path. You can edit the rail network, adding or amending junctions afterwards.

2.3.7. **MAP → Edit Resource Layer**
Different sprites are included for the Western, Eastern, Mediterranean, Middle Eastern and Desert regions.
**Note:** You cannot add additional Capitals to a country that already has a Capital.
**Tip!** To see what strength resources will have at the start of a game based on their connections to Key Resources, saving the campaign will recalculate their strengths afresh. Simply select the ‘Resource’ layer and when you pass over a resource, the info in the bottom information bar will show the resource strength in brackets next to the name.

2.3.8. **MAP → Edit Symbol Layer**
Add and edit symbols on the map.
These can be used for naval and land Loops, for showing raiding areas, or for denoting other information as you see fit.

2.3.9. **MAP → Edit Text Layer**
Add and edit text on the map.
This is used for the names of resources, geographical areas and other features.

2.3.10. **MAP → Edit Unit Layer**
Add and edit land, air and naval units on the map.
**Note:** To add units that will start the game in an Amphibious Transport or regular Transport, first place the new unit on land. Then right click on it,
select ‘Move’ and left click on a sea hex and it will give you the opportunity to place it as either type of Amphibious Transport or as a regular Transport.

### 2.3.11. MAP → Edit Weather Layer
Add and edit Weather Zones on the map. Select the hexes that you wish to assign to a Weather Zone and right click. This will allow you to set the Weather Zone for these hexes.

With the addition of Weather Zones, if you set an area to be an Arid, Semi-Arid, or Frozen zone then the look of the terrain will dynamically adjust to the new Weather Zone.

See *Edit Weather Data* for additional details on setting Weather Zones for the campaign.

### 2.3.12. MAP → Edit Map Size
Adjust the map’s size by amending its X and Y axis dimensions. Changing the X axis value will change the right boundary, while changing the Y axis value will change the map’s bottom boundary.

**Note:** Any reduction in map size will result in permanent data loss along the reduced axis, so be sure that this is really what you want to do before proceeding.

### 2.3.13. MAP → Shift Contents
Using this you can shift map contents to either the left or right, or up or down. Only one horizontal or vertical shift may be made per action.

Decide whether you wish to move the map vertically or horizontally and then manipulate the second or third rows of up/down buttons in accordance with whether you wish to move the left or right hand column if moving horizontally, or the top or bottom if moving vertically.

The first row represents the number of columns or rows that a map section is being shifted. The second and third rows represent the start and end column/row numbers of the map section to be shifted.

**Tip!** Practice in a copy of your campaign before amending the original.

**Note:** Shifting contents will result in permanent data loss from the hexes along the X or Y axis at the new location.
2.3.14. Editing Layers
The three sections that follow all relate to editing the various layers on the map.
There are ten different layers, and selecting the correct layer before proceeding is important as otherwise you may find yourself editing the wrong layer.

The different layers are shown here, as they appear in the second row at the top of the Editor. They can be chosen simply by left clicking on the one you want.

In order, the layers are:
- Hex
- Terrain
- River
- Road
- Rail
- Resource
- Symbol
- Text
- Unit
- Weather

Hovering your mouse over each one will show its name, e.g. Edit Hex Layer if hovering over the first.

2.3.15. Map → Draw
When in Draw mode, left clicking on the map places the currently selected sprite onto the map, over-writing whatever was previously in the hex.

The currently selected sprite is shown in the Upper Sprite Box at the top right in the Editor. You can change the selection by using the scroll bar on the right to go up or down the choices beneath the Upper Sprite Box. Left click on another sprite to select it, and note how the current selection in the Upper Sprite Box will change to the newly selected one.
Tip! When in Draw mode, if there is a sprite on the map that you would like to use elsewhere, right click on the sprite on the map. That sprite will now display as the current selection in the Upper Sprite Box. Now you can left click on the map to place this sprite where you would like it.

Note: Using the mini-map to move around while in Draw mode will only change your location within the map, it will not make any changes to the campaign.

2.3.16. MAP → SELECT ITEM(S)
Left clicking on the map or mini-map in this mode WILL NOT make any hex changes.

- Select individual hexes by moving your mouse around with the left mouse button held down. By default left clicking on hexes will only select the hexes of one country at a time.
- Select large numbers of hexes at once by moving your mouse around with both your left mouse and the Ctrl buttons held down.
- If you want to select hexes belonging to more than one country at the same time, hold down both your left mouse button and the Shift button while selecting. This will enable you to select hexes irrespective of their ownership.

Left clicking on any selected hexes again will deselect them.

Tip! Right or left clicking on a sprite from the sprite library on the right will display the current selection in the upper right sprite box and automatically reset the Editor to Draw. This action will return you to the drawing mode, and any selected hexes will automatically be deselected in the process.

2.3.16.1. ADDING COUNTRIES TO THE MAP
While using the Select Item(s) mode, right clicking while in the Edit Hex Layer mode will allow you to set Hex Owner/Controller status. This is the tool to use to define countries on the map, as by setting the Owner you are assigning hexes to belong to that country.

If the new country doesn't yet have a Capital, you will need to add one before you can save the campaign. To do this you will need to select the Resource layer, be in Draw mode, and add a Capital or Major Capital to one of this country's hexes.
Note: You can set the hex owner to anyone you wish from the country list. If choosing a neutral Minor country as the Owner, the Controller will default to neutral, whereas with a Major the Controller will be itself.

If any countries are set to be at war, i.e. belligerent, then when selecting hexes their Controller can be set to be either their own controlling Major, or a Major country on the other side. If used, setting the hexes to belong to an enemy Major would signify that some territory has been captured by the enemy before the campaign starts.

2.3.16.2. Editing Items on the Map

All of the following require using the Select Item(s) mode rather than the Draw mode.

Right clicking while in the Edit River Layer, Edit Terrain Layer or Edit Resource Layer modes will allow you to move, delete, rename, or set properties for the selected feature. This allows terrain features and resources to be named or re-named, or upgrade levels to be applied if applicable.

For Fortifications and Fortresses, under the Properties dialog you can also set a Destroy On Overrun or Surrender option. This means that the resource will be removed from the map should it fall into enemy hands.

Hiding Resources: If desired, these can be hidden. To do this, select the Hidden box that appears in the bottom left of the selected resource’s Properties dialog.

Right clicking while in the Edit Unit Layer mode will allow you to move, delete, rename, set properties or set mode (if applicable) for the selected unit.

Moving a land unit from a Land to a Sea hex will present the option to have that unit loaded onto a Transport, Amphibious Transport or Amphibious Transport (Long Range). This also works in reverse, so you can move a unit from any type of Transport back to land.

Editing units’ initial strength, experience and entrenchment levels, and supply levels for naval units, can all be done under the Properties dialog. The Set Mode dialog enables you to set the starting mode for those units with different modes, e.g. Artillery can be assigned their starting supply of Shells, Paratroops to Prepare, Subs to Silent mode, etc.

As you set research levels for the campaign, additional options will become available for customizing each unit or resource, such as enabling
the latter to be upgraded with Anti-Aircraft Defense. The Details section under the Properties dialog displays combat values for units and defense values for resources. The default values and costs will appear normally, and any upgrades based on higher research levels will appear in brackets like this: [...]. Unit attributes may not be set higher than your current research levels allow. See the Edit Research section for additional details on setting research levels for the campaign.

2.3.17. MAP → REMOVE ITEM(S)
With the Remove Item(s) tool selected you can erase hex contents by left clicking on a hex. This action is relative the layer selected. For instance, with the Edit Terrain Layer mode selected this will only remove terrain pieces like forests and mountains. The same applies for all others apart from when the Edit Hex Layer mode has been selected, as with this one if you remove a land hex then literally all the contents of this hex that were dependent on the land will also be removed, only the Symbol, Text and Weather Layers would remain. Caution: A warning message WILL NOT prompt you to proceed prior to making a change. Tip! Right or left clicking on a sprite from the sprite library on the right will display the current selection in the upper right sprite box and automatically reset the Editor to Draw. This is a very quick way to go back to drawing.

2.3.18. MAP → GENERATE FULL MAP SCREENSHOTS (F8)
To take screenshots of the whole map, press F8. A subfolder called Screenshots containing multiple images of your map will be created in the folder: User\Documents\My Games\Strategic Command WWII - World at War

2.3.19. MAP → DRAW MAP CONTROL VALUES (F9)
Press F9 to see the extent of hex ownership of all fully mobilized countries on the map. All hexes belonging to neutral countries will display the number zero, while fully mobilized countries will display the number of their controlling Major, e.g. the UK is 1, Germany 6.
2.3.20. **MAP → DRAW LAND CONNECTION VALUES (F11)**
Each set of connected Land hexes are assigned a number, so by pressing F11 you can see if a land mass correctly displays the same number throughout its length. Neutral countries will be shown as 0.

2.3.21. **MAP → DRAW NAVAL CONNECTION VALUES (F12)**
To check that all the Ports you have added to the map can access the sea, press F12 and check that the number showing over the Port is the same as that over the Sea hexes they should be accessible to.

The engine automatically divides Sea hexes into numbered Sea Zones, with all connected Sea hexes being in a zone. All Land hexes and Land/Sea hexes that are in a neutral inactive country will be shown as 0.

This function will probably only be useful if you have positioned some Ports in inlets connected to the sea via Land/Sea hexes, but it is useful to use this function to quickly check that all your Ports will be accessible as intended.

2.4. **CAMPAIGN**

2.4.1. **CAMPAIGN → EDIT CAMPAIGN DATA**
To edit basic campaign data, select **Campaign → Edit Campaign Data** from the Main Menu bar.

In the **Campaign Data** field you can set the Start Date, End Date, Who Starts and Centered Map Position.

You can also provide a brief description of the campaign and claim authorship of the scenario by inputting your name.

Any dates from year 0 to 9999 may be entered. The initial map display can be centered by specifying an initial map position in X,Y coordinates.

Campaigns may also be flagged as mini-campaigns. This has no real effect other than to help order main campaigns first and mini-campaigns second in the Select Campaign dialog when starting a new game.

**Note:** The campaign End Date must be greater than the Start Date. A warning message will prompt you prior to saving a change.
If you click on the Advanced button in the bottom right, this will bring up the Advanced Game Play Options dialog where you can amend the following:

- Select the Victory Basis to be Capitals or Objectives. The Capitals option means countries surrender or are liberated when their Capital and all Alternate Capitals have been captured. The Objectives option means that the standard surrender and liberation rules are disabled. In either case, victory is determined by the campaign's Victory Event Scripts.
- Display Borders, Convoy Map and War Maps. If unticked then these options won't display in game.
- Turns Remaining. This is used to advise players when the game is nearing its end date, to show them how many turns there are still to go.
- Preferences: Research, Diplomacy and Purchases. If unticked then these features will be disabled in game.
- Operational Movement (Land): This option will be unavailable if unticked. If ticked, then it can be set to be either Unrestricted or by Rail Only. With Rail Only you can set the minimum connection strength value for Resources to be able to act as the starting and way points for Operational Movement by land units. The minimum supply value that a unit must have in order to be operationally moved can be set here as well.
- Operational Movement by Air: This option will be unavailable if unticked. If ticked, you can set the minimum strength value for Resources to be able to act as the starting and end points for Operational Movement by air units. The minimum supply value that a unit must have in order to be operationally moved can be set here as well.
- Resource Supply Calculation: should this be Unrestricted or by Rail Only. If the latter is selected then supply from Key Resources travels outwards by rail, meaning that resources not connected by rail to a Key Resource will have lower strength and therefore supply values.
- The remaining general options are either available in game if ticked, or unavailable if their button is unticked. These are to allow:
  - Reinforcements
  - Elite Reinforcements
  - Upgrades
- Transports
- Amphibious Transports
- Disbanding
- Rebasing
- Consumable Research Chits
- Consumable Diplomacy Chits
- Variable Hex Placement
- Unit Placement Variation Upon DOW (Minors)

2.4.1.1. NOTES

- The Objectives option for Victory Basis disables the Alternate Capitals feature whereby Capitals move when the first one is captured. All Cities in the Capitals list will become Objectives, with the first City listed (i.e., the Capital) being the primary objective. All objectives will be highlighted with a yellow ring around them. If using the Objectives option, it might be wise to set any that would have been Alternate Capitals as Industrial Centers to allow them to act as supply and production sources if the primary objective is captured. See the Add/Remove Capitals and Add/Remove Industrial Centers for more details.
- The Rebasing option allows rebasing of air units.
- The Unit Placement Variation Upon DOW (Minors) option randomly moves by a maximum of one hex the placement of units for Minor countries when they are declared war upon. This makes planning an ideal invasion just that little bit harder.
- The Consumable Research and Diplomacy Chit options mean that one chit is consumed when a result is achieved.

2.4.2. CAMPAIGN → EDIT COUNTRY DATA

2.4.2.1. MOBILIZING COUNTRIES

To activate a country in the Editor, select Campaign → Edit Country Data from the Main Menu bar. In the following we will go through each section of the Country Data area in turn.
2.4.2.2. Select Country
Each individual country's data must be edited separately, and you can select the country you wish to activate in the Select Country list on the left. Each country that is represented on the map must have a Capital, but it is not necessary for all countries that will be involved in the war to be represented directly on the map, as Events can be used to create countries during a game. Please refer to the Editing Events section for details on how to do this.

2.4.2.3. Flags
Here you can set each country's:
- Alignment as Neutral; Axis or Allied
- Allied Parent if the country is a Minor. If the selected country is a Major then the default status is None.
- Axis Parent if the country is a Minor. If the selected country is a Major then the default status is None.
- Build Restrictions as None; Home Builds or Home/Occupied.
- Scorched Earth to be None; On Invasion; On Liberation or Full.
- Aircraft Operating Restriction as None, Home Country Only or Home/Controlled.

Minimum requirements are as follows:
- There must be at least one fully mobilized Major country. This can be either Axis or Allied.
- All Minor countries must have both an Axis and Allied Parent defined. The Axis and Allied Parents do not have to be fully activated, but they cannot be Neutral.

2.4.2.4. Build Restrictions
Setting a country's Build Restrictions to Home Builds Only limits the deployment of new units to within their home country.

The Home/Occupied setting allows new units to be deployed both within the home country and also within any cooperative countries directly under that Major's control.
Setting Build Restrictions to None allows unit construction in any friendly cooperative territories if a direct land connection with the home Capital is available.

2.4.2.5. Scorched Earth
Scorched Earth means that resources suffer damage when they are captured or liberated.

The Full setting sets Scorched Earth to occur whenever their resources change hands, whereas the On Invasion or On Liberation settings mean that it would only happen either when a country loses its resources, or when it regains them, but not both.

2.4.2.6. Aircraft Restriction
Aircraft Restriction denotes whether or not this country's air units will be able to operate to other countries.

Home Country Only means that air units can only operate within their own country.

Home/Controlled means that a Major can operate its air units within its own home country and any territory they occupy, including their subordinate Minors, but not to or from territory controlled by their allies.

2.4.2.7. Mobilization % and Status
Set a country's Mobilization % from 0 to 100. Note that:
- If a Neutral Alignment has been selected, then 0% Mobilization will automatically display.
- If a country has a pro-Axis or pro-Allied leaning of less than 100%, then the country is considered neutral (though not neutrally aligned) and not yet at war with anyone.
- If a Mobilized Status is selected, then 100% Mobilization will automatically display.

Although a country's initial alignment in a campaign may be set as Axis or Allied with a positive Mobilization %, for Minors, diplomacy or game events could drop this value below 0%. Should this happen, the alignment switches with a positive value towards the other side, as countries never have a negative Mobilization Value.
**Surrendered or Annexed.** Here you can set any activated Minor countries to have either status, defining the Occupier country for each in the box below. Surrendered means that the country’s forces are removed from play and their territory is occupied by the Occupier.

**Annexed** is a way to remove a pre-existing country and its armed forces from the map, with its territory transferred to its Occupier. This is useful as a quick way of editing a campaign like *1939 World at War* into one that starts several years later, as states like Danzig and Poland can be ticked as annexed. If you change your mind, then this can always be undone by simply unticking the Annexed box.

**Note:** Changing a Major’s status may also reset the Surrender or Annexation status of its dependents, as well as their Parent and/or Mobilization Status. The Axis and Allied parents of an annexed Minor do not have to be fully activated, but they cannot be Neutral. Also, annexing a country may reset its Capitals or Industrial Centers lists. A warning message will prompt you to confirm prior to making a change.

Set country **Cooperative** status. If ticked this allows a country to be fully cooperative with its allies and vice versa. Non-cooperative countries:

- Cannot operate their units into territory controlled by their allies.
- They do not exchange any HQ Supply benefits except to a similarly aligned Minor.
- Their Resources will provide a maximum of 3 supply to units belonging to other non-cooperative countries.
- They will not intercept or escort for each other.
- Non-cooperative Majors that liberate Minor countries will override the previous Parent country setting and become the new parent.

**Examples:** If the USSR is set as a non-cooperative Allied Major then:

- It cannot operate land or air units to British or US territory, and vice versa.
- If the British conquer Persia and the USSR is fully mobilized, no Persian resources would benefit from being connected to full strength Soviet resources.
- Yugoslavia has the UK as its Parent, but if Yugoslavia is conquered by the Axis and then liberated by the Red Army, it will become subordinate to the USSR and not to the UK.
In contrast, Canada’s resources will benefit from their connection to the USA when the latter enters the war, as both Canada and the USA are cooperative.

2.4.2.8. Coop. Restriction
Restrictions can be added to the Cooperative status, so that it is possible to denote whether or not units of countries allied to this one will be able to operate in and out of this country.

If the restriction is *(None)* then there are no restrictions and cooperative countries’ resources will supply each other, and both can operate air and land units in and out of each others’ territory.

If the setting is *Supply Only* then units from other countries can receive supply from that country’s resources, but no units from other countries can be operated into, through or within this country.

2.4.2.9. Belligerence
Use this tick box to assign who is at war with whom when the campaign starts. This only applies to Majors, as their subordinate Minors will automatically adopt the same Belligerence settings as their Parent Major.

2.4.2.10. Unit Orientation
Set the default orientation of units when they aren’t in enemy contact range. This is based on the unit facings in the image files that are set by default to face the right, or east.

The *Mirrored* orientation flips the default unit image to the left, i.e. facing west. The default orientation for a country will also affect friendly units placed in that country, so this is a useful tool to ensure that units adopt a logical facing according to their location.

The *Reflect at Position* option can be used separately or in addition to the Mirrored option. It means that a country’s units will automatically face the opposite way if they are on the other side of this Position.

**Example:** The default unit orientation for Germany is to face east. If the *Reflect at Position* option is ticked, then any units west of the Capital will automatically face to the west. This means that the default for a country
like Germany which faces the prospect of a two front war is for the units to face outwards towards the enemy.

2.4.2.11. Proximity and Facing
Any enemy land or air units that are within 5 hexes of each other, and connected by land to each other, will automatically face off against each other as logically as possible. Otherwise, if there is no unit within 5 hexes then they will face in their default orientation. For naval units the face-off range is 8 hexes.

2.4.2.12. HQs
Ticking the Attachable Minors tickbox will enable the selected Major to command units belonging to their subordinate Minors. Thus for example, German HQs can be set to command Slovak units, and British HQs can command Canadian units.

2.4.2.13. Modifiers
Here you can set the:
- Initial Military Production Points from 0 to 9999 MPPs (Majors only).
- Industrial Modifier % from 0 to 1000 (Majors only).
- National Morale – Start (NM) (Majors only). Use this if your campaign starts part way through a war, by setting a figure lower than the one you assign to National Morale - Upper in the box below. The difference can represent National Morale losses due to casualties and lost resources prior to the campaign starting.
- National Morale – Upper (NM) (Majors only).
- Max Occupational Efficiency % of captured resources from 0 to 100.
- Soft Build Penalty % from 0 to 100.
- Fortification Build Delay from 0 to 365 days.
- Min Paratroops Prepare Supply Level from 0 to 21. Setting this to 21 should only be used when designing a campaign where you don’t want Paratroops to be able to carry out Airborne drops, i.e. you are use the Paratroop slot for a different unit type.
- Max HQ Attachments from 0 to 25.
- Max HQ Attachment Range from 0 to 25.
2.4.3. Setting Key Resources

Key Resources are Capitals; Industrial Centers; Primary Supply Centers and Secondary Supply Centers.

2.4.4. Alphanumeric sort

Urban Resource names can be sorted either according to their position on the map, or in alphanumeric order. The latter is the default, but if you would like to sort them according to their position on the map, then untick the Alphanumeric button.

2.4.5. Urban Resources

Each country’s Urban Resources are listed in two separate columns, one on the left and another to the right of the middle. Select locations from the list on the left to add them to the Capitals or Industrial Centers lists. Locations in the right hand list can be selected and added to the lists of Primary and Secondary Supply Centers.

2.4.6. Add/Remove Capitals

Define a country’s Capital first and any alternate Capital(s) subsequently, in order, if applicable. If the current Capital is captured, the game will then move the country’s Capital to the next one listed that is still under friendly control. A country will only have one active Capital at a time during a game, and it will begin checking for surrender once its final Capital is captured.

If Capitals are liberated then the Capital can return to a previous location.

2.4.6.1. Add/Remove Industrial Centers

Define locations in addition to a country’s Capital that can serve as Industrial Centers. These Industrial Centers will not only act as a supply source similar to a Capital, but players will also be able to build and deploy units at urban resources that can trace a line of friendly hexes to these Industrial Centers.

2.4.6.2. Add/Remove Primary and Secondary Supply Centers

Define locations in addition to a country’s Capital and Industrial Centers that can serve as Primary and Secondary Supply Centers. These Supply
Centers will provide supply but unless there is a line of friendly hexes directly connecting them to a Capital or Industrial Center, players will not be able to build units here.

Note that an occupier gains the pre-existing Primary and Secondary Supply Centers when the country surrenders.

2.4.6.3. Customized Values & Restore Defaults
This game comes with default data settings for all countries and unit types. Any amendments you make will be classed as customized values, and these customized values will be displayed with an asterisk (*).

Selecting Restore Defaults at the bottom of the screen will enable you to restore some or all default values according to your selection.

Unit Build Lists: There will be a delay when restoring their defaults, as well as a warning message as the campaign needs to be saved before doing so.

Note: When you've finished editing, click on the OK button in the bottom right to go back to the Country Data screen, then click OK again to go back to the Editor itself.

Tip! It is wise to save your changes on a regular basis.

2.4.7. Campaign → Edit Country Data → Edit Unit Build Data
Here you can set Unit Build Limits for each unit type for each country. They can be set from -1 to 255. If set to -1 then no number will appear in the Build Limit, and the unit type will not appear in the Purchase screen during a game.

Note: Build limits do not restrict the number of units that can be placed on the map at the start of a campaign. Thus it is possible, if desired, to have units on the map that cannot be rebuilt once they have been destroyed.

2.4.7.1. Unit Name Lists
In this section on the right of the screen you can add/amend the unit names for all unit types for all countries.

Units with these names will then be available for deployment directly onto the map in the Editor, or for adding to the Purchase and Deployment Queues, or simply to be purchased in game. With HQ units you can set their Command Ratings from 1 to 10.
Select the country on the left whose Build List you wish to edit. Then select the relevant unit type, add a name in the field at the top right called Name: Click Add/Edit and the new name will appear in the List: box. Names may be amended or deleted from the list by clicking Remove near the bottom of the screen.

Note: During a game, renaming units is possible providing a unit of that country and type doesn’t already have that name.

Tip! By setting build limits at the 255 maximum you would effectively have a game with no limits.

2.4.8. Campaign → Edit Country Data → Edit Unit Cost Data
Set unit cost from 0 to 9999 MPPs by unit type for each individual country. All unit costs represent their costs without any research upgrades applied.

2.4.9. Campaign " Edit Country Data " Edit Production Delay Data
Here you can set the time it will take for new units to be ready for deployment from when they are purchased. This can be set to either Turns or Months using the buttons at the bottom left.

If set to Turns, the delay can be from 0 to 365 Turns for each unit type for each individual country. If set to Months, then from 0 to 60.

2.4.10. Campaign → Edit Country Data → Edit Combat Target Data
You can customize the Combat Target Values for any units in a campaign, changing any of their values for attack, defense, movement etc.

Attack and Defense values can be set to range from 0 to 10 by unit and resource type for each individual country, while most General Combat Target Values can range from 0 to 25. Exceptions to the latter are:

- The number of Interceptions, Escorts, Strikes can be set to a maximum of 2.
- Min Shells and Max Shells can vary from 1 to 10 for applicable artillery unit types.
- De-Entrenchment can vary from 0 – 8.
- De-Moralization can range from 0 – 100%.

With Anti-Aircraft units, their Intercept Range is the range at which they will attempt to shoot down attacking enemy aircraft. The Number of Interceptions determines the maximum number of enemy air attacks they can attempt to fire at in any one turn.

Loss Evasion in Land and Naval Combat can be set from 0 – 100%, with different values applied if desired for attacking and defending. Note that this is the % chance that this unit type will suffer no losses at all when attacking or defending.

In the Extra area you can set the Raid Multiplier in MPPs for unit types capable of raiding (naval units and bombers), and Enemy National Morale Losses (Per Raid). The latter is used to inflict a penalty per Raider on the National Morale of a Convoy recipient. For example, for every 10 MPPs sunk by a U-Boat while en route to the UK, the UK will also lose 25 NM points. The Raid Multiplier (MPPs) can be set to a maximum of 100, and the Enemy National Morale Losses (Per Raid) can be set to a maximum of 5,000.

Lastly, the Target Type is shown. As combat is resolved between the competing Attack and Defense Values by Target Type, it is recommended to familiarize yourself with them a little, so that the values you assign will be most applicable for your campaign.

Note: All values in this area represent their values without any research upgrades applied. Please see the Research section for additional details regarding how higher technology levels affect Combat Target Values.

2.4.10.1. Apply Data

At the bottom of the screen you'll notice that between the Restore Defaults and OK button there is one called Apply Data. This tool enables you to effectively apply the settings for one country to another. This can really speed up your editing so be sure to try it out!

From the Combat Target Data screen select a country whose Combat Target Values you would like to apply to another. Click on Apply Data.

Note that the selected country is shown right at the top of the newly opened Dialog Box, e.g. Apply Current Data (UK →).
Select countries on the left hand side that you would like to have the data applied to, and then select the unit type(s) on the right that will receive the same statistics as the selected country. If every country and/or unit type is to have the same Combat Target Values, then you can use the Select All buttons at the bottom.

The Apply Data function works in this way throughout the Editor, allowing data from one country to be applied to others.

2.4.11. Campaign → Edit Country Data → Edit Research

You can set the research values for each individual Major country for each research type. Select a Major on the left whose research values and costs you wish to view and/or edit.

The Current Research level, Maximum Research level, current Chits Assigned, and Maximum Chits Assignable may be set from 0 to 5. The cost of each research chit can be set from 0 to 1000 MPPs in increments of 5 MPPs for each category. The Maximum Research MPP investment is set at the bottom of the screen, and it can be set from 0 to 10,000 MPPs.

The cost of research chits already invested is automatically shown in the Current Research MPP field to the right of the Maximum Research MPP field, and this updates itself if more are invested.

If your campaign has the setting in place for research chits to remain invested in an area after technology advances are achieved*, you may wish to increase the research cost per chit invested.

*This is effected by unticking the Consumable Research Chits button by going to Campaign → Edit Campaign Data → Advanced. If ticked then one research chit is consumed whenever a research advance is achieved.

The Apply Data button works in exactly the same way as it does for Combat Target Values (see above) allowing you to transfer the settings from one country to others.

Tip! By setting Max Level values at 0 you can effectively block research in particular areas, while by setting the Maximum Research at 0 MPP for a Major you can effectively prevent it from performing any research. And if you would rather there was no research at all in your campaign, go to Campaign → Edit Campaign Data → Advanced and untick the Research button under Preferences in the bottom left.
2.4.11.1. Advanced Research Options

By clicking on the Advanced tab in the bottom right, it is possible to fine tune the increments that each level of research will provide. This provides a large amount of flexibility so that different countries can have different abilities. For example, each country’s increment per research level attained in Production Technology may be set from 5 to 100%, and for Industrial Technology from 5 to 100%.

The option to set Research Progression (Per Chit) only applies to Majors, so do not change any while you have a Minor country selected as doing so will not affect anything in game.

Minors’ armed forces can be set to be Upgradeable by selecting the Minor on the left hand side and ensuring that the Minors button in the top middle is ticked. They will then be able to upgrade in line with the research success of their Parent Major and their own upgrade limits. The cost of upgrading relative to the cost of upgrading its Parent Major is set using the Relative Cost (%) button.

In the top right is a box entitled Research Sharing (Increases Catch Up Bonus). This is where you can set the ability for fully mobilized Major countries to share research. If you select a Major then the drop down box will display all the friendly Majors that this Major could potentially share research with.

If the box is ticked then it will share research with that country. Sharing can be set to work one way, or both. For it to work both ways, e.g. between the UK and France, then both countries will have to have each others’ box ticked.

Moving to the central area of the Advanced tab, General Research Increments can be set here as follows:

- **Subs** – here you can set the Initial Dive % chance of a Submarine with no upgrades to dive. The Dive Increments are the increase in chance of the Submarine diving when it is attacked, with every upgrade of Advanced Subs that it receives.

- **Anti-Submarine Warfare** – The % set here will be subtracted from the Submarine’s % chance of diving, so its effect will be to reduce the chance of the Submarine diving. It is generally recommended to have Initial ASW set at zero. ASW Increments represent the increase per level
of Anti-Submarine Warfare research that will be deducted from enemy Submarines’ chances of diving when they are attacked.

- **Resource Bombardment** – here you can set the % chance that a unit that targets resources (Rail Guns, Rockets and Strategic Bombers) can also hit a unit that might be occupying the resource. This % can be increased through upgrading the unit’s primary attack research category, e.g. Artillery Weapons, Rocket Weapons and Heavy Bombers respectively.

- **Increments %** – here you can fine tune the % increases that Majors will benefit from by researching these four categories. These refer to the:
  - % bonus to your research that can be gained from Spying & Intelligence, or the decrease in your opponent’s bonus.
  - The decrease in costs gained by Logistics research.
  - The decrease in unit production and reinforcement costs from Production Technology.
  - The increase in home country economic production from Industrial Technology research.

- **Accuracy Loss Beyond Base Range (Per Hex)** – this enables you to make Artillery and Rockets firing at longer ranges lose effectiveness the further away the target is. This can be useful if research upgrades will increase Artillery ranges, as it may not be desirable for them to have the same potency at (say) a range of 4 hexes that they have at a range of 1 hex.

**Note:** If you change the benefits that any category provides, it will be best to update the Research Tool-tips too for your campaign. To do this, open up the game’s official localization.txt file which can be found within the main installation folder. Search for #GAME_RESEARCH_MENU_TEXT and copy the relevant lines that will need to be changed to your own campaign’s localization.txt file, and amend the details within your file. See *Customize your Campaign* for further details.

**2.4.11.2. Upgrade Data (Per Research Level)**

When in the **Advanced** tab for **Research**, click on the **Upgrades** button in the bottom right. Here you can fine tune specific research categories, costs and the maximum number of levels that each unit type can gain.
from research. These can be set independently for each Major, and their respective Minors will automatically have the same settings.

Each unit type can be assigned up to 3 research categories. If you have 3 set and wish to remove or change one, tick the Disabled? box relevant to the category. This will remove that one, and if you desire you can then click the tickbox next to the one you want to add from the list below, then tick the Select as replacement box.

You can also re-order the categories as needed by using the Up/Down buttons in the top right.

Important: Resources can only be upgraded with Anti-Air Defense, and with the other unit types, be careful not to apply research categories that really don't apply to them. For instance, giving an infantry unit the ability to upgrade with Advanced Fighters is not likely to help that unit, because changing research categories will not change the fundamental nature of the unit being upgraded.

2.4.11.3. Upgrade Increments
To change the specific benefits units receive from upgrades, click on the Upgrade Increments button at the bottom of the screen. Select the country, unit type and upgrade category you wish to amend. You can set the exact increment amounts per category, unit type and country. There are limits, e.g. Attack and Defense values can only increment by a maximum of 10 per level, spotting ranges and Action Points by 25. Tip! Restore Defaults and Apply Data work in this area too, and the latter may be especially useful here. Click OK when done.

2.4.11.4. Automatic Increments
To change the benefits Majors receive from Automatic Upgrades, click on the Automatic Increments button in the bottom right of the Advanced tab. Here you can select the specific upgrade types by country and unit type, as well as setting the increments per level. The customization this allows is very wide-ranging, so take care that too many upgrades won’t combine to inadvertently turn a unit into a really powerful super-unit!

Note: Increases in unit Build Limits from Automatic Research will not show in the Editor, but they will show in the game itself.
2.4.12. Campaign → Edit Country Data → Edit Diplomacy

Customizing the diplomatic options for a campaign can be accomplished from the Edit Country Data dialog and selecting the Edit Diplomacy option.

Set the maximum number of diplomacy chits between 0 and 100 for each individual Major country.

Set Influence costs from 0 and 1000 MPPs for four different types of diplomatic action:
- Friendly Minor
- Enemy/Neutral Minor
- Friendly Major
- Enemy Major

The Influence % Per Chit is the chance every turn of achieving a diplomatic success, according to the number of chits invested. This can be set from 0 to 100.

The Effect Range % is where you can set the % increase in Mobilization achieved by a diplomatic success. The left hand number sets the minimum increase in Mobilization, and the right the maximum.

The Minor Influence Bonus % (Per Hit) is the chance per diplomatic success that a Minor will receive an extra boost in its Mobilization % beyond the minimum and maximum set in the top row of the Effect Range % area. This chance of a bonus can also be set from 0 to 100.

Example: The default influence is 5% per chit with an effect range of 8-15%. If influence against a Minor is successful during a turn, the default Minor Bonus provides a 10% chance that the actual effect of the diplomatic breakthrough will be 16-30%, as the effect range of the bonus is also set at 8-15%.

In the Diplomatic Status box you can set the initial number of assigned diplomatic chits for each individual country, as chosen from the Select Country list on the left. Up to the maximum investable limit for each Major can be invested against a country, providing that country doesn’t have a limit on the number of chits that can be invested in it. This can be set in the Diplomatic Chit Assignment Limit (If Applicable) area.

Bear in mind when setting the initial investments that the net % chance of a diplomatic success is the cumulative effect of all the chits invested against it by both sides.
Tick the *Block Investment Towards This Country?* Box if you wish to prevent a Major from conducting diplomacy against a selected country.

Click on the **OK** button when done.

Just as with research, the option exists for diplomacy chits to remain invested in an area after a diplomatic breakthrough has been achieved, and if you do use this option, you may wish to increase the diplomacy cost per chit invested. To do this go to Campaign → Edit Campaign Data → Advanced and untick the Consumable Diplomacy Chits button.

**Note:** The maximum number of diplomacy chits cannot be less than the currently assigned chits. A warning message will prompt you to reduce assigned chits first.

**2.4.13. Campaign → Edit Country Data → Edit Production Queue**

Here you can select units by country and by type for arrival once the date specified has been reached.

Strength, experience and available research levels can be set for them all.

The Full Research option means that the unit will arrive fully upgraded with whatever applicable technologies have been researched by its production date. If Full Research is selected then it won’t be possible to set individual research levels if any are available at the start of the campaign.

Unit arrival dates can be set for any date, regardless of the Production Delay for that unit type. Whether or not the Production Delay option is selected, units in the Production Queue will arrive once the date specified has been reached.

A Destination Resource can be set where the unit will deploy. If this Destination falls to the enemy then the unit will deploy at the next best resource.

If you want to edit something that is already in the Production Queue, click on the unit and you can edit its arrival destination, strength, research etc. If any features are grayed out then they cannot be edited.

Click on ‘Add/Edit’ at the bottom of the screen when done, and it will add/update the item on the Production Queue to have the new settings.

**Note:** All new units will deploy with a supply value of 10, though during the end turn sequence the supply of land and air units will then be adjusted according to their proximity to supply sources.
2.4.14. Campaign → Edit Country Data → Edit Deployment Queue

Key units can be deployed where the player wishes at the start of a campaign before the fighting actually starts. To use this feature, add units to the Deployment Queue.

This works in exactly the same way as the Production Queue, except that any units placed here will be immediately available for deployment prior to the actual game starting.

If this feature is used then one or both sides will have a Deployment Phase when they start the game, where they will deploy these units. Once all units from the Deployment Queue have been deployed, the game itself will start.

2.4.15. Campaign → Edit Country Data → Edit Strength/Reinforce/Reformation Data

In this area you can set a number of unit specific qualities on a country by country basis.

Select the country and unit type you would like to edit. You can amend its Maximum Strength, with values between 1 and 10 being allowed.

Reinforcement and Elite Reinforcement costs can be set as a % of the unit’s base cost in MPPs (i.e. before any research upgrades are added) per strength point they receive as reinforcements. The cost of Elite Reinforcements should generally be set at least as high, if not higher than normal Reinforcements as they represent the incorporation of good quality troops within the unit.

The Reformation area signifies whether or not the unit can be rebuilt if it is destroyed. If the button is ticked, then it can be rebuilt but only if it was destroyed when it had a Minimum Supply value that was at least as high as the number set in the Min Supply box.

The cost to rebuild the unit after its destruction is the % Reformation Cost, as a % of the unit’s base cost in MPPs. The % Reformation Delay dictates the time it will take from paying the MPPs for its reformation and it arriving for deployment, as a % of the time it would take to create a new unit of this type.
2.4.16. Campaign → Edit Country Data → Edit Resource Data

Here you can set the economic value of all resources by country, from 0 to 10 MPPs per strength point for every resource type. MPP values per strength point can be set to include quarters, e.g. 0.25, 0.50 and 0.75 as well as whole numbers.

Note that changing the MPP resource value for a City will affect the economic penalties from Convoy raiding as described in Chapter 6 on Movement and Combat.

The National Morale (NM) value of resources can be set here too, with the value set being the NM points that a Major will gain every turn that it occupies a resource of this type belonging to an active Major. This value automatically equals the per turn penalty that the active Major that has lost the resource suffers. The NM value of these resources can be set on a country by country basis.

The % damage that a resource will suffer from Scorched Earth when it changes hands is also set here. Minimum and maximum values can be set so that there is variability in the damage suffered by resources when they are captured or liberated.

2.4.17. Campaign → Edit Major Country IDs Data

There can be a maximum of 10 Majors in your campaign, and you can select these from any of the countries in the Country List on the left hand side.

To make a country a Major, providing the limit of 8 hasn’t already been reached, select it on the left hand side and click on the >> button.

Click on Set Display Source on the right to select which set of Bitmaps it will use in the campaign. This may save any Bitmaps having to be amended if they can use those belonging to a pre-existing default set. For instance if you want both France and Vichy France to be Majors, both can be, and by assigning the same Bitmap source they will both use the same unit sprites in game.

Each Major is given an Index number, starting at 1. Use the Up and Down buttons to put the Majors in order, with all Allied Majors followed by all the Axis ones.

Index 1 is automatically the first Allied Major in the First Allied Major ID Index. Set the First Axis Major ID Index button to the first Axis Major.
Important: It is crucial that all Allied Majors are listed before any Axis ones. You can remove any countries from being Majors by selecting them in the Major Country IDs list and clicking on the << button to remove them. Click on the OK button when done.

2.4.18. Campaign → Edit Weather Data

Here you can edit Weather Data and set Weather Zone values. Each area of the map requires a Weather Zone according to its climate, so to add a new Weather Zone, the first thing to do is to click on Set Climate and choose between Temperate, Frozen, Semi-Arid and Arid. Now give your Weather Zone a name, e.g. North America.

In the Primary and Secondary Seasonal Effects (Land), and the Seasonal Effects (Sea) boxes, you can set the % chance per turn of the weather being of a certain type, in accordance with the season.

For example, it could have a 60% chance of being clear in a winter turn, 10% of being Mud and 30% of being Frozen. A Weather Zone can include both land and sea effects, as it can cover as wide an area as appropriate.

Once you’ve named your Weather Zone and set its effects, click Add at the bottom left. The new Weather Zone will appear in the Zone List on the right.

To edit a Weather Zone, select it from the Zone List, make any desired change, and then click Edit/Update to save your changes.

To delete a Weather Zone, select it from the Zone List on the right and click Remove at the bottom.

To close the Weather Zone Data dialog, click OK.

The cumulative trigger percentages for effects cannot exceed 100% for each season. The default seasonal effect is Clear or Calm if less than 100% is entered for the trigger values. Even so, it is recommended to ensure that the Trigger % for all items within each category add up to 100 as a way of checking that the settings are as intended.

In addition to the four normal seasons, four separate sub-seasons are provided for Late Spring (May 1 to June 20), Early Fall (September 21 to October 14), Late Fall (December 1 to December 20), and Late Winter (March 1 to March 20). These don’t need to be filled in, but if they are then their Trigger % will apply for the periods in question. If they aren’t filled in then the Trigger % for the main seasons will apply during these periods.
2.4.19. Campaign → Edit Weather Data → Advanced
The Advanced Weather Data screen can be used to advise the game engine which Weather Zones border each other. If this is done then it will make for smoother transitions between different Weather Zones.

For example, if a Weather Zone has a temperate climate and currently has snow, for any adjacent temperate zones where mud is possible its weather will be set to mud, whereas otherwise the latter might have been clear.

2.4.20. Campaign → Edit Turn/Economic Data
In this area, the Turn Length can be set to be Seasonal, Daily or Numbered. Seasonal turn lengths are set by default to one week in Summer, two weeks in Spring and Fall, and four weeks in Winter, but these can be adjusted.

Daily turn lengths can be set between 1 and 365 days.

Numbered turns are for campaigns where the date will not change, and instead the campaign will last for as many turns as are listed here, unless any Victory Conditions are achieved prior to then.

Select Turns to be Alternate or Simultaneous. Alternate turns advance the date on each side’s turn, while Simultaneous turns use the same date for both sides’ turns.

Under MPP Collection, if you tick the None box then resources will not provide any income to either side.

Ticking Normalized will equalize production capability over the course of the year if the campaign is set to have seasonal variations in turn lengths. This isn’t used in the default campaigns that come with the game but it can be used with campaigns using seasonal turns to increase production in winter turns and decrease it in summer turns. MPP collection would then be adjusted for Normalized production. All income from resources, including from Convoys are then adjusted to determine the final total of MPPs. Note that income or expenditure due to Decision Events will not be affected by selecting this option.

Caution: A simple change from Alternate to Simultaneous turns will essentially double the number of turns each year, doubling economic production in the process. Beware that this would significantly change a campaign unless costs are increased or resource values are decreased accordingly.
2.4.21. Campaign → Edit Defense Bonus Data
Here you can set or amend the bonuses that defending units receive from the terrain and resources that they are in. The higher the value, the harder it will be for the attacking unit to defeat the defending unit.

Each terrain/resource type can have different Defense Bonuses set according to all the different attacking unit types, ranging from -1 to 8. The negative defense bonus means that land units occupying that hex type have their attack values halved, so in effect it becomes a Defense Bonus for the unit not in this terrain type when it is attacked by a unit that is in this terrain type.

Terrain and resource data are generic and apply to all unit types for all countries.
Note: The Resource map layer takes precedence over the Terrain map layer for a hex’s Defense Bonus. So a City on a Mountain will only get the Defense Bonus for a City, not for a Mountain or for a Mountain plus a City.

2.4.22. Campaign → Edit Movement Cost Data
In the left side of this area, entitled Set Movement Costs, you can set additional movement costs for each terrain type. These additional costs can be from 0 to 8 Action Points, or they can be set as impassable by using the downwards scroll arrow. You can also set additional movement cost penalties for crossing enemy rivers, and Blitz Attack/movement. Movement costs are generic and apply to all unit types for all countries.

Clear hexes default to costing 1 Action Point to move into or out of, so they aren’t included in the editable list. For Terrain types that you would like to cost no more than clear hexes, set their extra cost values to zero. Otherwise a positive value signifies the additional Action Point cost of entering or leaving this hex type.

These editable movement costs start at River and end at Storms, two thirds of the way down the second column. The remainder of the categories in the second column represent MPP costs as a proportion of a unit’s Purchase cost for operating or transporting the unit. Note that operating air units costs double that of land units.

The three Fixed Cost categories at the bottom are set MPP costs that will be charged for carrying out any of these activities. If MPP costs are
set here, as well as in the % costs sections above them, then both will be charged. So you can set either or both to apply, in accordance with the following formula:

\[
\text{Total Cost} = \text{Unit Cost} \times \% \text{ Cost} + \text{Fixed Cost}
\]

The Action Points Multiplier for Forced March and Naval Cruise can be edited in the bottom left-hand corner.

2.4.23.1. **Editing Zone of Control Effects**

On the right we have an editable list where units can be set as Front Line, Support, or exerting No Zone of Control. You can also edit the exact parameters of Front Line and Support units to determine the Action Point penalty for enemy units coming within their Zone of Control, and the number of units required to be adjacent to these enemy units for the Zone of Control to have any effect.

**Examples:**

- If Front Line units impose a penalty of 1, and 1 unit is required to effect the penalty, then the presence of any front line units will impose that penalty.
- If Front Line units impose a penalty of 1, and 2 units are required to effect the penalty, then the presence of 2 or more front line units will impose that penalty.
- If Front Line units impose a penalty of 1, and 2 units are required to effect the penalty, while 4 Second Line units are required to exert the same penalty, then:
  - 1 Front Line unit will not impose the penalty.
  - 1-3 Second Line units will not impose the penalty.
  - But 2 Front Line, or 1 Front Line and 3 Second Line units will impose the penalty.

2.4.24. **Campaign → Edit Combat Data**

In this section the following things can be edited:

- Experience Point Allotment from combat.
- Max Unit Experience.
- Combat Losses (essentially the die rolls that modify combat results).
- Naval Supply Losses from combat.
- The Penalties for attacking across watercourses.
- The % chance of Paratroop and Amphibious units suffering casualties on landing.
- The chance of units retreating when attacked, according to the position they occupy.
- The distance retreating units can potentially retreat.

All of these things can be edited for each unit type, so that for instance, experience gains for artillery can be different to those for infantry and tank units, or cavalry units can be set to retreat more hexes than infantry.

2.4.25. Campaign → Edit Naval Damage Data
This section is where you can amend the % chance of all types of naval unit receiving some sort of damage when there are storms at sea. The damage can either be in strength point losses, unit morale losses, or both.

As the minimum and maximum Strength and/or Morale Losses can be set to zero, this allows for full customization, whereby some unit types could be made invulnerable to storms, while other types can be set to suffer.

2.4.26. Campaign → Edit Morale Data
Here the morale penalties and bonuses that units receive in the following situations can be edited:
- When a friendly country is liberated, with separate editable entries for land and naval units (air units as classed as land units).
- When a friendly country surrenders, with separate editable entries for land and naval units (air units as classed as land units).
- The unit morale penalty for Operating a unit.
- The unit morale penalty for using Forced March.
- The unit morale penalty for swapping units.
- The initial unit morale of new units.

2.4.27. Campaign → Edit Penalties/ Bonuses Data
Here you can set combat penalties and bonuses that units will receive simply by being in a certain terrain or resource type.
For example, Partisans can be set to have increased defensive bonuses if they are occupying Mountains or Forests. Conversely, Tank units could be set to have lower defensive abilities if they are defending an urban area against attacks by Soft or Hard target types.

Tip! There are innumerable options here, but be careful to ensure that players will understand them, otherwise confusion could arise.

2.4.28. Campaign → Edit AI Scripts
See Chapter 3: Scripts, the AI and General Advice

2.4.29. Campaign → Edit Event Scripts
See Chapter 3: Scripts, the AI and General Advice

2.4.30. Campaign → Replicating Layers
The following four functions copy the layer in question to the new one.

- Replicate Road Layer To Rail Layer
- Replicate Rail Layer To Road Layer
- Replicate Resource Names To Text Layer
- Replicate Text Layer To Resource Names

The aim of this is to save you time in designing a map, so that you can for instance, just draw the rail network, replicate it to the Road Layer, and then all you need to do is adjust the Road Layer if you don’t want it to be an identical copy of the Rail Layer.

The Replicate Resource Names To Text Layer function will not overwrite any pre-existing Text Layer entries.

In contrast, the Replicate Text Layer to Resource Names function will overwrite pre-existing Resource names, so if you update the Text Layer and then want to update the Resource Layer with the new name at the Resource location it will do so.

2.5. Go To → Select Map Position
Input the co-ordinates of where you would like to be taken to on the map, and click OK.
2.6. View

2.6.1. View → Mini-Map
Toggle the mini-map on/off. Clicking on the mini-map is a very useful way of moving quickly to a different location on the map.

2.6.2. View → Text
This turns the Text Layer On/Off. Turning the Text Layer off enables you to see the map in its natural state, which can be useful when trying to fine tune the position of an element, or checking that something is as aesthetically pleasing as possible.

Note that if the Text Layer is on, the text will temporarily disappear when you scroll the map.

2.6.3. View → Sprite Indexes
Every image sprite relating to the graphics used in the Editor has a sprite index number. You can turn these on for the current Layer you have selected by clicking on View → Sprite Indexes. This can be very useful as an aid in fine tuning your design.

2.6.4. View → Grid
Toggle the hex style grid on/off.

2.6.5. View → Borders
Toggle national borders on/off.

2.6.6. View → All Layers
Toggle all map layers on/off. With this set to off, the map only displays the layers defined by the current edit mode. This action is dependent on the hierarchy of the map layer selected. For example, the Edit Terrain Layer mode will only display the hex, river and terrain layers, but no Resources, units or weather.

Selecting the Resource layer and then using this function to turn off other layers is very useful, as it will show the map pretty much how it will appear in the game without any units showing.
2.6.7. **View → National Colors**
You can toggle national colors on/off. This is useful for checking the look of the map as some players may play with National Colors on, while others might turn them off, and ensuring the map looks as good as possible in both styles is useful.

2.6.8. **View → Double Selection Columns**
Here you can turn Double Selection Columns on/off. This is a very useful tool when editing as it doubles the options showing on the screen of the currently selected layer.
Tip! Right clicking on the map while in Draw mode will take you to the currently selected sprite of the currently selected layer, in the right hand column of sprites.

2.7. **Preferences**
**Border Style** – Select White, Orange or Black for national borders.
**Unit Style** – Select 3-D or NATO counter styles.
**Unit Counter Style** – This only applies when 3-D units are shown, and is a simple on/off toggle.
**Unit Research Level Style** – Switch between the two ways of showing unit upgrades, either as incremental icons or as numbers.

2.8. **Language**
**Interface Text** – Choose between English, German, French and Spanish.

2.9. **Mods**
Here you can select and de-select any installed Mods.

2.10. **Help**
Pressing **Help Topics...** opens an online Help file.

2.11. **Menu Buttons - Second Row**
Many of these are shortcuts to items included in the first row, so for these their explanations can be found in the above section.
They are listed in order, starting from the left, as follows:

- New
- Open Default Campaign
- Open User Campaign
- Save
- Undo
- Redo
- Lock Scroll
- Unlock Scroll
- Draw
- Select Item(s)
- Remove Item(s)
- Edit Hex Layer
- Edit Terrain Layer
- Edit River Layer
- Edit Road Layer
- Edit Rail Layer
- Edit Resource Layer
- Edit Symbol Layer
- Edit Text Layer
- Edit Unit Layer
- Edit Weather Layer
- View Mini-Map
- Toggle Text
- Toggle Sprite Indexes on Map
- Toggle Grid
- Toggle Borders
- View All Layers
- View National Colors
- View Double Selection Columns

2.11.1. ZOOM IN/OUT

The two buttons on the extreme top right are zoom functions that can be useful to see how your design looks on a grander scale, and then you can zoom back in to see things at their normal level.
3. SCRIPTS, THE AI & GENERAL ADVICE

3.1. EDITING EVENT SCRIPTS

To edit Event scripts, select Campaign and then Edit Event Scripts from the Main Menu bar.

Select the script to edit and then click Open/Edit. Your default text editor should open with the script file. Notepad, WordPad and Notepad++ which all support UTF-8 character encoding should work fine (the game supports Unicode (UTF-8) and over 650 languages for modding).

Each script file may contain multiple events, separated by a blank line.

After editing the script, save the text file and then go back to the Script window in the Editor. You will notice that the name of the script type you have edited now has an * next to it, and this is to show that the script needs to be updated in order to check that all the scripts in the file are correctly formatted.

3.1.1. UPDATING SCRIPTS

Click Update in the Script window. If the scripts are correctly formatted, after a little while (the time taken will depend on how many scripts there are) the update should complete. If it is successful, the * will disappear and each separate event name will appear in the Event List box as a reference for the selected script.

If there are any errors, the Editor should give you an error message as well as some detail including indication of the problem and the affected line number. To correct the error, go to the relevant line number in the text file, check and correct the issue, and then repeat the Update process. Keep repeating the process until the error asterisk no longer appears in the Script dialog.

There are two other Update buttons:
- Update All may be used to force a manual update of all scripts.
- Update * which should be used if you are confident that your script changes don't include any formatting errors. This will update them but if any are incorrectly formatted it won't highlight the specific location of the error.
It is not necessary to update every time you make a change, but you must do so before playing your campaign for these Event scripts to work properly. The Editor will also prompt you to update scripts as you make changes on the map, and the same advice applies: only update when necessary, i.e. before playing your campaign.

The event scripts for individual campaigns are saved in their Events sub-directory.

**Example:** The *1939 World at War* campaign has a sub-directory named `_1939 World at War`. This is where the specific scripts for *1939 World at War* are stored. These files may also be copied or edited directly with any text editor, though editing the originals will amend the default campaign.

### 3.1.2. Script Templates

The basic structures for each type of event script can be found in the game’s Templates folder (do not amend the contents of this file). When you save a new campaign, it will save with these script templates in its new folder. If you open an existing campaign and click on File → Save As, then the scripts from the campaign you have open will be saved into your new campaign’s folder.

### 3.1.3. Script Flags

Scripts can be turned on or off using the `#FLAG` command line. If you want the event to be active in the campaign then set `#FLAG= 1`, otherwise set it to be `#FLAG= 0`. This can be useful in testing, or for leaving optional scripts in a campaign that players can turn on or off as they desire in the game’s options.

### 3.1.4. Failsafe Dates

These are present for use in some script types, e.g. Unit, Belligerence and Resource. The way they work is that if all other conditions required for the event have been reached apart from the Trigger %, then once the Failsafe Date is reached then the event will fire if it didn’t fire before. If you don’t want the event to fire unless the Trigger % is reached, then set the Failsafe Date to be beyond the campaign’s end date.
3.1.5. Condition Positions
If you don’t want a Condition Position to be involved in the trigger for a script, then set it as follows:
- dummy condition position (always satisfied)
  #CONDITION_POSITION= 0,0 [0,0] [0,0] [0] [0]

Script Types
A general description of the different types of events found in the game is provided below.

3.1.6. Convoy
This event transfers MPPs from a source Port in an owner country to a destination Port in a recipient country. The owner and recipient countries must have similar leanings (i.e. they must both be pro-Axis or pro-Allied).

In addition, both source and destination Ports must have a strength level of at least 5 in order to have a fully functioning Convoy. If the owner is a Minor, then the recipient must be its parent Major. The trigger values for both countries are related to their Mobilization Value. A percentage value establishes the amount of MPPs transferable via Convoy, subject to possible seasonal reductions and Convoy raiding.

Multiple scripts may be set for the same #SENDER_ID= and/or #RECIPIENT_ID= to allow for several Convoys between countries. However, there can only be one active Convoy at a time from each country. Should a destination Port no longer be available due to enemy occupation or having a strength level less than 5, then the engine will search for an alternative Convoy script that it can use.

Convoy routes can be defined by setting Waypoints. Convoys start at a Source Port, pass through each Waypoint in the order specified, and end at a Destination Port. A path of valid Sea or Land/Sea hexes between Waypoints is required. The game code will calculate the most direct path between Waypoints, and the Convoy will be marked with arrows to show its direction.

Waypoints can be set to include hexes on the edge of the map, with the next Waypoint being a sea hex also on the edge. This enables a convoy to “sail” beyond the edge of the map for a portion of its journey, e.g. sailing around Africa from the Atlantic to the Red Sea, where only Northern Africa
is represented on the map. When doing so, Waypoints along the bottom most hexes need to be set to an “odd” x position in order to function properly.

If the Convoy route passes through a friendly Port while en route to its destination, and the Port is either damaged to below strength 5 or captured, then the Convoy will be disrupted.

For Convoys between Major powers, players have the option to decide how much will be transferred each turn. The transfer amount remains locked in until changed by the player via the Convoy Map, where an up and down arrow for the selected Convoy can be used to adjust the transfer value.

3.1.7. Resource
This event is used to mobilize resources. Resource positions included in these scripts will be inactive at the start of the campaign, with supply and MPP values of zero. Only when the Resource script’s trigger condition is satisfied will they commence production, with their strength values and MPP values relative to their strength, rising by 1 point per turn.

3.1.8. Supply
This event causes resource positions to suffer strength reductions. Among other potential triggers, supply events can be set to be seasonal.

3.1.9. Strength
This event can be used to generate Strength and Morale losses for units within a specified range. For example, this event can be used to simulate the effect of the Soviet Winter on Axis forces, large scale desertions, or casualties caused by unseen partisan attacks.

3.1.10. Unit
This event causes new units to appear in destination resource positions, either in response to a Decision or when a trigger condition is satisfied. Note that the new units will arrive with either no research if #FULL_RESEARCH= 0, or their current maximum research levels already applied if #FULL_RESEARCH= 1.
Unit scripts set to fire when a country reaches 100% Mobilization will immediately deploy if the relevant country is declared war upon and all other triggers are met.

There is a Private setting that can be used to make it so that only the owner's side will see any mention of a unit deploying. This is to avoid giving the enemy information that they shouldn't have.

Coastal Guns are the only unit type that can be set to arrive at any friendly hex. All others have to arrive at friendly Resources.

Multiple #DESTINATION_POSITION= are supported, simply add further ones beneath so that they will be alternatives if the first one isn't available when the units are due to deploy.

All units need to be able to be placed at a desired #DESTINATION_POSITION and if not the engine will move on to the next one on the list, if there is one. If they all fail, i.e. not all units can be placed at at least one of the #DESTINATION_POSITION=, then the event fails.

### 3.1.11. Free Unit
This event will allow Land and Air units of a surrendering country to continue fighting when their own country surrenders, providing they are outside their own borders and in territory controlled by a friendly power. Naval units of the surrendering country may become free wherever they are.

Free units now be controlled by the receiving country, who is responsible for their reinforcements and upgrades.

### 3.1.12. Partisan
This event triggers partisan activity at specified map locations. These locations can be either resources, including Mine and Oil hexes, or terrain elements. Partisans cannot trigger in clear hexes.

Partisan activity can either be simply disruptive, whereby resources receive strength losses due to their activity, or actual Partisan units can appear on the map.

The field #ADD_UNIT= can accept the following values:
(values range [0, 2]; False= 0; True= 1; True (if <= build limit)= 2
If True= 0 then no unit will be deployed, if True = 1 then a unit will deploy, and if True= 2 then a unit will only deploy if the Partisan Build Limit
has not already been reached. This means that you can prevent excessive Partisan units being deployed if you feel that such a circumstance could arise.

3.1.13. TERRITORY
This event causes territory to be transferred from one country to another when triggered, and it can also be used to have new states appear on the map. The first #MAP_POSITION= will be chosen as the new Capital if this is used to form a new state.

The #REMOVE field allows you to specify if you would like to remove enemy units from within the territory when the event fires.

3.1.14. ANNEXATION
This event causes a whole country's territory to be annexed by another. The annexed country will not produce any partisans to fight the country that annexes them. The annexed country's former Capitals, Primary Supply Centers and Industrial Centers will all be transformed into Secondary Supply Centers.

3.1.15. SURRENDER #1
This event causes a country's territory to be transferred to another country when the country losing the territory surrenders.

The transfer of territory may be to a newly created country with a new Capital, or to the conquering country. This is different than a normal surrender where the conquering country merely occupies the conquered territory, which can potentially be liberated at a later date. This event makes the territory an inherent part of the country that receives it.

This script type can also be used to transfer territory to the surrendering country itself, and the use of this feature would be to form an active “Government in exile”, e.g. the British transferring their Capital to Canada.

3.1.16. SURRENDER #2
This event can be used to force the surrender of a given country on a specified date. An example would be the ability to simulate the historical surrender of Italy in September of 1943.
3.1.17. War Entry
This event allows a neutral country to fully mobilize and enter the war when a specific trigger condition is satisfied.

3.1.18. Mobilization #1
This event allows Declarations of War to trigger neutral countries to have their Mobilization Values moved towards either the Axis or Allies.

3.1.19. Mobilization #2
This event allows a neutral country to have its Mobilization Value moved towards either the Axis or Allies when a specified condition is satisfied. This Mobilization script type is ideally suited for mobilizing countries in response to the presence, or absence, of units in a given location, or within a specified range of a given location.

3.1.20. Mobilization #3
This event allows a neutral country to have its Mobilization Value moved towards either the Axis or Allies, either on a set date, when certain political conditions have been met, or in response to a Decision Event.

3.1.21. Mobilization #4
This event allows penalties or bonuses to be applied to countries when Declarations of War are made. Essentially, the purpose of this script is to punish ahistoric declarations of war, and it can be used to directly punish or boost a Major’s National Morale, or to trigger events in the same way that Decision Events do.

If the #DECISION field has been completed, i.e. with a Decision Number, then providing the #COUNTRY_ID= is a fully mobilized country when the Declaration of War is made, any Events that are set to be triggered by the Decision Number can now fire.

3.1.22. Belligerence
This event is used to set countries at war with each other in certain circumstances, such as representing the German declaration of war on the USA following Japan’s attack on Pearl Harbor in December 1941.
3.1.23. Loop

This event allows a country's units to move off-map between start and finish positions with a specified number of turns to delay completion of the Loop. If the Loop fails due to the presence of enemy units at the finish positions, then units will be returned to their start positions. The Loop script will only initiate on a moving unit's turn. Units in a Loop will be lost if the parent country surrenders.

- If COUNTRY_ID = 0 then all countries of the completed ALIGNMENT_ID can use the LOOP, i.e. either all Axis or all Allied countries can use this LOOP.
- If COUNTRY_ID = 0 and ALIGNMENT_ID = 0 [i.e. Neutral] then any unit can use the LOOP, i.e. Neutral, Axis or Allied.
- If COUNTRY_ID is not equal to 0, then only that country can use the LOOP, and only if that COUNTRY_ID has the matching alignment value as specified in ALIGNMENT_ID.

Use the Symbol Layer to place a suitable symbol on the map to indicate where Loops start and finish. These do not have any other effect on play, they are just there to inform players of the hexes where a Loop starts.

You should also use the Text Layer to add a brief description on the map of all Loops' destination and its Delay value, so that players know how long their units will be off-map when using Loops.

It is best practice to ensure that every Loop has at least 2 finish locations, unless it is inappropriate in a specific case for there to be more than one.

- If there is a #FRIENDLY_POSITION= specified (no matter what position) then the arrival land hex must be friendly controlled.
- If there is no #FRIENDLY_POSITION= specified, then units using Loops will be able to arrive and take control of the destination hexes, even if they are under enemy control.

Note: Starting hexes at sea are not defined as part of any Weather Zone, to prevent weather effects from interfering with movements.
3.1.24. VICTORY
This event defines Axis and Allied Victory Conditions based on the control of map positions, as well as any that might be triggered by Decision Events. For instance, Decision Events can be used for negotiations to see if one side has the will to continue the fight, triggering a relevant Victory Condition if it hasn’t.

3.1.25. POPUP
This event displays a text message based on specific trigger conditions or on or after a specified date. The message is for information only and has no effect on game play.

The #MESSAGE= field can support the following special characters:
- %N = newline or carriage return
- %T = horizontal tab
- %R = right align text, must be applied at the beginning of a newline, otherwise ignored
- %C = center align text, must be applied at the beginning of a newline, otherwise ignored
- %B = bold text, must be applied for each word you wish to bold
- %V = italic text, must be applied for each word you wish to italicize

Multiple #ALIGNMENT_POSITION= can be set, or this field can be left empty if it isn’t applicable.

There is a Private setting that can be used to make it so that only the event owner’s side will be aware of a message.

Viewing PopUp Events in the Editor
Once you’ve added or amended any PopUp Events, providing you Update the script you can then see these scripts as they would appear in the game by selecting PopUp and clicking on the View Button that appears in the bottom right of the screen where you Update the scripts (Campaign → Edit Event Scripts).

If you edit any PopUp scripts while you are viewing them, when you left click on the viewing panel it will refresh to show you the latest version of the relevant script.
3.1.26. **National Morale**

This event is used to add or subtract National Morale points when triggered. Multiple #ALIGNMENT_POSITION= can be set, or this field can be left empty if it isn’t applicable.

3.1.27. **Decision**

This event provides the player with a choice, the consequences of which can be used to trigger other scripts.

The details of the Decision should be spelt out in the #POPUP field, though to avoid having too much text in that area, some details can also be put in the #NOTES field.

You can select co-ordinates on the map by filling in the #NOTESPOSITION= field. When a player is presented with the Decision and they click on the ‘View Map’ button, they will then be taken to the location designated in that field. This allows players to view the location most relevant to that Decision. This field can be left empty if there isn’t a specific location relevant to the Decision.

Decision Events that do not contain a #POPUP entry are treated as an automatic ‘YES’ decision selection. This can be useful in campaign design as a trigger for events when it would be inappropriate to offer players an actual decision. They can also be used to either add or deduct MPPs from a country, e.g. to represent a temporary increase or decrease in the military budget.

To assist with the fine tuning of Decision Events, multiple #ALIGNMENT_POSITION= can be set, or this field can be left empty if it isn’t applicable.

With the #TYPE=field, the engine works through events in the following sequence:

- The Decision Event fires
- The engine works through all events looking for scripts to be triggered by this Decision Event.
- The engine fires the next DECISION event in the list of events whose trigger has been met.
- When this process has been completed, any Decisions that were TYPE=2 will be reset to a null state, waiting to be triggered again on each and every subsequent turn when their conditions are met.
The #MESSAGE= field can support the following special characters:
%N = newline or carriage return
%T = horizontal tab
%R = right align text, must be applied at the beginning of a newline, otherwise ignored
%C = center align text, must be applied at the beginning of a newline, otherwise ignored
%B = bold text, must be applied for each word you wish to bold
%V = italic text, must be applied for each word you wish to italicize

Viewing Decision Events in the Editor
Once you've added or amended any Decision Events, providing you Update the script you can then see these scripts as they would appear in the game by selecting Decision and clicking on the View Button that appears in the bottom right of the screen where you Update the scripts (Campaign → Edit Event Scripts).

If you edit any Decision scripts while you are viewing them, when you left click on the viewing panel it will refresh to show you the latest version of the relevant script.

3.2. Editing Artificial Intelligence Scripts
To edit Artificial Intelligence (AI) scripts for the computer opponent, select Campaign and then Edit AI Scripts from the Main Menu bar. This will allow you to edit all of the AI's specific script types.

As with editing Event scripts, select the AI script to edit and then click Open/Edit. If you open them, each one has a small write-up about what they do and how to use them.

After editing the script, save the text file and update the script(s) like you would with Event files.

The default AI script templates are located in the game's Templates\AI directory. The AI scripts for individual campaigns are saved in the Scripts\AI sub-directory created for each campaign in the Campaigns directory.

A general description of the different types of AI events found in the game is provided below.
3.2.1. Guard
This event handles AI requirements for guarding places on the map.

3.2.2. Fortification
This event handles the AI’s construction of Fortifications.

3.2.3. Offensive
This event handles AI requirements for preparing and executing operations such as launching a German offensive against a neutral USSR, or for attacking smaller neutral countries.

Generally the AI can manage offensives without requiring scripts once it is at war with a country, providing it has built up the necessary units and any resources of lesser importance are added to the AI’s Exclusion Lists.

To view and amend the AI’s Exclusion Lists, click on Campaign → Edit AI Scripts and then click on the Advanced button in the bottom right. Resources can then be excluded or included from each side’s lists, and it is recommended to start by excluding everything, and then when you run your tests, study the results as you selectively remove important resources from the Exclusion List.

Info: The AI will not declare war on neutral countries when the weather in the region is Rain, Snow or Sandstorms.

3.2.4. Amphibious
This event handles the AI’s launching of amphibious landings, and the AI will automatically try to assign a HQ to this script.

3.2.5. Transport
This event handles the AI’s transporting of units from Port to Port on the map, and the AI will automatically try to assign a HQ to this script.

3.2.6. Amphibious Minor
This event handles the AI’s launching of amphibious landings, but without using a HQ.
3.2.7. **Transport Minor**
This event handles the AI's transporting of units from Port to Port on the map, but this will not move HQs.

3.2.8. **Fleet**
This event handles the AI's naval movements and offensives.

3.2.9. **Purchases**
This event handles AI purchases on a turn-by-turn basis.
Units that have been destroyed will only be rebuilt if there is a matching Purchase script entry for this unit type. However, if there are no Purchase scripts for the country whose unit has been destroyed, then this rule doesn’t apply, for instance you don't need to create Purchase scripts for all Minors in the game, as the AI can attempt to rebuild their destroyed units without a script being in place for that Minor.

3.2.10. **Diplomacy**
This event handles AI diplomacy allocation on a turn-by-turn basis.

3.2.11. **Research**
This event handles AI research allocation on a turn-by-turn basis.

3.3. **Suggestions For Creating a New Campaign**
The Editor is a powerful tool not only for adjusting the current campaigns, but also for creating brand new ones. You can try your hand at reproducing old favorites or developing completely new campaigns using the *Strategic Command* game engine. The possibilities are virtually endless!

Although this is first and foremost a game engine designed for covering the Second World War, its game mechanics for combat, economics, diplomacy and research can be applied to many other conflicts. The Editor is flexible enough to allow a significant amount of customization for other time periods, and for virtually any scale and scope.
3.3.1. Develop a Design

The first step for creating a new campaign is to decide what the fundamental elements of your design are going to be. You may already have an idea about the time period, the location, and the forces involved.

Now you need to decide on some specifics for your game. How big do you want your map to be? How long should each game turn last? What size should your combat units be: Corps or Divisions for operational campaigns, or something smaller for tactical battles? How complex your game will be and how long it may take to play will depend on what you decide at the outset.

Once you determine how large your map needs to be, start a new campaign by selecting File → New as described above in the Creating a New Campaign section. Here you can define your new map size and begin filling in the various map layers using the instructions and tips provided.

You may also want to use the Import Data menu to select items and settings from a pre-existing campaign for re-use in your own campaign, since editing existing data is generally easier than starting from scratch. Save your new campaign with its own name to create a new sub-directory for it with its own campaign.ini file.

3.3.2. Customize Your Campaign

Once you've saved your new campaign, in the Campaigns directory there will be a sub-directory for your new campaign, and within this sub-directory you will find a campaign.ini file containing the lines:

```
#CUSTOM_BITMAPS= 1
#CUSTOM_INTERFACE= 1
#CUSTOM_SOUND= 1
#CUSTOM_MUSIC= 1
#CUSTOM_FONTS= 1
#CUSTOM_LOCALIZATION= 1
```

The setting of = 1 means that the campaign will automatically use any custom files and localization that you add to it. Changing any to = 0 means that the campaign would not use any custom settings for the relevant field.

#CUSTOM_BITMAPS= 1
To use custom bitmaps you will need to create a Bitmaps sub-directory within your custom campaign directory for your customized items. Then copy the original default Bitmaps file(s) that you wish to amend, pasting them into your campaign’s own Bitmaps sub-directory, and amend the new file. The game will then use these customized items instead of the default image files.

Caution: Be very careful when editing image files, as you do not want to amend the original files that come with this game. Make sure that you are editing copies, rather than the originals themselves. Making backups as you work is also recommended.

#CUSTOM_INTERFACE= 1

You can customize the images used in the game interface, such as having alternate flag sprites for the Major countries involved in your campaign or just changing the appearance of the interface. You will need to create an Interface sub-directory within your custom campaign directory for your customized items. Copy over the original files that you wish to amend from the game’s interface folder and paste them into this new sub-directory. The game will then use these customized items instead of the default ones.

#CUSTOM_SOUND= 1

To use custom sound files you will need to create a Sound sub-directory within your custom campaign directory for your customized items. Place your edited .ogg files there. The game will then use these customized items instead of the default .ogg files.

#CUSTOM_MUSIC= 1

To use custom music you will need to create a Music sub-directory within your custom campaign directory for your customized items. Place your edited .ogg files there. The game will then use these customized items instead of the default .ogg files.

#CUSTOM_FONTS= 1

To use custom fonts you will need to create a Fonts sub-directory within your custom campaign directory for your customized items. Place your custom .ttf or .otf files there. You may need to right click and install these fonts onto your system and then the Editor will list these customized items when editing the text layer of the campaign. The customized fonts will then show in game when you load the campaign.
Note: A warning message will let you know if you have done something wrong when attempting to load a campaign using any of the above customizations.

#CUSTOM_LOCALIZATION= 1

Custom localization means is that you will be able to rename many of the game’s elements, including the names of countries, unit types, research categories, etc.

To do this you will need to create a new localization.txt file within the custom campaign sub-directory for your customized items.

You can do this by copying some or all of the original localization.txt file from the game’s main directory into your custom campaign sub-directory. The “#NAME=” items are all names used by the game engine code itself and cannot be edited, but any or all of the text names to the right of the “=” sign can be edited.

It is strongly recommended to only include entries in your localization.txt file where you are using an edited entry, as otherwise the load time for turns could increase unnecessarily if more entries are included than are needed. The game will then use these customized items instead of the default text names.

Example: Consider a Roman game with Rome instead of Germany, and Legion instead of Tanks. In the combat target dialog and properties dialog sections of the localization.txt file, change Tank Attack to Legion Attack. In the terrain dialog, change Tank Defense to Legion Defense. In the Country IDs, change Germany to Rome. In the Unit IDs, change Tanks to Legion. In the Research IDs, change Advanced Tanks to Legion Equipment, and so on.

3.3.3. Add Your Own Media

Adding images to the campaign to provide historical ambience or information for players can be very useful, and the image guidelines are as follows:

- Save all image files as .png files
- The size of the image should be 732 x 412 pixels
- Save them in a Media folder inside the subfolder for your campaign
- Type the name of the image you wish to use, including the file extension (i.e. .png) into the relevant script’s row #IMAGE= . More than one image
name can be typed here, separating them with a comma, and the engine will choose at random an image to show whenever the script fires.

Use the images within the default Media folder, found within the installation folder, as a guide. Any suitable images can be re-used in your own campaign.

Adding sound to the campaign can also be useful, and the sound guidelines are as follows:

- Save all sound files as .ogg files
- Save them in a Media folder inside the subfolder for your campaign
- Type the name of the sound you wish to use, including the file extension (i.e. .ogg) into the relevant script's row #SOUND=. More than one sound name can be typed here, separating them with a comma, and the engine will choose at random a sound to play whenever the script fires.

### 3.3.4. Playtest Your Campaign

Getting your map and unit counters to look good is easy enough if you have some artistic skills, and even if you aren't very artistic, you might be surprised at how much you can do!

Getting your new game design to work smoothly will require some more effort, especially if you are making significant changes to the default values of the original game.

A good rule of thumb is to start simple, and then gradually add desired complexity. First verify that your basic features work as desired and then slowly build in more advanced features. If you try to do too much too fast, it may be very difficult to determine how to resolve a complex problem with your game design.

So, if designing a new campaign totally from scratch, it's best to start with just one section of the map roughly worked out. Use this area as a combat testing ground to check that things like the map scale, the unit density you have in mind and the essential combat values of those units are in line with your desired result.

Once your game is running smoothly and you have had time to evaluate its strengths and weaknesses, further adjustments for play balance and variability can be made. Take your time and have some fun with the game design process!
If there are any special instructions or information a player will need to know about your campaign, it will be best to include a separate readme.txt file containing these in your Campaign’s folder.

3.4. FURTHER ADVICE & INFORMATION

3.4.1. TEXT ON THE MAP EDGE
On the left edge of the map (the y axis) there is a restriction in place to prevent any text being added that couldn’t be read by the game engine, as it would be outside the readable area.

3.4.2. UNUSED TERRAIN SPRITES
Some terrain sprites have not been utilized for this release, and these have a large red X through them within the sprite file. These sprites are available for modding use, and will be used in future expansions as our range of official graphics is expanded.

3.4.3. DESIGN PARAMETERS
As previously discussed in the above sections, the Campaign Editor does have some parameters for campaign design. In summary:

- The minimum map size is 10x10 hexes. The maximum map size is 512x256 hexes.
- As a minimum requirement, there MUST be at least one fully activated Axis or Allied Major country. Also, all Minor countries MUST have both an Allied and Axis parent defined.
- The game will support a maximum of 120 countries, of which 10 can be Majors, the rest being Minors, and their names can be defined in the localization.txt file.
- All countries represented on the map MUST have a Capital, and they can only have one active Capital at a time during a game.
- Campaigns may be set to run through any dates from year 0 to 9999, and the campaign end date must be greater than the start date.
3.4.4. Testing the AI in Game
There are 3 standard features available via the F1, F2, and F3 keys that can be used when developing and testing AI scripts in game.

**F1** creates a DEBUG subfolder in the “SAVE” directory that creates saved game files for each turn played by both you and the AI. This can be a useful reference for when you see the AI do something unexpected, as you can easily use the save file to load up the turn again to re-watch the AI's maneuvers in action.

These files will be saved in the following folder:
\Users\<username>\Documents\My Games\Strategic Command WWII - World at War \Save\DEBUG

**F2** creates a DEBUGLOGS folder with files that keeps track of AI Planning, Research and Diplomacy investments as well as turn-by-turn Weather information. In addition, it creates a *summaries.log* file which lists all the losses, military activity, and research activity for each turn for easy reference.

These files will be saved in the following folder:
\Users\<username>\Documents\My Games\Strategic Command WWII - World at War \DEBUGLOGS

**F3** triggers the AI to play against itself. This is very handy whenever you would like to see just how balanced your AI scripts are for both sides and/or if you quickly want to observe your AI planning from both sides. This button can be turned on before or during game play. If you press it before selecting any campaigns then the AI will play itself right from the very first turn, and you can sit back and watch or just review its progress periodically to see if things are roughly in line with your expectations.

4. Scenario Design Guide
By Alvaro Sousa

You have played *Strategic Command* for months on end. You played the Axis, played the Allies and tried every strategy possible exploring the “what if” of history. It is now time to try your own hand at designing scenarios.
Perhaps a small challenging battle no one has ever heard of, perhaps creating your own European theater to your liking. The question is how to start?

This guide is not how to use the editor. It will show you a path to organize your ideas and how to bring them to life. Creating a game is a much more difficult process than most people think. There are many steps to go through before the final product. You want to make your scenario as appealing to the player as possible with the most accurate information on the scale of the conflict you are trying to represent while maintaining balance and fun.

4.1. WHAT DO YOU WANT TO SIMULATE?
Some might think this is a silly question to ask but choosing what to create within the engine is important. Some scenarios might be more difficult than others to implement due to the mechanics, because while they can create many scenarios from many genres of war in some cases it might not be suitable. For instance creating a space strategy game using this engine might prove challenging.

Don't make a scenario for the sake of making it. Choose a game you will enjoy building. It takes a lot of time and effort to get things right so others will enjoy it. If a task becomes too tedious you might lose interest and quit before giving it a chance.

If creating something new seems too daunting then perhaps changing an existing scenario to make it to your liking will suit you better.

Once you have the battle you want to create the next step is gathering information

4.2. SCENARIO DATA AND INFORMATION
There are 3 sources to get information on battles and wars: books, the internet, other games.

Books are a challenge to get information from. Many history books don't have statistical information about units, battles, equipment, etc to use in your game. Buying book is very expensive. My suggestion is that if
you want to use books for information on the scenario you want to design
go to the local library or book store to find books on your subject and
examine them for this data. Some books have it, some don’t. I can list 2
recommendations that are specific data books for WWI and WWII. I do
recommend buying these two books if you are a WWI or WWII hobbyist:

*The World War I Databook: The Essential Facts and Figures for all the
Combatants* by John Ellis

*The World War II Data Book* by John Ellis

Both these books hold vast amounts of data on names, production,
casualties, formations, equipment, and configurations.

The internet holds a lot of hidden information if you know how to
find it. There are tons of websites that offer order of battles, statistics,
and unit statistics. There are forums that people talk about the accuracy
of information that others have found. When looking for difficult to find
records, such as railway systems during WWII, be creative in your search.
Sometimes these will be articles, other times it will just be a picture of an
original map from that time showing the information you are looking for.
Using the internet can be a double edged sword as some places might
have conflicting views on your subject. Sources like Wikipedia are a good
place to start to get data on battles. Doing a Google search under images
might get you US archives of documents concerning what you are looking
for. Using key words like “WWII” or a specific year narrows the search
considerably.

Other games are also excellent sources of information. They will offer
ideas on how to run production, technology, use the proper wording, get
order of battles for different countries, topography, etc. Many games are
partially available on Boardgamegeek.com in digital format. There you
can find game manuals, maps, counter sheets, setup sheets to help you
determine the structure you need for development. Keep a folder of this
material on the era you wish to design for.

Each resource is not exclusive. Use material from all sources and see
which information applies and helps you best. Get all the data required for
your game before you even start to work on the editor.
4.3. Map Research and Scaling
Using the tools above you should have found a map of the scenario area you want to design for. Try to get map information based on that time that you are creating. Modern maps may have changed landscape features and make the map inaccurate for the time period you are trying to recreate. For example, forests might have been cleared, rivers diverted, railways and roads might have been changed.

Once your map has been found you have to design on the scale of your game. Be aware that the earth is curved and there are different map types. A Gall–Peters projection map shows land masses and oceans accurate to the curvature of the earth. Mercator projection maps distort true areas in favor of linear lines. This is the map we are used to seeing in books and in video.

Your map size also affects the unit size. Be sure to use only the area you need for your battle. The smaller the map the less work you have. The time period you are designing for may have difference sizes for similar unit name types. Determine how much area the base type of unit for the map occupies and use that scale for the map. For example if your game is on a division scale and the frontage of a division is 10 miles then each hex should be 10 miles. If you are making a Corps level game then each hex should be 25-30 miles frontage.

Once you determine the scale of the game you can use many free graphics programs to overlay your map and place a hex layer on top of it. Programs like Gimp are absolutely free and better than some older Photoshop software in my opinion. If you know the size of the map you want to use then it is a matter of dividing it by the scale and setting a hex layer overlay to match the scale. You can use that to draw the map in the editor.

4.4. Game Map Design
Creating a map is a very long and tedious process. Resources, rail, roads, terrain, and weather all have to be placed while converting data from one format to another. A helpful way to reduce the clutter of doing all this is to take one item at a time. Within that item take one feature at a time to place on the map.
I suggest always starting with resources after the outline of the map is complete. So let's use it as an example. Start with the most important resources in the game that will help you better identify and estimate locations on the map, your major cities. From there place less important resources like towns, mines, ports, and oil. Place less important resources as you go using previous resources as placement estimations. After you have the resources in place it will be much easier to do the other assets of the map. Now you have a guide to follow for rivers, terrain, rail, roads, etc.

Spacing for map assets is another consideration when drawing a map. Putting too little assets shows a featureless map, placing too many a crowded map. A small scale scenario might not have as many cities and towns while another is so large you have many. In either case you need to fill in the empty areas with something else. Filling empty places with terrain, rivers, roads, and rail would be an option. I suggest using game supply as a guide. If you find supply too scarce in some spots you don't have enough resources. If supply stays too high, perhaps you have too many resources in that area. Overall if you step back and it doesn't feel correct then change it.

Text labeling the map is generally the last on my list of design. A suggestion would be to place labels on some major assets on the map for locational reference such as capitals and major cities/resources. A strong suggestion that software designers recommend is not to use more than two different fonts and a font size of 12 or more. If your audience is older a font size of 14 or higher is preferable. You might have someone complaining the fonts are too small. These could be gamers who have high definition monitors like I do. Set your game labels to the size that fits the average gamer’s monitor size and resolution. Many gamers and college students have laptops with the following average resolutions: 15.6” screen with 1366 x 768 HD (High Definition), 1600 x 900 HD+ (High Definition+), or 1920 x 1080 FHD (Full High Definition)

At the time of this guide the above suggestions are accurate, but with the availability of high definition monitors it might change.

Once you have completed your map go over it for obvious errors. Don't worry minor opinionated details. You will be modifying it later as you create the rest of your scenario. As you keep writing your game you will
probably have to change locations and adjust borders or assets on the map to improve game play for the players and/or the A.I. So if it doesn't look 100% to your liking don't worry about it.

4.5. Country Information

Your game is a simulation of the conflict you want to represent. It is not an accurate historical simulator. All gamers have the luxury of hindsight so following history is probably not the best way to make a fun game. There is also common sense hindsight on how to accurately reflect certain military arms of a country. Air forces and navies will probably be the greatest challenge in balancing the force pools due to how a game handles such assets in play and due to their limited numbers. Land units are plentiful and it is easier to balance. The variance is high when one side gains dominance in one field when the number of units in that field is small, like airplanes. So the differences between force pool strengths have to be closer than probably history says it should be.

Other factors that are involved in developing the game play and balance are a matter of trial and error giving your best guess to what is correct for areas like research, upgrades, unit statistics. My suggestion would be to start conservative following examples of past games and go up from there. It is easier to assess how much more you need than how much less if the scales are too high.

4.6. Unit Map Ratio

A game with too few pieces lacks fun and one with too many is tedious. With land units a general rule of thumb is to have enough units to form a front line with some reserves on an active front and about half the number of units on an inactive front. Have enough units that players are generally never finishing their force pools if there is a lot of action. There should always be some units to build and rebuild.

Naval and air units need to be adjusted to what you feel is appropriate for the scale of these units relative to each other and land units. For example if each air counter is 1000 planes and each navel unit is 2 ships
your scales are off. You need to rethink the scales. I suggest adjusting air unit scales to aircraft units scales and values. So if a carrier fleet is equal to four large carriers, which have about 400 planes, then the air unit should be a value of 400, 800, or 1200. Depending on the scale adjust the values of the air units to reflect their strength. I believe the naval and air ratios are more important to get right than the air and land ratios.

4.7. Event Scripting

*Strategic Command* has its own scripting method unlike a programming language. It is fairly easy to learn and use. All the variables and fields in a script are fairly self explanatory and used globally with all the scripts that perform different functions. So many identifiers will be similar. The user manual has all the references for what each variable and field means.

Writing events is fairly easy. But chart out your event sequence before you start adding every detail in your game. Consider what is trivial and what is important. Overwhelming your players with information that has little use to the scenario can easily frustrate a war gamer with boredom.

When making decision events my usual approach is to give players a valid equally positive choice. For example if they want a free airplane or free armor. Players love making choices that can impact the way their war goes. Trivial or easy choices can be added to give the game a little historical flavor. But too many easy obvious choices might bore your players. An alternate method is to offer a positive/negative “yes” choice or neutral “no” choice. This is where if a player takes the choice there is a negative consequence later or somewhere else in the game. This can be something as simple as paying MPPs for winter clothing on the Russian Front or allying a country at the cost of US entry for example.

Another possible choice is an obvious easy choice that is what I call an absolute. Either the price you pay is worth taking the decision or it isn’t and its impact on the game is large. I would try to avoid those because they can be overpowering in the game giving one side a distinct advantage. Paying for Spain’s entry into the war with MPPs is an example. It is either worth it, or it is not. Spain’s entrance as an Axis can be a game changer.
4.8. ARTIFICIAL INTELLIGENT SCRIPTING

A.I. scripting is where the hardest part of the game design lies. This is not something you can simply sit down and write out file at a time in a day. It is the longest part of designing a game and increases in time as the size of the scenario grows.

Just like any battle plan you need to create one for the A.I. Think how you would fight this battle or war yourself. Get input from other gamers on different strategies they employ to defeat opponents. Write down a logic tree of how to approach the strategy from every angle possible. Once you have an outline of how your A.I. will play then you can begin scripting for it.

You will make hundreds of mistakes. You will have to hunt down hundreds of bugs in the scripts. At times you might have to adjust the map so the A.I. can function in that part of the game correctly. For example having the A.I. attack a narrow part of the map that can be easily defended by a human is difficult to do.

You will need to be creative and flexible on how to approach what the A.I. will do. Sometimes less forces for a task is better than more forces. Splitting up a large attack into many attacks may also be preferable to prevent overcrowding of units. Then at other times letting the A.I. do its intrinsic fuzzy logic attack routines that are integral to the game engine is the best strategy.

How can you be sure the A.I. is running correctly? Have it play itself and watch the screen or play it yourself. With the function keys you can save debug logs, turns, and have the computer play itself. Go back and review what the A.I. did and adjust. Once you see the A.I. flowing through its strategy fairly seamlessly then you can feel confident it is ok for humans to test.

4.9. PLAY TESTING

Once you have everything done and you feel you’re A.I. is at a decent level of competence from playing itself or you then you can place it out to the public to play. Many gamers will happily play your scenario and give you feedback and opinions. If you get negative feedback learn from it and don’t take it to heart. Sometimes you get a player who is just a stickler for some small insignificant detail. This doesn’t mean you have to adjust your game.
for it. But take the time to read all the comments and suggestions. The greatest amount of knowledge you attain is learning from your mistakes, not your victories.

4.10. Graphics
I will touch on this lightly. When you create a new scenario a folder is created on your hard drive specifically for this scenario. Here you can customize graphics, sounds, and scripts to your liking without affecting the original files. If you are not good at using graphics programs I would suggest just copying and modifying the images provided in the original game. Gimp is a free graphical program that a designer can use to change or create new images.

4.11. Conclusion
To create a game from scratch is a task that usually requires many people with different skill sets. With the advent of modding many companies have created editors, and game design software, to encourage new ideas and development. Most of these are for free. Strategic Command has its own unique editor software that makes it easy to create your own scenarios. A single person can create amazing games from their computer within a reasonable amount of time.

Designing and creating a new battle is a very exciting experience. The lovely graphics and software that come with Strategic Command will bring big game company life to your ideas with the only cost being time. Don't be discouraged if you get stuck or your game is not as appealing as you hope it would be. Every scenario you make only is a learning experience on how to improve for the next time.

Pick up some books on game design, artificial intelligence, and graphics if you want to take designing games seriously. It is time consuming work but very rewarding to see other people enjoying what you create. If your work is good enough you might even get recognized by a game company and asked to join their team. So if this is your passion you are on the right path. I wish you the best of luck in your endeavors of game design.
4.12. MAP DESIGN EXAMPLE

When initially designing a map, making use of a hex sheet overlay makes it a fairly simple process to translate it from the original image to the SC Editor as a game map. The example I've decided to use here for Part II will be a D-Day scenario using Corps as our unit scale and 40 miles per hex for our overall game map scale. I've used this general map found on Wikipedia and a hex sheet I found on the internet quite easily. Be sure that any hex sheet you use has the hex flat on the top, not pointy as that is how the SC maps are set. Here are both images as seen in Photoshop 6.

Conveniently enough, the map I selected from Wikipedia already has the scale in miles set for it on the lower right side. However, if a map doesn't have the scale written down, use a real map and find the distance between two cities with this website https://www.distancecalculator.net/. Try and find two cities that are your scale away from each other. In this case it is 40 miles. That will give you a starting point to know the pixel to hex scale.

If you had to measure your cities then count the pixels between them. Finding two cities that are separated by your scale model makes it easy to calculate the pixel size.

Once you have the scale to pixels, modify the image size of the hex overlay sheet to match. The vertical height of a single hex on the sheet must be the number of pixels you measured so it matches to scale. Overlay the hex sheet on to the map. Now you are ready to draw on the Editor.

When starting to draw your map within the Editor, I would draw the full hexes first then fill in the outside coastal hexes. Here I did some of the Normandy Beaches. While you can tell it is not perfect it is a starting point. Note: There are many tiles in the SC Editor to choose from to design coast lines. It takes time and patience to design the map.

4.12.1. UNIT CONVERSION FROM BATTLE MAP

Another difficult task is how to design the right unit scale on the map from data. Sometimes it can be confusing on exactly how to do this. The map I selected, once again conveniently details where Divisions are Corps were located in the Normandy area. Some maps are very easy to use and setup your units such as this one, but if a map didn't have the Corps locations
we would have to do a little research to find out where the Corps were located in Normandy on that day.

Converting the units from this map to the Editor is fairly easy. We have our Corps listed; LXXXIV at Normandy Beach, XLVII Armored Corps near Rouen, LXXXI Corps near Dieppe, and I Armored Corps near Paris. But there are other units listed out on the map with no Corps names such as the one near Cherbourg. What we do here is compromise and combine units. The best way to group units is by the amount of men a unit has to our unit scale. In this scenario let's assume a German Corps has about 50,000 men. You can estimate how many Corps you need by grouping together loose divisions to form a Corp. Use references to look up which Corps might have been in the area and the strengths of the Divisions. Some Corps might have had two half full divisions, some might have had 5 divisions for a total of 60,000 men. You don't have to be perfect, just match about how many men there were in the theater with the number of units and just select a Corps name of a unit that was historically nearby. You can always move or change the units to your liking.

If you want to modify units it is pretty easy. Don't worry about picking the right unit if it is not listed correctly on the name list. You can modify anything in the unit later. This picture below shows the Corps I placed in the editor using the D-Day map above. I can go individually to each unit and modify any of its properties and its name.

Some of you might want to get the historical accuracy of the scenario perfect. Sometimes you can't unless your scale is small. Often you will have to group units together to form another unit without the exact Corps that it represents. At times you can do this by placing two units and lowering the strength of them representing two under strength historical Corps. But the impact and ease for a player to reinforce the units to full strength might be too easy. Or it might give them too many physical units on the map and these are design decisions to keep in mind.

A good base start to know how many units a country has in a given scenario is to look up exactly how many men, tanks, and planes they had in the theater, figure out your unit scale and divide that into the number of physical units on the map. If the Germans have 500,000 units on the Western Front on June 6th 1944 and your scale is 50,000 men per Corps then you should have 10 Corps on the map for this scenario for example.
4.12.2. Conclusion

Defining maps and placing units is a task of estimating and abstract thinking. While other sections of this Manual give clear details on how to use the Editor functions and how to begin a basic design, the proposed methods and outlines in this guide should make your endeavor that much easier. It should help you better gauge how to design maps and the value that units are worth in SC game terms. Combining the two creates a scale for your game that fits the unit sizes.

When new gamers first get excited about scenario designing they might not know how different units were in World War II. Russian infantry divisions were 10,000 strong grouped into armies. Russian armored Corps were grouped into armies. Most Western Allied divisions had 18,000 to 20,000 men per division. Germans had 12,000 to 15,000 men per division. The Japanese has special reinforced divisions of 20,000 men. Early in the war Germany had 3 battalions per division, later they had 2 with more defending firepower. So there are many configurations to examine and calculate for. Grouping your units based on the number of men, not actual unit names, makes the task of map and unit design much easier to scale.

To help you get started below is a list of resources to guide you on your journey:

- All World Wars http://allworldwars.com/index.htm - general information about various subjects in WW2 with some maps
- Wikipedia https://en.wikipedia.org/wiki/Main_Page - lots of good sources on battles with statistics on those battles. It has order of battle, unit names, time atlases and much more.
- Convoy Web http://www.convoyweb.org.uk/ - Merchant ships of WW2
- Pacific Naval Battles http://combinedfleet.com/battles/ - Good source for the Pacific if you want to build some naval scenarios
- WW2 Reference Guide for Gamers and Modders http://www.acsu.buffalo.edu/~dbertuca/miniatures/ref-ww2.html#afg - Lists of many places you can go to find information
- WW2 Armed Forces http://www.niehorster.org/ - Large database of order of battle
4.12.3. ABOUT THE AUTHOR
Games have been my passion since my first game of Third Reich in the 1980s. I have seen the transitions that board and computer games have gone through over the years. I lived through the golden age of video games. My favorite part of game design is writing A.I. for computer opponents. I enjoy creating computer opponents that challenge players so they come back to a game over and over again. I designed Brute Force 1939 for Strategic Command 2, Assault on Communism, and Assault on Democracy. Currently I am a professional poker player, beta tester for Fury Software, and developing games using the Unity Game Engine as an indie game developer.

5. REFERENCE TABLES

5.1. COMBAT
Not having a better understanding of the effects that the unit variables hold on combat results can often lead to poor choices when it comes time to decide on whether to attack, defend, reinforce or upgrade a unit.

The in game indicators of potential combat losses and the breakdown of the attacker and defender combat target values, certainly help, yet often there are times where there are so many different unit values to consider that some clearer examples would likely paint a better overall picture.

Below we offer several tables that present a variety of differing combinations of changing unit strength, supply, readiness, morale, experience and applicable research levels.

For the sake of simplicity, all tables use Tank versus Tank combat with the attacker having a default attack value of 4, and the defender a default defense value of 3. Most tables assume the Prepared Attacker Readiness Bonus of 25%.

Please refer to the Combat Losses section in this manual for further details on how attacker and defender losses are precisely calculated using the values in the tables shown below.
| Attacker (Strength) | Defender (Morale) | Readiness (%) | Supply | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%) | Level | Experience | Morale (%)|
## TANK VS. TANK – DECREASING ATTACKER STRENGTH AND SUPPLY READINESS/MORALE

<table>
<thead>
<tr>
<th>Attacker = 4</th>
<th>Defender = 3</th>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>68</td>
<td>90</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>60</td>
<td>80</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>53</td>
<td>70</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>45</td>
<td>60</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>38</td>
<td>50</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
</tbody>
</table>

*With Prepared Attack Bonus*

## TANK VS. TANK – INCREASING ATTACKER ADVANCED TANKS RESEARCH LEVELS

<table>
<thead>
<tr>
<th>Attacker = 4 + Level</th>
<th>Defender = 3</th>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>2</td>
<td>2</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>7</td>
<td>0</td>
<td>0</td>
<td>7</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>8</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>5</td>
<td>2</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>9</td>
<td>0</td>
<td>0</td>
<td>9</td>
</tr>
</tbody>
</table>

*With Prepared Attack Bonus*
### TANK VS. TANK - INCREASING ATTACKER STRENGTH AND EXPERIENCE

<table>
<thead>
<tr>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
<th>Attack Level</th>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>3</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>4</td>
<td>0</td>
<td>1</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>15</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>6</td>
<td>0</td>
</tr>
</tbody>
</table>

*With Prepared Attack Bonus*

### TANK VS. TANK - INCREASING ATTACKER STRENGTH, EXPERIENCE AND ADVANCED TANKS RESEARCH LEVELS

<table>
<thead>
<tr>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
<th>Attack Level</th>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>7</td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>3</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>4</td>
<td>0</td>
<td>1</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>15</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
</tbody>
</table>

*With Prepared Attack Bonus*
## TANK VS. TANK - INCREASING ATTACKER AND DEFENDER ADVANCED TANKS RESEARCH LEVELS

<table>
<thead>
<tr>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>2</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>5</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>5</td>
<td>4</td>
</tr>
</tbody>
</table>

**With Prepared Attack Bonus**

## TANK VS. TANK - INCREASING ATTACKER AND DEFENDER ADVANCED TANKS RESEARCH LEVELS

<table>
<thead>
<tr>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
<th>Strength</th>
<th>Supply</th>
<th>Readiness (%)</th>
<th>Morale (%)</th>
<th>Experience</th>
<th>Level</th>
<th>Losses</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>2</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>5</td>
<td>2</td>
<td>10</td>
<td>10</td>
<td>75</td>
<td>100</td>
<td>0</td>
<td>5</td>
<td>3</td>
</tr>
</tbody>
</table>

**Without Prepared Attack Bonus**
5.2. Convoy Raiding

These final tables outline the maximum expected results per raider type and per season, for the major convoys found in game. Please refer to the Combat Raiders Mechanism section in this manual for further details on how these values are precisely calculated. Each convoy raider result as shown below assumes units at a max strength of 10. In addition, and for further simplicity, Subs are assumed to be at Advanced Subs Research Level 0 with an enemy Anti-Submarine Warfare Level of 0 as well.

<table>
<thead>
<tr>
<th>CANADIAN SUPPLY CONVOYS TO THE UK</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit</strong></td>
</tr>
<tr>
<td>Tactical Bombers</td>
</tr>
<tr>
<td>Medium Bombers</td>
</tr>
<tr>
<td>Strategic Bombers</td>
</tr>
<tr>
<td>Maritime Bombers</td>
</tr>
<tr>
<td>Dreadnought</td>
</tr>
<tr>
<td>Battleship</td>
</tr>
<tr>
<td>Battle Cruiser</td>
</tr>
<tr>
<td>Heavy Cruiser</td>
</tr>
<tr>
<td>Light Cruiser</td>
</tr>
<tr>
<td>Destroyer</td>
</tr>
<tr>
<td>Escort Carrier</td>
</tr>
<tr>
<td>Carrier</td>
</tr>
<tr>
<td>Sub</td>
</tr>
<tr>
<td>Motor Torpedo Boat</td>
</tr>
</tbody>
</table>
### US Lend Lease to the UK

<table>
<thead>
<tr>
<th>Unit</th>
<th>Raid Multiplier</th>
<th>Winter (50%) MPP</th>
<th>Spring (75%) MPP</th>
<th>Summer (100%) MPP</th>
<th>Fall (75%) MPP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tactical Bombers</td>
<td>4</td>
<td>3</td>
<td>5</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>Medium Bombers</td>
<td>5</td>
<td>4</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Strategic Bombers</td>
<td>3</td>
<td>2</td>
<td>3</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>Maritime Bombers</td>
<td>5</td>
<td>4</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Dreadnought</td>
<td>10</td>
<td>8</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Battleship</td>
<td>10</td>
<td>8</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Battle Cruiser</td>
<td>8</td>
<td>6</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Heavy Cruiser</td>
<td>8</td>
<td>6</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Light Cruiser</td>
<td>8</td>
<td>6</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Destroyer</td>
<td>5</td>
<td>4</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Escort Carrier</td>
<td>5</td>
<td>4</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Carrier</td>
<td>10</td>
<td>8</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Sub</td>
<td>10</td>
<td>8</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Motor Torpedo Boat</td>
<td>5</td>
<td>4</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
</tbody>
</table>

### UK Arctic Convoys to the USSR via Murmansk

<table>
<thead>
<tr>
<th>Unit</th>
<th>Raid Multiplier</th>
<th>Winter (100%) MPP</th>
<th>Spring (100%) MPP</th>
<th>Summer (100%) MPP</th>
<th>Fall (100%) MPP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tactical Bombers</td>
<td>4</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Medium Bombers</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Strategic Bombers</td>
<td>3</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Maritime Bombers</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Dreadnought</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Battleship</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Battle Cruiser</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Heavy Cruiser</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Light Cruiser</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Destroyer</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Escort Carrier</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Carrier</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Sub</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Motor Torpedo Boat</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>
### UK ARCTIC CONVOYS TO THE USSR VIA ARCHANGELSK

<table>
<thead>
<tr>
<th>Unit</th>
<th>Raid Multiplier</th>
<th>Winter (0%) MPP</th>
<th>Spring (75%) MPP</th>
<th>Summer (100%) MPP</th>
<th>Fall (75%) MPP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tactical Bombers</td>
<td>4</td>
<td>0</td>
<td>5</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>Medium Bombers</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Strategic Bombers</td>
<td>3</td>
<td>0</td>
<td>3</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>Maritime Bombers</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Dreadnought</td>
<td>10</td>
<td>0</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Battleship</td>
<td>10</td>
<td>0</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Battle Cruiser</td>
<td>8</td>
<td>0</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Heavy Cruiser</td>
<td>8</td>
<td>0</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Light Cruiser</td>
<td>8</td>
<td>0</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Destroyer</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Escort Carrier</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Carrier</td>
<td>10</td>
<td>0</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Sub</td>
<td>10</td>
<td>0</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Motor Torpedo Boat</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
</tbody>
</table>

### SWEDISH IRON ORE SHIPMENTS TO GERMANY

<table>
<thead>
<tr>
<th>Unit</th>
<th>Raid Multiplier</th>
<th>Winter (0%) MPP</th>
<th>Spring (75%) MPP</th>
<th>Summer (100%) MPP</th>
<th>Fall (75%) MPP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tactical Bombers</td>
<td>4</td>
<td>0</td>
<td>5</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>Medium Bombers</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Strategic Bombers</td>
<td>3</td>
<td>0</td>
<td>3</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>Maritime Bombers</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Dreadnought</td>
<td>10</td>
<td>0</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Battleship</td>
<td>10</td>
<td>0</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Battle Cruiser</td>
<td>8</td>
<td>0</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Heavy Cruiser</td>
<td>8</td>
<td>0</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Light Cruiser</td>
<td>8</td>
<td>0</td>
<td>9</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>Destroyer</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Escort Carrier</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Carrier</td>
<td>10</td>
<td>0</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Sub</td>
<td>10</td>
<td>0</td>
<td>11</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>Motor Torpedo Boat</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>8</td>
<td>6</td>
</tr>
</tbody>
</table>
# NORWEGIAN SUPPLY SHIPMENTS TO GERMANY

<table>
<thead>
<tr>
<th>Unit</th>
<th>Raid Multiplier</th>
<th>Winter (100%) MPP</th>
<th>Spring (100%) MPP</th>
<th>Summer (100%) MPP</th>
<th>Fall (100%) MPP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tactical Bombers</td>
<td>4</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Medium Bombers</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Strategic Bombers</td>
<td>3</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Maritime Bombers</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Dreadnought</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Battleship</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Battle Cruiser</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Heavy Cruiser</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Light Cruiser</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Destroyer</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Escort Carrier</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Carrier</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Sub</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Motor Torpedo Boat</td>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

## SUBS

<table>
<thead>
<tr>
<th>Unit</th>
<th>Enemy ASW Levels</th>
<th>Maximum General Convoy Raiding (MPP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub Level-0</td>
<td>0</td>
<td>15</td>
</tr>
<tr>
<td>Sub Level-1</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>Sub Level-2</td>
<td>0</td>
<td>25</td>
</tr>
<tr>
<td>Sub Level-3</td>
<td>0</td>
<td>30</td>
</tr>
<tr>
<td>Sub Level-4</td>
<td>0</td>
<td>35</td>
</tr>
<tr>
<td>Sub Level-5</td>
<td>0</td>
<td>40</td>
</tr>
</tbody>
</table>

# Increasing Advanced Subs Research Levels with a matching level of enemy Anti-Submarine Warfare (ASW) Research. Subs assumed to be at strength 10 and with a raiding multiplier of 10.
CREDITS

FURY
Game Design and Programming
Hubert Cater

Campaign and Scenario Design
Bill Runacre, David Stoeckl

Development Testers

User Manual and Layout
Bill Runacre, Marta Falbo

Editing
Dan Fenton, Jim Potts

Sounds
Matt Faller

Music
Alexandre Bergeron Guyard

Artwork and Graphic Design
Jean Vincent Roy, Marta Falbo, Christian Walter

Special Thanks
Coral Bliss, Eddie Cater, Sophia Cater, Claudia Petracca

In Memory
Dave “Immer Etwas” Maurer

MATRIX
Chairman
JD McNeil Development

Director
Iain McNeil
Technical Director
Philip Veale

Creative Director
Richard Evans

Marketing
Director Marco A. Minoli

Lead Producer
Bart Schouten

Producers
Tamas Kiss, Adam Grace, Erik Rutins

Product Manager
Alberto Casulini, Daniele Meneghini

Social Media Manager
Simone Parenti

Media Relations
Paolo Paglianti

Production Design
Adriana Bienati

Manual Layout
Myriam Bell

Production Lead
Matthew Davis

Production Team
Lucas Young, Sam O’Neill

Administration
Dean Walker, Annick Tuesley

Customer Support Staff
Paulo Costa, Joseph Miller

Web Development
Valery Vidershspan, Andrea Nicola, Fernando Turi